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New Features in ArchiCAD 8
For more information on these features, see the relevant Chapter of the User Guide.

“Interaction Techniques”
“Interface Elements”
“Tool Functions”
“Project Customization”
“Content”
“Visualization”
“Publishing and Data Exchange”
“Other Revisions”
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Interaction Techniques
“Pet Palette”
“Real-Time Pan and Zoom”
“Single and Multiple Copies with Drag, Rotate, Mirror ”
“Single Key Shortcuts”
“Group”
“Visual Placement Feedback”

Pet Palette
• Available when drafting or editing polygonal elements or a continuous chain of single elements
• Contains standard editing functions of polygonal elements plus shortcut to Arrow Tool’s pet palette. 
• Already drafted segments of polygonal elements can be used as snap references for new segments.
• Also available for Arrow Tool.

See “Pet Palettes” in Chapter 2 of the User Guide.

Real-Time Pan and Zoom
• With a wheel-mouse: zoom in and out on the area around the mouse pointer. Press the wheel to pan. (Available 

during 2D editing operations).
• With Notebook/Mac and tablet devices: Use the numeric keypad to pan left, right, up and down. Use the + and - 

keys to zoom in and out; press these keys continuously to simulate wheel-mouse pan and zoom effects.
The “±” zoom button in the scrollbar also models wheel–zoom.

• Zoom popup button in the scrollbar saves zooms and accesses predefined zooms.
See “Redrawing or Rebuilding a View” in Chapter 2 of the User Guide.

Single and Multiple Copies with Drag, Rotate, Mirror 
• Press the Control key while using the regular Drag/Rotate/Mirror commands to create a copy. (This adds a small + 

mark to the cursor). 
• Press the Control-Alt keys with these commands to create multiple copies. (This adds the ++ mark to the cursor).
• Separate “Drag a Copy”, “Rotate a Copy” and “Mirror a Copy” commands can added to the Edit menu (through 

Preferences or the context menu).
See “Drag, Rotate, Mirror a Copy” in Chapter 4 of the User Guide.

Single Key Shortcuts
To cancel operations: Esc
Toggle among relative construction methods:

• Parallel/Perpendicular   P
• Angle Bisector   H
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• Offset/Repetitive offset   O
• Align to Surface/Dividing PointD

Other toggle shortcut keys:
• Grid Snap states   S
• Geometry Methods   G
• Construction Methods   C

Group
Elements may be grouped in suspended mode. 
See “Grouping Elements” in Chapter 5 of the User Guide.

Visual Placement Feedback
When placing an object, its outline will follow the crosshair cursor. (This feature can be disabled in 
Preferences).
See “Moving Elements” in Chapter 5 of the User Guide.
New Features in ARCHICAD 8-20 21



New Features in ArchiCAD 8
Interface Elements
“New Startup Dialog”
“Project Navigator”
“Tool Settings Dialog Box”
“Info Box”
“New Scrollbar Items”
“Element Info Palette”

New Startup Dialog
Contains extended file access and quit functions.
See Starting or Opening a Project in Chapter 6.

Project Navigator
• Integrates the former QuickViews with the Publisher.
• Provides overview of project structure and access to all documents in project file.
• Allows user to create documentation sets and distribute them in all known formats.
• Includes View Sets tab page with three preset view sets and user-defined hierarchical groups.

See “ArchiCAD Palettes” in Chapter 2 of the User Guide.

Tool Settings Dialog Box
• Resizeable.
• Simplified default views.
• More parameters visible at a time without tab pages.
• Includes access to Favorites Palette.

See “Tool Settings Dialog Boxes” in Chapter 2 of the User Guide.

Info Box
• Resizeable.
• Fully customizable to show tool settings in any order.

See “The Info Box” in Chapter 2 of the User Guide.

New Scrollbar Items
• Shortcuts to Project Navigator and Navigator Preview.
• The “±” zoom button models wheel–zoom.
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• Zoom popup button saves zooms and accesses predefined zooms.
See “Chapter 2: The ArchiCAD User Interface” in the User Guide.

Element Info Palette
Provides instant access to information on ArchiCAD elements.
See “Element Information” in Chapter 10 of the User Guide.
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Tool Functions
“Arrow Tool”
“Marquee Tool”
“Polyline Tool”
“Associative Labels”
“Dimension Tools”
“Detail Drawing Tool ”
“Mark-up Tool”

Arrow Tool
• New Geometry Methods: Polygon/Rectangle/Rotated Rectangle 
• New Construction Methods: Select Fully Included Elements/Select Partially Included Elements
• Selection: Select polygonal elements by including any of their edges in the selection rectangle.

See “Selection Using the Arrow Tool” in Chapter 5 of the User Guide.

Marquee Tool
Creates both convex and concave 3D cutaways based on any Marquee shape.
See “Selection using the Marquee Tool” in Chapter 5 of the User Guide.

Polyline Tool
• Polylines are fully implemented and can be used to draw any polygonal shape on the fly.
• Transformation of Lines/Arcs into Polyline: “Unify” option of Line Extras command (Tool menu) connects endpoints 

of selected selection of lines and arcs to transform them into Polyline element. (Chains of elliptical arcs cannot be 
unified).

See “Straight Lines and Curves” in Chapter 4 of the User Guide.

Associative Labels
• Accessible from Listing panel of current element’s tool settings box.
• Use “Label Element” checkbox to apply the associative Label.

See “Label Tool and Settings” in Chapter 4 of the User Guide.
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Dimension Tools
ArchiCAD keeps track of manual dimension text positions in multiple scales: any change will be 
effective only in the scale that was in effect at the time of the positioning action (unless the Revert 
to Automatic checkbox is selected).
See “Dimensioning” in Chapter 4 of the User Guide.

• Section Generation
• Zero Depth method generates a draft section that displays only the cut elements.
• Sections can be divided into close and distant areas with separate pen weights for each area.
• Section lines can be shown fully or partly, with or without markers.
• Staggered section lines can contain unlimited number of segments.
• Associative Labels can be added to construction elements on Sections.

See “Section/Elevation Tool and Settings” and “Placing Associative Labels” in Chapter 4 of the User 
Guide.

• Detail Drawing Tool 
• Features customizable detail markers with direct links to dedicated workspaces. 
• External libraries containing 2D details can be hotlinked to detail drawing windows.
• Set separate scale for Detail Drawing window from Options menu.

See “Detail Drawing Window” in Chapter 2 and “Detail Tool and Settings” in Chapter 4 of the User 
Guide.

Mark-up Tool
• Highlight elements to call attention to them, without making corrections or suggestions or altering element 

attributes.
• Highlights may be revealed or hidden independent of the layer system (in Display Options).
• Use “Mark-Up mode” in Teamwork to add corrections and highlight elements in other team members’ workspaces. 

• Reassign Mark-Up entries with full editing rights to other team members. 
• Mark Up report: available from Mark-up Tools palette.
• Discussion panel allows back-and-forth communication among Mark-Up participants.

See “Project Mark-Up” in Chapter 9of the User Guide.
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Project Customization
“Display and Output Options”
“Reference Levels ”
“Preferences - New Panels”
“Interface Customization”

Display and Output Options
• Detail Boundary: Show/Hide.
• Mark-up Items: Show/Hide.
• Beams: Full/Centerline/Contours.
• Section Markers: Normal (displays full section line) or Key plan (places a single marker at midpoint of imaginary 

Section Line).
See “Display Options” in Chapter 6 of the User Guide.

Reference Levels 
• Can be input across entire user interface (e.g. Surveyor Zero) and/or documentation (e.g. Sea Level).
• Z value (in the Coordinate Value Fields) can be measured from any Reference Level.

See “Preferences” in Chapter 6 of the User Guide.

Preferences - New Panels
• 2D Redraw Options: Set options (Model Display in 2D Navigation, Open GL Settings, etc.) which affect speed of 2D 

redraw.
• Temporary and Cache folders: Set location of these folders. Changes take effect after program is restarted.
• Dialog Boxes and Palettes: Adjust their display.
• Revert to Operation Methods of earlier ArchiCAD versions

See “Preferences” in Chapter 6 of the User Guide.

Interface Customization
Customize the following items from the Options menu:

• Info Box
• Tool Settings Dialog Boxes
• Keyboard Shortcuts
• Palette Shapes

See “Workplace Customization” in Chapter 6 of the User Guide.
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Content
“GDL Objects”
“Library Manager”
“Browser Features”
“New Door/Window Parameters”
“Parametric Markers for Doors and Windows, Sections/Elevations, and Details”
“Smart Editable Hotspots for Parametric Objects”
“Add-On Manager”

GDL Objects
• Includes subtypes to speed library browsing, object handling and operation of add-ons that work with library parts.
• Wall material will turn in at window edges.

See “GDL Object Subtypes” in Chapter 8 of the User Guide.

Library Manager
Attached libraries can be read directly from PLA archive files. 
See “Archive Files” in Chapter 11 of the User Guide.

Browser Features
• Two-panel browser in dialog boxes for Door/Window, Object, and Stair settings: left panel with file structure of the 

loaded libraries, and right panel with contents of selected folder.
• Browse for library parts using flick arrows in the Preview and Positioning panel.

See “Parametric Objects” in Chapter 4 of the “Graphisoft ArchiCAD User Guide”.

New Door/Window Parameters
• SubFloor Thickness: Adjust nominal sill height to the desired level of the slab.
• Door/Window Opening Sill/Header Update: Set either header or sill height to remain unchanged when modifying 

door and window height parameters (in Preferences/Construction Elements).
See “Window/Door Tool and Settings” in Chapter 4 of the “Graphisoft ArchiCAD User Guide”.
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Parametric Markers for Doors and Windows, 
Sections/Elevations, and Details

• GDL-based dimension markers for Doors and Windows, Sections and elevations, and Details are associative and 
parametric.

• Available from the appropriate panel of the settings dialog box.

Smart Editable Hotspots for Parametric Objects
Some parametric objects, including parametric markers and labels, contain editable hotspots to 
allow graphical editing of parameters in any view.
See “Object Tool and Settings” in Chapter 4 of the User Guide.

Add-On Manager
• Loads Add-Ons from any location.
• Permanently removes Add-Ons while ArchiCAD is running.
• Controls which Add-Ons should load automatically when ArchiCAD is started.
• Displays information loaded Add-Ons.

See “Managing Add-Ons” in Chapter 6 of the User Guide.
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Visualization
“Open GL Graphic Card Support”
“Smart Sketch Renderer”
“Boolean Solid Operations”
“Texture Positioning for Individual Elements”
“Customized Display of 3D Elements”

Open GL Graphic Card Support
Supports high-performance video cards for real-time 3D navigation.
See “Preferences” in Chapter 6 of the “Graphisoft ArchiCAD User Guide” and “System Requirements 
- MacOS” or “System Requirements - Windows” in “Getting Started”.

Smart Sketch Renderer
Faster, and customizable with extended set of user controls. Includes great variety of line textures 
and demo preset styles.
See “Sketch Rendering Engine” in the More Information section of Chapter 11 in ArchiCAD Help.

Boolean Solid Operations
• Allows modeling and instant views of intersections between any ArchiCAD elements in model based sections, 

details and 3D views.
• Allows creation of custom objects by users not familiar with GDL.
• Provides exact quantity calculations.

See “Solid Element Operations” in Chapter 5 of the User Guide.

Texture Positioning for Individual Elements
Align 3D Texture command (Edit menu) sets orientation and origin of element textures in 3D 
window.
See “3D Texture Alignment” in Chapter 5of the User Guide. 

Customized Display of 3D Elements
Elements to Show in 3D command (Image menu) allows customization of 3D element display.
See “Image Menu Commands” in Chapter 11 of the User Guide.
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Publishing and Data Exchange
“PlotMaker Layout Book”
“Enhanced DWG/DXF Compatibility”
“Listing Enhancements”
“PDF Printer Driver”
“IFC Data Exchange Standards”
“Image Files”

PlotMaker Layout Book
• Integrates PlotMaker with ArchiCAD.
• Organizes all project documentation into a single file accessible directly from ArchiCAD.
• Includes automatic page numbering.
• Includes multiple master pages .
• Includes intelligent title block elements.
• Includes integrated Publisher function for archiving, printing/plotting, and publishing on the Internet.

See “PlotMaker Concepts” in Chapter 12 of the User Guide.

Enhanced DWG/DXF Compatibility
• Improved graphical user interface .
• Configuration files accessible via the LAN.

See “DXF/DWG Conversion Guide” in the More Information section of Chapter 9 in ArchiCAD Help.

Listing Enhancements
• Additional quantity types and object parameters can be listed.
• Interactive Element Schedule allows two-way communication between the schedules and the Virtual  Building.
• Standard SQL commands can be used to access the project database and export data in external database formats.

See “ArchiCAD Calculation Guide” in the More Information Section of Chapter 10 in ArchiCAD Help.

PDF Printer Driver
Available on ArchiCAD 8 for Windows. (Built-in feature of Mac OSX).
See “PDF Creation from ArchiCAD/PlotMaker” in the More Information section of Chapter 13 in 
ArchiCAD Help.
30 New Features in ARCHICAD 8-20



New Features in ArchiCAD 8
IFC Data Exchange Standards
ArchiCAD 8 qualifies for IFC 2.0 certification and will be compatible with future IFC 2.X standards.

Image Files
• All QuickTime based image files can be read and saved by ArchiCAD 8.
• Available file types include: Photoshop, MacPaint, QTIF, PNG, Truevision TGA image, TIFF, progressive JPGs and 

GIFF. (Some formats may not work with previous versions of ArchiCAD.) Note: GIFF Files cannot be saved by 
ArchiCAD.

• Macintosh and Windows files are fully compatible with each other and can be directly read by either system. 
See “Getting Started” section of ArchiCAD Help.
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Other Revisions
“Revised Menus”
“Simple Copy Transformations”
“Window Menu”
“Elevation Values and Gravity”

Revised Menus
New and Reset: Moved into New, except when no Add-Ons are loaded.
New from Template: Moved into New.
Save Special /Archive: Moved into Save as.
Hotlinked Drawings: Moved into Publisher. 
ArchiCAD Object: Moved to GDL Objects submenu.
PlanDump: No longer supported.
Open DWF Redline File: Icon within Mark-Up palette.
Make (Mark-Up) Report: Icon within Mark-Up palette.
New Library Part (and its submenu): Moved and renamed as GDL Objects/New.
Click to Trim: Replaced by Cmd/Ctrl-click shortcut.
Click Wall to Split: Moved into single Split command.
Wall Wizard: All functions available from Pet Palette.
See “Chapter 11: Menu Command Reference” in the User Guide.

Simple Copy Transformations
Drag a Copy, Rotate a Copy, Mirror a Copy: replaced in Edit menu by regular Drag/Rotate/Mirror 
commands. Use these with Ctrl key to make one or more duplicates. (Original Drag/Rotate/Mirror 
Copy commands may be replaced in Edit menu using Preferences or context menu.)
See “Drag, Rotate, Mirror a Copy” in Chapter 4 of the User Guide.

Window Menu
Brings selected opened window to front. (To get overview of project structure, use the Project 
Navigator.)
See “Window Menu Commands” in Chapter 11 of the User Guide.
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Elevation Values and Gravity
Gravity settings and relative base elevations available from Coordinate Box only (no longer available 
in settings dialogs).
See “Elevation” and “Gravity” in Chapter 3 of the User Guide.
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New Features in ArchiCAD 8.1
In the following pages, we introduce you to the new features of ArchiCAD 8.1. We have divided 
these into five sections:
1. Improved 2D Representation: These small features can make a big difference in improving the 

2D representational capabilities of some virtual building elements.
2. Better Usability: Improved interface elements (in areas such as shortcuts and GDL hotspots) and 

smarter display and printing options make working in ArchiCAD faster and more intuitive.
3. PlotMaker Enhancements: Title Types, Drawing Numbers, and control over Drawing attributes 

make layouting more automated and give a better overview of complex projects.
4. Better DXF/DWG Compatibility: Our latest DWG improvements make data exchange with 

AutoCAD users even more accurate.
5. GDL Enhancements: More options for users of the GDL programming language.
The more extensive innovations which characterize ArchiCAD 8 are summarized in the New 
Features section of ArchiCAD Help, and explained fully in the other volumes of the ArchiCAD 8 
documentation.
“Improved 2D Representation”
“Better Usability”
“PlotMaker Enhancements”
“Better DWG/DXF Compatibility”
“GDL Enhancements”
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Improved 2D Representation
The following features, including a freestanding Wall End Tool, let you fine-tune the way you display elements on the 
floor plan.

“Enhanced Line and Fill Options for Composite Structures”
“Composite Structures Settings in Element Dialog Boxes”
“Show/Hide Wall End Lines ”
“Show/Hide Beam End Lines and Centerline”
“Wall End Tool”

Enhanced Line and Fill Options for Composite 
Structures
Using the Composite Structures dialog box (Options menu), you can edit not only individual skins, 
but also the line types and colors of contour lines, separator lines, and skin end lines in the 
composite elements.
Composite Structures settings will affect all elements (walls, beams, and/or slabs) for which the 
Composite Settings checkboxes have been activated in the Wall/Beam/Slab Settings dialog box.
In the Edit Skin and Line Structure panel of the Composite Structures dialog box, highlight the 
name of the item (contour line, separator line or skin) you wish to edit.

If you have selected a line, choose a line type and pen color in the Edit Selected Item panel below. 
If you have selected a skin, edit its fill and background colors and thickness in the Edit Selected Item 
panel below. A third pencolor pop-up sets the pen of the two end lines of the selected skin.
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You can make any contour line, separator line or skin end line invisible by checking the Hide 
checkbox.

Composite Structures Settings in Element Dialog 
Boxes
When choosing a Composite Structure for a wall, slab or roof, you can adjust the fill color and line 
type/color settings individually in the Wall, Slab, or Roof Settings dialog boxes. The description 
below illustrates wall settings, but slab and roof settings work essentially the same way.
In the Floor Plan and Section panel of the Wall Settings dialog box, customize the fill colors, 
background colors, contour line type/color (including skin end lines), and separator line type/color 
for the selected element.

Note: The Contour Line you select in the Settings dialog box will be applied to all contour lines, 
including skin end lines.

Alternatively, if you prefer to activate the settings that are in effect in the Composite Structures 
dialog box, mark the desired checkboxes (Composite’s Fill/Background Color; Composite’s Contour/
Separator Lines).
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Show/Hide Wall End Lines 
The Wall End Lines pop-up, in the Floor Plan & Section panel of Wall Settings, gives you four ways to 
display a freestanding wall on the Floor Plan. The options let you show or hide one or both end lines 
of the wall. (The end line is the contour line perpendicular to the longitudinal axis of the wall.)

Note: if you check the Composite’s Contour Lines checkbox, the contour lines set in the 
Composite Structures dialog will override your Wall End Line settings.

Show/Hide Beam End Lines and Centerline
The Beam End Lines pop-up in the Floor Plan panel of Beam Settings offers the same four 
possibilities for displaying beam end lines.

In addition, a new checkbox lets you show or hide a beam’s centerline.

Wall End Tool
The Wall End Tool, whose Toolbox icon pops out of the Wall icon, allows you to create a correct wall 
end profile with a single click. Wall Ends can be placed at either end of a wall. 

Wall Ends are parametric GDL objects, similar to window and door objects.  Wall End parameters 
(such as width and height) can be customized using the Wall End Settings dialog box (see below). 
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Wall Ends are counted as objects in list schedules. Depending on its type, a wall end might reduce 
the wall’s surface or volume, but does not add to it.
During a Trim to Roof operation, Wall Ends are handled as part of the wall, just like windows. Wall 
Ends also remain in place if a Stretch, Drag or Split command is executed.
“Wall End Settings Dialog Box”

Wall End Settings Dialog Box
The Wall End Settings Dialog Box is analogous to the Object Settings dialog.

In the Parameters panel, you can adjust the size, thickness, and (where applicable) fills and colors of 
the wall end.

• The Fit to wall height checkbox is checked by default. If you uncheck it, you can use the settings below to enter any 
value for the height of the wall end and for the distance of the wall end from the base of the wall.

• The 2D Cut Width parameter tells you how much of the wall, in the Floor Plan view, is cut by the wall end.
Where applicable, the Thickness panel contains a preview to assist in setting the wall end’s 
thickness.
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• Depending on its type, a Wall End can be set to automatically inherit the wall’s skin fills, or you can custom-set the 
Wall End fills instead.

• For wall end objects with turning skins, you can set which wall fills should turn together with the wall end.

As with other objects, you can also set many of these parameters in the Info Box or by using the wall 
end’s editing hotspots.
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Better Usability
These features, including single-key shortcuts to every Toolbox item, give you better control over drafting and printing 
your ArchiCAD plan, saving you time and aggravation. 

“Automatic Clean Intersections at Wall Crossings”
“Snap to All Corners of Walls with Clean Wall Intersections Off”
“Enhancement of Editable GDL Hotspots”
“Customizable Single-Key Shortcuts”
“Display Options Combinations”
“Display Settings for Individual Section/Elevation Markers”
“Printing Enhancements”

Automatic Clean Intersections at Wall Crossings
Two walls crossing each other in an X junction will automatically create a clean intersection without 
the need to manually split one of them. (This result is visible when the Clean Wall & Beam 
Intersection option is ON.)

When making an X wall junction, the wall you place second will cut the wall that is already on the 
plan; the intersection sequence is visible in the 2D window. You can modify this intersection 
sequence using the Display Order command from the Tools menu. The 2D Display Order affects the 
intersection sequence in both the 2D and 3D windows.

Snap to All Corners of Walls with Clean Wall 
Intersections Off
To make alignment of connecting walls easier, the intelligent cursor will snap to all sides and corners 
of wall segments even if Clean Wall Intersections is turned off. In the case of composite walls, the 
cursor snaps to each endpoint of the inner skin as well.
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Enhancement of Editable GDL Hotspots
A new diamond-shaped hotspot identifies those object hotspots which, when edited, produce an 
editable on-screen parameter palette.

The diamond-shaped hotspot serves to alert you that in addition to graphical editing, direct 
numerical editing through a palette (for example, setting a window’s sash-opening width by typing 
it in) is also available through that hotspot (provided that the applicable pet palette option has been 
selected).

The diamond-shaped hotspot and associated editing palette is also available in the 3D window.

Note: The diamond-shaped hotspot appears only for editing options that produce a parameter 
editing palette. No other type of function is necessarily associated with this type of hotspot.

Customizable Single-Key Shortcuts
The Keyboard Shortcuts dialog box, from the Options/Customize menu command, contains tab 
pages for three categories of shortcuts: Menu Commands, Actions and Tools.
Unless they are disabled, all shortcuts can be customized using the modifier and character 
combinations of your choice. The Special Key field includes arrow and Page up/down keys as well as 
(in Windows) function keys. Generally, you can use any shortcut component that is not disabled. 
You cannot create new shortcut items.
On the Menu Commands tab page, you can define or redefine a shortcut to the selected menu 
item. Menu shortcuts require Ctrl (Command on Macintosh) as a modifier key.
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The Actions tab page contains a list of common ArchiCAD actions. Actions can consist of single-key 
shortcuts (i.e. T), but multiple-key shortcuts (i.e. Ctrl-T) are also allowed. (The first key must be a 
modifier, i.e. Ctrl, Shift, or Alt/Option).

The Tools tab page lists all ArchiCAD tools and tool-type Add-Ons with their registered shortcut 
keys.
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Tools can be assigned single-key shortcuts (such as T), but multiple-key shortcuts (such as Ctrl-T) are 
also allowed. (The first key must be a modifier, such as Ctrl, Shift, or Alt/Option).
For all categories of shortcuts, the Shift modifier can only be used in combination with a letter 
(either upper or lower-case). Shift cannot be used in combination with non-letter characters (such 
as \) unless you also use the Ctrl modifier. 

Display Options Combinations
Display Options Combinations allow you to save customized sets of display options.
The top panel of the Display Options dialog box has a drop-down menu with five pre-set display 
options combinations. You can apply any of these combinations, or customize and save them under 
a new name.

Once you begin changing the pre-set settings, the Display Options Combinations name changes to 
Custom. These custom settings can remain in effect even after you close the dialog box, but they 
are not saved under that name. Every time you change the settings on an existing Display Options 
Combination, that combination becomes the new Custom, overwriting any existing Custom 
combination. Therefore, once you are satisfied with your set of options, you should save it under a 
new name using the Save As button in the Display Options Combinations panel of the dialog box.
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Press Save to save the Display Options Combination under the new name. Press OK to close the 
dialog box and rebuild your plan using the new settings.
Press Cancel to return Display Option settings to their original state.
To delete a saved Display Option Combination, press the Delete button next to the selected Display 
Option Combination name:

After deleting one or more combinations, press OK. A warning appears: once you delete a Display 
Options Combination, you cannot undo that action.

“Display Options Combinations in the Navigator”
“Print Marquee Option”

Display Options Combinations in the Navigator
Similar to Layer Combinations, the active Display Options Combination is 
displayed in the bottom section of the Navigator tab pages if the 2D 
window is in front on your plan. (If the 3D window is in front, the Display 
Options Combination is disabled.) You can select a different Display 
Options Combination here using the pop-up menu.
When creating and editing View Sets in the Navigator Palette, you receive 
visible feedback on the Display Options item, just like the Layer 
Combination and Scale items. 
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Display Settings for Individual Section/Elevation 
Markers
In the Section Marker part of Display Options, you choose the display type for your section/
elevation markers: either Normal or Key Plan. The chosen display option will affect all markers in 
the plan.
As an alternative, you can determine each section/elevation marker individually: select the As in 
Settings option from the Section Marker part of Display Options, then go to the Section Marker 
Settings dialog box.

Use the controls in the Floor Plan panel to choose either a Section or Elevation-type marker for the 
selected marker.

In this fashion, provided that the Section Marker Display Option is set to As in Settings, you can use 
both section and elevation marker displays in a single plan.

Printing Enhancements
“Header/Footer Option for Printed Pages”
“Print Marquee Option”
“Access to Print Setup from Print Dialog Box”
“Arrangement of Print Area”
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Header/Footer Option for Printed Pages
When printing from ArchiCAD’s 2D or 3D window, you have the option to place a Header or Footer 
on the printed page.
To place a Header or Footer, check the Header/Footer checkbox on the right-hand side of the Print 
dialog box. 

Next, press the Settings button, which has now been activated.

In the Header/Footer dialog box, check the items you would like to include in your header or footer. 
The Preview field at the bottom of the dialog box shows you what your header or footer will look 
like.

A symbolic preview of your header or footer is also viewable in the Print dialog.
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To create your own item, use the Custom Text field.

On the right side of the dialog box, set the Text Properties of your header or footer: its Font, Height, 
and Location.  

When using a header or footer, please note:
• If you are working on a shared Teamwork Project, the User Name field changes to Team Member name.
• A header or footer can only be a single line.
• You cannot change the order of the fields.

Print Marquee Option
If you have placed a normal rectangular Marquee in a Floor Plan, 3D, Section, or Detail window, the 
Print dialog box gives you the option of printing just the marquee area.
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The Print Marquee Area option is active only if you have used the regular rectangular geometry 
method.

Access to Print Setup from Print Dialog Box
In Windows, the Print Setup dialog box can be accessed using the Print Setup button at the upper 
right corner of the Print dialog box. 

Arrangement of Print Area
The nine Positioning arrow-buttons help you arrange the printed content on the sheets of paper.
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PlotMaker Enhancements
To give you a better handle on large, complex publishing projects, PlotMaker assigns a number and a title to each 
drawing placed on the layout. In addition, PlotMaker now gives you the option of editing some of the attributes of 
placed drawings.

“Expanded Drawing/Image Settings Dialog Boxes”
“Control of Drawing Attributes in PlotMaker”
“Automatic Drawing Numbers in PlotMaker”
“Hyperlinks in PDF Documents (WIN only)”
“Title Types in PlotMaker”
“AutoText References in PlotMaker”

Expanded Drawing/Image Settings Dialog Boxes
With several new features to increase user control over placed drawings, the Drawing and Image 
Settings dialog boxes have been expanded so that you can access all the relevant settings for the 
selected drawing or image in one place.
The Drawing Settings dialog box has five panels: Identification, Frame & Output Color, Title, 
Attributes, and Attributes Update Rules.

The top section of the Identification tab page contains:
• the Drawing name, or the ArchiCAD project’s file name and path name
• the name and path of the ArchiCAD View from which the Drawing was imported (if applicable)
• the date it was last modified 
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The lower section of the tab page contains controls pertaining to the PlotMaker Drawing number.
See “Automatic Drawing Numbers in PlotMaker” below.
The second tab page, Frame & Output Color, contains controls familiar from the dialog boxes in 
earlier PlotMaker versions.

The third tab page, Title, lets you set the appearance of the selected drawing’s particular title.
See “Title Types in PlotMaker” below.

The fourth tab page, Attributes, contains settings for the drawing’s pens, layers and scales.
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The fifth panel, Attributes Update Rules, allows you to customize the drawing attribute update 
rules that are set in PlotMaker’s Preferences dialog box.
See “Control of Drawing Attributes in PlotMaker”.

The panels of the Image Settings dialog box work like their counterparts in Drawing Settings.

The following sections explain the new PlotMaker drawing features in more detail.

Control of Drawing Attributes in PlotMaker
When importing drawings into PlotMaker, a link is created between the imported drawing and its 
source file. You can update the imported drawing at any time to reflect changes in the source file. 
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As a default, drawing attributes are not editable in PlotMaker, only in the source file. Thus, 
PlotMaker dialog boxes affecting these attributes are marked View Only and the OK buttons are 
inactive.

However, you have the option to reset these update rules for Layers, Layer Combinations, Pens and 
Colors, and Scale attributes, and to edit them in Drawing Settings, independently of their status in 
the source file. To edit these attributes in PlotMaker, go to the Drawing Attributes tab page in 
Preferences and uncheck the desired attributes. These unchecked attributes will now be editable in 
PlotMaker and stored with the placed drawings.
Another checkbox in Preferences: Drawing Attributes determines which color table the imported 
drawings will use when you edit them in Drawing Settings: if you check Uniform Pens & Colors for 
Drawings and Book, all drawings in the Layout Book will use a single pen color table. If you leave it 
unchecked, imported drawings will access their own pen color tables.

The Attributes settings in Preferences applies to all the Drawings in your Layout Book. To set update 
rules that apply only to a particular drawing, use the Attribute Update Rules in the Drawing Settings 
dialog box.
“Attribute Update Rules for a Selected Drawing”
“Editing the Attributes of a Selected Drawing”
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Attribute Update Rules for a Selected Drawing
The Attribute Update Rules panel of Drawing Settings lets you customize the update rules (which 
you set in Preferences) for the selected drawing.

To customize the update rules, choose the Custom for this Drawing control.
• Check the box of the attributes you want to be overwritten by the source file during updates. These attributes will 

not be editable in PlotMaker.
• Uncheck the box of the attributes you want to remain unchanged during updates, and which you will edit 

separately in PlotMaker.

Editing the Attributes of a Selected Drawing
Now, to edit the selected drawing’s attributes, go to the Attributes panel of Drawing Settings.

The Pens and Colors field will indicate which pen/color table the drawing uses (depending on the 
status of the checkbox in the Drawing Attributes page in Preferences):

• Uniform Pens and Colors indicates that the drawing uses the pen/color table belonging to the Layout Book.
• Own Pens and Colors indicates that the drawing has its own pen/color table.
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If the attribute update rule is set to allow the editing of pens, the button to the right is Edit Pens. 
(Otherwise, the button is View Pens.) Pressing the button will take you to the Pens and Colors 
dialog box.

The Layer Combination field contains the name of the current Layer Combination. If no Layer 
Combination is active, the field will read Custom.
If the attribute update rule is set to allow the editing of pens, the button to the right is Edit Layers. 
(Otherwise, the button is View Layers.) Pressing the button will take  you to the Layer Settings 
dialog box.

Enter the desired Output Scale, if this attribute is set as editable in PlotMaker.
At the bottom of the panel, set the size of Text & Markers either as fixed, or else resized to the 
output scale. 

Automatic Drawing Numbers in PlotMaker
Each drawing placed onto a PlotMaker layout is assigned a Drawing Number. The Drawing Number 
appears in front of the Drawing Name in PlotMaker’s Navigator, provided that Show Numbers or 
Show Names and Numbers is selected.
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Drawing Number is available as an AutoText entry within drawings and drawing titles.

To set a scheme for assigning Drawing Numbers, go to the Drawing Settings dialog box’s 
Identification panel:
• The default setting is By Layout. In this case, PlotMaker will number the drawings sequentially in 

the order in which they are placed on the layout. 
Drawing Numbers generated by Layout will adjust automatically when you change the sequence 
of drawings on your layout, by dragging them to a new position in the Navigator.
As a default, the Include this Drawing in Numbering checkbox is active. To leave the selected 
drawing out of the numbering sequence on the layout, deselect this checkbox.

• If you choose By ArchiCAD, the Drawing Number will consist of the ArchiCAD reference ID (if the drawing is a 
section, elevation or detail) or the story number (if the drawing is a floor plan).

Note: The ArchiCAD Reference ID is the identification number which ArchiCAD assigns to 
sections, elevations and details.
With the By ArchiCAD numbering option, items unnumbered in ArchiCAD (such as lists and 3D 
views) will have no Drawing Number in PlotMaker.
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• If you choose the Custom option, you can use the text field to assign a custom Drawing Number (numerals and 
letters are both allowed).

To set the numbering style of Drawing Numbers, go to Layout Settings and choose the desired style 
from the Drawing Numbering section of the dialog box.
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“Drawing Numbers in Detail Markers”

Drawing Numbers in Detail Markers
In ArchiCAD, you can set a detail marker to include the detail drawing’s PlotMaker drawing number. 
The Drawing Number parameter of ArchiCAD’s Detail Settings contains a pop-up menu with two 
choices of how to display the drawing number in the ArchiCAD detail marker: PlotMaker and 
Custom.

• If you choose the PlotMaker option, the drawing number will be generated in PlotMaker. The detail marker in 
ArchiCAD will show a placeholder in place of the drawing number; the actual drawing number will not be 
generated until you import the detail into PlotMaker for publishing. 

Note: If you don’t want to display the placeholder, turn off the Show AutoText Placeholder 
control by unchecking the checkbox in the drop-down menu below.

• The Custom option lets you type in any text or number into the Detail marker to serve as the drawing number, in 
both ArchiCAD and PlotMaker, although this is most useful when you print directly from ArchiCAD. Use the Custom 
Text field in the drop-down menu below to enter the desired data. 
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The drop-down menu’s other display control is Show Reference ID. To show the reference ID of the 
detail in ArchiCAD, turn on this parameter. To hide the reference ID, uncheck the box.

Note: This option is only valid for use in ArchiCAD. In PlotMaker, the locally generated drawing 
number will be shown.

Hyperlinks in PDF Documents (WIN only)
When you save a PlotMaker file in a Windows-based PDF format using the built-in PDF Amyuni 
printer driver, the detail/section markers, as well as Layout names, will appear as hyperlinks. 
Clicking on the marker will switch you to the detail’s respective layout. 

Title Types in PlotMaker
Each drawing or image placed onto a PlotMaker layout can be assigned a title containing graphic 
elements and information referring to the drawing data.

The title’s format is determined by the settings and content of its Title Type.
Standard title types, including one set as a default, are located in the Title Types folder in the 
Navigator.  If needed, you can customize these or create new ones. See below.
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You can assign a title type to several drawings or images: for example, all the drawings on a layout 
might have the same title type. 
Titles are linked to the placed drawing: when the drawing is moved, dragged, or rotated, the title 
will follow along with the drawing. You can also select an individual title and move it around.
“Assigning a Title Type”
“Displaying or Removing Titles”
“Title Type Settings”
“Title Type Appearance”
“Title Type Original Position”
“Creating or Customizing a Title Type”
“Customizing Individual Titles”
“Exploding Titles and Drawings”

Assigning a Title Type
To assign a title type to a drawing, select the title type in the Navigator and drag in onto a drawing 
name. 

Alternatively, select a title type from the drop-down menu in the Title panel of Drawing Settings. 

Displaying or Removing Titles
To avoid assigning titles to drawings when you place them in PlotMaker, uncheck the Append Title 
to newly placed Drawings checkbox on the Miscellaneous page of Preferences.
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To remove the title of an individual drawing, uncheck the Append a Title to this Drawing checkbox 
in the Title panel of Drawing Settings.

Title Type Settings
Title types can be formatted in the Title Type Settings dialog box. Open the dialog box by using the 
selected Title Type’s context menu from the Navigator, or press the Settings button from the 
Navigator’s bottom section.

The Title Type Settings has two sections: Appearance and Original Position.
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Title Type Appearance
In the Appearance section, you can assign or edit the name, scale, border, background, and preview 
of the chosen title type. Note that Scale is expressed as a percentage of the actual size of the title 
contents in the title type.
Once you have made any desired modifications to these Appearance settings, press OK to confirm 
them. The new settings are applied in real time to already placed (as well as newly placed) titles of 
this type. 

Title Type Original Position
In the bottom half of the box, set the title’s Original Position with respect to the drawing using the 
12 radio buttons. The Align to Drawing Center checkbox at right offers an additional option: it 
places the title in the center of the drawing.
Modifications to these Original Position settings are applied only to subsequently placed titles of 
this type. The changes are not automatically applied to already placed titles of this type. 
However, you can bring all placed titles of this type into conformity with the Original Position 
settings by checking the Revert All to Original Position checkbox.

Creating or Customizing a Title Type
To customize or create a title type, open an existing title type in the title type window by double-
clicking it in Navigator, or choose Create New Title Type from the title type context menu.
Modify or create the title type using AutoText, regular text or graphical items. AutoText entries, 
such as drawing name/number/path/scale, derive their content from the particular drawing to 
which the title type will be appended.
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Once you are satisfied with the title type content, open the Title Type Settings to set its name, 
appearance and original position. Changes to title types will take effect on each placed title of this 
type.

Customizing Individual Titles
You can select just the title and drag it to adjust its position on the layout. To undo a manual change, 
use the Revert to Default Position checkbox in the Title panel of Drawing Settings.
To rotate a title along with the drawing, check the Rotate with Drawing checkbox.
To set a custom rotation angle for the title, uncheck the Rotate with Drawing checkbox, then enter 
the title’s rotation angle in degrees. 
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Exploding Titles and Drawings
To edit the content of a placed title individually, first select the title on 
the layout. Next, explode the title using the Explode command from 
the context menu or Edit menu.
An exploded title will consist of individual, editable drawing elements 
in grouped mode, and is no longer linked to the drawing.
You can also explode a Drawing that has been placed on the layout. (In 
this case, its title will also be exploded.) This function is useful for 
editing relatively simple graphical drawings, such as a North symbol or 
titles created in an earlier version.

AutoText References in PlotMaker
A new function in PlotMaker lets you set a particular drawing as an AutoText reference.  This allows 
you to use AutoText whose values are generated from the reference drawing. This means that your 
AutoText does not necessarily have to refer to the drawing or layout onto which you are placing the 
text.
To set a drawing as AutoText reference, select a drawing from the Navigator or the layout.
Use the Edit menu or the Context menu to select the Set as AutoText Reference command.

With the Text tool active and your cursor in the text field, select Insert Autotext for 
(DrawingName), where Drawing Name displays the actual name of the reference drawing.

The AutoText entries will then show values based on the reference drawing.
New Features in ARCHICAD 8-20 63



New Features in ArchiCAD 8.1
Better DWG/DXF Compatibility
These improvements simplify communication with AutoCAD users, offering a closer approximation of AutoCAD’s 
background-color usage and improved conversion functions.

“Automatic Pen Color Adjustment for Improved On-Screen Visibility”
“Window Background Pen”
“Exporting PlotMaker Drawings as XREFs ”
“Support for QuickTime Image Formats”
“Custom Conversion Functions”
“Additional Conversion Improvements”

Automatic Pen Color Adjustment for Improved On-
Screen Visibility
When the luminance value of a particular background color falls below a threshold value - that is, if 
your background is sufficiently dark - black pens will be shown as white on your ArchiCAD screen. 
(This is useful if you use a dark or black background to imitate AutoCAD methods.)
However, when printed, pen colors will print according to their actual settings in the pencolor table.
Non-black pens that would be difficult to see against a particular background will automatically 
shift to a similar, but more easily visible color. Again, when printed, pen colors will print according to 
their actual settings in the pencolor table. 
To disable this automatic color adjustment, uncheck the Automatic Pen Color Visibility Adjustment 
checkbox on the Miscellaneous tab page of the Preferences dialog box.

Window Background Pen
The Window Background pen color palette, in both ArchiCAD and PlotMaker, has a Window 
Background Pen option: the pencolor marked  will produce a fill background color (with number 
-1) that is identical to the current window background color.

If the background pen is set to window background (-1), any fills that are empty (or 
0%) will be converted to an AutoCAD Wipeout.
A Patch object’s background fill color is assigned the window background pen color 

(-1): as a result, the patch will be displayed correctly when the background color changes. When the 
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Patch is converted to AutoCAD, its background is transformed to an AutoCAD wipeout (WPOut) 
without a frame, and will be displayed correctly.

Note: If you are using an AutoCAD version preceding AutoCAD 2004, Wipeout is available as 
part of “Express Tools.” Wipeout is integrated into AutoCAD 2004.

Exporting PlotMaker Drawings as XREFs 
When exporting a PlotMaker drawing, the Translator Settings “Save” dialog now gives you two 
options for placing it into a DXF/DWG file: 

• Model Space: the PlotMaker drawing is converted into Model Space.
• Linked XREF Drawings: With this option, every drawing on the layout gets its own DXF/DWG file, and the content 

of the individual drawings is found in the model spaces of these files. In addition, a comprehensive DXF/DWG file is 
created whose Model Space contains the individual drawing files as XREFs, and whose Paper Space contains the 
drawings’ physical arrangement as derived from the Layout.

Support for QuickTime Image Formats
The Translator’s Save Options panel allows you to choose among picture file formats when 
converting pictures from ArchiCAD to other programs. (The same list of formats is found in the 
Open Options panel.)

Note: If your AutoCAD file format is R12 or R13, pictures can be converted only to TIFF format.
As a default, Picture’s Original Format is selected; in this case, no conversion takes place.

If you check the Force output in AutoCAD picture formats checkbox, the list of available image 
formats will show only those which the selected version of AutoCAD can read. The rest of the 
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choices are disabled. If you have also selected Picture’s Original Format, the picture will retain its 
original format only if it is recognized by AutoCAD; unrecognized file formats will be converted as 
TIFF. 

Custom Conversion Functions
Custom Functions is a new set of translator settings containing add-ons for both Open and Save 
operations. Several functions are loaded by default; you need only turn them on or off using the 
checkboxes. To change the order in which they are executed, you can drag and drop them to new 
locations within their element groups.

A Path field displays the location of the add-on. If you add additional functions or delete any of 
them, you must press the Reload Functions button to refresh the function list. Custom function files 
are located in your ArchiCAD folder, under Add-Ons\Import Export.

Additional Conversion Improvements
“Convert Complex Elements to Blocks”
“Hatches and Fills”
“Splines”
“Leaders and Labels”
“Custom-positioned Dimension Texts”
“Ordinate Dimensions”
“Conversion of Object’s Visible Parameters”

Convert Complex Elements to Blocks
When saving an ArchiCAD floor plan, you can choose to convert complex elements to blocks that 
are recognized by AutoCAD. By choosing this option in the Saving Floor Plan menu of the 
translator’s Save options dialog box, you avoid having to explode complex ArchiCAD elements.
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Hatches and Fills
When importing a file from AutoCAD version R14 or later, hatches will be converted into fill types in 
ArchiCAD. However, if you are opening a file from an earlier version of AutoCAD, you have the 
option of importing hatch blocks by checking the Import AutoCAD Hatch Blocks checkbox in the 
Open Options panel of the translator. In this case, AutoCAD fills will be transformed into unnamed 
groups of individual lines (hatch blocks) and will not be recognized as fill types in ArchiCAD. 

Splines
Splines imported from AutoCAD can only be approximated in ArchiCAD, since the two programs 
handle this element differently. In ArchiCAD 8.1, you can choose between two ways of 
approximating an AutoCAD spline:

• Import as Polylines. ArchiCAD will approximate the Spline using a series of connected straight line segments (that 
is, a polyline).

• Import as ArchiCAD Splines. ArchiCAD will approximate the spline using a series of connected curves. This option 
uses less memory, but might be time-consuming.

Leaders and Labels
Custom functions allow you to convert AutoCAD Leaders to ArchiCAD Labels, and vice-versa, 
without having to explode them.
Multi-line text labels are also converted directly into Multi-line Leaders. (Because leaders and labels 
are constructed differently, the converted element might not look exactly like the original.)

Custom-positioned Dimension Texts
Dimensions whose position was customized by the user in ArchiCAD will be accurately converted 
into AutoCAD.
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Ordinate Dimensions
Ordinate dimensions in AutoCAD are now converted into a parametric GDL object in ArchiCAD, 
instead of dissolving into drawing primitives. 

Conversion of Object’s Visible Parameters
When objects are converted into AutoCAD blocks, their visible parameters will also be converted. In 
the case of zones, non-visible parameters will also be converted as editable text attributes.
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GDL Enhancements
The following GDL commands and topics have been enhanced for ArchiCAD 8.1. 

• New RULED command
• Enhanced WALLNICHE and CUTFORM commands
• Construction Fills display option request
• Composite skins globals
• Globals for wall end caps
• Working unit format requests
• Editable hotspots with display parameter

For more information, see the “Graphisoft GDL Reference Manual” in ArchiCAD Help.
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New Features in ArchiCAD 9

Improved Documentation Productivity

Renewed Text Handling
In both ArchiCAD and PlotMaker, you can use the new on-screen text formatting options for 
individual characters and paragraphs as well as text blocks. The Text editor also lets you set tabs and 
indents and justify text.
Text blocks can now be drawn with a separate background color, resulting in better visibility (for 
example, when the text block is placed over a fill).
The background color in the text editor will be the same as in the plan window. If the edited text 
block has its own background color, the text editor will appear with that color. If you use the 
Automatic pen color visibility adjustment feature from preferences, which modifies some colors in 
the plan window, the letters in the text editor reflect this modified color.
For a detailed description, see “Text Blocks” in the ArchiCAD 9 Reference Guide.
ArchiCAD properly converts formatted texts imported from AutoCAD 200x or from external word 
processors.
A Text Wrapping option in PlotMaker allows you to create multi-lined AutoText entries.

Text Rotation
With each placement of a hotlinked module, you can set whether the text it contains will rotate 
with the module or remain fixed at its original angle. Similarly, you can set the angles of individual 
zone stamps, text blocks and labels to either remain fixed or follow the element’s rotation.
For a detailed description, see “Placing a Module” in the ArchiCAD 9 Reference Guide.

Favorites for Labels
Label favorites can include the text of the Label, so you can use the favorites to place Labels with 
predefined texts.

Leading Value for Labels and Text
Leading value for Labels and Text can be less than 100%. This leading will be correctly displayed in 
the plan window and on all output devices.
70 New Features in ARCHICAD 8-20



New Features in ArchiCAD 9
Opaque Background for Labels
You can define a background color for the Label Tool, similarly to the Text Tool.

“Cover” Fills for Zone, Slab, Roof, Zone in 2D
You can define fills that are associated to zones, slabs, and roofs on the floor plan, since they are 
defined in a separate category from those in section view (“cut fills”) and those drawn by hand 
(“drafting fills”). You can export these fills to separate layers in DXF/DWG format based on their 
category. 
Display options work individually for each fill category: this gives you more flexibility in changing the 
representation of building elements and their details.
Zones can now be displayed by their category color, fill categories and/or background color, 
enabling you to apply more than one zone display logic within the same project.
The new fill categories are adjustable in the Attribute Manager dialog box.
For a detailed description, see “Fill Types” in the ArchiCAD 9 Reference Guide.

Aligning and Displaying “Cover” Fills in 2D and 3D 
Windows
It is possible to align the vectorial hatch simultaneously in 2D and 3D for Slabs and Zones. If you 
choose Link to Fill Origin in the Floor Plan panel of the Slab or Zone Tool Settings dialog box, you 
can customize the fill vector orientation in 2D or in 3D. By also checking the Use Fill of surface 
Material checkbox, the fill’s custom orientation will be displayed in both the 2D and 3D windows.

Section Transparency
When you save a section as a view in the View Editor, the Transparency in Shading settings (Image > 
3D Window Settings) will be saved along with the view.

Drawing Numbering in PlotMaker
You can include a Numbering Grid as part of your PlotMaker Master Layouts. Placed drawings will 
be automatically numbered according to the grid’s numbering system.
For a detailed description, see “Grid for Drawing Numbering Panel of Master Layout Settings” in the 
ArchiCAD 9 Reference Guide.
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Dimension Settings Saved in Views 
An ArchiCAD view’s dimension style and units are now saved along with each view. This way you can 
import to PlotMaker or publish views that have different dimension units, without having to re-set 
them manually.
For a detailed description, see “View Editor Palette” in the ArchiCAD 9 Reference Guide.

Smoother Import of Views into PlotMaker
The link between ArchiCAD designs and PlotMaker output has become smoother: 
PlotMaker’s Import dialog box displays all settings of a selected view (layer combination, display 
option, scale, zoom information) to help the user identify the desired views.
You can import ArchiCAD zoom information, so that a Drawing in PlotMaker will be displayed at the 
zoom level of the saved ArchiCAD view.
3D views created with ArchiCAD’s internal rendering engine are now imported as vectorized PMK 
drawings, resulting in improved image quality.
Better icons and link information in the Drawing Usage mode of PlotMaker’s Navigator make 
drawing updates simpler.
For a detailed description, see “Importing ArchiCAD Views” in the ArchiCAD 9 Reference Guide.

Easier Publication of View Sets in PDF Format
PDF format is now integrated into the Publisher function in both ArchiCAD and PlotMaker; you no 
longer have to install a separate PDF printer driver. Each view or layout can be saved into a separate 
document, or can be merged together into a single PDF file.
For a detailed description, see “Creating PDF Output” and “Saving to PDF Format” in the ArchiCAD 9 
Reference Guide.

Reviewer Enhancements
To allow clients to navigate among the drawing sheets faster and more easily, Project Reviewer has 
been retooled:
• provides mouse wheel support for zoom and pan functions
• integrates a toolset for length, area and angle measurements
• allows redlining with any color or fonts installed on the client’s machine
• incorporates the enhanced DWF format, thereby overcoming some linetype representation and printing problems
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Improved Column Display
You can assign separate pens to a column’s core and veneer fills and to its crossing symbol. In 
addition, you can assign separate linetypes for the core and veneer outlines, resulting in better 
detail designs. 
A crosshair symbol is now available for displaying columns on the floor plan.
For a detailed description, see “Column Tool and Settings” in the ArchiCAD 9 Reference Guide.

Hide Zero Decimals in Dimensions
To conform with local conventions and improve dimension text display, you have the option 
(Options > Preferences > Dimensions) of hiding zeros to the right of the decimal point.
For a detailed description, see “Dimensioning Standards” in the ArchiCAD 9 Reference Guide.

Editing Enhancements

Polyline, Fillet/Chamfer, Arc Tangent, Ellipse Stretch
Polyline editing has been made more consistent: you can extend a polyline from either of its ends, 
explode it, or open a closed polyline.
The combined Fillet/Chamfer command lets you edit all corners of a polygon with a single click.
You can now edit an arc using the tangent to either of its endpoints, and stretch an ellipse using a 
new pet palette command.
For a detailed description, see “Continue a Polyline” and “Modifying Element Sizes” in the ArchiCAD 
9 Reference Guide.

Drag/Rotate/Mirror One or Multiple Copies
Copied element(s) will be selected after the transformation is completed.
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DWG Enhancements

DWG 2004 I/O 
• New, DWGDirect based add-on
• Reads all files from R12
• Reads/Writes DWG 2000, 2002, 2004 formats
• Enable to set drawing scale during DWG Import

Spline Compatibility
• Improved spline-spline conversion 

Paperspace Control 
• Save only the content of the cropped drawings from the layout

Composite Parts to Separate Layers 
• Map Composite Structure components to separate AutoCAD layers (Fills and Lines are assigned to categories: Cut, 

Drafting and Cover Fills; Cut, Drafting and Skin Separator Lines. Skin Separator lines and fills of different categories 
can be mapped to separate AutoCAD layers.)

Improved Merge Methods 
• Enable to define location (x-y, and host story(z)) when using merge or XREF function with DWG files
• Ability to drag & drop DWG files into ArchiCAD
• Support I-drop technology
For details, see “DXF/DWG Conversion Guide” in ArchiCAD Help.
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LightWorks: New, Powerful Rendering 
Engine
The LightWorks rendering engine, built into the ArchiCAD PhotoRendering interface, gives you the 
power to create high-quality photorealistic images that can be published as ArchiCAD views. 
LightWorks offers ray-tracing, soft-shadow and reflection features and complex shader editing 
capabilities, yet its interface is compatible with ArchiCAD’s own elements.
For details, see “LightWorks Rendering Engine (Add-On)” in the ArchiCAD 9 Reference Guide and 
“Rendering with ArchiCAD” in ArchiCAD Help (see its PDF version in the ArchiCAD folder).
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Expanded Workplace Customization

Customized Work Environment Schemes and Profiles
User-specific ArchiCAD settings are now grouped together and can be defined in Options > Work 
Environment.
You can customize any of these settings while you work: just open the Work Environment dialog 
box, change the setting you need, and press OK. The setting will take effect.
The individual settings are divided among Schemes: User Preference Schemes; Shortcut Schemes; 
Tool Schemes; Palette Schemes; and Command Layout Schemes. 
You can store any or all of the schemes by name; you can also combine any of the schemes into a 
Profile, and store the Profile under its own name. Using the ArchiCAD interface, you can export and 
import Schemes and Profiles: this enables you to transport your favorite settings to other 
computers, or to keep them after installing a new version of ArchiCAD.
CAD managers can create office-standard Work Environment Profiles stored and read from a 
network server to reduce the risk of errors.
ArchiCAD is shipped with several default Profiles. By default, the Standard User Profile is loaded 
when you start ArchiCAD.
For details, see “Managing Schemes” and “Work Environment Profiles” in the ArchiCAD 9 Reference 
Guide.

Enhanced Shortcut Customization
Shortcut Schemes in Options > Work Environment now allows you to assign a one-key (or multiple-
key) shortcut to any command, menu, or action within ArchiCAD or PlotMaker.
From the same dialog box, just push a button to print out a reference list of currently assigned 
shortcuts.
For a detailed description, see “Customize Keyboard Shortcuts” in the ArchiCAD 9 Reference Guide.

Customize Palette/Toolbar/Menu Contents and 
Display
Palette Schemes and Command Layout Schemes (Options > Work Environment) allow you to 
customize the contents and display of any ArchiCAD toolbar, menu and sub-menu, as well as the 
position and display of the main palettes, and to save these preferences as part of a Profile.
For details, see “Palette Shapes”, “Palette Schemes”, “Customize Toolbar” and “Customize Menus” 
in the ArchiCAD 9 Reference Guide.
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Customize Toolbox/Tool Settings/Info Boxes
ArchiCAD’s new Personal Toolbox organizes the ArchiCAD tools into logical groups, each on a 
separate panel. To customize your own Personal Toolbox, use the Options > Work Environment > 
Tool Schemes dialog box to display (or hide) any tools, in any order, in any grouping you prefer. 
Show or hide tool names or icons as you like.
If you prefer Classic Toolbox of versions 8.1 and earlier, you can still use it.
Similarly, Tool Settings dialog boxes and Info Boxes can be customized using the Tool Schemes part 
of Options > Work Environment.
For details, see “Customize Toolbox”, “Customize Tool Settings Dialog Boxes” and “Customize Info 
Box” in the ArchiCAD 9 Reference Guide.

Smart Palette Management
Maximize your usable drafting area by docking (Windows) or snapping (Macintosh) your floating 
palettes, in both ArchiCAD and PlotMaker. Docked palettes can be grouped together, enabling you 
to move or resize several palettes at once.
Palette layouts are set in Options > Palette Shapes, and saved as part of your User Profile (Options > 
Work Environment > Palette Schemes).
For a detailed description, see “Docking/Snapping Palettes” in the ArchiCAD 9 Reference Guide.

Customize Location of Special Folders
During the Install process, you can define the location of the program folder, default libraries and 
DWG translators.
For a detailed description, see “Installing ArchiCAD” on page 10.

Suspend Autosave
If the Suspend Autosave feature is on (Options > Work Environment > User Preference Schemes > 
Data Safety), ArchiCAD suspends the saving process for a few seconds (indicated with an icon in the 
statusbar). If during this time you switch to another application, ArchiCAD will save the project right 
away.
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Other Improvements

Parameter Transfer between Objects
In the Object Settings dialog box in the object browser, parameters can be transferred from one 
object to another by pressing Ctrl+Alt (Windows)/ Cmd+Alt (MacOS) buttons (the cursor changes 
from arrow to syringe). Parameter transfer ensures that you do not lose your custom object settings 
if you change to another object of similar type.

Improved Selection Methods
The new “Quick Selection” option for the Arrow tool lets you select fills, walls, polygons and objects 
simply by clicking anywhere in their area. To suspend the Quick Selection function on the fly, press 
the Shift key.
To speed up selection while working on your plan, just press the Shift button to change your cursor 
to the Arrow shape. Most Arrow tool possibilities are now accessible, as long as you keep the Shift 
key pressed.
If several elements’ nodes overlap, it is not always easy to find and select the element you need. 
With the relevant tool active, press [Ctrl]+[Shift], then also press the Spacebar to temporarily 
enable Quick Selection.This way you do not have to position the cursor on the overlapping node, 
just keep the cursor above the area of an element while you click.
For details, see “Quick Selection” and “Selecting Among Overlapping Elements” in the ArchiCAD 9 
Reference Guide.
Editable hotspots can now be assigned their own color (to contrast with regular selection dots) to 
ease selection.

Saving Custom-Shaped Doors and Windows from the 
Plan File
ArchiCAD 9 can create a custom shape hole in the wall from a slab or a roof that has an ID of 
“Wallhole” or “Wallniche”. (ID’s are assigned in the element’s Settings dialog box, Listing and 
Labeling panel.) Slabs and roofs bearing these IDs will not be implemented as 3D bodies in the door 
and window objects but as a hole or a niche in the wall. You can combine several slabs or roofs to 
create complex holes or niches. Since you can define inclination angle for the roofs you can even cut 
non-perpendicular holes in walls.
These shapes can then be saved as usual, as a 3D model and as window or door with an editable 
script or non-editable binary script.
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Search Library Parts by Name
In addition to browsing folders and subtypes, you now have a third way to locate a library part. The 
“Find Library Parts” option in the Object Settings dialog boxes lets you enter search criteria, 
including wildcard characters, to locate library parts by name.
For a detailed description, see “Locating a Library Part” in the ArchiCAD 9 Reference Guide.

Rebuild Sections Manually 
To avoid rebuilding a section every time you activate its window, you now have the option of 
assigning it a manual-rebuild status (instead of Autorebuild). When working with complex projects, 
you will save waiting time by avoiding unneeded rebuilds.
For a detailed description, see “Section/Elevation Window Status” in the ArchiCAD 9 Reference 
Guide.

Keep Section Zoom on Rebuild
By default, a zoomed detail in a Section window will remain at its zoom level even after a Rebuild 
command, saving you the trouble of having to recreate the zoom.

Place Elements in 3D Window Using Fewer Clicks
If you prefer, you can opt (Options > Preferences > Miscellaneous) to place construction elements 
into the 3D window without specifying their height or elevation value. The result: fewer clicks are 
needed when drafting.
For a detailed description, see “Specify Z-Coordinate when Placing or Editing Element in 3D 
Window” in the ArchiCAD 9 Reference Guide.

Quicker Story Creation
The Create New Story dialog box, used to create new stories on the fly, lets you specify the Story’s 
Name and Height: new stories are created more quickly.
For a detailed description, see “Defining Stories” in the ArchiCAD 9 Reference Guide.

Pet Palette
New two-row pet palettes display all available command icons every time you access a pet palette 
during an editing operation, regardless of the active tool.
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Enhanced “Esc” Functions
Functionality of the Esc key, if clicked while working in ArchiCAD, has been slightly modified:
• During input: Esc to cancel the operation
• Selected item(s): Esc to deselect
• Selected item(s) with Marquee: Esc to remove Marquee; Esc again to switch to Arrow Tool
• If nothing is selected: Esc to switch to Arrow tool
For a detailed description, see “Deselection with Esc Key” in the ArchiCAD 9 Reference Guide.

Consistent Story Name Display
All stories are identified consistently, by their number and name, throughout the ArchiCAD 
interface.

More Complete Layer Pop-up Information
Every layer information pop-up now includes icons for all layer attributes (visibility, locked status, 
intersection number, 3D wireframe mode), providing you at-a-glance information without having to 
open the Layer Settings dialog box.

Better Info Box for Arrow Tool
The Info Box of the Arrow Tool now includes the number of selected elements in the plan.

Windows Taskbar Shows ArchiCAD File Name
Your Windows taskbar now displays the name of the file opened in ArchiCAD, making it easier to 
choose the project you need in case you are running multiple ArchiCAD programs.
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Fresh Look and Feel with Docking Palettes
It is now possible to customize your user interface by managing your Palettes. The most important 
Palettes of ArchiCAD 9 can now be docked (on Windows) or snapped together (on MacOS). 
Dockable or snappable palettes include the Info Box, Toolbox, Navigator, Navigator Preview, 
Coordinate Box, Control Box and Favorites Palette. These Palettes can be docked to any side of the 
ArchiCAD Window. Any of them may be hidden or shown, allowing you to set your working area 
virtually any way you want.
Not every palette can be docked to all sides of the screen. The following palettes cannot be docked: 
3D Navigation; Markup; Selections; Libraries; Pet Palettes; Find and Select; RoofMaker; View Editor/
Publisher; Solid Element Operations; Sign in; Text Formatting.
Docking can be achieved by starting to drag a Palette (e.g. the Info Box) and dragging it close to one 
of the sides of the ArchiCAD Window. In the below illustration, you can see that the Info Box is 
dragged to the left side of the ArchiCAD Window (about 15 pixels from it or closer) and the black 
ghost rectangle shows that the Info Box would dock to the left side of the Window. On the right you 
can see the result.

 
If it is dragged upwards, when it nears the bottom of the Toolbar (within about 15 pixels), it will 
show that the Info Box will dock to the bottom of the Toolbar. The result can be seen on the right.

 
Similarly, any of the other resizable Palettes may be docked anywhere. In the following example, the 
Favorites Palette is docked to the right edge of the ArchiCAD Window. See how many different 
places you can place the Navigator Preview Palette. The left picture is always before docking, the on 
one the right is the result.
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The Coordinate Box and Control Box can be docked only to the upper and lower edge of the 
Window, while the Toolbox can be docked only to the left and right edges. 
On MacOS, you can snap ArchiCAD floating palettes to each other, to the edge of the screen, or to 
the side of the drawing window. Palettes will snap to each other if you pull them within a given 
range of each other. If a palette is snapped to the bottom or to the right of another, then both 
palettes can be dragged as a single object. If a palette is snapped onto the top or to the left of 
another palette, then they will not “stick together” when you move them.
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You can double-click on the header of any of the docked Palettes. This will pop them out of the 
docked position and restore them to their position on the screen prior to docking them. Another 
double-click at the header will restore their docked position.
Any Palette may be hidden by clicking on the small X in the right corner of their header. 
When more than one Palette occupies a vertical docking position, a minimizing arrow appears in 
the header. Clicking this will minimize the Palette, letting the other Palette(s) occupy more space. 
Clicking the arrow again will restore its size. In the illustration below, the Info Box is minimized in its 
docked position, leaving more room for the Navigator Palette.

If you are viewing a docked Palette that has more fields than that can be displayed in its docked 
position, you can use the scroll of your mouse to scroll vertically among the fields of the Palette. 
This way you can keep the size of the Palette relatively small and still have all its fields (or icons) 
available to you. The screen capture below shows the user scrolling through the Info Box of the Wall 
Tool: any field in the Info Box is accessible even at this size.

By dragging the border of Palettes in the dock, you can resize them within it. 

Their docked size may be increased or decreased by dragging their outside border.
New Features in ARCHICAD 8-20 83



What Makes ArchiCAD 9 Easy?
The Info Box has a context menu, which comes up when right-clicking the Info Box. The two options 
at the bottom lets you specify where the header should be located (left edge or top) when the Info 
Box is not in a docked position. When docked, the program automatically decides which position is 
better.

The Toolbox also has a context menu accessible by right-clicking it. The Toolbox can have two basic 
appearances: the Personal Toolbox and the Classic Toolbox. The Personal Toolbox may be 
customized to your personal preference in the Work Environment dialog box. The Personal Toolbox 
is resizable and dockable just as the other Palettes.

 
Another enhancement of the Toolbox is its revamped look with 3D construction element icons to 
better express that ArchiCAD is in fact a modeling program, in which you actually build virtual 
buildings.
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When the Toolbox is switched to Classic Toolbox, you have options for setting its shape and 
complexity. You can switch between Extended/Compact and Single-column/Two-column. These two 
options are the same as those available for the Classic Toolbox in Options > Palette Shapes.

In the Palette Shapes dialog box, you can set options for the Coordinate and Control Box as well, just 
as in previous versions. The Info Box options are also accessible in this dialog box.

Palette Shapes and Palette Schemes for floating and docked Palettes can be saved as part of your 
User Profile.
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Search Library Part by Name
In addition to browsing for Library Parts in folders and subtype hierarchies, ArchiCAD 9 offer a third 
possibility for locating a Library Part. The Find library part option in the Object Settings dialog box 
lets you enter search criteria, including wildcard characters, to locate Library Parts by name.

The following fields are available with this option:
Keyword: here you may type any characters, including the ‘*’ and the ‘?’ characters. The meaning of 
these characters matches their usual meaning in operating systems’ search functions: When a ‘*’ 
character (asterisk) is given, it may be substituted for any number of consecutive characters. When 
a ‘?’ character (question mark) is given, it may be substituted for any single character.
Find all file names which: four possible character-matching criteria are available here. These are: 
match keyword (an exact match is looked for – use it when you know the exact name of the Library 
Part you are looking for), contain keyword (the search string may be anywhere within the name of 
the Library Part), begin with keyword (the Library Part’s name starts with the keyword) and end 
with keyword (the Library Part’s name ends with the keyword).
Search in: here you may select one of the loaded libraries to limit your search range, or select All 
libraries.
Clicking the Find button performs the search with the given criteria. The results will be displayed in 
the Library parts found area in the lower portion of this panel of the Library Part Settings dialog 
box.
Clicking the New Search button will clear the Keyword field so you may enter a new search string 
for a new search.
Below the New search button are three small buttons controlling how to display the search results. 
The possible choices are (from left to right) to list them as Large Icons, as Small Icons or as a List 
View.
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The three listing views of found library parts
At the bottom of the panel there are two fields which display location information for the found 
library part which has been selected. The top one (with the yellow folder icon) displays the full path 
of the Library Part on your computer’s storage device. The bottom one (with the green folder icon) 
displays where the object can be found in the ArchiCAD Library Part ancestor hierarchy.

Examples:
1. Keyword: “chair” Find all file names which: “contain keyword”Result: all Library Parts containing 

the string “chair” are found. E.g. “Chair 01”, “Office Chair 04”, “Piano Chair”.
2. Keyword: “chair???” Find all file names which: “contain keyword”Result: all Library Parts 

containing the string “chair” and having three additional characters after it will be found. E.g. 
“Office Chair 02”, “Chair 05”. Note: “Piano Chair” is not a result in this case.

3. Keyword: “chair*” Find all file names which: “contain keyword”Result: all Library Parts 
containing the string “chair”, plus any number of characters (but at least one character) after it 
are found. E.g. “Office Chair 02”, “Chair 05”. Note: “Piano Chair” is not a result in this case either.

4. Keyword: “chair” Find all file names which: “begin with keyword”Result: all Library Parts 
beginning with the string “chair” are found. E.g. “Chair 01”, “Chair 04”, etc. 

5. Keyword: “???????chair” Find all file names which: “begin with keyword”
Result: all Library Parts beginning with any seven characters, then immediately containing the 
string “chair” are found. E.g. “design chair 01”, “lounge chair”, “office chair 03”.

6. Keyword: “???????chair” Find all file names which: “match keyword”
Result: all Library Parts beginning with any seven characters, then immediately ending with the 
string “chair” are found. E.g. “lounge chair”, “wicker chair”.
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This feature is available in all Library Part Settings dialog boxes (Window / Door / Corner Window / 
Skylight / Object / Lamp / Stair).
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Revised Selection Methods
ArchiCAD 9 introduces a new “Quick Selection” option for the Arrow Tool.

The Quick Selection button is the one on the right among the three buttons of the Arrow Tool’s Info 
Box. Quick Selection is optional in 2D and Section/Elevation & Detail Windows; it is automatic in the 
3D window. By default it is enabled.
When this option is enabled, you can select all construction elements, Doors/Windows, as well as 
Fills, Zones, Dimension Texts and placed Figures by simply clicking anywhere within the boundaries 
of their enclosing polygon/rectangle on the Floor Plan. This means you no longer have to find an 
edge or a node of an element to be able to select it. Just click onto the Wall, Slab or Roof etc. when 
the cursor’s Quick-Selection shape indicates that an element is underneath it and is available for 
being selected.

See how the shape of the cursor changes into the Quick Selection cursor shape when the cursor is 
over a Wall

If the cursor is on an area that you can quick-select, you cannot draw a selection rectangle or 
polygon, because your first click will select the element. You can quick-select an element only on its 
own home story.
With the Arrow Tool and Quick Selection active, in a 2D or Section/Elevation window, you can drag 
any element by clicking on it and holding down the button while you drag it, without having to use 
the Drag command. (The click-drag option with Quick Selection is not available in the 3D window; 
use the Edit menu commands or Pet Palette instead.) In a 2D or Section/Elevation window, 
overlapping elements can be selected in sequence by clicking repeatedly at the intersection. Only 
the selected element will be dragged if you use the click-drag option.
In case of Doors/Windows, you can click in their area; only the Door/Window will be selected, not 
its enclosing Wall. If you want to relocate a Dimension Text, you do not need to look for its Selection 
node. Instead, just click on the Text to select it (note: selecting a Dimension Text will not select the 
Dimension itself, only the Dimension Text).
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In case of Text Blocks, you can click on the area of the Text Block to select it with the Arrow Tool. To 
bring up the text editor window, you can just click for the second time within the area of the Text 
Block after you have selected it.
You can speed up selection while working in any of the Tools: press the Shift key, and the program 
switches to Arrow Tool mode. The cursor shape will turn into an arrow, and the Quick Selection 
method along with most other Arrow Tool possibilities will be available as long as the Shift key is 
kept pressed. When you release the Shift key, the program returns to the mode of the currently 
selected Tool of the Toolbox. This is evident from the change of the cursor’s shape. Note that the 
Toolbox will not switch to the Arrow Tool when you press the Shift key. You can toggle between the 
Quick Selection method’s on and off status by holding down the SPACE bar.
Another feature is the use of the Ctrl-Shift key combination. Up to ArchiCAD 7.0 it was possible to 
cycle through element of a certain type when you had that Tool active, CAPS LOCK was on, and you 
kept the Shift key pressed while selecting the element you needed. This feature is now available 
again in ArchiCAD 9 (except that the key combination is Ctrl-Shift). This can be handy when several 
elements of various types overlap or share the same edge. Let us consider the following example:

Here two Slabs and a Wall share the same edge. If you want to select only one of the Slabs (there 
may be more complicated cases where you don’t see other edges of the Slab, only this edge), you 
can choose the Slab Tool, press Ctrl-Shift and keep clicking the shared edge. With Ctrl-Shift pressed, 
ArchiCAD will cycle through only the elements created with the currently selected Tool. This way 
you can limit the number or type of elements to choose from, allowing you to more easily select the 
exact element you need.
Pressing the SPACE key will toggle the status of the Quick Selection button. If Quick Selection is 
enabled, you can disable it while the SPACE key is held down.
When using the Ctrl-Shift method to select an element from among elements of the same type, you 
may not have Quick Selection enabled. In this case, while holding down Ctrl-Shift, you can also press 
SPACE to temporarily enable Quick Selection. This way you do not have to click on a node or edge of 
elements: you can find the one you need by successively clicking on their overlapping area while 
ArchiCAD finds the one you need.
Please note that the Quick Selection method cannot be used for transferring attributes between 
elements (Alt-click and Ctrl-Alt-click operations). For this you still need to find a node or an edge of 
the element involved in the attribute transfer.
Another feature related to Quick Selection is that only those elements may be selected that are 
identifiable at the current zoom factor. As a rule: if no nodes of the element to be selected are 
visible at the current zoom level, you will not be able to select it using Quick Selection.
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On the above illustration, one node of the Fill’s polygon is visible in the Floor Plan Window. When 
you go over it, the cursor changes shape and it can be selected using Quick Selection.

On this illustration, the zoom factor is so great that no nodes of the Fill’s polygon are in the Floor 
Plan Window. The cursor does not change shape and the Quick Selection method is not available. 
You may still select the Fill using the traditional method of finding and clicking an edge.
This feature seeks to help you avoid selecting elements that are not visible enough on the screen to 
be always correctly identifiable.
A new development in GDL enables Library Parts to have not only Hotspots but Hotlines as well. If a 
Hotline is scripted in the 2D Script of a Library Part, the cursor will sense this line within the Library 
Part just as if it were a normal line created with the Line Tool. In the illustration below, the cursor 
changes to a Mercedes shape (indicating it has found a Line) when going over the 2D Symbol of the 
Library Part Design Table 01.
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Standardized Escape (“Esc”) Logic
The functionality of the Esc key has been slightly modified with ArchiCAD 9. It now provides four 
levels of escaping the current operation one is involved in. Let us consider the following example: 
the user is working with the Object Tool, has a Marquee around an area on the Floor Plan. With the 
Select All command of the Edit menu, he selected all Objects within the Marquee and started to 
drag them.

The four levels of escape functionality work as follows:
1. The program quits the current operation
2. The program deselects selected elements
3. The program removes the Marquee (you no longer have to right-click on the Floor Plan and use 

the Remove Marquee command.
4. The program returns to the Arrow Tool from the currently active Tool.
In the example given above, consecutive presses of the Esc key result in the following actions:
1. The drag-a-copy operation is cancelled

2. The Objects within the Marquee become deselected
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3. The Marquee is removed from the screen

4. The Arrow Tool becomes the currently active Tool.
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Tutorial
• Select Window > Palette Layout > ArchiCAD 8.1 Layout to create ArchiCAD 8.1-style Palette 

arrangement. Drag the Info Box by its Header and dock it to the left side of the ArchiCAD 
Window. Try to move it around the edges so that the rubberband rectangle appears, indicating 
where the Palette would be docked. Dock the Navigator under the docked Info Box. Dock the 
Toolbox, Coordinate Box and Control Box as well.

• Scroll with your mouse while the cursor is over the Info Box. See how you can access all Info Box 
panels this way.

• Double-click the header of any docked Palette. It jumps back to its position on the screen prior 
to docking. Double-click its header again. See how it docks back to the same place.

• With the Info Box and the Navigator below it, both docked, click the minimize arrow in the Info 
Box’s header. See how it is reduced, giving more room to the Navigator. Switch it back to normal 
size.

• Drag the border of a docked Palette to resize its width. Drag the border between two Palettes 
docked one above the other. See that there is a minimal size for each Palette. 

• Right-click the Info Box and the Toolbox to see available options in the Context menu. Try some 
of the options and see the changes they bring about. Switch between the Personal Toolbar and 
the Classic Toolbar.

In the Object Settings dialog box, do searches for Library Parts. Type any text you like in the search 
field. Experiment with the wildcard characters (? and *). Also experiment with the begins with, 
contains etc. options. Select a found Library Part and check its location at the bottom of the found 
items list. Switch back to normal Library structure.
Familiarize yourself with the Quick Selection method of ArchiCAD 9. Check the cursor shape when 
you go over any polygonal element. Select elements with this method. Select a Tool and press Shift. 
Keep it pressed and select elements. See how it works. Work with the Ctrl-Shift selection method. 
Observe that the program selects only elements created by the currently active Tool when Ctrl-Shift 
is pressed.
Select an element using Quick Selection. Now zoom in so much that no nodes of the element 
polygons are in the visible Floor Plan area. Observe that the element now is not selectable with 
Quick Selection.
Check the object Design Table 01 for hotlines. See how the cursor senses them and changes shape 
accordingly.
Familiarize yourself with the new Escape mechanism. Draw a Marquee, select a Tool, select all 
elements of that Tool within the Marquee. Start dragging them. Press the Esc key several times and 
see how each keypress cancels the current operation, taking it back to a previous level.
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Better Usability

Improved Pet Palettes
In previous versions, the command icons available for a Pet Palette of a Tool were different 
depending on whether the currently active Tool was the Arrow Tool or another Tool. In effect, there 
were two separate Pet Palettes for each element type. In ArchiCAD 9, these two Pet Palettes 
became unified in a single two-row Pet Palette that displays all available buttons for the current 
element type. This eliminates the need for switching between these two Pet Palettes, thereby 
speeding up element editing operations.

Editing Enhancements 
Polygon editing has been enhanced in ArchiCAD 9. It applies to all elements created by drawing a 
polygon (Polygonal Wall, Slab, Roof, Mesh, Zone, Fill). One enhancement is the unification of the 
Fillet and Chamfer commands. When clicking a corner of a selected polygonal element (e.g. a Slab), 
the Fillet/Chamfer dialog box comes up.

Here you can specify whether to Fillet or Chamfer the given corner of the polygon. If you wish, you 
can apply this editing action to all corners of the polygon.
When you click an edge of the selected polygon, you have two new editing options.
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The third button of the Pet Palette from the left is called Edit segment using tangent. It will create a 
curved segment of the polygon. By dragging the mouse you can specify a tangent between that 
edge of the polygon segment that is closer to the location on the segment you clicked, and the point 
you click. The polygon’s segment will be curved to fit the specified tangent and the other edge of 
the segment. During the operation, a line (vertical in below illustration) shows the direction of 
current tangent of the segment.

This command may be used to create a half-circle segment for a polygon. Use this command on an 
edge, and make the tangent perpendicular to the existing state on the edited edge. The resulting 
segment will be a half-circle.

The fifth icon is called Extend neighboring edges. With its use you can delete any segment of a 
polygon and extend its neighboring segments so they join in a new polygon node.

Please note that this icon does not appear on the Palette if this operation is not possible. In the 
below example the icon does not appear the two neighboring edges of the clicked segment are 
parallel, therefore it is not possible to extend them so they would join.
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The Offset Edge command for polygon editing has been modified to eliminate an incorrect working 
method in previous versions. In ArchiCAD 9, when you offset the edge of a polygon, no other 
existing edges of that polygon change. Additional edges are created if necessary. In previous 
versions the polygon might have changed its shape considerably because of such a command. This 
has now been improved so the program modifies no existing edges.

 
In ArchiCAD 9, it is possible to open a closed Polyline. Ctrl-click on a segment of the Polyline. The 
segment will disappear, making the Polyline open. Please note that if the Polyline is selected and 
the Polyline Tool is the active Tool, this will not occur, because in that case the program assumes 
you are trying to edit the geometry of the polygon of the closed Polyline. If the Polyline is not 
selected, it is possible to cut the segment. The following example shows the original (left) and the 
resulting open Polyline (right).

If you Ctrl-click additional segments of the open Polyline, those will be trimmed as well. However, 
there is a special case just as with opening the closed Polyline. If the Polyline Tool is the active Tool 
and the Polyline is selected, Ctrl-clicking on a segment will find the closest edge of the segment, and 
split the Polyline in two. The shorter of the two resulting Polylines will remain selected. The 
example shows the original (left) and the result of such an operation.
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Another usability enhancement is that disabled buttons do not appear on a Pet Palette, i.e., if a 
button of a Pet Palette cannot be used in a given situation for the given Tool, the button does not 
appear on the Pet Palette. The following illustration of the Wall Pet Palette shows this. The one on 
the left (from ArchiCAD 8.1) has two buttons disabled; on the Pet Palette on the right (in ArchiCAD 
9) those buttons do not even appear.

Several Tools also received enhancements and working with them has been made smoother.
With the Wall Tool, the Pet Palette now also appears when you click the edge or nodes of the Wall 
that is opposite to the Reference line side. This was not possible in previous versions. In this case, 
general element modification commands are available (Drag, Rotate, Mirror etc.).

When the Reference Line side of a straight Wall is clicked, the Straight Wall can now be converted 
into a Curved Wall by either the Curve edge or the Edit segment using tangent methods.

When the Reference side of a Curved Wall is clicked, the Radial Stretch button receives a new icon 
for easier identification.

When one end of the Reference side of a Curved Wall is clicked, the Angular Stretch button also 
receives a new icon.
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In case of the Trapezoid Wall, the Move Node and Stretch Trapezoid Wall command buttons have 
been unified. While moving the node, the program calculates the new width of the Trapezoid Wall 
at its stretched end based on previous widths and the ratio between its width before and after 
stretching.

With the Roof Tool, a new concept called sub-element editing appears. When a certain element is 
selected, it may have a sub-element within it. For example, a Roof element always has its pivot line 
as its sub-element. When clicking the middle or end node of the Roof’s pivot line, the Pet Palette 
comes up and you have the choice to either move the sub-element (the pivot line) or the whole 
element. In the illustration below, the selected Pet Palette button will move the sub-element, while 
the one below it will move the whole Roof.

This feature is also available for the Zone Tool, where a Zone element has one sub-element: its Zone 
stamp.
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The same feature can be used with the Section/Elevation Tool. A Section/Elevation Line element has 
several sub-elements: each line segment of the Section/Elevation Line is a sub-element. The Lines 
marking the limits of the Horizontal Range and the Distant Area are also sub-elements.
Clicking on any of these, you have the choice between moving the clicked sub-element or the whole 
Section/Elevation Line. When you click on the middle of a Line segment of the Section/Elevation 
Line, you have two choices. The first one is two break the Line segment into two parts.

The other is to modify the location of the clicked Line segment.

For the Line Pet Palette, the new option is the Edit segment using tangent button.

The Circle Pet Palette received new features as well. The first is that now a Circle can be graphically 
converted into an Ellipse by dragging one of its Hotspots, thereby redefining the size of one of the 
axes of the Ellipse (a Circle is a special Ellipse, the major and minor axes of which are equal). 

When editing an Ellipse, it can be converted back into a Circle using another Pet Palette button. The 
way it works is that the radius of the created Circle will be the size of that axis of the Ellipse (major 
or minor axis) whose end point you click before selecting this command from the Pet Palette. In the 
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example below, you can see from the shape of the rubberband ellipse that the upper node of the 
Ellipse is stretched, hence the size of the resulting Circle.

An additional feature enhancement is that now a rotated Circle will have its selection quarter 
hotspots rotated as well.

Polyline editing has also been enhanced. It is now possible to continue an already drawn Polyline. 
Click one of the two endpoints of the Polyline and choose the Continue Polyline command from the 
Pet Palette. New segments will be added to the Polyline starting from the clicked end. It works as if 
you were drawing a new Polyline which ArchiCAD 9 automatically unifies with the original Polyline.

Note: When extending the original Polyline, you can backspace to delete the last drawn 
segments, but you cannot delete segments of the original Polyline.

It is now also possible to select a Polyline and extend it or trim it to any other Line, Arc, Circle/
Ellipse or Spline by Ctrl-clicking the element you want it extend/trim to.

Spline editing has been improved as well. It is now possible to insert a new node into an already 
existing spline. Select the spline and select the Add new node to Spline icon from the Pet Palette 
(icon in upper row). The shape of the spline will stay exactly the same.
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Two new icons are available when you click an end node of the spline. The first one lets you move 
the end node of the spline while leaving all other nodes untouched.

The other one lets you move the tangent handle of the Spline.

The functionality of the Unify command has been extended in ArchiCAD 9. You can now unify any 
number of connected (continuous) Lines, Arcs and Polylines by selecting all of them and selecting 
the Tools > Unify menu command. Previously you had to explode Polylines and then unify the 
resulting line/arc segments. When using Unify, the attributes of the last selected element will be 
applied to the unified set of elements. 

Note that you cannot Unify elliptic arcs and splines with other types of linear elements. However, 
you can Unify one or more connected Splines into one Spline. To do this, select all connected 
Splines and choose Tools > Unify. The control points of Splines will remain in place and the resulting 
shape of the new Spline will be calculated based on these control points.

In case of the Drag-a-copy, Rotate-a-copy and Mirror-a-copy operation, in ArchiCAD 9 the element 
created with the operation will become selected with the original element becoming de-selected. 
This change was done because experience showed users more frequently wanted to work with the 
element they just created than with the original element. Hence the change in program behavior. In 
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the example below, a copy of the upper line was dragged downward. See the difference between 
previous versions (left) and ArchiCAD 9 (right).

In case of multiple Drag-a-copy operations [Ctrl-D (Windows)/CMD-D (MacOS), then press Ctrl-Alt 
(Windows)/Ctrl-OPT (MacOS)], all new elements created during the operation will become selected 
along with the originally selected element(s). In the below illustration you can see the difference 
between the way it worked in previous versions (left) and in ArchiCAD 9 (right). This works the same 
way when using the Multiply commands: all elements involved remain selected.

Although we believe this working method will be better for most users, it is possible to switch back 
to the old working method. In Options > Preferences > Miscellaneous, you can check the Keep only 
original elements selected after Copy Transformations checkbox to return to the way the program 
worked in previous versions.

Parameter Transfer between Library Elements of 
Same Type
Using Ctrl-Alt-click on Windows / CMD-OPT-click on MacOS, it is possible to transfer between two 
Library Objects the whole set of parameters they have in common. Let us say we have a Window 
selected on the Floor Plan. If we go to its settings dialog box, we see the following:
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We can now find any other Window from the browser panel on the left. In the Window in the lower 
left area, scroll to the desired Window object, but do not click on it to select it. (If you click it, you 
would select it instead of the current Window object, but with its own default parameters.)
Instead, when you find the desired Window, Ctrl-Alt-click (CMD-OPT-click on MacOS) on its name or 
icon in the list. 

As you can see in the above screen capture, the cursor changes to the syringe shape, indicating 
parameter transfer is possible. When such an operation is done, the values of all matching 
parameters are transferred if the matching parameters are of the same type. E.g. if there is a 
variable named Frame_thickness in both objects having the Length variable type, its value would 
be transferred. Note that in this example, Frame_thickness is not the text you see displayed for the 
parameter, but the name of the GDL variable that is taking the value entered for this parameter.
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Keep Section/Elevation Zoom after Rebuild
Earlier, a rebuild in a Section/Elevation also meant that if you left the Section/Elevation zoomed in 
on a detail in it, after the rebuild, ArchiCAD switches to a zoom factor so the whole model was fit 
into the Section/Elevation Window. ArchiCAD 9 keeps the zoom factor previously zoomed to even 
after a rebuild, thereby saving you the trouble of having to recreate the desired zoom.
This option has become a User Preference. In Work Environment Profiles > User Preferences 
Schemes > Imaging and Calculation of the Options > Work Environment Dialog Box, there is a new 
checkbox in the middle called Section Window Rebuild Control. It is ON by default, meaning that 
this feature of keeping zoomed detail of Sections/Elevations is enabled. You can return to the way it 
worked in previous versions by unchecking this checkbox.

Place Elements in 3D with their Default Heights
There is a new checkbox in Options > Preferences > Miscellaneous.

It is the Specify Z-Coordinate when placing or editing element in 3D Window checkbox. The 
default state of this checkbox is unchecked, meaning you can create and edit construction elements 
in the 3D window using fewer clicks. For example, when creating a straight Wall in 3D, in earlier 
versions, you first input the starting point of the Wall, then the end point of the Wall, and as a third 
step you graphically specified the height of the Wall. In ArchiCAD 9, with this checkbox unchecked, 
you can place the Wall in 3D with only two clicks, because the program will assume you want to 
place the Wall using the height specified earlier in its Settings dialog box or the Info Box. 
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Create Independent Detail
In ArchiCAD 9, it is possible to create an independent Detail that is not linked to a Detail Marker 
placed on the Floor Plan. The Create Independent Detail command is available from the Tools menu 
by default. In earlier versions, the method for creating such a Detail was to place a Detail Marker on 
the Floor Plan. The Detail showed up in the Navigator among Details, with its icon showing that it is 
a Detail linked to a Detail Marker. Then you could delete the Detail Marker from the Floor Plan, by 
which the Detail became an Independent Detail, indicated by a different icon in the Navigator. In 
ArchiCAD 9, you can create such Details directly.

When its command is selected from the Tools menu, the above dialog box comes up, letting you 
specify a Reference ID and Name for the new Detail. Clicking OK will create the Detail, which will 
appear in the Navigator and among Details in Window > Detail Drawings > Open Detail Drawing. In 
the screen capture below, check the icon of Details D-3 and D-5, which are Independent Details, 
and compare it to the icon of Details D-12 and D-20.

Quicker Story Creation
When trying to go up or down to a not-yet created story, ArchiCAD 9 now presents you with the 
Create New Story dialog box. With this dialog box you can specify the two most important data of 
the story to be created: its Name and Height. While creating these data on the fly, there is no need 
to enter the Story Settings dialog box, so you can create new Stories more quickly.
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Layer Pop-Ups Show All Layer Attributes
Every layer information pop-up now includes icons for all layer attributes (from left to right: locked 
status, visibility, 3D wireframe/solid mode, intersection group number – the latter two are new 
additions), providing the user at-a-glance information about layers. This way the user does not have 
to open the Layer Settings dialog box to obtain these data about layers in the Project.

Show Number of Selected Elements in the Info Box of 
the Arrow Tool
When the Arrow Tool is active, the number of currently selected elements is displayed at the top 
area of the Info Box to provide additional info for the user during selections.

Library Parts’ Name is Shown Bold in Info Box
When Library Part-type elements are selected (Doors/Windows/Objects/Lamps etc.), the name of 
the current Library Part is now shown in the Info Box with a larger bold text for easier identification.
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Location of File Selected in Recent Documents 
Shown
On both Windows and MacOS, when an ArchiCAD Project File or a Library part is selected from the 
list in File > Recent Documents, the full path of the file is displayed in the Status bar of the program 
at the bottom left of the ArchiCAD application window.

This helps to locate the exact file needed, even when several files with the exact same file name but 
different locations are listed in Recent Documents.
If your Status bar is not visible at the bottom of the ArchiCAD Window, you may right-click 
anywhere on the Toolbar below the menu bar and select Show Status bar from the context menu.

View Editor and Publisher Open Their Own Windows
In ArchiCAD 9, when you select the View Editor or the Publisher Window from the Navigator 
Palette, they open in their own windows. (View Editor is also available from the Window > Palettes 
menu; Publisher is also available from the File menu.) Previously the Navigator turned into a View 
Editor or Publisher Window. They are now separate palettes that can be moved, resized and closed 
without affecting the Navigator Palette.
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Windows Taskbar Displays ArchiCAD File Name
This handy feature helps the user when several copies of ArchiCAD are open at the same time on 
the same machine and a different file is opened in each one. The user can simply go over the 
ArchiCAD button of his choice on the Taskbar, at which point the ArchiCAD version and the name of 
the file opened is displayed over his cursor. This aids easy location of the copy of ArchiCAD he 
wishes to work on.

Consistent Story Name Display
All stories are identified consistently by their number and name throughout the whole ArchiCAD 
interface. In any field or pop-up, where a Story is displayed, both the Number and the Name of the 
Story are displayed for better identification.
These include:
• The Stories displayed in the menu
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• Stories in the Go to Story dialog box

• Stories in the Ghost Story pop-up of the Story Settings dialog box

• Stories in the Navigator

Dimension Texts have Visible Handles
If the Text field in the Options for Display only panel of the Display Options dialog box is set to 
either Text with Handles or Greek with Handles, Dimension Texts will have a handle displayed in 
the lower left corner of their enclosing rectangle, just like other text elements do. This makes 
locating and moving them easier.
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The Dimension Text Handle is at the point of the red arrow.
Alternately, you can now find the Dimension Text by clicking onto it, if the Quick Selection button is 
activated in the Info Box when the Arrow Tool is active. With this method you can select Dimension 
texts even when Text Handles are hidden.

The Quick Selection icon is displayed as the cursor moves over the Dimension Text

Editable Selection Dot has Separate Color
Selection dots that are editable in 2D or 3D now can have a separate color defined for them, so they 
may be distinguished from normal selection dots not only by their shape (diamond-shaped 
hotspots, as opposed to round dots for normal hotspots and rectangular hotspots for elements of 
modules), but their color as well. The red selection dot below at the cursor is such a selection dot.

The color of these selection dots can be defined in Options > Preferences > Miscellaneous:
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Door/Window Opening Height Changes can Work 
Differently
In Options > Preferences > Construction Elements, it is now possible to set how changes in the 
height of Windows and Doors will affect each element type. For both types, you can choose 
whether the change will affect the Door/Window sill of their height. See the four radio buttons at 
the bottom of the dialog box as opposed to the two radio buttons in previous versions.

More Intelligent Autosave
The Autosave functionality of ArchiCAD has been enhanced for version 9. The new working method 
offers solutions to a situation wherein several copies of ArchiCAD are open on the same machine 
where the machine crashes (because of operating system failure, power outage etc.). In this case, 
several Projects had Autosave data to be recovered. In previous versions it was possible to recover 
the Autosave data of only one Project.
What is new in ArchiCAD 9 is that the Autosave data of each crashed Project may be recovered. 
When you start ArchiCAD 9 after such an occurrence, the following dialog box comes up.
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The list will contain the names of Projects whose Autosave data are available for recovery. You can 
select one from the list. Then you have three choices. Choose the Open selected project radio 
button to recover the selected project from its Autosave data. Autosave data belonging to other 
projects will be left alone. Choose Open selected project and delete the others if you want 
Autosave data belonging to other projects be deleted while opening the selected one. This is how 
previous versions of ArchiCAD worked. Choose Delete all to discard all Autosave data without 
opening any of them.
If you had more than one copies of ArchiCAD crashing, you can open one, select a project to 
recover, then open another copy of the program and select another project to recover. This way you 
will suffer no serious data loss.

Hide Zero Decimals in Dimensions
A new checkbox in the Options > Preferences > Dimensions dialog box gives you greater control 
over how zeros in Dimension measurements are displayed.

When the Hide Zero Decimals checkbox is checked, no trailing zeros in decimals of Dimension Text 
will be displayed in ArchiCAD. Let us see how it works. The illustration below shows how a 
dimensioned part of a Project would look with this option unchecked.
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Now, if the checkbox is checked, those trailing zeros will all disappear, saving room on the drawing 
and allowing the user in certain countries to better conform with local conventions and regulations 
on drawing format.

Note that the Hide Zero Decimals and the Hide Zero Wholes checkboxes cannot be used together 
(they would make Dimension Text disappear), so checking one will automatically uncheck the other.

New Interface Item: Icon+Text Pop-Up Menu
In ArchiCAD 9 there is a new interface item: a pop-up menu that can hold both icons and text. With 
it you have fast and easy access to available functions. When customizing toolbars, you can use this 
new feature in ArchiCAD 9 to create toolbars showing not only an icon, but also a descriptive text of 
the command you wish to use.

Tutorial
• Create a Slab, Roof, Mesh or Closed Polyline. Use the new unified Fillet/Chamfer command on 

one corner. Then Fillet/Chamfer all corners. Erase an edge to extend the its neighboring edges. 
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• Ctrl-click a closed Polyline to make it an open one. Ctrl-click a selected open Polyline to cut it 
into two Polylines. Select the two Polylines and use the Unify command to make them into one 
Polyline.

• Familiarize yourself with new options and icons available for straight, curved and trapezoid 
walls. Convert a straight wall into a curved one. Modify the curved wall’s curvature with the Edit 
using tangent Pet Palette command.

• Create a Roof with its pivot line visible. Select it and use Pet Palette commands to move its pivot 
line or move the whole Roof polygon.

• Select a Zone and use Pet Palette commands to move only the Zone Stamp first, then the whole 
Zone polygon.

• Draw a Section/Elevation line made out of several line segments. Using the new Pet Palette 
commands, break its Line Segments or modify the location of the clicked line segment.

• Create a Circle and use the new Pet Palette command to convert it to an Ellipse. Resize the 
Ellipse. Convert it back to a Circle. Rotate a Circle and check the location of its hotspots in its 
rotated state.

• Draw an open Polyline. Select it and continue it with the appropriate Pet Palette command. 
Extend and trim the end segments of Polylines to lines, Circles or Splines.

• Use drag/rotate/mirror-a-copy commands to familiarize yourself with which element(s) remain 
selected after such operations.

• Go to a Section/Elevation Window and zoom in on an area. Close the Section/Elevation Window 
and open it again. See that the zoomed area is preserved. You may want to set the Section/
Elevation to a manual-rebuild type. Press Rebuild to manually rebuild the Section/Elevation.

• Create elements in 3D using the fewer-clicks method.
• Use the Create Independent Detail command to create details. In Navigator, check the icons of 

Independent Details and compare them to the icons of details created by linking them to a 
placed Detail marker.

• Create a New Story on the fly. See how you can assign it a name and height.
• Select the Wall Tool and click the Layer pop-up button in the Info Box. See how each of the four 

characteristics of each layer is displayed in the pop-up.
• Select some elements on the Floor Plan. See the number displayed at the top of the Info Box.
• Select a Library Object. See how its name is displayed using bold text in the Info Box.
• Go to File > Recent Documents and go over the name of a file you worked with earlier. Check the 

Status Bar to see its full path.
• Open the View Editor or Publisher Palettes in ArchiCAD. Notice how they are now independent 

of the Navigator.
• Have several copies of ArchiCAD open concurrently. Go over their buttons on the Taskbar to see 

the Tool Tip showing the ArchiCAD version and the name of the file opened.
• Check how story names and numbers are consistently displayed in all part of the ArchiCAD 

interface.
• Select Dimension Texts by clicking on them. Make the handle of the Dimension Text visible in 

Display Options.
• Go to Options > Preferences > Miscellaneous and modify the color of editable hotspots. Check 

its effect on a Door or other Library Part.
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• Go to Options > Preferences > Construction Elements and set different options for how changes 
in opening height affect Doors and Windows. Place a Door and Window. Change their opening 
heights in the Info Box and see how their Sill height/Head height values reflect the changes.

• In Options > Preferences > Dimensions, check the Hide Zero Decimals checkbox and see the 
result on your dimensions. Observe that it cannot be used together with the Hide Zero Wholes 
checkbox.

• Check the default toolbars of ArchiCAD 9 for pop-up menus containing both icon and text.
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Better Element Representation

Advanced Fill Categories
In ArchiCAD 9, created Fills may belong to three distinct categories. A new panel has been created in 
the Fill Settings dialog box for this purpose. It is called the Advanced Settings Panel.

The Fill Categories are as follows:

Drafting Fill
These are simply Fills that are created on the Floor Plan, or Sections/Elevations or Details for 
enhancing the look of the ArchiCAD document. They do not have any relationship with construction 
elements such as Walls, Slabs or Roofs.

Cover Fill
A Cover Fill is a new idea in ArchiCAD. It can be associated with a Slab, Roof, Mesh or Zone on the 
Floor Plan. Its purpose is to enhance the representation of these construction-type elements in the 
Floor Plan Window on their own and on other stories. Architect do not have to duplicate work by 
having to place fills on top of slabs, roof, meshes or zones to show in plan views, show finish 
materials or create other needed representation. See more about this later in this document.

Cut Fill
This Fill is the one drawn on the Floor Plan, or Sections/Elevations or Details, wherever a 
construction-type element is cut so that its section is visible in the given Window. Fills of Walls and 
Columns on the Floor Plan, plus Fills of all 3D elements in Sections/Elevations or Details belong to 
this category.
When placing a Fill that does not belong to a construction element, you can still specify to which Fill 
Category the Fill should belong. This can be handy because Fills in the same Fill Category are 
treated the same way as regards to Display Options or as regards to their classification when saving 
as DXF/DWG. For example: if you have a Wall in a Section/Elevation and you unlink it from the 
model, Fills generated from the section of the Wall will belong to the Cut Fill category. Now you can 
draw additional Fills with Cut Fill as their specified Fill Category and these drawn Fills will be treated 
the same as those coming from the construction element.
These three new Fill Categories are also available in the Fill Types Settings dialog box (Options > 
Attribute Settings > Fill Types).
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Here you can specify which Fill Type is available for which Fill Category. 
In the Attribute Manager, it is also possible to change the availability of Fill Types for Fill Categories.

Advanced Line Categories
There are now also categories for Lines in a Project file. They can be found in the Advanced Settings 
Panel of the Line Settings dialog box.

The Line Categories are as follows:
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Drafting line
These are simply 2D lines that are created on the Floor Plan, or in Sections/Elevations or Details, for 
enhancing the look of the ArchiCAD document. They do not have any relationship with construction 
elements such as Walls, Slabs or Roofs.

Cut line
This line is the one drawn on the Floor Plan, or Sections/Elevations or Details, wherever a 
construction-type element is cut so its section is visible in the given Window. The contour lines of 
cut construction elements belong to this category. 

Skin Separator line
This Line Category also belongs to cut construction elements that appear on the Floor Plan, or 
Sections/Elevations or Details. The difference is that skin separator lines of composite structures of 
Walls, Slabs and Roof, plus the skin separator lines between the core and the veneer of Columns 
belong to this category.

New Display Options for Line Weight
A new option has been added to the options for Line Weight in Display Options: Bold Cut Lines.

This option displays all cut lines as a bolder line than view lines. View lines are displayed with 
hairlines, while Cut Lines are displayed with a line double the width of a hairline on the screen. It is 
not true weight, but a thicker line. This helps you identify cut structures on the Floor Plan, while still 
displaying hairlines. This option is an intermediate step between the two other options already 
available. The following illustration shows the results of the three options: Hairline (left), Bold Cut 
Lines (middle) and True Weight (right).
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New Display Options for Fill and Line Display
The following paragraphs apply to both Fill and Line categories, how various Display Options affect 
their display and what they are good for.
In Display Options, three new fields replace the Construction Fills and Polygon Fills fields: the Cut 
Fills, Drafting Fills and Cover Fills fields.

The Cut Fills field control how Cut Fills are displayed in ArchiCAD. They also control how Cut Lines 
and Skin Separator Lines are displayed as these also belong to cut constructions.

In the example below, you can see how each of the options in this field affects a composite 
structure, whose Lines and Fills belong to the Cut Lines, the Skin Separator Lines and the Cut Fills 
categories. From left to right they are: No Fills, Separators Only, Solid, Bitmap Pattern, Vectorial 
Hatching.

Please note that the Fill Background Color setting in Display Options also affects how the 
backgrounds of these fills are displayed, but the results are different for Bitmap Pattern and for 
Vectorial Hatching, where fills have a background color.
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In Drafting Fills, you have the same options that were available in previous versions for Polygon 
Fills, plus an additional one: No Fills. This setting affects only fills created by you, which belong to 
the Drafting Fill category.
The illustrations below show how a drafting fill looks with the various settings (from left to right): 
No Fills, Solid, Bitmap Pattern, Vectorial Hatching.

The settings in Cover Fill affects only how Cover Fills belonging to Slabs, Roofs, Meshes and Zones, 
plus Fills created by you and belonging to the Cover Fill category, are displayed.

It has the same four choices as for Drafting Fills and the results are the same as well. See illustration 
above at Drafting Fills.
Fill and Line Categories come handy when working in Sections/Elevations. When you make a 
drawing out of a Section/Elevation, construction elements are broken up into Fills and Lines. 
ArchiCAD 9 intelligently places Fills and Lines deriving from a construction element or a composite 
into their correct Fill or Line Category. The Wall Core’s fill in the below illustration is placed in the 
Cut Fill Category.
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The contour line of the composite is placed into the Cut Line Category.

The line separating the insulation from the core of the wall is correctly placed into the Skin 
Separator Line Category.

Moreover, you can add Fills and Lines to Section/Elevation Drawings. By correctly setting their 
category you can ensure they will be displayed the same way as the Fills/Lines they belong to and 
they will be exported to the correct special layers if that options is used when saving a DXF/DWG 
file.
Here is the result when the Cut Fills field is set to Separators Only in Display Options. Hence, no Cut 
Fills are displayed, but cut lines and Skin Separator Lines are.
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Fill Background Color Setting Now Part of Display 
Options
The Fill Background Color setting that was earlier located in Options > Preferences > Miscellaneous 
has been relocated into the Options for Display and Output panel of the Display Options dialog box. 
The Fill Background setting is no longer global, but can be saved as part of a Display Option 
Combination, thereby giving greater flexibility.
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Place Fills on Top of Slabs, Roofs, Meshes or Zones in 
Plan View
As mentioned earlier, it is now possible to assign a Cover Fill to the above four construction 
element types. This helps you enhance the representation of these elements on the Floor Plan on 
the story the element is located and on other stories as well. You can turn on Cover Fill for an 
element by clicking the large button just left to the long Fill Pattern selection button in the 
element’s Tool Settings dialog box.
A Cover Fill will take the shape of the Polygon of its parent element and follow it. You can specify a 
Fill pattern, Fill pattern pen and Background pen for the Cover Fill. Note that only those Fills defined 
as Cover Fills in Options > Fill Types dialog box are available here. They will be displayed on your 
plan according to the setting chosen in the Cover Fills category in Display Options. You can also – 
just as with any other Fill – specify a Fill Origin for it, or leave it to ArchiCAD to link it automatically 
to the Project Origin.

In case of a Slab, you have another choice with the Use Fill of surface Material checkbox. When this 
checkbox is checked, the Fill Pattern selection field becomes grayed. ArchiCAD checks if there is any 
fill specified as a 3D Hatch for the top surface of the Slab. If there is, it will use that Fill pattern 
instead of the Fill otherwise specified for the Cover Fill.

With the settings in the above illustration, see what difference occurs when the Use Fill of surface 
Material checkbox is unchecked (left) and checked (right).
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If the Link to Fill Origin checkbox is also checked along with the Use fill of surface Material 
checkbox, then the surface will not only take the 3D Hatch assigned to that material, but the custom 
Fill orientation will be applied both in 2D and 3D.

The above working method applies to Zones as well.
In case of Roofs, the Use Fill of surface Material checkbox is not available. This is because an 
alternate fill pattern would have to be created for each cover fill for each Roof with a different 
slope, which would threaten to clutter up ArchiCAD with fill attribute definitions. However, there is 
a different checkbox available for the Cover Fill. It is the Align with Slope checkbox. It becomes 
enabled when the Link to Fill Origin radio button is selected. When checked, the Fill Origin of the 
Cover Fill will be oriented so that it will be in alignment with the slope of the parent Roof. This is 
handy because by default, the Fill is aligned automatically to the longest edge of the Roof Polygon, 
which might not be the same edge we want.

The following pictures show the effect on the Cover Fill when this checkbox is unchecked (left) and 
checked (right).
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In case a Roof has a Cover Fill with the Link to Fill Origin option, Roof input has additional steps 
involved because the Origin of the Fill must be given as well. After you have specified the pivot line 
and contour polygon of the Roof, you need two additional clicks to define the Origin and direction 
of the Cover Fill of the Roof as seen below.

 
If you are using the PolyRoof or Dome construction method to create Roofs, the Cover Fills will be 
aligned with the slopes of individual Roof planes by default.
In case of Zones, the same Use Fill of surface Material option covered at Slabs is available and it 
achieves the same result as for Slabs.

Another feature is that now Zone Cover Fills may have an outline. Click the large button to the left 
of the grayed Line Selection button in the Floor Plan panel of the Zone Settings dialog box. When 
this button is pressed, you can define a line type and a pen color for the outline of the Cover Fill of 
the Zone.
There are also new display options for Zone Polygons, now six different choices in total. The new 
choices came about by the new development in ArchiCAD 9, which is that Zones too can have their 
own Cover Fill. This setting affects how the color of a Zone Polygon, plus the Fill pattern and 
background color of its Cover Fill are displayed.
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In the below example, we have a Zone with a Cover Fill. The Zone’s category is lilac in color. The 
Cover Fill is a ceramic tile pattern with a light green background color. Cover Fills are set to be 
Vectorial Hatching, Fill background color is set to By Element Settings. The results (from left to 
right, top to bottom) are for the following settings: None, Category Only, Cover Fill, Solid 
Background Colored Fill, Fill Pattern on Category and Fill Pattern Only.

Cover Fill for Zones allows the user to better differentiate zones within the same category. For 
example, you might want to draw each room in a flat with different colors. Add Cover fills with 
different colors to these rooms. By changing Display Options, you can have these room displayed 
with different colors (when solid background color of fill is displayed) or with the same color (when 
category color is displayed for zones).
For Slabs, Roofs and Meshes, there is another feature enhancement in ArchiCAD 9 that works in 
conjunction with Cover Fills. It is the enhancement of the Show on pop-up list, which has received a 
new item called Custom.
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If you select this item from the list or click the button to its right, a new dialog box comes up. Here 
you can set on which stories you want the outline and the fill to be shown. You can set these 
separately for the outline and the cover fill. With this you can avoid having to draw extra lines or fills 
on upper or lower stories to correctly represent your element. For example, you may have a canopy 
on 1. Story with metal sheathing on it. You want it and the fill of the sheathing to be visible on its 
home story, and the 3 stories above it. On 0. Story, you want only the contour of the canopy with 
dashed lines. You would set the following Show On options:

The result would be the following on the story below (top image), on the home story (middle 
image) and on the three stories above (bottom image):
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Text Rotation for Modules
When placing modules, a new checkbox is available in the Place Module dialog box.

If you check the Adjust angle of fixed-angle elements to reflect module rotation checkbox, text 
blocks within modules are rotated and mirrored with the module and keep their orientation relative 
to other elements within the module. This is the default working method of ArchiCAD.

In the above illustration, the Module on the right was placed normally. Another instance of the 
same Module (shown on the left) was rotated at 30 degrees and mirrored with the new checkbox 
checked. Note how it retains its Text orientation relative to elements in its own Module. (This was 
the original working method of previous versions of ArchiCAD). This checkbox can be separately set 
for each instance of the same Module.
If you leave the checkbox unchecked (this is the new option available in ArchiCAD 9), individual 
texts within the Module react to any rotation/mirroring based on whether the Fix Angle checkbox is 
checked in their Settings dialog box. In the example below, the large text has a fixed angle of 30 
degrees. Room names have a fixed angle of 0 degrees. Even though the module on the left was 
placed rotated 30 degrees and mirrored, these text elements preserved their angle in all 
circumstance. The right instance of the Module was placed without any rotation or mirroring. As 
you can see, Label elements in the Module did not have their angles fixed so they got rotated with 
the Module in the instance on the left.
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Text Rotation with Other Tools
The Label Tool also received enhancements related to its Text displaying capabilities.

Fonts can now be similarly selected by Font type and Code Page just as with Texts. The 
Strikethrough, the new Leading, the Width factor and Spacing factor formatting options are also 
available for Labels.
The Fix Angle checkbox is available for Labels, too, and works similarly to text blocks.

Check the Fix Angle checkbox to force the Label Text to keep its angle even after being rotated or 
mirrored. This checkbox is available only when the last option of the Label orientation radio buttons 
is active.
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An additional enhancement for the Label tool - as seen in the screen capture on the previous page - 
is that it can have its own opaque background color. Check the Opaque checkbox to define a 
background color for the Label.

One other enhancement of the Label Tool is that Label Text is saved with Label Favorites. This way 
you can quickly place Labels with pre-defined texts. To do this, double-click the Label Favorite in the 
Favorites palette for its settings to be transferred to the default Label settings, and place the Label.
The Fix Angle checkbox mentioned earlier is also available for Zone stamps.
Note that this option is not available when you modify the angle of Dimension text.

No Fix Angle checkbox in the Dimension Text Settings dialog box

Improved 2D Representation of Columns
Several new small features have been added to the Column Settings dialog box to facilitate better 
Column display on the Floor Plan.
New Features in ARCHICAD 8-20 131



What Makes ArchiCAD 9 Polished?
A new option is now available for the Floor Plan Symbol of the Column: the Column crosshair sign. 
This feature has been incorporated to better conform to local standards in some countries. When 
this option is selected, three additional settings may be set (from top to bottom): the distance 
between the edge of the Column and the end of the crosshair line, the distance from the center of 
the Column to the beginning of the crosshair line, and the crosshair line’s pen. See the example 
below.

The crosshair works for both rectangular and circular Columns.
Additionally, the angle of the Column now may be set in the Settings dialog box, and it is stored with 
the Column data. In earlier releases you could create Columns at an Angle only by placing them and 
then rotating them, or dragging/multiplying a rotated Column. Now you can simply place Columns 
at the desired angle.
132 New Features in ARCHICAD 8-20



What Makes ArchiCAD 9 Polished?
The Floor Plan and Section panel of the Settings dialog box also contains new fields. Until now, the 
Column’s core contours and veneer contours had the same line type and pen. You can now assign 
the Column Veneer its own Line Type and Pen. 

If there is no veneer, the contour line of the core belongs to the Cut Line category. Its fill belongs to 
the Cut Fill category. If there is a veneer, the veneer contour belongs to the Cut Line category, while 
the core contour belong to the Skin Separator Line category. Both core and veneer fills belong to 
the Cut Fill category.
The Cut Fill field in Display Options has an effect on how the Column is displayed on the Floor Plan. 

    
The above show how a Column with veneer is displayed according to the various settings in the Cut 
Fill field (from left to right): No Fills, Separators Only, Solid, Bitmap Pattern, Vectorial Hatching. 
Notice how the X-shaped sign on the Column is different with the No Fill options when there are no 
skin separator lines shown, only the contour of the whole Column.
There is also a new field in the Options for Display and Output panel of the Display Options dialog 
box. It enables you to either Show or Hide Column Symbols on the Floor Plan.
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Tutorial
• Place several Fills on the Floor Plan. Select various Fill Categories for each so you have Fills from 

every Fill Category on your Floor Plan.
• Place several Lines on the Floor Plan. Select various Line Categories for each so you have Lines 

from every Line Category on your Floor Plan.
• Set Bold Cut Lines for Line Weight in Display Options. See on the Floor Plan the difference 

between this new option and the two ones previously available.
• Place Composite Walls on your Floor Plan. Zoom in or out so all these placed elements are 

visible to you.
• Go to Display Options and set various settings for the Cut Fill field. See how it affects each of the 

placed Fills and Lines belonging to the various categories and how it affects the display of skin 
Fills, contour and Separator lines of the Composite Wall. Try the options in the Drafting Fills and 
Cover Fills fields as well.

• Now change the place of several Fills on the Floor Plan. Select various Fill Categories for each so 
you have Fills from every Fill Category on your Floor Plan.

• Now change the Fill Background Color field and see how this modifies the display of Fills and 
Lines with some options of the Cut Fill field.

• On the Floor Plan or in a Section/Elevation Window, explode a composite structure. Select Fills 
and Lines derived from it and check which Fill/Line Category they belong to. Add some more 
Fills and Lines to it. Again check how Fills/Lines coming from composites, on the one hand, and 
Fills/Lines belonging to the same category as Fills/Lines derived from composites, on the other 
hand, behave the same way for different Display Options settings.

• Create a Slab with a Cover Fill. Set various options for the Cover Fill. See how these affect the 
Slab’s appearance on the Floor Plan. Check the Use Fill of surface Material checkbox and select 
a material with a 3D hatch for the top of the Slab, or assign a 3D Hatch to the top material of the 
Slab. Check the result in 2D and in Top View in the 3D Window (using the Internal Engine, and 
with 3D hatching turned on in Image > 3D Window Settings). See how the fills are the same.

• Create a Roof with a Cover Fill. Check how it looks in 2D and 3D. Choose the Link to Fill Origin 
radio button. Create another Roof. Notice how additional steps are required in the Roof creation 
process to define the Cover Fill’s origin and direction. Select the created Roof and check the 
Align with Slope checkbox. See how the direction of the Cover Fill changes in 2D.

• Create a Zone with a Cover Fill. The Cover Fill’s background color should be different from the 
Zone Category color. Go to the Display Options dialog box, and try all six options for Zone 
Polygon to see your options with this tool.

• Select a Slab with a Cover Fill and select Custom in the Show on field. In the appearing dialog 
box, set on which Stories the Slab outline and the Cover Fill should appear. Set the line types as 
needed in Options > Preferences > Construction Elements. Check the result.
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• From the Module folder, place the file “Module A.mod” on the Floor Plan. Load the file “3D 
GA.PLA” as a Library so Library Parts in the Module are correctly displayed. Now place another 
instance of the same Module with a rotation angle set, and the above-mentioned checkbox 
checked. See orientation of Texts within it. Rotate and mirror each of these Modules to see how 
Texts within them behave.

• This time open “Module A.mod” and modify the text block “Type A”. Set its angle to 30 degrees, 
check the Fix Angle checkbox and move it to the middle of the Module plan. Send the text to 
the back in Display Order. Save the Module. In another file, place this module in several 
instances. Leave the Adjust angle of fixed-angle elements to reflect module rotation checkbox 
unchecked. In one or more of the instances, set rotation and/or mirroring value for the placed 
instance of the Module. See the result. See how texts kept their Angle while Labels did not. 

• Go back to the Module File and set some Label elements to Fix Angle. Save the Module. Then go 
to the project in which you placed the Module and update the placed instances. See how the 
Angle of Label elements change.

• On the Floor Plan, place a Label with a rotated text block and the Fix Angle checkbox checked. 
Rotate the Label and see how the text keeps its angle.

• On the Floor Plan, place a Zone with a rotated Zone stamp and the Fix Angle checkbox checked. 
Rotate the Zone and see how the Zone stamp text keeps its angle.

• Place a Column. Experiment with the new crosshair Floor Plan Symbol. Set an angle for the 
Column. Place rotated Columns. Place a non-rotated Column. With Alt-click and Ctrl-Alt-click 
transfer the settings of the rotated Column to the non-rotated one. Set different line types and 
pen color for the core contour and the veneer contour. Observe that it, too, becomes rotated. 
Select different values for the Cut Fills and Column Display field in Display Options and see how 
the 2D representation of the Column changes.
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Enhanced Document Output

Reviewer Enhancements
To allow clients to navigate among drawing sheets faster and more easily, while reviewing and 
redlining, the Project Reviewer web environment’s tool set has been enhanced. Reviewer now has 
mouse wheel support, so by scrolling with your mouse you can zoom in and out in the DWF file 
quickly. These work the same way as in ArchiCAD 8.
There is a new set of tools integrated, called the Surveyor Toolbar. It contains tools for length, area 
and angle measurements.

The first among these new tools is the Length measurement button. Select this button and simply 
start drawing consecutive Line segments. While you draw, a small Text box appears, showing two 
numbers. The first shows the length of the currently drawn segment, the second shows the total 
length of all segments drawn. Double-clicking will finish drawing segments. Another click will start a 
new segment, deleting the previously drawn segments.

The next button is the Rectangular Area Measurement button. Select it and draw a rectangle. While 
drawing and also when you finish drawing it, the small Text box will show the perimeter and area of 
the rectangle drawn. Clicking again will start a new rectangle, deleting the previously drawn one.
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The next button is the Polygonal Area Measurement button. It works the same way as the 
Rectangular Area Measurement button, with the difference that you can draw a polygonal area and 
it returns the perimeter and area of that.
The last one is the Angle Measurement button. Select it, then click three times to get an angle 
measurement. First, click the apex of the angle, then the end of one side of the angle, and finally 
the end of the other side of the angle. The text box will show the angle based on the constructed 
three points.

The Redlining Options part of Reviewer has also been enhanced. There is now a small Color 
Selection button to the right of the color selected.
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Instead of the basic 16 colors, you can now choose any color of your choice for redlining. Go into 
the Color Selection dialog box and use any of the three Tab Pages to pick the colors you wish to use 
for redlining.

It is now also possible to select any font installed on your operating system for the font of redlining 
text, instead of the 5 font types previously available.

Another enhancement is that the new and enhanced DWF format is incorporated in the new 
Reviewer version, thereby overcoming some line type presentation and printing problems 
encountered in previous versions.

Dimension Preferences Saved with Views
In ArchiCAD 9, dimension style and units are now saved along with each View. This way you can 
import to PlotMaker or publish views that have different dimension units; you do not have to reset 
them manually. You may have plans that have a certain dimension setting, and have views saved 
from Sections/Elevations whose dimension settings are different. When you go to the View Editor 
and select a saved View, you can see at the bottom of View Settings & Storing Options that 
Dimensions are also stored.
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As an example, two Views were saved from the same Project, one with Dimensions set to metric, 
the other set to US Architect. The two View were imported onto a PlotMaker Layout with the 
following result. As you can see, dimension styles are different.

Section Transparency Setting Saved with Views
When a Section/Elevation is saved with a View, transparency settings are also saved along with it. 
This is governed by the Transparency in shading drop-down list in the Effects field of the 3D 
Window Settings (Image menu). After you saved the Section/Elevation as a View and switched 
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Transparency in shading to OFF, when you display the Section/Elevation, it will still show it with the 
Transparency settings that were in effect when the View was created.

Fine-Tuned Connection between PlotMaker and 
ArchiCAD
The link between ArchiCAD Projects and PlotMaker layouts has been made smoother.
The Import dialog box now displays all settings of the selected View at the bottom of the dialog box 
(from top to bottom: layer combination, scale, display options, zoom information) to help the user 
identify Views more easily.

PlotMaker now takes into consideration the zoom factor stored in the View, so a drawing in 
PlotMaker will be displayed at the zoom level of the saved ArchiCAD View. It will also be cropped so 
that only the rectangular area of the ArchiCAD Floor Plan shown at the saved zoom factor will be 
displayed in PlotMaker. The result is that you see the same area of a drawing at the same zoom level 
as you would in ArchiCAD. This option can be enabled or disabled in Options > Preferences > 
Miscellaneous in PlotMaker.
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3D Views created with ArchiCAD’s Internal 3D Engine are imported as vectorized PlotMaker 
drawings (instead of the earlier bitmap picture format), resulting in improved image quality.
Buttons and fields in PlotMaker Navigator’s Drawing Usage mode dialog box have been slightly 
rearranged, with better icons and link information to make drawing updates simpler. Also, in 
Drawing Usage mode, drawings placed on the currently selected Layout have their names in bold 
type for easier identification.

In PlotMaker’s Publisher, a new button allows you to show the names, numbers or both of Layouts 
in the Layout Book to be published. This makes it easier to identify Layouts when Publishing large 
sets of documents.

Other improvements in PlotMaker: 
• Text blocks can have a fixed width, allowing AutoText entries to be multilined. 
• The backup functionality in PlotMaker ensures that the last saved version of the Layout Book is 

also retrievable in emergency cases.

PDF Output Enhancements
More and more architects are now archiving their drawing sheet in PDF format. Therefore, 
publishing view sets from ArchiCAD and PlotMaker in PDF has been greatly simplified and improved 
in ArchiCAD 9 to speed up the archiving process.
The PDF format was integrated into the Publisher’s Save method. PDF format appears as an option 
for file format of saved Layouts.
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Users no longer need to install a separate PDF driver in order to be able to Publish in PDF from 
ArchiCAD and PlotMaker.
In PlotMaker, the PDF Layout sizes are automatically inherited from the master pages, but can also 
be easily altered separately for each PDF if desired. To do this, select a PDF file and click the Page 
Options button. Clicking the Document Options button will let you resize the Layout to fit the Page 
Size defined in Page Options. 
If you select the folder containing the PDFs, a checkbox called Merge PDFs into a single file appears 
at the bottom of the Publisher Window. If you check this, all PDFs belonging to that folder will be 
saved into the same file. Each page within the resulting PDF have can have a different page size and 
orientation. In the example below, a Landscape A3 page and a Landscape A4 page were saved as 
PDF and merged into the same PDF file.
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Grid for Drawing Numbering in PlotMaker
A new panel has been added to the Master Layout Settings dialog box in PlotMaker. With this, 
PlotMaker enables you to import a set of Views onto a Layout, and automatically create drawing 
numbers for them in their title based on settings specified in this dialog box. To enable this option, 
check the This Master Layout should use a grid to assign Drawing Numbers checkbox at the top of 
the panel. When doing so, all options on the panel become enabled.

You have two numbering methods to choose from: Matrix (resulting Drawing Numbers will be in 
the form of A1, A2…, B1 … etc. or similar) or Flat (in the form of A, B, C… or 1, 2, 3…).
In the two text fields in the Number of Cells area, you can set the number of horizontal and vertical 
cells of the numbering grid.
In the Numbering Direction and Style area, you may set whether numbers of letters should be the 
members of the horizontal and vertical series. You can also set directions for the horizontal (left-to-
right or right-to-left) and the vertical (bottom-to-top or top-to-bottom) series. This area appears if 
Numbering Method is set to Matrix. Also in this case you can select Row/Column or Column/Row 
order in the Drawing Number format area.
In case Numbering Method is set to Flat, the Start Numbering From area appears, where you can 
select one of the four corners of the Layout (top left, top right, bottom left, bottom right) to start 
numbering from. You can also specify its style in the Style field. The Primary Direction area also 
appears, where you can choose either Horizontal or Vertical, as the primary direction numbering 
should start.
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In the Distance from Margin Style fields you can specify how much space should be kept between 
the margins of the Layout and the borders of the numbering grid on the left, right, top and bottom 
sides of the Master Layout.
You can specify a line type and a pen color for the Grid lines.
In the Grid line display area you can choose how the grid lines are shown on the Layout. You can 
show grid lines, hide them, or hide only those intersecting with a drawing. This can happen if an 
imported drawing occupies more than one cell of the numbering grid.
You can see how the numbering grid will look on your Layouts in the Preview area of the panel.
In the Drawings occupying multiple cells should use drawing number from cell at field you have 
four choices. If a drawing occupies multiple cells, only one cell number will be assigned; the other 
numbers that would be assigned to the multiple cells will be skipped. As can be seen below, 
numbers 2, 5, and 6 are skipped in numbering if cells 2, 3, 5 and 6 are occupied by one placed 
drawing. In this example, the drawing number is taken from the top right cell of the four cells; the 
other three cells are not numbered. The Preview will always show you the result you can expect.

When the Master Layout with drawing numbering is applied to a Layout, it will look similar to the 
Layout below. The grid numbers indicate what drawing numbers will be created once you import 
drawings.
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If a drawing is then automatically placed in the upper left cell, its drawing number will be 1. If you 
later move the drawing so it will be located in another cell (e.g. cell 3), the drawing number of the 
placed drawing will automatically be adjusted to 3.
This feature may be especially useful when publishing standard-sized details or large 
documentation sets.

Tutorial
• Publish some DWF files in ArchiCAD/PlotMaker and include the Project Reviewer Web 

Environment.
• Open the starting HTML page for the saved DWF files. Check the buttons available in Reviewer. 
• Click the Surveyor Toolbar button so the Surveyor buttons appear. Familiarize yourself with 

these tools by measuring some distances, rectangular and non-rectangular areas and angles as 
well.

• Click the Redline options button. Click the Color Settings button and set any color you wish.
• Click the Font drop-down list. See all the available font types (instead of the 5 previously 

available).
• In Options > Preferences > Dimensions, set linear dimensions to Metric. Save a view. Go back to 

Preferences and set linear dimensions to feet and inches. Save the same view under a different 
name. Import both Views into PlotMaker. Observe that the Dimension settings have been saved 
with the View. Also, observe that PlotMaker crops the placed drawing to the zoomed area of the 
imported view.

• Import ArchiCAD Views into PlotMaker. In the Import dialog box, select a View to be imported. 
Observe data displayed about it in the lower left corner of the dialog box for easier 
identification.

• In Drawing Usage, see which drawing names are displayed with bold type. These are the 
drawings placed on the currently selected Layout.

• In Publisher, check the Show Name/Number button. See how much easier it is to identify Views 
in Layouts.

• Create a set to be published. Select its folder and select PDF from the file type list below the list 
of sets. See how all files within that folder are set to PDF. While the folder is selected, mark the 
Merge PDFs into a single file checkbox at the bottom of the dialog box. Select different Layouts 
from the set and set different pages sizes and orientations for them (A4, A3, A0, Portrait, 
Landscape). Before doing so, notice how each PDF takes its size from its Master Layout. Select 
the folder containing the PDFs and publish the set. Watch the resulting PDF in Acrobat Reader. 
See how pages in the same PDF file have different sizes and orientations.

• Familiarize yourself with the drawing numbering grid feature of PlotMaker. Create a grid for a 
Master Layout. Change its Numbering Method, its Primary Direction, Numbering Style and 
direction as well as other options. After making a change, check the result in the Preview of the 
panel. Click OK. Import several detail drawing onto a Layout based on this Master Layout. 
Observe how the Drawing Numbers of these placed drawings are automatically created based 
on the grid. Move a placed drawing from one cell of he grid to another one and watch its 
drawing number be updated as it is placed into a new cell.
New Features in ARCHICAD 8-20 145



What Makes ArchiCAD 9 Polished?
DXF/DWG Enhancements
ArchiCAD 9 has a new DXF/DWG Add-On that is based on the DWGDirect third party DXF/DWG 
Translation code library. It can read all DXF/DWG files from R12 up to DXF/DWG 2004 formats. It can 
save data in DXF/DWG 2000 and 2004 formats.

Note: The AutoCAD 2005 file format is identical with AutoCAD 2004. We will refer to this format 
as AutoCAD 2004 in this documentation.

DWG 2004 Specialties
In AutoCAD 2004 it possible to create pen colors that are not specified by the pen index number, 
but an RGB (red, green, blue) value. In AutoCAD 2004, these new pen colors get a pen index of 256 
or higher. All AutoCAD pens with a pen index number of 256 or higher will have their pen index 
changed to 255 in ArchiCAD. A note reminds you of this in Attributes > Pens and Colors > Methods 
on the Settings in selected Translator panel of the Translation Setup dialog box.

There is another checkbox in this dialog box that comes into play when saving as AutoCAD 2004 
format. It is the Export ArchiCAD pencolor as RGB color (true color) if exact match not found 
checkbox. When an ArchiCAD view is set to be saved in AutoCAD 2004 format, and Searching for 
best color match is the choice for matching ArchiCAD and AutoCAD pens, and this checkbox is 
checked, then the program searches through the AutoCAD color table to find an exact match for the 
pen color. If it does not find one, it will save its RGB value and assign it a pen index number of 256 or 
higher in the AutoCAD drawing.
Another new feature of AutoCAD 2004 is that it is possible to protect drawings with a password.
When importing or opening such a file, you may find that you need to open a password-protected 
AutoCAD 2004 file. Currently, on the MacOS platform, it is not possible to open password-protected 
AutoCAD 2004 DXF/DWG files, because the operating system does not support the encryption 
method used by these password mechanisms. In such a case an alert will come up on your MacOS. 
On Windows, the operating system may be such that it does not support the password decoding 
routine. In this case, too, the system sends you an alert. If the system does support the decoding 
routine, the following dialog box comes up, and you may enter the password you received from the 
person sending you the file. If you entered the wrong password, it is possible to reenter it.
In case of XREF files, the program will require the password the first time the XREF is reloaded in 
ArchiCAD. If there are several XREF files being reloaded, only the password-protected file will not be 
reloaded if its password is not entered or incorrect.
A third specialty in AutoCAD 2004 is that it is possible to define gradient fills. Since there is no such 
an element type in ArchiCAD, these fill types will be imported into ArchiCAD as Solid Fills.
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New Options in Attach XREF Dialog Box
The Attach XREF dialog box has received several new options that take up the lower half of the 
Attach XREF dialog box.

In the Anchor Point portion you may define by which point of the XREF to place the drawing.
• Drawing’s own origin: the Global Origin (0;0 coordinate) of the attached XREF will be located at 

the coordinates specified by you on screen or in this dialog box.
• Drawing’s own anchor point: the attached XREF drawing’s own anchor point (if any) will be 

located at the coordinates specified.
• Bounding box node: ArchiCAD calculates the size of the bounding box of the attached XREF. You 

choose any of the 9 significant points of the bounding box, and that position of the XREF will be 
located at the coordinates specified fro placement.

From the Place on Story drop-down list, you may choose the story onto which the XREF should be 
placed. Before the actual placement, ArchiCAD will switch to that story.
The Translator field displays the currently selected DXF/DWG Translator to be used during the 
conversion of the attached AutoCAD drawing. You may select any of the currently available 
Translators from the drop-down list. Clicking the Settings… button will bring up the Translator 
dialog box where you can make modifications to the Translator Settings before attaching the XREF 
file.
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The Description field shows a short explanation and note about the currently selected Translator so 
you can decide if it fits your needs.
Clicking the Attach button will execute the attach operation; clicking Cancel will abort it.

Set Scale Factor for Importing Texts and Arrowheads
A new option in the Drawing Unit page of the Settings in Selected Translator panel of the Translator 
Setup can be used to set the scale factor for importing texts and arrowheads of the DXF-DWG file.

There are three possible choices:
• Set scale factor separately with each conversion
In this case, the following dialog box appears after clicking the Open button in the Open File dialog 
box:
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You may click the arrow before the text “Show Example…” to display an example of this type of 
scale factor conversion.

This scale factor has an effect on Texts and Arrowheads of the imported AutoCAD drawing. Click OK 
to accept the scale factor. 
• Use constant factor for all conversions
Set a scale factor for ArchiCAD to use for these conversions. In this case the Scale Factor dialog box 
will not come up.
• Always use the scale set in the currently active ArchiCAD window
The scale of the ArchiCAD Floor Plan will be taken for conversion. This is the same method used in 
ArchiCAD versions up to 8.1.

Note: the Scale Factor dialog box will also come up if an AutoCAD drawing is dragged and 
dropped onto the ArchiCAD Window background (drag-and-drop Open), and if an AutoCAD 
drawing is merged into the ArchiCAD Floor Plan, a Section/Elevation Window or a Detail 
Window (drag-and-drop merge)

In PlotMaker, this option is not available.

Composite Parts to Separate Layers
New custom layer fields have been created in Attributes\Layers\Methods of the Settings in 
Selected Translator panel of the Translator Setup. These custom layers make it possible to save fills 
belonging to the various fill categories onto separate layers in the resulting DXF-DWG file. 
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These are in effect along with the Windows and Doors fields already available when 
• you save from the Floor Plan, Section/Elevation Windows, Detail Windows or the 3D window 

and 
• the Create Layers according to option is set to ArchiCAD/PlotMaker Layers or ArchiCAD/

PlotMaker Layers combined with Pen->Layer Conversion. 
These fields allow you to assign Windows, Doors, Drafting Fills, Cover Fills and Cut Fills to separate 
layers, instead of remaining on the same layer as the construction element they belong to. 
If you enter a layer name into the “Windows” edit field, all the Windows will be part of that layer 
instead of the layer of the Wall containing those Windows. If you clear it, Windows will go to their 
default layers (the layers of the Walls containing them). The same rules apply to Doors. 
Drafting Fills will go to the layer specified in the “Drafting Fills” edit field.
Fills (if any) belonging to Slabs, Roofs, Meshes and Zones, and Fills having the “Cover Fill” category, 
will go to the layer specified in the “Cover Fills” edit field.
Fills showing cut surfaces or sections of construction elements and Fills having the “Cut Fill” 
category will go to the layer specified in the “Cut Fills” edit field.
Skin Separator Lines of cut composite structures, plus Lines having the “Skin Separator Line” 
category, will go to the layer specified in the “Skin Separator Lines” edit field.
Contours of cut construction elements and composite structures (they belong to the “Cut Line” 
category) and Lines having the “Drafting Line” category will remain on the layer they were on.
In case of a Column: if there is no veneer, the contour of the Column belongs to the “Cut Line” 
category. If there is a veneer, the contour of the Column belongs to the “Cut Line” category, and the 
lines between the core and the veneer belong to the “Skin Separator Line” category and will be 
saved accordingly.
In case of Fills: the contour of a Fill (if any) that belongs to the “Cut Fill” category will belong to the 
“Cut Line” category. Contours of other Fill categories will belong to the “Drafting Line” category.

Better Splines Compatibility
Functions used for importing splines have been enhanced in ArchiCAD 9. In most cases it will take 
less time to perform the conversion of these elements. You may still choose two methods for 
importing splines:
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• Import as ArchiCAD Splines. Most splines imported from AutoCAD can now be converted into 
ArchiCAD splines using new ArchiCAD conversion functions. ArchiCAD will approximate 
AutoCAD splines using a series of connected curves. In case of certain types and very 
complicated AutoCAD splines, the spline approximation function introduced in ArchiCAD 8.1 will 
be used to ensure the Splines look the same. This latter method uses less memory, but might be 
more time-consuming.

• Import as Polylines. ArchiCAD will approximate the AutoCAD Spline using a series of connected 
straight line segments (that is, a Polyline). This may be useful in some rare cases, when the 
converted ArchiCAD Spline still looks a bit different from its AutoCAD counterpart.

The default choice is that AutoCAD Splines are converted into ArchiCAD Splines. In the Translation 
Setup dialog box’s Settings in Selected Translator panel, the “Import AutoCAD Splines as” pop-up 
specifying this conversion method has been removed from the “Open Options” area. Instead, a new 
checkbox has been introduced in “Miscellaneous\Miscellaneous Options” of the Settings panel. 
Checking the “Convert Splines into Polylines” checkbox will convert Splines into Polylines in 
ArchiCAD.

Improved PaperSpace Control
New controls were introduced in the Save Options page of the Settings in Selected Translator panel 
of the Translator Setup. They give better control over how and into what Space of a DXF/DWG file 
the content of the Layout is saved. The first field is the Save Layout into drop-down list.

There are three possible choices here. They are available when saving/publishing in DXF/DWG 
format from PlotMaker.
• Paper Space with Cropped Drawings’ content

Drawing elements drawn on the Layout in PlotMaker will be saved into the Paper Space of the 
resulting AutoCAD drawing. The image of the Layout will be reconstructed in the Paper Space of 
the AutoCAD drawing. Drawings placed on the Layout will first be cropped by their placement 
polygon on the Layout (meaning only those elements and parts of elements inside the cropped 
area will be exported), and then saved in DXF/DWG format.
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• Model Space with Cropped Drawings’ content
Drawing elements drawn on the Layout in PlotMaker will be saved into the Model Space of the 
resulting AutoCAD drawing. The image of the Layout will be reconstructed in the Model Space of 
the AutoCAD drawing. Drawings placed on the Layout will first be cropped by their placement 
polygon on the Layout, and then saved in DXF/DWG format.

• Paper Space with Full Drawings’ content
Drawing elements drawn on the Layout in PlotMaker will be saved into the Paper Space of the 
resulting AutoCAD drawing. The image of the Layout will be reconstructed in the Paper Space of 
the AutoCAD drawing. Drawings placed on the Layout will be saved in their entirety in DXF/DWG 
format.

The other field that works in conjunction with the previous one is the Place PlotMaker Drawings 
into drop-down list.
It controls how drawings placed on a Layout will be saved in the resulting AutoCAD drawing(s).

There are two choices:
• Single DXF/DWG file

All drawings (either cropped or in Full – depending on the value of the Save Layout into field) 
are saved into a single DXF/DWG file. They are placed side by side in the file, so in either the 
Paper Space or the Model Space they will look like the Layout in PlotMaker.

• Linked XREF drawings
A DXF/DWF file will be saved. In this file there will be placement references to XREF files. All files 
will be saved in other separate DXF/DWG files and these files will be placed in the first DXF/DWG 
file as XREFs.

If the Save Layout into field is set to either Paper Space with Cropped Drawings’ content or Model 
Space with Cropped Drawings’ content, the only possible choice is Single DXF/DWG file. If the Save 
Layout into field is set to Linked XREF drawings, it will automatically switch to Single DXF/DWG file.

Drag-and-Drop Functionality while Importing 
AutoCAD Drawings
In ArchiCAD 9, enhancements have been made to the drag-and-drop functionality of the program 
so that a DXF/DWG file may be dropped onto ArchiCAD, thereby opening or merging the file. There 
are several ways to use Drag-and-Drop techniques while opening/merging AutoCAD drawings:
• If you Drag-and-drop a DXF/DWG file onto the background of the ArchiCAD application window, 

the ArchiCAD menu bar or the ArchiCAD icon, the file will be opened.
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• Drag-and-dropping a DXF/DWG file onto the ArchiCAD Floor Plan, Section/Elevation Window or 
Detail Window will Merge the file.

• Drag-and-dropping a DXF/DWG file onto the background of the PlotMaker application window, a 
PlotMaker Layout, the PlotMaker menu bar or the PlotMaker icon will result in placing the file in 
PlotMaker onto the currently shown Layout of the Layout Book.

Drag-and-drop can be done in two different ways:
• Normal method: left-clicking the AutoCAD drawing, dragging it over the desired location and 

dropping it
• Expert method: holding down the Ctrl button while drag-and-dropping the file, or drag-and-

dropping it with a right-click instead of a left-click of the mouse
In case several DXF/DWG files are drag-and-dropped, only one of them will be dropped. Since you 
cannot control which one will be dropped, it is recommended to drag-and-drop only one such file at 
a time.

Opening a DXF/DWG file with drag-and-drop
The first time a file is opened with the Normal drag-and-drop method, the Translator dialog box will 
come up for the user to choose a Translator to be used.
With the Normal method, the file will be opened using the last-used DXF/DWG Translator.
With the Expert method, the user can choose a Translator from the Translator dialog box, and the 
file is opened using the selected Translator.
In PlotMaker, drag-and-drop opening of DXF/DWG files works similarly.

Merging a DXF/DWG file with drag-and-drop
When a DXF/DWG file is dropped onto an ArchiCAD drawing Window (e.g. Floor Plan) with the 
Normal method, ArchiCAD will check to see if the file contains any SmartMerge data that can be 
merged into the current file.
If the program finds that the currently open ArchiCAD Project is not the file from which the DXF/
DWG file was saved (because its name is not the same as the ArchiCAD Project File stored as the 
source of SmartMerge data), the following alert window comes up:

The name of the Project file might have been modified. If this is the case, select Merge & Compare. 
To ignore the warning, select Merge anyway. Select Cancel if you are not sure whether it is the 
correct file to be merged into.
If the Merge & Compare button was selected, the DXF/DWG Merge dialog box will come up (both in 
case of the Normal method and the Expert method). Here you may select or modify the Smart 
Merge configuration file used, and select a Translator to be used or modify its settings. Click Merge 
when you are finished and want to proceed with the Merge operation, or click Cancel to abandon 
the process.
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In this case the DXF/DWG file will be placed at its original location in the file, so the Drawing 
Placement dialog box will not come up.
If you clicked the Merge Anyway button and are using the Normal drag-and-drop method, the DXF/
DWG Scale dialog box will come up. This is where you set the scaling factor for Texts and 
Arrowheads contained in the AutoCAD drawing. When you click OK, the DXF/DWG file will be 
merged and placed to its original location.

If you clicked the Merge Anyway button while using the Expert drag-and-drop method (Ctrl+left-
click, or right-click), the Drawing Placement Dialog Box opens, so you may specify exactly how the 
AutoCAD drawing is placed. You may specify an insertion point, scale and rotation (or you may 
specify these on the fly on screen). You may choose an anchor point for the drawing to be merged. 
Also, you may specify on which story of your ArchiCAD Project the drawing should be placed. If the 
story of placement is different from the current story, ArchiCAD will automatically switch to that 
story before executing the merge. This field is grayed when the drawing is merged into a Section/
Elevation or a Detail Window. There is a checkbox you may check if you want to import the whole 
drawing as a GDL Object. You may select a Translator or access the Translator Dialog Box to make 
modifications to its settings before merging.
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Click the Place button to merge the drawing, or click Cancel to abort the operation.
After this, the drawing is placed in the ArchiCAD Window, or you may need to use mouse clicks to 
show the program where to place it.
If the AutoCAD drawing does not contain SmartMerge data, neither the Smart Merge Warning nor 
the DXF/DWG Merge dialog box will come up. Only the DXF/DWG Scale dialog box (in case of 
Normal drag-and-drop method) or the Drawing Placement dialog box (in case of Expert drag-and-
drop) will come up before the drawing is merged.
In PlotMaker, drag-and-drop merge is not possible. Even if you try to merge a DXF/DWG file into a 
drawing opened in PlotMaker, the program will place the file onto the currently visible Layout.

Drag-and-Drop of DWG/DXF files from web pages to ArchiCAD (the i-Drop method – available on Windows 
only)
i-Drop is a technology by AutoCAD that is freely available. It allows users to download DWG/DXF 
objects from the web and drop them directly into their CAD software of choice. ArchiCAD now 
supports this functionality. The needed software (which is an Internet Explorer extension) may be 
downloaded from Autodesk. 
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Web pages usually contain a preview of how the object looks. When one goes over the object 
preview picture with the cursor, it changes into an “i-Drop Indicator” cursor form (see above 
illustration), which shows it is an object that may be drag-and-dropped into your CAD application.
To use such an object in ArchiCAD, press the left mouse button while your cursor is over the preview 
picture of the object. Drag it over the ArchiCAD Window (Floor Plan, Section/Elevation Window or 
Detail Window) and release the mouse button. ArchiCAD will download the object from the web. 
Meanwhile, an indicator may appear showing the progress of the download.

Each such object may consist of two files: the DWG/DXF file and a preview picture file. ArchiCAD 
will download both, if they are available. The preview picture may or may not be available, or it may 
not be the same image file that is shown on the web page as a preview. ArchiCAD saves the 
downloaded files into the folder defined in the Web Objects’ Folder field of the Web Options panel 
in Options > Work Environment > Work Environment Profiles > User Preference Schemes.

You may drag-and-drop using Normal mode (simply drag-and-drop the file over ArchiCAD) or Expert 
Mode (drag-and-drop of DXF/DWG file while pressing the right mouse button [or pressing left 
mouse button while holding down the Ctrl key]). In Normal mode, the DWG/DXF file is simply 
merged into the ArchiCAD Project file. The 3D content of the file is not imported, only its 2D 
appearance.
With Expert mode, the Drawing Placement dialog box comes up, where you may set the various 
fields related to the actual placement of the DWG/DXG file.
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If the “Import drawing as GDL object” checkbox is not checked, the 2D portion of the DWG/DXF file 
will be imported just as in the case of Normal mode. If it is checked, a Library Object is generated 
from the DWG/DXF file in the same folder where the file was saved by ArchiCAD after download. 
From the Drawing Placement dialog box, you may access the Translator dialog box, but you will not 
be able to modify settings related to the conversion of the DWG/DXF file into a Library Object. You 
need to set these settings (specifically the “3D data in created Library Parts” field under “Opening as 
Library Parts” of Open Options) before the drag-and-drop operation. The name of the resulting 
Library Part file will be the same as that of the DWG/DXF file.
In case of file names longer than 25 characters, the GSM file’s name will be truncated. In the Library 
Manager and the Object Settings dialog box, the newly downloaded object will be found under 
“Other Objects”.

Tutorial
• Familiarize yourself with the new options available in the Attach XREF dialog box. Select various 

Translators and go to the Translator Setup dialog box from this dialog box. Place XREFs using the 
different anchor point options and locations.

• Open several DXF/DWG files (in AutoCAD 2004 format if possible). Try various options for the 
Set Scale factor for importing texts and arrowheads field. Notice that the appearance of the Set 
Scale Factor dialog box depends on your choice in the Translator Setup. Set different scale values 
and see their effect on text and arrowhead sizes in the opened DXF/DWG file.

• Fill out the fields in the Create Custom Layers for area in the Translation Setup dialog box. 
Export a Floor Plan or Section/Elevation that has Fill and Lines of various categories and 
Composite structures in it. Read the saved DXF/DWG file back into ArchiCAD. See what new 
layers were created and what Fills/Lines went to which special layer. Before opening the saved 
DXF/DWG file, try to predict on what layers various Fills/Lines will be located.

• In PlotMaker, save Layouts that have several cropped drawings placed on them. Before saving, 
set the Save Layout into and Place PlotMaker Drawings into fields. Observe how the latter can 
be set depending on the value selected in the former. Save your Layout with different options in 
these fields and compare the results.

• Try the various Drag-and-drop opening/merging methods with DXF/DWG files. Drag-and-drop a 
DXF/DWG File onto the ArchiCAD Application background or its Title bar/toolbar. Try alternately 
holding and not holding down the Ctrl key while doing so. See how the Normal and Expert 
branches of DXF/DWG Drag-and-drop work. Then drag-and-drop a DXF/DWG file onto the 
ArchiCAD Floor Plan while holding/not holding down the Ctrl key. Notice that it makes a 
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difference which part of the ArchiCAD application window you drop the file onto. Try the various 
options encountered during the drag-and drop open/merge process. Try to use drag-and-drop 
to open/merge a DXF/DWG data that was saved from ArchiCAD and contains SmartMerge data. 
See how this modifies the drag-and-drop process.

• Go to the idrop folder and open the file idrop.htm in your Internet Explorer browser. Click on 
the text get i-drop now to download the iDrop browser enhancement program from Autodesk. 
You may have to restart your browser. Again open the idrop.htm file. The i-drop indicator cursor 
should appear when you go over the image on the html page. Press your mouse button and 
drag-and-drop it over and onto the ArchiCAD Floor Plan. The data will be downloaded and it will 
shortly appear in the Floor Plan. Try both the Normal and Expert drag-and-drop methods while 
using i-drop. Research additional web sites from which DXF/DWG drawing files may be 
downloaded to ArchiCAD with the i-drop method. Download these with the Import drawing as 
GDL Object checkbox checked. Check the resulting GDL Objects generated from those DXF/DWG 
files.
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Improved Installer Options
With ArchiCAD 9 it is now possible for CAD Managers to create office-standard installation 
packages. The installation will run automatically without any interference from the user. The CAD 
Manager can create User Profiles to be used office wide, complete with User Preference Settings, 
Keyboard Shortcut Schemes, customized menu structure, etc. He can set locations for special 
folders, such as Temporary and Cache Folders and Template Folders. He can create DXF-DWG 
Translators to be used office-wide. He can set office libraries to be loaded from shared network 
locations.
Using all the above options, he can create a custom ArchiCAD Install package for his office to use.
The following steps outline how this is done:

Install ArchiCAD 9 Using the “Typical” Installation 
Option

When installing ArchiCAD, the installer first checks if you have Java Runtime Environment on your 
computer. If not, it will be installed.

Then the installation program starts. You will need to specify a folder into which ArchiCAD 9 will be 
installed.
Then select Typical from among the installation options.
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ArchiCAD will show you information about installation. After you click the Install button, ArchiCAD 
will install the program.
After this, you will need to restart your computer for the hardware key to work correctly.

Create your Office Profiles
Go to Options > Work Environment and create all the various User Profiles that you wish your users 
to use with ArchiCAD 9. First, create all the various schemes. As part of this process, set default 
locations for Special folders in ArchiCAD 9. Temporary and Cache folders may be local, but you 
might want to specify a network folder for Template files from which all ArchiCAD 9 users can load 
templates.

After this, create Profiles from the schemes you created. In the example below, schemes called 
Office Standard have been created. Then a User Profile named Office Scheme is created.
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When this is done, Set as Default the Profile you want to be installed as default from among the 
available Profiles.

Specify Office Libraries
Go to the Library Manager and load all Libraries that you want to be loaded for users. These should 
be shared libraries used office-wide (they can be located on a file server).
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Create DXF-DWG Translators
In the DXF-DWG Translator Setup dialog box, create Translators that you want to be available as 
defaults. Save these Translators into shared network folders. See the location of the selected 
translator in the Location field.

Besides this, you can create Translators that will not be loaded from a network location, but from 
local folders. In the example below, the Translator named Custom Translator is located on the local 
machine, as indicated in the Location field.
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When all this is done, quit ArchiCAD so the program will write to the hard drive all information you 
just created.

Create your Profiles in PlotMaker
Create your Profiles in PlotMaker as well, including setting the location for folders as necessary.

Having done this, quit ArchiCAD for the program to be able to save these preferences changes to 
the hard drive.

Copy Installer to a Network Shared Folder
• From the ArchiCAD 9 installation CD that contains the ArchiCAD 9 Installer file, take the folder 

named ArchiCAD 9 and copy it into a shared network folder. This will be the folder from which 
all users will install ArchiCAD 9. Within this ArchiCAD 9 folder on the shared network folder, 
create a new folder named CompanyDefaults.

Copy Preferences Files to CompanyDefaults Folder
You need to copy several files/folders into this newly created CompanyDefaults folder. These are:
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• From the folder C:\Documents and Settings\<user>\Application Data\Graphisoft\ArchiCAD 9.0.0 
INT R1 (Windows) / System:Users:<user>:Library:Preferences:Graphisoft:AC 9.0.0 v1 INT 
(MacOS), copy the Default Libraries.xml file and the WorkEnvironment  folder into the 
CompanyDefaults\Defaults\ArchiCAD subfolder.

• From the folder C:\Documents and Settings\<user>\Application Data\Graphisoft\PlotMaker 
9.0.0 INT R1 (Windows) / System:Users:<user>:Library:Preferences:Graphisoft:PM 9.0.0 v1 INT 
(MacOS), copy the WorkEnvironment  folder into the CompanyDefaults\Defaults\PlotMaker 
subfolder.

• From the folder C:\Documents and Settings\<user>\Application Data\Graphisoft\ Dxf-Dwg 
Preferences AC 9.0 INT (Windows) / System:Users:<user>:Library:Preferences:Graphisoft:Dxf-
Dwg Preferences AC 9.0 INT (MacOS), copy the Translator List.xml file into the 
CompanyDefaults\Defaults folder.

• From the folder C:\Documents and Settings\<user>\Graphisoft\Translators (Windows) / 
System:Users:<user>:Library:Application Support:Graphisoft:Translators (MacOS), copy any 
Translator Xml files into the CompanyDefaults\Defaults\DXF folder.

When done, the folder structure should look like this:

ArchiCAD 9
archieve.exe
archive.jar
media.inf
setup.AC
setup.config
Setup.exe

JVM
CompanyDefaul
ts

Defaults
Translator 
List.xml

ArchiCAD
Default 
Libraries.xml

WorkEnvironment
ProfileSet.xml

Command 
Layouts
Palettes

Profiles
Shortcuts
164 New Features in ARCHICAD 8-20



What Makes ArchiCAD 9 Polished?
Install ArchiCAD 9 with Logged Installation
Run the Setup.exe program from another machine using the following parameters 
-W log.record=yes
So the complete command would look like this:
"\\Laci\AC9-Installer\ArchiCAD 9\Setup.exe" -W log.record=yes
If you do not have SPACE characters in your file path, the quotation marks are not necessary.

You may run the installation from the same machine as before. In this case you will have to uninstall 
ArchiCAD 9 after copying the defaults and before doing this step.

Install with “Advanced” Option
From the installation options, choose Advanced.
After this, the installation program will only show you the options that are read by it from the 
CompanyDefaults folder. You may select to install an option or not, but it is not possible to change 

Tools
User Preferences

PlotMaker
WorkEnvironment

ProfileSet.xml
Command 
Layouts

Palettes
Profiles
Shortcuts

Tools
User Preferences

DXF

Custom 
Translator.xml
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what is offered in the dialog boxes. These are the same options the user will see later when 
installing ArchiCAD 9. ArchiCAD will save the log file created during this installation into the folder 
containing the Setup.exe file.
With these steps, you will have a customized ArchiCAD 9 installation package. If users install 
ArchiCAD 9 using this setup program, they will end up with the working environment on their 
computer that has been specified by the CAD Manager. When a user starts the setup.exe program, 
the installation starts immediately, skipping the questions of the installation wizard, so that users 
have no opportunity to alter any option for the ArchiCAD 9 installation.
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What Makes ArchiCAD 9 Powerful?

Enhanced Performance in Key Areas
The performance of ArchiCAD has been enhanced in several areas for version 9.

Faster Application Speed
Part of the code of ArchiCAD has been re-worked, resulting in faster speed in the following 
operations:
• Changing Views within the same drawing (Zoom In/Zoom Out, Rebuild)
• Working with Projects containing large bitmaps
• Changing Views between different types of Project Items (Stories, Views)
• Selection/Input/Editing of elements
• Section Generation
• Open/Save
• Saving drawings from 3D view
• Undo

Rendering
Our new rendering engine, LightWorks, is built into the ArchiCAD PhotoRendering interface. It gives 
you the power to create high-quality photo-realistic images that can be published as ArchiCAD 
views. LightWorks offers ray tracing, soft shadows and reflection/refraction features and complex 
shader editing capabilities, yet its interface is compatible with ArchiCAD’s own elements. 
LightWorks is optimized for multi-processors, a feature with significant benefits for high-end 
computers. If you have a two-processor computer, you may render an image with the LightWorks 
engine in ArchiCAD while working in another application. LightWorks will use one of the processors, 
your other applications will use the other, and you will not notice any performance decrease just 
because your machine is rendering.

Section/Elevation Auto-Rebuild can be Turned Off
The Section/Elevation Settings dialog box has received a new drop-down list that controls the status 
of the Section or Elevation View. There are three possible choices here:
• Auto-rebuild Model:This is the way model elevations behaved in earlier versions. Whenever 

you open a Section/Elevation Window, it forces ArchiCAD to rebuild the whole model to keep 
the Section/Elevation View fully up-to-date with the latest changes.
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• Manual-rebuild Model:A new feature in ArchiCAD 9. Section/Elevation Views are not rebuilt 
automatically every time you view them. The are rebuilt only when you press the Rebuild menu 
item or the appropriate key combination. This way you may save much time (especially with 
larger Projects) not having to wait for the program to rebuild it even after a small change in the 
Floor Plan.

• Drawing:The given Section/Elevation is unlinked from the ArchiCAD model and there is no need 
to rebuild it.

Of course, any Section/Elevation may be switched from any of these settings to any other.

Prevent Autosave Interruptions
In the lower right portion of the Status bar, a small text appears when an Autosave operation is 
pending. The idea is not to disturb the user with Autosave operations (which may take several 
seconds) while he is working. So ArchiCAD checks whether your mouse is moving. If it does not 
move it will count back from 5 seconds while the Bulldozer icon flashes in the Status bar. If you 
move your mouse, click a button on it, zoom or pan, ArchiCAD will assume that you are working and 
so will restart the countdown from 5 seconds. It will do the Autosave as soon as you do not use your 
mouse for the 5 seconds that Autosave is pending. 

This operation also gives a feedback to the user so one can control when the program autosaves. If 
you feel it is time, simply stop working for five seconds and ArchiCAD will do the autosave.
In the Work Environment Profiles > User Preference Schemes page of Options > Work Environment, 
you can control Autosave functions. Clicking the Autosave Off button will disable Autosave 
altogether, so you will have to manually save your work to avoid its possible loss in case of a crash. If 
Autosave is On (the default setting) and the Suspend Autosave feature is also on, you can also set 
the User idle time value in seconds, if you wish the program to suspend Autosave for a different 
time period than the default 5 seconds. However, when you switch from ArchiCAD to another 
application, the Autosave operation is carried out immediately by the program.
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Tutorial
• Go to the Section/Elevation Settings dialog box and set it to Manual rebuild type. Go to the 

Section/Elevation Window and observe that it does not automatically rebuild. Press Rebuild to 
manually rebuild the Section/Elevation.

• While working on a Project, stop moving your mouse and check the Status bar for Autosave info. 
See how it waits for a specified time. Observe how it restarts counting idle time whenever you 
move the mouse. Check in User Preference Schemes the options you have in controlling the 
behavior of Autosave.
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Improved Text Formatting
In ArchiCAD 9, the Text tool has been improved significantly so that so-called rich-text elements can 
be created. This means that you can create multi-line texts with full-scale font options, multiple 
styles and alignment in any direction. Text blocks can be created in the Floor Plan, in Section/
Elevations and in Detail Drawing windows. You can format the content of text blocks as a whole 
(using Tool Settings or Info Box), and you can also individually format characters within the text 
block (using the Text Editor).

A Text may be started with a double-click while in the Text Tool, (which will result in a “non-
breaking” text block – there are no line breaks, the text block is of flexible width). Alternatively, it 
may be started by drawing a rubberband rectangle with the Text Tool, which results in a “breaking” 
text block (meaning the text block’s width is fixed, and entered Text will be wrapped to the width of 
the Text block.) An Editing Window will appear with a Formatting Palette above it. 

The Text block at the top of the screen capture is non-breaking, while the one being edited is a 
breaking text block.
In a “breaking” text block, you can see a right-side indent (marked with the red circle above) that 
shows the width of the text block. On the left side, you can see a first-line indent mark (at the top of 
the ruler) and the left-side indent mark (at the bottom of the ruler). While editing a text block, you 
may right-click the editing area and select the Indents and Tabs menu item to bring up the dialog 
box where you may edit these.
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Alternately, you may choose Indents & Tabs from the Edit menu. This menu item is enabled only 
while editing a text block; otherwise, it is grayed.

In the Indents and Tabs dialog box, you can numerically set the three indents and any number of 
Tab locations for your current text block. The settings will be valid only for the current text block. 
Depending on the unit set in Options > Preferences > Working Units, you may set values in 
centimeters (cm) or inches (in). After you are finished, click the OK button. The defined Indents and 
Tabs will appear on your ruler above the Text Editor field.

You can drag indents manually to their desired location in the ruler. While you drag an Indent, a Tool 
Tip will appear showing the current location of the Indent. You can drag in 0,25 cm or 1/8” 
increments.
You can also drag Tabs manually. You can create a new Tab by clicking on the ruler at its desired 
location; then you can drag it if necessary. Clicking on a Tab and dragging it off the ruler will delete 
it.
Text blocks may be edited by selecting them and clicking into them. Then you may type the desired 
text into the Text Editor. A flashing text cursor indicates your position in the text block. When 
creating non-breaking Text, the Text Editor’s width will extend indefinitely. If needed, a horizontal 
scroll bar will appear to indicate the width of your text block. With breaking text blocks, Text is 
continued in the next row, when the width of the text block is reached. Hitting Enter/Return will 
start a new line of the text block. Clicking Cancel in the Control Box or the Esc key on the keyboard 
will cancel the current changes made to the Text. Clicking the OK button in the Control Box, clicking 
on an empty space on the worksheet of the Text or pressing Ctrl-Enter will finish editing the Text 
and keep the changes made.
The style and formatting of a newly placed Text Block depend on the settings in the Text Settings 
dialog box and Info Box. If you want different styles or formatting for the particular characters or 
paragraph you are typing, use the Formatting Palette seen below.

The characters of a text block may be formatted individually. You may select a character, a number 
of consecutive characters, a line, a paragraph or the whole text block and apply one or more of the 
following formatting options (listed from left to right, and from top to bottom):
• Choose Favorite: The text style saved under the given name will be applied to the selected text.
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• Insert Symbol: The operating system’s Character Table will appear, from which you can select 
and copy special characters or symbols and copy them into the text block being edited.

• Align Left/Center/Right, Justify: aligns the whole line(s) of the selection according to the button 
chosen. Note that “line” means all characters between two line breaks. In breaking text blocks, a 
line may extend to more than one line, and all these lines will be aligned as a whole. With 
“Justify,” the selected Text is justified only if its line extends more than one rows in the Text 
Editor. Lines shorter than the width of one row are not justified.

• Leading: Defines the distance between the base line of the selected Text and the base line of the 
next line of text in terms of percentage. The Leading field may be set to any integer value greater 
than 50%. 100% equals Single Leading. Values lower than this place lines closer, larger values 
place them larger distances apart. You can either click the arrows to adjust the leading value in 
increments of 25%, or you can type an integer value
Note that on the Windows, the Text Editor will take Leading values of less than 100% but it 
cannot display them for correct visual feedback. However, they will be correctly displayed in 
ArchiCAD and will be printed/plotted correctly. When Leading is set to less than 100%, a small 
warning icon appear at the upper right corner of the Text Editor. If you move your cursor over it, 
a text warns you of this restriction.
Leading behavior is similar to that of the Align buttons and applies to whole lines. 

• Text Font: Applies the chosen Font to the selected Text
• Text Size: Specifies the size of the selected Text. Depending on the unit set in Options > 

Preferences > Working Units, it may be given in millimeters (mm) or points (pt).
• Bold/Italic/Underline: Applies bold, italic or underline formatting to the selected Text.
• Superscript/Subscript/Strikethrough: Creates a superscripted or subscripted text from the 

selected Text, or applies strikethrough formatting to it.
• Text Pen: Modifies the pen and color of the selected Text according to the specified Pen and its 

color.
While editing in the Text Editor, the Info Box is grayed. This is because settings changed in the Info 
Box (and the Settings dialog box) will apply to the Text element as a whole. 
Some new items in the Text Settings dialog box make this tool even more flexible to use.
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In ArchiCAD 9, fonts are now listed by Font Type and Code Pages in two separate lists (this is a 
Windows-only feature). This way the number of Fonts displayed in Font selection drop-down boxes 
of ArchiCAD (and PlotMaker) will decrease dramatically as different Code Pages of the same Font 
will not appear as separate entries as they did in versions up to ArchiCAD 8.1.

Among styles, Strikethrough appears as a new option to be applied to the whole text block.
Alignment now includes the “Justify” option besides the ones already available.

The Width factor and Spacing factor field offer better AutoCAD compatibility. Earlier versions of 
ArchiCAD could not correctly handle such expanded or shrunk texts created in AutoCAD, requiring 
the user to modify them in ArchiCAD. Until now, either the format of the Text was kept (WYSIWIG) 
but the text blocks were broken up, or text blocks remained intact but formatting went wrong. With 
these two new features, this issue is now solved.
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In the Width factor field, you may set a percentage by which Text blocks are stretched or 
compressed horizontally. It may be set between 75% and 1000%.
In the Spacing factor field you may set a percentage by which spaces between the characters in the 
Text block are stretched or compressed horizontally. It may be set between 75% and 1000%.
A new panel named Text Block Formatting was added to the Text Settings dialog box providing 
additional options for this tool.

Below the Text Block Angle field, there is a new checkbox called Fix Angle. It causes the Text Block to 
always have the same angle even if it is rotated or mirrored. 

In the above example, the Text block on the right at point B is rotated around point A and 3 copies 
are created. 
The Text Wrapping checkbox creates a right indent for the Text block when checked. With this 
checkbox, non-breaking Text blocks can be turned into breaking ones, and vice versa. When this 
checkbox is checked, a right indent mark on the ruler above the Text Editor will appear.
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When the Opaque checkbox is checked, a background Fill may be specified for the rectangle 
enclosing the text block. The Pen of this Fill may be set to 0 (Transparent) or –1 (Window 
Background) as well.
With the Frame checkbox checked, a frame with the specified color is drawn around the Text block.
Below it, a new field specifies the distance around the Text that separates it from its frame. It is 
given in either mm or Pt.

The display and displayed color of the Text block’s background fill is regulated by the Fill 
Background Color drop-down list that has been relocated into the Display Options Dialog Box. The 
following illustrations show how the Text background will look at different states of this setting.

Fill Background Color field set to ‘Drawing Background’

Fill Background Color field set to ‘Transparent’

Fill Background Color field set to ‘By Element Settings’
Note: When checking the Automatic Pen Color Visibility Adjustment checkbox is checked in 
Options > Preferences > Miscellaneous, certain colors are changed a bit by ArchiCAD so they are 
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better seen against the background. If a Text block has an opaque background color, this color 
will reflect in its color the adjustment made by ArchiCAD.

The Scalability radio buttons set whether the given Text block should stay the same size at all scales 
(Fixed) or change as the user switches between different scales in his Project. 

 
See above how at the scale of 1:50, the number displayed in this field changes. On the left, it is 
given in model size, on the right it is given in printed size.
Copying and pasting text information from external word processors into ArchiCAD/PlotMaker is 
now possible without loss of formatting, as illustrated in the example below. This is how it looked in 
Word,

This is what it became after drawing a text frame in ArchiCAD and pasting the text data into it 
(background color and frame distance was set for the text block earlier). It is best to first draw a Text 
block with the rubberband rectangle method so it will become a fixed width text block. Otherwise 
the text block might become very wide when pasting long paragraphs from word processors.

Tutorial
Do the below steps to familiarize yourself with the new possibilities of the Text Tool:
• Select the Text Tool and double-click on the Floor Plan. Start creating Text.
• Check the Indents and Tabs on the ruler. Create and modify Indents and Tabs. Delete some Tabs.
• Select some Text within the Text Editor and apply a Favorite to it, or change its Font type or size, 

change its Alignment, make it Bold, convert it into Subscript, change its Leading value.
• Go to its Settings dialog box and fix its angle. Rotate and Mirror it to see its effect. Set Text 

Wrapping on and edit the Text to see its effect.
• Set various Width factor and Spacing factor values and check their results.
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• Create a background and frame for the Text block. Set Scalability and change scales to see its 
effect. 

• Go to your word processor. Select a formatted text block several paragraphs long which includes 
multiple font types and formatting. Copy it to the Clipboard. Go to ArchiCAD. Start a fix-width 
text block by drawing a rubberband rectangle. Paste the data from the Clipboard into the Text 
Editor. See how formatting is preserved.
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Workspace Customization
In ArchiCAD 9, each registered user of the operating system is considered a different user having 
his/her own user profiles. The program handles users logged in under different user names exactly 
the same way the operating system does.
User-specific ArchiCAD settings are now grouped together in so-called Work Environment Profiles. 
These can be defined in Options > Work Environment. You can customize any of these settings while 
you work: just go to the Work Environment Dialog Box, change the settings you need, and click OK. 
The modified settings will immediately take effect.

The individual settings are divided among 5 different schemes. These are User Preference Schemes, 
Shortcut Schemes, Tool Schemes, Palette Schemes and Command layout Schemes. You can store 
any or of all of these Schemes by name. You can also combine these Schemes into a Profile and 
store the Profile under its own name. You can export and import Schemes and Profiles: this enables 
you to transport your favorite settings to other computers, or to keep them after installing a new 
ArchiCAD version.
CAD managers may create office standard Work Environment Profiles that are stored and read from 
a network server to reduce the risk of errors.
ArchiCAD 9 is shipped with several default Profiles. When you select one of them, the bottom 
portion of the dialog box shows you which Schemes are stored in the currently selected Profile. The 
default Profiles and Schemes are locked (as indicated by the Lock icon next to their names). The 
little checkmark by the Lock icon of the Standard Profile shows that Profile is the default.
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You can create a New Profile by clicking the New Profile button. Another dialog box will come up. 
Here you can give your Profile a name, plus select which of the available Schemes to apply for each 
of the 5 possible Schemes associated to the profile. Click OK to accept these settings.

The newly created Profile will not be locked and can be modified at any time. With the available 
buttons, you may Edit it or Delete it. By clicking the Export button, you can bring up the Export 
Profile dialog box. Here you can browse a Folder for the profile. You can also set a Folder name for 
the Profile. A new folder with the given name will be created in the browsed folder, which will 
contain the XML files that store your various Schemes belonging to the saved Profile.

Similarly, you can Import a Profile. Click the Import button. In the upcoming dialog box, specify the 
folder(s) in which Profile data are located. Profiles found in that folder will be listed so you can 
select the one you would like to import. Click the Import button to execute the command.
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Click the Set by default button to make the selected Profile the default Profile. Click the Apply 
Schemes of Profile button to switch to the Schemes define in the selected Profile. 

Changes will only take effect when you leave the Work Environment dialog box by clicking the OK 
button. When this happens, it takes a couple of seconds for ArchiCAD to reload the new Schemes, 
restructure its menus, toolbar, toolbox etc., if necessary. Then your new Profile is ready to use.

Within a Work Environment Profile, you have the various Schemes. The first is User Preference 
Schemes. As you will notice, there are still many Preferences in the Options > Preferences dialog 
boxes. These are Project-specific Preferences. They are saved with the Project you are currently 
working on. In contrast, preferences stored in a User Preference Scheme are stored separately, so 
they can be used as part of your work environment in any other Project.
Schemes are managed similarly to Profiles; you can store a new Scheme by clicking the Store as… 
button. A new dialog box comes up where you can specify a name for the new scheme. Clicking the 
Store button will store it. Storing a scheme means you store all the settings that belong to the 
Scheme.
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You can Rename or Delete any selected Schemes that are not locked.
When you make any changes in any of the settings belonging to this Scheme, a new Scheme called 
Custom will appear among Schemes. Also, the Redefine button becomes enabled when selecting a 
Scheme and the Scheme is different in any of its settings from the current state of the settings. 
Clicking the Redefine button will modify the selected Scheme.
You can also Export and Import the Scheme to and from any place on your hard drives or network 
you like.
Clicking the Apply Scheme button will modify settings belonging to this Scheme based on their 
values stored in the Scheme.
While you are making changes in any of the pages of the selected Scheme, the Apply Scheme 
button will appear in the upper right corner of the dialog box. Click it to bring up a list of stored 
Schemes available for that Scheme. By selecting an item from the list, settings from that Scheme 
will be applied to the current Scheme.
Scheme Options and the Apply Scheme button work similarly for all the Schemes.

There are some small changes and enhancements in Preferences belonging to User Preference 
Schemes. These are the following:
In Imaging and Calculation, there is a new checkbox controlling whether zoomed details are kept 
when rebuilding a Section/Elevation. (See more about this at Keep Section/Elevation Zoom in this 
document.) The other change is that the Calculate menu appearance drop-down list was taken out 
as it controlled the menu structure of the Calculate menu. This has become obsolete as now with 
Command Layout Schemes, you can control the layout, name, appearance and structure of any of 
your menus, including the Calculate menu. 
In Data Safety, a new checkbox and field controlling Autosave suspend and User Idle time appeared. 
Read more about these at Prevent Autosave Interruptions in this document. 
In Dialog Boxes & Palettes, the Pet Palette movement area received some enhancements. When 
you choose the Follow Cursor radio button, ArchiCAD allows you to have more control over the 
distance of the Pet Palette from the cursor. You can set two different sliders: the upper slider sets 
the palette’s initial distance from the cursor when it first appears on screen. The lower slider sets a 
minimum “following distance”: the palette will not follow the cursor until the cursor is at that 
predefined distance from the palette. (This is useful if you want to prevent the palette from 
covering up the very area that you want to edit.) Experiment with various settings to see which 
distance suits you best. Alternately, you can check the Use Pet Palette format of ArchiCAD 8.1 and 
earlier checkbox to make it work like in previous versions.
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With the introduction of Rich Text in ArchiCAD came the Text Formatting Palette. Two new radio 
buttons control the location of this Palette on the screen. Choosing Above Text Editor will always 
make it appear above the Text Editor Window. Choosing Jump to preferred position will preserve 
the position to which move the Palette on the screen; the Palette will jump to this position the next 
time you start editing a Text block.
In Web Options, a new setting was added. It is called Web Objects’ Folder. It specifies the folder 
into which GDL Library Parts downloaded from the Internet are placed. You can either accept the 
Default Location offered by ArchiCAD 9 or you can choose your own location for these files.

The Special Folders page contains settings that were previously displayed in the Temporary & 
Cache Folders page of Options > Preferences. It also has a new item for specifying the location of 
the Template Folder. You can either use the default location, or choose your own.

The next Scheme within the Work Environment is the Shortcuts Schemes. Here you can customize 
your keyboard shortcuts for any menu item, toolbox tool, action or Add-On command available in 
ArchiCAD 9. The dialog box has been restructured for better organization. In the main list, you can 
see all the available commands, actions, menu items etc. Immediately below it is a small Text field, 
explaining what the currently selected item is for.
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Above the list, there is another drop-down list controlling how the available commands are 
displayed in the list below it. You can list commands based on the Current menu structure, or you 
can list All commands by theme or All commands in alphabetical order.

To the right, in the first field you type the shortcut you wish to assign to the currently selected 
command. Below it is the field showing whether your desired shortcut is currently assigned to any 
other command. The third field shows which shortcuts, if any, are currently assigned to the selected 
command. You may select any shortcut in this list and detach it from the currently selected shortcut 
by pressing the Detach selected shortcut button.
The Window Types area controls where the currently selected shortcut will function. They may 
function either in a Text Window or a Non-Text Window (depending on what kind of Window you 
were in when you opened the Work Environment dialog box), or both.
At the bottom is the Show Shortcut List in Browser button. When you click it, ArchiCAD 9 creates an 
XML file listing all currently set shortcut keys, starts a web browser and displays the XML file in it. 
This way you can have an electronic or printed reference of keyboard shortcuts you can consult.
The XML list also contains non-customizable shortcuts for your
reference.
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Next are Tool Schemes. Here you can customize your Personal Toolbox, Tool Settings Dialog Boxes 
and the Info Box.
In the Toolbox page, you can create and customize you own Personal Toolbox.

On the left, all Tools are listed. On the right, you can see the created Toolbox groups. Each Toolbox 
group has a name plus two icons besides their name. The first indicates whether the group is always 
open or not.

 Icon showing pin facing down means group is always open
 Icon showing pin facing down means group is not always open

The other icon shows whether Tools belonging to the group will have their icon, or their icon and 
text shown in the Personal Toolbox.

 The arrow icon means only the Tools’ icons are shown. 
 The icons showing and arrow and text shown both their icon and text will be displayed in the 

Personal Toolbox.
Clicking the Tool Group Options button brings up a list of commands related to Tool groups.

Click the Create new group… button to create a new Tool group. Enter the name for the new group 
and click OK.

Click the Rename button to rename the currently selected Tool group, or click the Delete button to 
delete it. Check or uncheck the Always keep group open item to toggle whether the currently 
selected group should always be open showing the Tools belonging to it, or not. Click either the 
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Show icon and tool name or the Show icon only buttons to control how Tool in the current group 
should appear.
The list below this show what Tools currently belong to the selected group. Click on any Tool in the 
list on the left and click the Add selected button to add it to the currently selected group. Tools can 
belong to more than one group at the same time. Select a Tool in the lower list on the right and click 
on the Remove button to remove the selected Tool from its group.
The Tool Settings Dialog Boxes page works similarly as in previous versions, but the interface has 
been modified a bit. 

Click on any Tool on the left of the panel. In the list on the right, all Settings Dialog panels available 
for the selected Tool appear. You can move any of them, and make them visible/invisible as in 
previous versions. There is a new button called Panel Preview… Clicking it will show you a preview 
of how the currently selected panel of the currently selected Tool looks like. Here is what is shown 
when you want to preview the Preview and Positioning panel of the Object Tool.

In Info Box, you can do the same customizations for the Info Box. It works the same way as in 
ArchiCAD 8.1, with the interface modified a bit. Here you can also move and make visible/invisible 
any panel of the Info Box if the currently selected Tool, and see a preview of the currently selected 
panel, just like with Tool Settings.
The next in Schemes is Palette Schemes. Here there are no settings to change. This Scheme will 
store the positions, sizes, shapes and show/hide status of all floating and docked palettes. It will 
store the state all these palettes are in at the moment of saving them as a Scheme. Note that the 
state of the Toolbars is not stored in this Scheme, but the next one, Command Layout Schemes.
The Command Layout Schemes enables you to create, build, edit or customize toolbars and menus.
New Features in ARCHICAD 8-20 185



What Makes ArchiCAD 9 Powerful?
The first item is the Toolbars page. It has two panels called the Customize Toolbar panel and the 
Further Options panel.

On the left side of the first panel, just as with Keyboard shortcuts, you can list available commands 
in various formats. Here you have the same three list formats as in Shortcuts, plus a fourth one, All 
menus in alphabetical order.

Below the list of available commands, a text field explains the action of the command currently 
selected in the list. 
On the right side, the top list shows all toolbars that are currently available in the current Scheme. 
Select any of them to view, in the list below, which commands belong to that toolbar.

Below this list is the Toolbar Options button: 
• Click New toolbar to create a new toolbar
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• Click Rename toolbar to have a new dialog come up where you can give a new name to your 
selected toolbar

• Click Delete toolbar to delete the selected toolbar,
• Click Duplicate toolbar to create a new toolbar with the name you specify in the upcoming 

dialog box. This toolbar will have the same commands as the duplicated toolbar.

The last four items in Toolbar Options control how commands appear in the currently selected 
toolbar. You can Show Icon only, Show name only, or both by choosing Show Icon and Name. 
Choosing Show Icon and Name selectively will display the name of the command if the Show 
command name in case of “Selective” option checkbox is checked in the Further Options panel.

In the field listing the commands belonging to the currently selected toolbar, some items may have 
a small icon at the right, as in the illustration below. 

This shows that the item is a submenu or a pop-up list. You can enter this list by double-clicking it. 
When you are at such a lower level in the structure of the toolbar, the “move up in hierarchy” 
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button becomes enabled. Clicking it will take you one level higher, back to the state shown in the 
previous image.

When you are at a lower level of the hierarchy, you can see that available submenus and menus are 
listed, instead of toolbars.

At this stage, you will have a Menu Options button below the drop-down list. You have New menu, 
Rename menu, Delete menu and Duplicate menu as your options for menus. They work similarly 
to those of Toolbar options. 

When a pop-up list or submenu is part of the commands of a toolbar, the Sticky pop-up menu 
checkbox will become enabled in the Further options panel. 

If you check this checkbox, the pop-up list will stick to the command just before it on the list of 
commands. If you do not, it will be listed as itself and the pop-up will come from it. On the below 
illustration, the Stories’ List item is shown with the Sticky pop-up menu checkbox checked (left) 
and unchecked (right). See the difference.

 
In the Menus page, you can customize your menus in ArchiCAD 9. The left side of the panel is 
practically the same as in the Toolbars page with the same functionality. On the right side, you have 
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menus instead of toolbars, with similar fields; at the top the list of menus in the current Scheme. 
You can select any of them and the items of that menu will appear in the list below it. The Menu 
Options button gives access to the same commands as with menus that are parts of toolbar 
hierarchies. You can create New, Rename, Delete and Duplicate menus. You can move up and down 
the menu hierarchy the same way as with toolbars.
When a menu item is selected, the Alternating menu items checkbox is available in the Further 
options panel. If you check this checkbox, the menu item will be linked to the menu item 
immediately preceding it in the menu structure. If you correctly select keyboard shortcuts for this 
item and the one preceding it, then it will be possible in the menu to alternately show these 
commands depending on what key modifier you press.

The keyboard shortcut of the menu item must be the same as that of its preceding menu item, but 
have an additional modifier in it. For example, the New command in the File menu has the default 
shortcut Ctrl-N. The New & Reset All command that follows it has the shortcut Ctrl-Alt-N. Since 
Ctrl-Alt-N is the same as Ctrl-N with an additional modifier (Alt), the New & Reset All command will 
not appear on the menu as itself but will become an alternate menu item for the New menu item. 

If you move you cursor over File > New and press the Alt key, you will see that the New menu item 
changes to New & Reset All. In the image above, you can also see that the New & Reset All menu 
item is shown indented below the New item. This is another indication of these two menu items 
having this relationship.

It is possible to set up to four level of this alternation. For example, you may have the 3D Modes: 
Block, Wireframe, Hidden Line and Shading. In the menu structure they follow each other. For the 
latter 3, check the Alternating menu items checkbox. Change their keyboard shortcuts to Ctrl-F9. 
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Ctrl-Shift-F9 and Ctrl-Shift-Alt-F9, consecutively. They will be displayed indented in the Work 
Environment dialog box in the Menu list.

The result will be that the latter three will not appear on the menu.

But by pressing Ctrl, you will see the following,

pressing Ctrl-Shift (in this order), you will see the following,

and pressing Ctrl-Shift-Alt (in this order), you will see the following.

Please note that each of them is based on the one immediately preceding it. So pressing Ctrl-Alt-
Shift-F9 or Shift-Ctrl-F9 will not bring the desired result. The order in which modifiers are pressed 
counts.
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Tutorial
Go to Options > Work Environment. Create a new Profile based on one of the existing Profiles. Try to 
edit it, change it, export it, delete it and import it. See how a Profile is the composite of 5 different 
Schemes.
Select a Profile and apply its Schemes. OK the dialog. See the changes it brought about in your 
menus, toolbar, Palette shapes and location, keyboard shortcuts, etc.
Go to User Preference Schemes. Familiarize yourself with the options with which you can Rename, 
Redefine, Delete, Export and Import this or any other Scheme. Familiarize yourself with all new 
options in the various pages of User Preference Schemes.
Go to Shortcut Schemes and familiarize yourself with the new option in Keyboards Shortcuts. Try 
the different listing options available for the commands. Create, modify, and detach some 
shortcuts. Save your changes to the Scheme.
Go to Tool Schemes. Create new groups for the Personal Toolbox or modify existing groups. Add 
Tools to different groups of the Personal Toolbox or delete Tools from some of them. Go to Tool 
Settings Dialog Boxes. Rearrange the panel for some Tools, hide some panels and see the results. Do 
the same in the Info Box page.
Make modifications to existing toolbars. Create new ones. Delete some, rename or duplicate one of 
them. Check the Further Options page for available options. Experiment with the Show command 
name in case of “Selective” option and Sticky pop-up menu checkboxes and see their results in 
toolbars. Check how ArchiCAD default toolbars are structured.
Make modifications to existing menus. Create new ones. Delete some, rename or duplicate them. 
Experiment with the Sticky pop-up menu and Alternating menu items checkboxes. Check how it is 
done in default ArchiCAD menus. By setting the correct keyboard shortcuts and checking the 
Alternating menu items checkbox, create such menu structures on your own.
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New Rendering Engine
LightWorks introduces ray tracing to ArchiCAD. Ray tracing works by casting rays from the point 
being shaded toward each light source, thus establishing whether there is a direct line of sight from 
the point of the light source. This way it is possible to determine whether a surface point is lit or in 
shadow from a light source.
The simplest way to start working with LightWorks is to open an ArchiCAD Project and switch to the 
LightWorks Rendering Engine in Image > Rendering Engines. The LightWorks Engine will understand 
ArchiCAD materials and convert their Transparency, Emission, Reflection and Glowing values to its 
own format. The following picture was taken in ArchiCAD 8.1.

The same Project opened in ArchiCAD 9 and rendered with the LightWorks Rendering Engine will 
look like the image below. Thanks to ray tracing, you can see reflective glass surfaces and nicer 
shadows in this rendering.

There is one point of caution in simply taking materials defined in older Projects. Although 
ArchiCAD materials all have Reflection values defined for them, rendering engines in previous 
version did not use these values. Since the LightWorks Rendering Engine understands and uses 
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these values, this might lead to unexpected results if these values are not adjusted. So you might 
have a material named Concrete that is very shiny with a lot of diffuse light around it. This can come 
from those Ambient, Diffuse and Shininess values. It such a case, adjust these values until they give 
a satisfactory result.
Another thing to consider is the fact that an ArchiCAD material now can have a texture assigned to 
it as well as a LightWorks shader (another texture in effect). The ArchiCAD texture will be displayed 
in the 3D Window when OpenGL is selected for 3D Engine and in PhotoRendering when it is created 
with the Internal Engine or the Z-Buffer Engine. But if you use OpenGL in the 3D Window and 
LightWorks Rendering Engine in PhotoRendering, the textures might look completely different, 
which can be misleading. There are two solutions to this if you plan to create your PhotoRenderings 
with LightWorks. The first is not to use the OpenGL engine in 3D so it will not mislead you as to how 
it will look in PhotoRendering. The second is to remove ArchiCAD textures from those materials to 
which LightWorks shaders are assigned. Then these materials will not display any texture in 3D, 
even with the OpenGL engine, and no misunderstanding occurs.
When working with LightWorks, the usual procedure after building the 3D model is to define 
materials, then load and modify shaders connected with these materials using the LightWorks 
Shader Settings panel in the Material Settings dialog box (Options > Attribute Settings > Materials).

The Create Preview with drop-down includes a new item called LightWorks Rendering Engine. If 
you select this, the preview at the upper left of the dialog box will be generated by this engine. 
Checking the Disable unrelated controls checkbox will make invisible all panels of the dialog box 
that are not related to the currently selected Rendering Engine. If you check it while LightWorks 
Rendering Engine is selected, all 3 other panels of the dialog box will disappear, as these all contain 
data related to materials defined for the Internal Engine and other engines.
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The Load Settings from Archives button leads you to another dialog box where you can load 
shaders. These archive files store hundreds of predefined shaders.

Most of the time you can find the shader you like among the predefined ones. From the pop-up list, 
select the Shader archive you want to browse: this gives you a folder structure with a list of shaders. 
Select the shader you wish to use and click OK. In the example below, the shader named Polished 
Gold was loaded from the shader archives.
LightWorks shaders can have textures, like the textures used with the Internal Rendering Engine. 
Another feature is so-called “procedural” shaders in which patterns are defined by a set of 
parameters. Image-based shaders can easily exhibit tiling when patterns are repeated across a 
surface, can lose definition when viewed close up, and can use up large amounts of memory. 
LightWorks procedural shaders, in contrast, do not exhibit tiling, give a unique appearance at each 
point of the surface, are more memory efficient, and offer more flexibility because of their 
adjustable parameters.
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The Class buttons will take their values from those of the loaded shader, and the preview is 
updated. By clicking on any of the Class buttons, you can start modifying the various parameters 
belonging to that group of parameters of the shader. The Colour button gives you access to shaders 
defining the color of the Material. You can choose from among dozens of shaders if you wish to 
modify it. There are simpler shaders (like Plain) that have few parameters and others having many 
parameters. The Plain Color shader has one parameter defining the color of the shader applied to 
the Material. The Set Parameters field lists all parameters belonging to the currently selected 
shader. Checking the Show Essential Only checkbox will list only those parameters that are 
necessary for the correct definition of the shader. When it is unchecked, you have access and are 
free to modify any parameter of the shader.
If we select Granite from the list of color shaders, more than a dozen parameters will be available 
for it. Clicking any of them will have a field appearing below the list. Click it to adjust the currently 
selected parameter (e.g. Mineral 1 Colour). You can adjust the color of this parameter to any other 
color of your choice.
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In case of the granite shader, checking Show Essential Only will leave only the four color 
parameters displayed.
The Reflectance button lets you choose shaders that will help you define or modify shaders that 
specify how the surface of the Material reflects light. Click the Reflectance button: its shaders in the 
list next to it will become available for viewing or editing. The method is the same for each button: 
select the button, select the shader from the list next to it, then modify its parameters, which 
appear on the right side of the dialog box panel.
The Transparency button gives you access to shaders that define how much and in what pattern the 
Material will let light go through its surface.

The Displacement button contains shaders that can help define a bumped appearance for the 
surface of the Material. See how the Rough shader modifies the appearance of our gold ball in the 
Preview.
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The Texture Space button lets you access shaders that define a 2D rectangular area having a certain 
unit size and repeating itself in a tiled fashion over the surface. When you are using certain shaders 
(most wrapped shaders), all the effects of those shaders on the surface will be applied taking 
settings in the Texture Space area into consideration. With these shaders you can scale, rotate, 
mirror and offset the 2D texture space.
In the example below, we have a Wrapped Brick Bonds shader used for Color. Here is how it looks:

If we set S Scale to 0,5 in the St Layout shader within the Texture Space shader group, the texture 
will shrink to half its previous size in the horizontal direction.
As you can see in the image below, the vertical mortar gaps between individual brick members have 
also been reduced by half, showing the scaling. S in Texture space is the coordinate parallel to the X 
axis, T is the coordinate parallel to the Y axis. By default they start from the upper left corner of a 
surface with the S axis running to the right and the T axis running downward.
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Now if we set the Rotation value to -20, the Texture space will be rotated accordingly (positive value 
means it is rotated 
counter-clockwise):

These transformations are applied to the Texture Space in the following order: first, they are 
mirrored in the S direction, then mirrored in the T direction, then scaled and rotated, and the result 
is offset from its origin, if applicable.
The Pipeline button gives access to shaders defining light emission.
Whatever modification you have made to an ArchiCAD material with the LightWorks Engine 
controls, you can always get back its original settings by clicking the Match with Internal Engine 
button.

Note: All shaders are described in detail in help files located in the Library 
Examples\Documentation\LightWorksIntegration folder of your ArchiCAD 9 folder.

When you have set all materials to your liking, you should set the LightWorks Rendering Engine 
parameters in the PhotoRendering Settings dialog box. The dialog box has two panels specifically 
related to the LightWorks Rendering Engine.

In the LightWorks Effects panel, you can set rendering effects used by the Engine. In the Method 
and Antialiasing fields, you have options that serve the same purpose as with the Internal 
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Rendering Engine. The Transparency and Smooth surface checkboxes have the same effect as with 
the Internal Rendering Engine. Checking the Reflection checkbox will enable ray tracing so light will 
be reflected from surfaces; the Rendering will display this result.
In the Light sources field, you have four possible sources of light the LightWorks Engine can take 
into consideration. These are Sun (as defined in the Sun Settings dialog box), Ambient (light coming 
from or existing in the environment), Camera (light coming from the Camera position going toward 
the target point of the Camera) and Lamps (light coming from lamps and special Lamp objects – 
such as the SkyObject, SunObject or the WindowLight lamp objects). For the first three, you can 
set a percentage of how much of the light’s strength should be taken into consideration when 
calculating their effects on surfaces.
These light sources behave differently. Sun is a distant light source that emits parallel light from the 
source in a certain direction in space (defined by Sun Altitude and Sun Azimuth) as if it were very far 
from the model. Ambient light has no location in space, but produces a uniform illumination across 
the whole model. Without an ambient light source, all areas that are in shadow from the main light 
sources would be black. Too much ambient light can produce flat images. Ambient light does not 
cast shadows. Camera as a light source has the characteristic of emitting light from the eye point to 
the target point of the currently active camera. Light from a camera does not cast shadows.
The Shadow casting field controls how shadows are cast in the LightWorks Engine renderings. 
Choosing Off will result in no shadows, while selecting Hard will result in hard shadows. Hard 
shadows have a sudden, clearly defined border between surfaces in shadow and lit surfaces. With 
soft shadows, the edges of these borders are much softer and the transition between lit and unlit 
surfaces is much smoother. Selecting By lamp settings will follow the settings chosen in placed lamp 
objects.
In the Shadow Resolution field, you can either check the By lamp settings checkbox to have the 
smoothness of tones of shadows defined by lamp object, or leave it unchecked and globally define 
this resolution with the slider in the Override field. The higher the resolution, the smoother the 
transitions between shades of a soft shadow. Of course, setting higher values in many of these fields 
will result in longer Rendering generation times.
The other panel of this dialog box is the LightWorks Environment panel. Here you can define 
characteristics of the Sun including its Shadow Type (Soft or Hard), Colour Temperature and other 
parameters.
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You can also apply Foreground and Background shaders. For example, the Fog Light Foreground 
shader will create a light foggy effect in the foreground of the rendered picture. The Background 
button gives access to similar shader effects that are applied to the background of the model in the 
LightWorks rendering. If the Render Background with Internal Engine checkbox is checked, the 
Background button is disabled and the Internal Rendering Engine will create the background of the 
rendering.
The Background and Brightness panels of the dialog box work the same way for the LightWorks 
Rendering Engine as with the Internal Rendering Engine.
The following examples show different Light sources set in the LightWorks Effect panel.
First, there is only 100% Sun light.

Then 100% Ambient light is added to it.
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Then 100% Camera light is added to the previous two light sources.
As you can see, there are no shadows seen from the Ambient and Camera light sources, but the 
image is sufficiently light to simulate a daylight situation.

Then Camera light is decreased to 70%.

And finally Sun light is turned off. There are no shadows, as no shadow-casting light source is 
present.
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Some Library Parts were specifically created to work in conjunction with the LightWorks Rendering 
Engine. They can be found in the LightWorks Lights 9 folder of the Object Library.
The first one is the SkyObject lamp object. It is used to simulate the diffuse light effect of the sky. It 
consists of distant lights distributed in a hemispheric array. It can be set with its parameters in the 
Parameters panel of the Lamp Settigns dialog box.

As with all lights, you can turn it ON or OFF, set its Light Intensity and Color.
The Latitude Resolution and Longitude Resolution parameters, along with Light Intensity, will 
define how many lights will be distributed evenly on the surface of a hemisphere. This object is 
basically a hemisphere with a radius large enough so it is larger than the whole 3D Model. 

The Number of Light Sources field shows how many lights will be generated based on the above 
values. There are parameters for turning Shadow casting and Soft Shadow on. You can also set 
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Shadow Quality and a Contour Pen for display in 2D. These shadow-related parameters will have an 
affect only on shadows created by the light sources coming from this lamp object. To use this object, 
just place one copy anywhere in your Project.

Note that LightWorks rendering doesn't give a proper image quality if the 3D data structure is 
generated from a selection (e.g. with the Arrow Tool or with the Marquee Tool) and if this 
selection does not contain the SkyObject lamp object. 

In the following picture you can see Soft Shadows. See how fine the transition of the shadow is on 
the floor of the corridor.

Another lamp used to simulate exterior light is the SunObject lamp. It can be placed anywhere on 
the Floor Plan, like the SkyObject lamp. This lamp is used to simulate the effect of the Sun on 
rendering. In the case of this lamp, the light is coming from a distant source.
Its use is also very similar to the SkyObject lamp. You can set light intensity, the color of its light, 
shadow quality and make it cast Soft Shadows as well. Unlike in the SkyObject lamp, where the 
program automatically calculates the number of light sources from the longitude and latitude 
resolutions you entered, here you can directly specify the Number of Light Sources. Otherwise, this 
lamp works very similarly to the SkyObject lamp.
As you can see, with LightWorks, you can simulate the effects of the Sun in two ways: 1) by checking 
the Sun checkbox as a light source in the LightWorks Effects panel of the PhotoRendering Settings 
dialog box, or 2) by placing a SunObject lamp anywhere on the Floor Plan. These two methods have 
different effects. The major difference is that the light intensity of the SunObject lamp can be varied 
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in a much larger range. Although both can be used at the same time, it is advisable to use only one 
of them at a time so it is easier to identify its effect on the rendering.

While the SkyObject and SunObject lamps are used to simulate exterior light, the WindowLight 
lamp object is good for simulating diffuse light in interior rooms that are generated by incoming 
light. This type of lamp must be placed on the inner side of any Window or Door. You can do this in 
2D or 3D. The width and height of the WindowLight lamp object should be the same as those of the 
Door/Window it is linked to. The object will be shown both on the Floor Plan and in 3D.

The object has parameters that are similar to those of the SkyObject lamp object. The Light 
Intensity parameters along with the Light Resolution parameter will define how many individual 
light sources are generated to simulate diffuse light coming through the Door/Window.
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You also have the Cast Shadow, Shadow is Soft and Shadow Quality parameters to control how 
shadows created by this light source are generated. The Rotation Angle parameter is used when the 
object is placed next to a Skylight object in a Roof. See the effect of the Shadow Quality parameter 
below. In the image on the left, Shadow Quality = 1. See the crude graduation of shadows on the 
wall on the left and on the ceiling. In the image on the right, Shadow Quality = 3. See how much 
smoother shadow shades are on the wall and ceiling.

 
In the following picture you can see effects created by the SunObject and WindowLight lamp 
objects. See the light areas on the ceiling of the corridor and the room close to the outside 
Windows, which is caused by the light generated by these lamp objects.
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Tutorial
Go to the Material Settings dialog box and switch to the LightWorks Rendering Engine. Check the 
Disable unrelated controls checkbox. See how panels disappear from the dialog box
Familiarize yourself with the various shader settings. Load shaders from archives. See how values of 
the Shader Classes change after a new shader is loaded from an archive
While working with shaders, uncheck the Show Essential Only checkbox to see all parameters 
related to the given shader. Try different Colour, Reflectance and Transparency shaders and see the 
Preview for their result
Click the Match with Internal Engine button after modifying a material and see how it changes back 
to its default defined by ArchiCAD.
Go to the 3D Window using OpenGL. Then create a rendering with LightWorks Rendering Engine. 
See the difference in textures of the two results.
Go to the PhotoRendering Settings dialog box and select LightWorks Rendering Engine. Select a 
small area with the thick Marquee in the demo file. Render several images using different light 
sources and different percentages for the light sources. See how they affect the result. Set different 
values for Shadow Casting as well. Change only one thing at a time and compare it to the rendering 
created just before it so you see the difference that change makes in the final result. Set different 
settings for Shadow Resolution as well.
In the LightWorks Environment panel, select the Sun button. Uncheck the Show Essential Only 
checkbox and change some of the Sun parameters, like Shadow, Shadow Quality, Shadow Type, 
Colour Temperature etc. See in rendering the difference they can make in the lighting effect of the 
Sun.
Choose various shaders for Foreground/Background. See what effects are possible using these.
Place a SkyObject lamp anywhere in your Project. Make sure Lamps is checked among Light sources 
in the PhotoRendering Settings dialog box. Render scenes using this setting. Set various values for 
its parameters. You may try turning off other light sources to see only the effect of the SkyObject 
lamp on the result. Change the Resolution parameters and see how the Number of Light Sources 
field changes. Render scenes with various settings for Cast Shadow, Shadow is Soft and Shadow 
Quality. Change the Color of the SkyObject lamp to achieve different results.
Place a WindowLight lamp object in one of the rooms of the demo building. Make it the same size 
as the Door/Window you are placing it in front of. Render interior scenes trying various settings for 
this lamp object. Change Light Resolution and Light Intensity to see how many light sources it will 
create automatically. You can try placing more than one of these lamp objects if there are several 
exterior Doors/Windows of the Room rendered. Here, too, try turning off other LightWorks light 
sources to see the effect.
Continue familiarizing yourself with the various shaders and light source settings available in the 
LightWorks Rendering Engine until you are comfortable with them.
206 New Features in ARCHICAD 8-20



New Features in ArchiCAD 10
New Features in ArchiCAD 10

Modeling Freedom in ArchiCAD 10
Architects today are increasingly pushing the boundaries of conventional design. Not only high-end 
buildings, but also everyday designs can take unusual shapes. This trend is driven not only by 
architectural fashion, but also by cheaper technologies for creating custom elements. As a result, 
new shapes and interesting geometries are appearing more frequently. 
As we know, architecture involves not only the design of new buildings. Many architects today work 
on renovating older or historical buildings. These buildings were often built with irregular, slanted 
or battered walls. 
Graphisoft is on top of these trends: with ArchiCAD, we give architects the tool they need to fully 
model these complex buildings. ArchiCAD 10 gives the user more freedom than ever before to 
model and shape construction elements, so all buildings – new, unconventional designs as well as 
historical buildings – can be correctly modeled and documented.

Slanted/Inclined/Complex Walls, Columns and 
Beams
ArchiCAD users are not constrained to a vertical/horizontal world anymore. In ArchiCAD 10, all 
Walls, Beams and Columns can be set to an angle.

New Options for Wall Geometry
In the Wall Settings dialog, you will see a new series of buttons: the four Wall Complexity buttons 
allow for Straight, Slanted, Double Slanted and Complex walls.
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The Straight button enables you to create Walls the same way as in ArchiCAD 9.
With the Slanted Wall button, the Slant Angle field to the right becomes active: set the slant of the 
wall relative to a horizontal plane. The Wall is always rotated around its Reference Line at the base 
level of the Wall. 
The direction of the wall slant depends on the position of the wall’s Reference Line. The rule is that 
the Wall body slants from the side opposite to its Reference Line side toward its Reference Line side 
if the Slant Angle is between 0 and 90, and it will slant from its Reference Line side toward the other 
side if the Slant Angle is between 90 and 180. 
In the illustration below, the Wall’s Reference Line is on its right side. The slant angle is set to 75. 
The lower Wall shows the result: the Wall slants from the side opposite to its Reference Line side 
toward its Reference Line side.

Wall thickness means its slanted thickness, not its thickness obtained by cutting it by a horizontal 
plane. In the following example, the thickness of the Slanted Wall was set to 500 mm.

The next option is the Double Slanted Wall: a second Slant Angle field appears under the one 
already available. 
The upper field specifies the slant of the Reference Line side, the lower field specifies the slant of 
the opposite side. The same rules as to the slant direction and axis apply as with a Slanted Wall.
If the two angles are each other’s supplements, the two sides will be parallel. If both slant angles 
are greater than 90, the sides will slant toward each other. 
In the illustration below, the right side of the Wall was set to 75, while the left side was kept at 90.
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The thickness of the Double Slanted Wall is measured at the wall base. The thickness at the top of 
the Double Slanted Wall (calculated by using the base thickness and the slant values) must be zero 
or greater: the two sloped sides may not intersect at a height below the top of the wall. If you do set 
either angle in such a way that the two sides would intersect, ArchiCAD will automatically increase 
the thickness of the Wall base, so that section of the Double Slanted Wall will be a triangle.
In the image below, the left Wall has slant angles of 90 and 95. If you change the 90 slant to 105, the 
resulting Wall will look like the one on the right. Note that the wall base thickness has increased, in 
order to maintain the full height of the wall and a triangular shape in section view. 

The last option is the Complex (Profile) Wall. If you select this option, you can choose a Profile in the 
STRUCTURE portion of the Floor Plan and Section panel of the Wall/Beam/Column Settings dialog. 
The selected Profile will be applied to your element. 
For more information, see “Creation and Editing of Complex Profiles” on page 233.
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New Options for Column Geometry
Columns also include a new Slanted option, which activates the Slant Angle field to its right. Enter a 
value to set the angle of the Column to a horizontal plane. The value must be between 1° and 90°.

For a slanted column, three placement methods are available:
• Simple: Place the Slanted Column with one click. The Column axis will be projected vertically 

from the Floor Plan.
• Rotated: Your first click determines the position of the Column’s Anchor Point at its Base, the 

second will define its rotation angle around a vertical axis.
• Revolved: Your first click determines the position of the Column’s Anchor Point at its Base, the 

second will define its rotation angle around a vertical axis. The third click will set the Rotation 
Angle of the Column section around its Anchor Point.

Columns can also have Complex (Profile) structures. These can also be Slanted and are placed the 
same way as simple Columns. Column Wrapping is not available for Complex Columns.
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For more information, see “Creation and Editing of Complex Profiles” on page 233.

New Options for Beam Geometry
If you choose the Inclined beam option, the slant angle field is enabled. The slant angle of Inclined 
Beams must be between -89° and +89°, and is measured from the starting point of the Beam. The 
Beam is inclined in the vertical plane defined by its Axis.

Inclined Beams are placed the same way as Horizontal Beams. The 3D body of an Inclined Beam is 
created so that the height of its section cut by a plane perpendicular to its Inclined Axis will be 
constant at every point (and equal to the Beam Height value). In the image below, the Beam’s 
height was set to 500 mm in its Settings dialog. 

Like Walls and Columns, Beams can also use a Profile for their cross section. When the Profile 
button is clicked, Profile Rotation is enabled. Depending on the angle value you enter, the beam 
profile is created counter-clockwise around the Beam’s Axis (if it is a Horizontal Beam) or the 
New Features in ARCHICAD 8-20 211



New Features in ArchiCAD 10
horizontal projection of the Beam’s Axis (if it is an Inclined Beam), when looking horizontally from 
the beginning point of the Beam toward its end point.

A Rotated Profile can also be applied to an Inclined Beam. In this case, the Profile of the Beam is first 
rotated around its horizontal axis (as described in the previous paragraph), and then its Axis is 
inclined from its horizontal position. The image below shows the Floor Plan of an Inclined Beam 
with a Rotated Profile on the left, and its Section view on the right.

Enhanced Intersections in 3D on Solid Geometry 
basis
Walls intersections now affect the 3D wall shape only in the common vertical range of the two 
Walls. This means they intersect only in that vertical range where the 3D bodies of both Walls exist. 
In the image below, the Wall on the right joins the other Wall in a L-joint. It is not as high as the 
other Wall either at its bottom or its top. Still, their 3D intersection is created correctly. The shape of 
the other Wall remains unchanged in those Vertical Ranges where it does not intersect with any 
other Walls.
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One Wall is also able to intersect with different walls at different levels in different ways 

The illustration below shows the four possible intersection scenarios for two Walls having different 
heights, joined in an L-joint. See how the 3D bodies of the two Walls was are generated depending 
on how their Reference Lines join.

Complex Walls and Beams intersect with each other properly, on 3D solid basis:
• The Walls/Beams are lengthened if necessary to wholly intersect each other.
• The Wall/Beam with a higher priority cuts the one with a lower priority 
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The solid intersection of complex Walls and Beams handles even extremely complex profiles (e.g. 
profiles including “bays” or holes).

Flexible Placement of Wall Openings

Door and Window vertical anchor
In ArchiCAD 9, Doors and Windows were vertically anchored to the bottom of the parent Wall. Now 
these elements can be anchored in various ways, using the new Anchor field in the Parameters 
panel of Window/Door Settings dialog.
214 New Features in ARCHICAD 8-20



New Features in ArchiCAD 10
The function of the Anchor is to provide a point of reference for the height position of the Window/
Door. The Anchor Point determines which direction the Window/Door body will extend.
Set one of the following Anchor Point options for each Window or Door: 
• Sill to Wall Base: this is the method used in previous versions
• Sill to Story 0 (Current Story): the height of the Sill will be measured relative to the level of the 

Current Story. If the Wall Base is not at the Floor Level, you must pay special attention. For 
example, say the Wall Base is at -100 mm below Floor Level (Subfloor Thickness is 100 mm). 
Anchor Height is 1000 mm, giving an effective Sill Height of 900 mm from Floor Level. If you 
choose Sill to Story 0, you must change your Anchor Height to 900 mm for the Window/Door to 
be at the same Level.

• Header to Wall Base: same method as the Sill to Wall Base options, but you must provide the 
Header height.

• Header to Story 0 (Current Story): same method as the Sill to Story 0 options, but you must 
provide the Header height.

• Select Story: If you choose this option (select the Story name from the list in the appearing 
dialog box), the chosen story’s Floor Level will serve as the Anchor from which the Window/
Door should be measured. This option may be used, for example, when a Glass Curtain Wall is 
created and all individual panes must have their heights set to a common height (e.g. Project 
Zero).

For example, you might have a Window at 4000 mm Sill Height from Wall Base, where the Wall is a 
multi-story Wall placed on Story 0 (Story Height of Story 0 is 3000 mm). If you want the Sill Height 
value to reflect height from the level of Story 1, choose the Select Story command and select “1. 
Story” in the appearing dialog. The Sill Height field will change to 1000 mm to reflect this 
modification. 
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Door and Window Fit to Slanted and Complex Wall 
Surfaces
Door and Window settings have been adjusted to enable fitting to Slanted and Complex Walls. A 
new Window Plane field gives you two options for setting the vertical slant of Windows/Doors:
• Associated to Wall: the slant of the Window/Wall will be associated to the Wall into which they 

are placed. In slanted Walls, the Window/Door slants at the same angle as the Wall. In Double 
Slanted Walls, the Window/Door slants at the same angle as the side of the Wall into which the 
Window/Door was placed. Thus, if you move the Window/Door to the other side of the Wall, its 
slope will change accordingly. 

• In Complex Profile Walls, the slant of the Window/Door is determined in the Profile Manager: 
use the Opening Reference Layer in the Design Layers panel to define the slant of Windows/
Doors set into the Complex Wall.

See “Design Layers” on page 237.
• Vertical: the Window/Door will be vertical regardless of the type of Wall it is placed into.
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Openings in Polygonal Walls
In ArchiCAD 10, Openings can be placed into Polygonal Walls just as easily as into Linear, Trapezoid 
or Curved Walls. The panes of a Window/Door placed in a Polygonal Wall are always vertical.

Doors and Window can be freely relocated (Dragged, Mirrored) and Rotated within the Wall. The 
Window or Door will move into its new location, and the hole will be cut into the Polygonal Wall.

Opening components (Sill/Threshold, Trim) can also be fit to the Wall surfaces on both sides.

3D Zones Fit to Complex Element Geometry
3D Zones have been enhanced to interact correctly with complex element geometry in ArchiCAD 10 
(Slanted, Profiled Walls, Slanted Columns and Beams).
• In the image below, the Zone body is defined by slanted surfaces. The second image shows the 

Zone body in 3D. Their shape and volume is correctly calculated based on Solid Geometry.
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• Walls and Columns within Zones (e.g. parapet walls, standalone columns) can be subtracted 
automatically from the zone area or zone volume. The relation of columns or walls to zones is 
defined in their Settings dialog boxes, in the “Relation to Zones” pop-up of the Listing and 
Labeling panel. The new option, Reduce Zone Volume, causes ArchiCAD to deduct the volume 
of such elements from the volume of the Zone, thereby giving accurate Zone volume 
information in listing windows.
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• Trimming 3D Zones by Slabs and Roofs is now based on solid operation technology; it can work 
on complex 3D Zone geometry.

New Floor Plan Display for Complex and Multi-story 
Elements
In architecture, the Floor Plan representation of building elements is usually a symbolic view, 
derived from its horizontal cross-section, but in most cases the view is not an exact depiction. 
With ArchiCAD 10, you can choose exactly what kind of Floor Plan representation you need: an 
exact horizontal cut, an abstract symbol, or something in between. This way you will get the correct 
documentation drawings you need, even for multistory elements and complex shapes, without any 
extra touch-up work required.
In ArchiCAD 10, Walls, Columns, Beams, and Roofs are shown on all stories they intersect, by 
default. This “automatic” option can be set in a new Show on / Link to Stories drop-down setting in 
the Settings dialog boxes.

There are two options:
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• Own/Current Story Only: the element will be shown only on the Story it is placed on, even if it 
spans multiple Stories. The element’s remains associated (linked) to its home story, regardless of 
its vertical position.

• Automatic: ArchiCAD automatically calculates how the multi-story element should be displayed 
on each Story. With this option, a multi-story element will be displayed and editable on all 
stories which it intersects, and its home story will depend on the current vertical position of its 
reference line.

Both above-mentioned options allow Walls, Beams, Columns and Roofs to be displayed with either 
a standard or a more realistic representation: use the Floor Plan Display and Show Projection fields 
in the Floor Plan and Section panel of these elements’ Settings dialog.

In Floor Plan Display, there are six possible choices: 
• Projected: projects the 3D model of the element on the Floor Plan
• Projected with Overhead: in addition to the Projected display, it also displays the element’s 

outline above the Floor Plan Cut Plane (with the appropriate attributes set for the overhead 
part)

• Cut Only: displays the cut part, as cut with the Floor Plan Cut Plane
• Symbolic Cut: The whole floor plan projection of simple walls or vertical (simple or complex) 

columns will be displayed as cut, using their cut line and cut fill attributes, regardless of the 
elements’ vertical position. This option is available only for simple straight walls or columns, or 
for complex columns, and only if the Show on Story control is set to “Current/Own Story only”. 
The Floor Plan Cut plane settings do not affect the display of elements set to “Symbolic Cut.”

• Outlines Only: the whole element outline is displayed with its uncut attributes
• Overhead All: the whole element outline is displayed with its overhead attributes
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The Show Projection field controls how projected multi-story elements should be displayed on each 
story they are visible on.

This field is enabled only when the selected choice on Floor Plan Display is either Projected or 
Projected with Overhead. (In case of the other options, the Show Projection options do not apply.) 
The three available options are:
• To Floor Plan Range: the uncut (and overhead) part will be cut at the top and bottom 

boundaries of the Floor Plan Range
• To Absolute Display Limit: the uncut part will be cut at a global project level (e.g. the terrain 

level). The Absolute Display Limit can be set in the Floor Plan Cut Plane Settings dialog.
See “Floor Plan Cut Plane” on page 222. 
• Entire Element: the uncut (as well as the overhead) part of the entire Element will be displayed 

on all relevant stories

In the example below:
• the Curtain Wall is set to “Projected with Overhead” and “Entire Element”
• the mullions – made of columns - are “Cut Only”
• the round structural columns are set to “Projected with Overhead” and “To Floor Plan Range” 

(only their relevant vertical range is displayed on each story)

   
New Features in ARCHICAD 8-20 221



New Features in ArchiCAD 10
Floor Plan Cut Plane
The Floor Plan Cut Plane dialog box lets you enter the parameters of the Floor Plan Cut Plane. 

The Cut Plane Height to Current Story field lets you specify the location of the Cut Plane on the 
Floor Plan: how high above the Floor Level of each Story that structures should be cut.
The other two settings (Relative Floor Plan Range and Absolute Display Limit) only apply to 
construction elements whose floor plan display you have set as being projected to either of these 
two types of limits (in the “Show Projection” option of the element’s Settings dialog box).
The Relative Floor Plan Range limits the element display to a part of the current Story. These 
settings take effect on elements whose Show Projection option is set to To Floor Plan Range.
• Show up to: you can either specify a height offset from the Current Story level (e.g. 2600 mm 

above the Current Story), or a height offset from a story level at a certain number of Stories 
above the Current Story (e.g. 300 mm below the level of the Story above the Current Story). This 
affects the display of the Overhead portion of elements.

• Show down to: you can either specify a height offset from the Current Story level (e.g. 0 mm 
above [or at] the Current Story level), or a height offset from a story level at a certain number of 
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Stories below the Current Story (e.g. 2000 mm above the level of the Story below the Current 
Story). This affects the display of the Projected portion of elements.

The Absolute Display Limit defines a level below which elements will not be displayed. For 
example, you can ensure that any part of the structure that is underground is not displayed. This 
setting affects elements whose Show Projection option is set to To Absolute Display Limit.
• Show down to: specify a height offset from the Project Zero level (e.g. 500 mm above Project 

Zero), or from the 1st or 2nd Reference Level. This setting affects the display of the Projected 
portion of elements.

All Floor Plan Cut Plane settings are used globally when navigating between different Stories (in the 
Project Map or using the “Go up/down a story” commands). These settings are also saved with 
View Settings, which allows the user to define varying Floor Plan Cut Planes for different Views of a 
single story. (e.g. Partition and Ceiling Plan).

Floor Plan Display of Openings in Slanted/Complex Walls
Windows and Doors are traditionally represented in Floor Plan as symbols. However, with the 
possibility of Slanted and Complex Walls, ArchiCAD 10 has introduced the real 3D representation of 
openings in Floor Plan Views, based on the Floor Plan Cut Plane.
The Floor Plan Display selection list is thus available for Windows and Doors, too.

The four possible choices are:
• Projected: the Window/Door body is cut by the Floor Plan Cut Plane. The opening’s cut part, 

plus the hole cut out by it from the Wall are all drawn projected. 
• Projected with Overhead: the Window/Door body is cut by the Floor Plan Cut Plane, and its cut 

portion, plus the hole cut out by it from the Wall are all drawn projected. The structure of the 
Window/Door above the Floor Plan Cut Plane level is also displayed.

• Symbolic: the Window/Door is displayed using the traditional symbolic method, as defined in its 
2D Script

• Overhead All: The Window/Door is shown with its full Symbol, underneath the Wall Fill, 
showing its Overhead portion. The Floor Plan Cut Plane does not cut into its body.
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Note that the dashed lines around the overhead portions of Windows in the above illustration are 
generated as part of the Wall, not the Windows.

Priority-based Wall Intersections: Composite and 
Complex Walls
This feature enables the correct Floor Plan intersection of Composite and Complex (Profile) Walls. 
You can assign intersection priority to wall elements or individual wall skins (through composite 
attributes) or wall components (through profile attributes). Wall skins and components intersect 
with each other based on their intersection priority, if assigned, or based on the intersection priority 
of the Wall as a whole.
These two types of Walls will also intersect perfectly according to the following rules:
• Skins/components with higher priorities will block skins with lower priorities.
• Skins/components with equal priorities will form a mitered joint. (provided they have the same 

fill pattern)
Wall Outlines and Overhead lines also intersect each other.
The Composite Structures dialog is slightly modified to accommodate these changes.
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As you can see, each skin in the Edit Skin and Line Structure panel displays its Priority. Each skin can 
be assigned a separate priority in the Edit Selected Item panel. 
In the example below, the Wall Priorities of both Walls are set to 8 in their Wall Settings dialog 
boxes. The brick veneer skins intersect, which is not what we want.

So we set Skin Priority numbers for the Composite used for these Walls. In this composite, we set 
the Core skin’s Priority to 12. Then we return to the Wall Settings dialog box and check the Apply 
Structure’s Settings box. 
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Now, the skins intersect as desired.

Complex Wall skins are represented as cut with the Floor Plan Cut Plane. A priority value is assigned 
to each component of a Complex structure, just as they are assigned to each skin of Composite 
Structures. 

Note: Wall (and Composite Structure) and Column Intersection Priority Numbers are always 
even numbers; Beam Intersection Priority Numbers are always odd numbers. Thus, any time a 
Wall/Column intersects with a Beam in 3D, the program can determine which is “dominant” 
depending on their Priority Numbers.
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Graphical Editing of the Model: New 
Techniques
In ArchiCAD 10, basic editing commands (Move, Horizontal/Vertical Stretch, Rotate, Mirror, Multiply 
etc.) commands are available for all construction-type elements (Walls, Beams, Columns etc.) in all 
View types (Floor Plan, Section/Elevation, 3D). Also, new element type- and/or View-specific 
commands are introduced to reshape complex elements.
During editing operations, the Tracker (another new feature in ArchiCAD 10) displays and allows 
editing of relevant parameters.
For more information, see “In-Place Numeric Input Using Tracker” on page 315.

Editing Straight Walls
For Straight Walls, the Rotate, Mirror and Multiply commands are new in the 3D Window (this is 
new in other element types, too, so it will not be mentioned separately from here on). Also, the 
Modify Angle command may be used to convert it into a Slanted Wall by horizontally moving its top 
surface in a direction perpendicular to its Reference Line. The same command is available at the 
bottom of the Wall, so you can modify the bottom surface of the Wall.

Editing Slanted Walls
A Slanted Wall in 3D is shown with additional hotspots located not at the Wall body corners, but 
where the Floor Plan Cut Plane cuts the Wall body (see illustration below): the same editable 
hotspots as those shown on the Floor Plan.
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Three pet palette commands are available to modify the shape of a Slanted Wall in 3D.
Stretch Height: Use this command to modify the height difference between the top and bottom 
surfaces of the Slanted Wall, while their projected position on the Floor Plan stays the same.

Stretch Slanted Height: Use this command to change the height of the Slanted Wall, while its slant 
angle remains the same. 

Modify Angle: Use this command to modify the slant angle.
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Editing Double-Slanted Walls
To modify a Double Slanted Wall, four pet palette commands are available. 
Stretch Height: Use this command to change the height of the top surface of the Wall. The size of 
the top surface stays the same, the angles of the sides of the Wall will be modified.

Stretch Height with Fixed Angles: This will also change the height of the Wall, but the wall side 
angles will remain constant; the size of the wall’s top surface will change accordingly

The third button is the Modify Angle with Fixed Height button. It works the same way as with 
Slanted Walls. The size of the top surface and the height of the Wall remains, the position of the top 
surface changes, and the angle of its sides also change.

Modify One Angle with Fixed Height: Use this command to modify the angle of one side. The size 
of the top surface will be modified accordingly, while the angle of the other side remains fixed.
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Editing Profile Walls
For a Wall with a Complex Profile, two pet palette commands are available for changing its shape. 
The Stretch Profile Horizontally and Stretch Profile Vertically commands will stretch the section of 
the Profile in the indicated directions, and in accordance with the Stretch Zones defined for the 
Profile.

Editing Straight Columns
For Straight Columns, click the center of the Column to access the Modify Angle command. 
Entering an angle value will convert your column into a Slanted Column. At the same time, you can 
also rotate the column graphically around its center point.
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 The next command is the Rotate Profile command. Use it to rotate the Straight Column around its 
center.

The third and fourth buttons are both called Stretch Profile. You can stretch the Column in the 
direction of both of its main axes. No matter which corner you stretch, the Column will always be 
stretched so its center will stay at the same position.

All these command are available for Columns even where the Column has a custom Profile.
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Editing Slanted Columns
In case of Slanted Columns, you have the Modify Angle, Stretch Height and the Stretch Height with 
Fixed Angle command. These work the same way as in case of Slanted Walls.

Editing Beams
For a Beam, use the Modify Angle to change the height of one end of the Beam and thereby 
convert it to an inclined Beam. The section of the Beam and its projected vertical size will remain 
the same. 

Editing Model Elements in the Section/Elevation Window
Many of these editing operations are also available in the Section/Elevation Windows. Since a 
Section/Elevation Window is like a 3D View that is limited to one viewpoint, not all editing 
operation are available in all Section/Elevation Window, depending on the position of the Section/
Elevation Line. 
As an example, the following image shows a Section containing a Slanted Wall. The Section Line is 
perpendicular to the Reference Line of the Slanted Wall. In this case, all shape editing command are 
available, since the shown (or cut) size of the Profile of the Slanted Wall is its real size.
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In the next case, the Section/Elevation Line is not perpendicular to the Reference Line of the 
Slanted Wall. As you can see, part of the Slanted Line is shown in the Section/Elevation as view 
lines. In this case, you can graphically modify only those parameters which are displayed in their 
true size in the Section/Elevation view. Below, only the Stretch Height command is available 
because only the height of the Wall is shown as its true size.

Creation and Editing of Complex Profiles
In ArchiCAD 10, Walls, Columns and Beams can have custom cross section profiles. In case of 
Columns and Beams, this Profile can also be freely rotated around the element's axis. Elements with 
custom cross-section profiles are called Complex Elements.
Complex Elements are represented with their exact geometry in 3D, but their components are 
represented as unified bodies, though they can display individual surface materials. In Sections, 
their profile components are represented with the individual section attributes defined for them: 
fills, pens, surface materials.

Custom Profiles vs. Profile Attributes
A Custom Profile is meant for particular elements: it can be individually edited, and changes are 
only applied to that element. Custom Profiles can be edited by choosing Capture Profile of Selection 
from the Context Menu of a selected Wall/Beam/Column in any model View. Changes to the Profile 
can be applied to a Wall/Beam/Column directly from the Profile Manager Palette by clicking the 
Apply to Selection button.
Profile Attributes are re-usable (standard) profiles. They can be associated to several elements, and 
changes in the Profile Attribute will be automatically applied to any of its placed instances.
To assign a profile attribute, use the Structure panel in the Settings dialog box of the Wall/Beam/
Column. If the geometry method is set to Complex Profile, the Profile selection pop-up is available, 
in which you can easily identify and choose Profiles by their name and preview.
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Notes: The Attribute Manager now includes a tab page for Profiles features, enabling you to 
perform all operations with Profiles as with other attribute types (e.g. loading Profiles from 
other Projects into the current Project)
The Find & Select dialog was also enhanced to accommodate searching based on Profile Name: 
the Section Profile search criterion is available for Walls/Beams/Columns.

Profile Manager Palette
The Profile Manager Palette and the Profile Editor Window accommodate all functions needed to 
create, modify and manage Complex Profiles.
Access the Profile Manager at Window > Palettes > Profile Manager, or at Design > Complex Profiles 
> Profile Manager. Alternatively, you can select a Wall/Beam/Column, then choose the Capture 
Profile of selection command from the Context Menu. This option is available in all Views (Floor 
Plan, Section/Elevation, 3D Window).

This command will capture the Profile used by the last selected element, and enter the Profile 
Manager Palette where you can start editing it.
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Manage Profiles
The Manage profiles panel displays a preview of the Profile under creation. Use the Choose profile 
pop-up list to pick any of the available Profiles. ArchiCAD 10 comes with a set of default Profiles and 
you can create your own.
In the Use with area, click type(s) of elements for which you want your Profile to be available. The 
Profile defined in the image above will be available for Walls only.
Use the Duplicate button to create another copy of the same Profile under a new name. It will be 
named Custom until you store using the Store Profile button at the bottom of the Palette.
To create a brand new Profile with no graphical information defined for it, click the New button.
If you click the Edit chosen profile button, a 2D editing dialog - the Profile Editor - will appear in 
which you can create the geometry of your Profile.

Draw your Profile using the Fill tool. Set desired values for the Fill Outline Pen, Fill Pattern, Fill 
Pattern Pen and Fill Background Pen; these values will be applied to the element when you check 
the Apply Structure’s Settings in the Floor Pan and Section palette of the Wall, Beam or Column.
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You can add hotspots to the Profile element in the Custom Profile Editor. These hotspots will be 
visible in 3D at both ends of the Profile body.
A Profile may consist of several pieces (components). Each of these pieces can have their own 
attributes (Fills, Materials etc.) and they do not even have to adjoin each other.

Note the location of the Local Origin of the Profile in the Profile Editor Window. This Local Origin 
affects the placement height of the profile element.
The generation of the Profile happens according to the following rules: 
• In case of Walls: if you are looking at Wall from its starting point toward its endpoint, and if you 

created the Wall using the Left Construction Method (i.e. the body of the Wall extends to the 
left side of the Reference Line) then the placed Profile wall will face the same direction as shown 
in the Custom Profile Editor. If you switch the wall’s Reference Line to the other side, or if you 
view it from its endpoint toward its starting point, you will see the vertically mirrored image of 
the Profile. The Local Origin of the Custom Profile will placed at the Wall insertion level (base 
height) as defined in the Wall Settings dialog.

• In case of Columns: the Local Origin of the Profile will be at the insertion point of the Column on 
the Floor Plan. (Anchor Points do not apply to a Column with a Custom Profile.) The Profile will 
look the same on the Floor Plan as it looked in the Custom Profile Editor.

• In case of Beams: if you are looking at Beam from its starting point toward its endpoint, then you 
will see the Profile that you created in the Custom Profile Editor. The Local Origin of the Custom 
Profile will placed at the Beam insertion level (absolute height) as defined in the Beam Settings 
dialog.

If you add holes to the Fill drawn for the Profile geometry, these holes will be generated in the 3D 
body of the element using the Profile.
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The last button in this panel is the Captures element’s profile button. This button becomes enabled 
whenever the last selected element is a Wall, Beam or Column in Floor Plan, Section/Elevation View 
or in the 3D Window. Use this button to get the Profile of a Wall, Beam or Column into the Profile 
Editor and continue working on that.
When the Custom Profile Editor is visible, the other panels of the Profile Manager Palette are also 
enabled. 

Design Layers
The Design Layers panel contains layer settings that apply to the Profile Editor window only. The 
layer of the active tool will be highlighted. 
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The Construction Layer contains the Fill Tool and the Hotspot Tool. No other Tool may be used on 
this Layer. 
Elements on the Drafting Layer include additional drawing data that may be useful for the Profile, 
such as Text Blocks, Lines, Arcs, or Dimensions. Nothing drawn on this Layer will be part of the 3D 
body of the Profile.
The Horizontal Stretch Layer contains two vertical lines. These lines define a Stretch Zone: the part 
of the Profile between these two lines. Whenever you stretch the placed Profile element 
horizontally, only the parts of the Profile within the Stretch Zone will be stretched; the parts outside 
the Stretch Zone will keep their shape and proportions.

In the image above, the horizontal Stretch Zone is defined with the two vertical lines. If you stretch 
the Profile horizontally, only its middle portion will stretch, and the portions between its middle 
and its two sides will keep their dimensions.
The Vertical Stretch Layer contains two horizontal lines. They have the same function as horizontal 
stretch lines and work the same way, except they apply to vertical stretches.
The lines located on the Horizontal Stretch and Vertical Stretch Layers cannot be deleted. Neither 
can any other element be placed on them. Only the lines already there may be modified.
The Opening Reference Layer contains one or more line segments which are the slant reference 
lines for openings (Windows/Doors) placed into a Complex Wall, provided that the Window/Door 
Plane field is set to “Associated to Wall” in its Settings dialog. 
In the image below, the Opening Reference lines on both sides of a two story Wall are shown in 
orange. ArchiCAD calculates the slope of the Windows/Doors as by referring to the Window/Door’s 
Anchor Point (defined in its Settings dialog). When you place a Window/Door into a Complex Wall, 
the program considers the Anchor point and starts to fit the opening to the Wall on the clicked side. 
When it hits the Opening Reference line, that point will be considered the edge of the Wall and the 
slope of the Line at that point will be used. If it does not hit a line, then the Window/Door will be 
vertical (since no Opening Reference is defined at that height of the Wall).
Since it is the Anchor height of the Window/Door that counts, it is possible that a Window/Door 
placed in the below Wall will be sloped if it uses the Sill as its Anchor, and vertical if it uses the 
Header as its anchor.
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Opening Reference lines can be placed on both sides of the Wall, and can overlap each other 
vertically. In this case, the line further away from the Wall at the Anchor Point height will be used 
(the one reached sooner when the program is fitting the opening into the Wall).
Only lines may be used to draw an Opening Reference line. To approximate an arc, use multiple line 
segments.
All Layers may be switched on and off using the Eye icons. The last three Layers also have a 
checkbox: if you uncheck a box, the content of that Layer disappears, in effect deleting what was 
there. If you now re-check the box, its default state will be restored.

Components – Structure and 3D
This panel lets you define the structure and 3D appearance for every single Fill (Component) drawn 
in the Custom Profile Editor. Select a component by selecting its fill in the Profile Editor. 

The Priority slider lets you define a 3D Intersection Priority for the Profile Component. If this Profile 
will be used for a Wall, you can set a separate Intersection priority for each Component: for 
example, one may be set stronger than Beams, another weaker.
The Core Component checkbox lets you set the selected Component(s) as Core Components. This 
affects wall dimensions which you have defined as “core only” (Dimension Settings > Dimension 
Details panel). 
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By default, all sides of a component have uniform properties, but you can set individual edge 
properties if needed: select the edge in the Custom Profile Editor and set properties for that edge of 
the Profile using the pet palette command “Set parameters for profile edge.”

Use the appearing dialog box to set properties.

You can set the material of the surface extruded from this edge of the Fill in the Surface material 
field. The Edge Contour area contains a selection pop-up for the line type and line pen of that edge 
of the Fill. This will be visible both in the Custom Profile Editor and also in Section/Elevation View 
when the Profile is dissected.
In the Apply changes to area choose the Selected edge only radio button to apply these setting only 
to the currently edited edge of the Fill and the surface extruded from it, or choose the All edges 
radio button to apply it to all edges of the Fill and all surfaces extruded from these edges.
Back in the Components – 3D and Structure panel, the next field is Side materials. Choose the 
Uniform radio button for all side surfaces of the Profile body to have the same material as chosen 
from the material selection pop-up (this choice will override any properties you defined for 
individual edges). Alternatively, the Custom edge included radio button will assign the edge 
material specified in the Custom Edges Settings dialog.
The Ending contours field lets you select the Pen and line-type for both ends of the Profile body.
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Profile – Uniform contours
Use these controls to set line-type and Pen for the contours (fill edges) of the Profile. These options 
are handy for achieving the desired cross section look of the Profile.
Cut Lines parameters will affect the contours of the Fill which will be cut when the Profile body is 
dissected. The Separators parameters affect the contour line of adjoining Fills, thereby acting in 
section as a sort of Separator Line.

Click the Override button to apply these settings to all Fills in the Custom Profile Editor, overriding 
other settings (even custom edge settings for that edge).

Apply to selection
This button is enabled when a Wall, Beam or Column is selected in any View. Click this button to 
apply the current Profile (the one being edited) to the selected Wall/Beam/Column.

Store profile
This button is enabled as soon as you make any change to any setting of the currently visible Profile. 
Click this button to store these changes, bringing the Profile will be up-to-date.

Create Profile by Merging Elements
A quick way to create a complex profile is to use the Design > Complex Profiles > Merge Walls/
Columns/Beams commands.
To use this command, draw multiple walls, columns or beams in the model window. The elements 
must be of the same type and must be parallel to each other.
Executing the command will create a new profile element, which will replace the original elements. 
The new profile element will be as long as the longest original element, and will inherit the 
attributes of the original as well as any wall openings.
By default, the new profile is named “custom” but can be opened in the Profile Editor, modified and 
renamed.
To merge two or more parallel Straight Walls, use the Merge Walls command on them. The Walls 
will become the same length, and the cross section of the resulting Wall will be a unity of the cross 
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sections of the two Walls. The bodies of the two Walls do not need to touch, they may be at a 
distance from each other. This command works only for Straight Walls (Vertical, Slanted, Double-
Slanted, Custom Profile). It does not work for Trapezoid, Polygonal and Curved Walls. 

The Merge Columns command allows you to merge two or more Columns whose axes are parallel 
to each other. If this condition is met, all types of Columns (Vertical, Slanted, Custom Profile) may be 
merged. More than two Columns may be merged at the same time.

Use the Merge Beams command to merge two or more Beams whose axes are parallel to each 
other. If this condition is met, all types of Beams (Horizontal, Inclined, Custom Profile) may be 
merged.

Moving Wall Openings
ArchiCAD 10 includes several enhancements to make it easier to move wall openings. These 
operations work with Drag, Rotate, Mirror and Elevate commands. All these operations are 
available in the Floor Plan, Section/Elevation Windows and the 3D Window, for slanted and straight 
Walls only. 
The first is that Door/Windows do not need to be dragged by their hotspots. After selecting the 
Window/Door, choose the drag, move or multiply command, then click anywhere in the view to 
define the starting and ending points of the operation’s vector.
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The second improvement is that Windows/Doors may be dragged/moved/copied along with other 
Element types in one step. In the following image you can see that the Column is dragged. The 
Windows will also be dragged within their Wall by a distance that equals the component of the Drag 
vector along the Wall.

The third enhancement is that Windows/Doors may be moved across multiple Wall elements. You 
can drag or copy a Window from one Wall and end up in another Wall element.

Moving an opening across multiple elements works only if the Wall elements involved have their 
reference-side wall planes all in the same plane. If there are two vertical Walls involved, their 
Reference Lines must be aligned in a single vertical plane. If they are slanted Walls, their Reference 
Wall sides must align in a single slanted plane. The thicknesses and other attributes of these Walls, 
however, do not need to be identical; the Walls involved do not even need to be connected to each 
other.
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Also, when you stretch a Wall with the Marquee, the Windows/Doors included in the Marquee will 
also be dragged/copied, so they retain their position relative to the end of the Wall.
244 New Features in ARCHICAD 8-20



New Features in ArchiCAD 10
Integrated Design and Documentation
ArchiCAD 10 fully integrates the layouting process (formerly handled by the PlotMaker application) 
to provide a seamless workflow throughout the whole project lifecycle, including design, layouting 
and documentation. Integration means that multiple workflows - based on different customer 
needs, or project size and complexity - are supported, providing maximum flexibility to users.
This section describes the new features and benefits that come from the integration.
This integration does not mean that existing workflows have become impossible: you can still keep 
the model(s) and documentation in separate files; AC10 continues to support the layouting of 
drawings that originate from several separate model files. Furthermore, ArchiCAD 10 includes a 
dedicated Layouting Work Environment profile for this distinct part of your workflow.

Editing Layout and Model Views in Single 
Environment
As a result of the integration, the same editing methods and environment are available for layout 
views and model views alike:
• A Drawing Tool is introduced in the Toolbox 
See “Drawing Tool” on page 258.
• The Info box is available for all elements placed on the Layout
• Any drafting and annotation tools, including 2D parametric GDL objects (Markers, Drawing 

Titles, Labels, Tables and Schedules), can be placed on the Layout. 
Read more about “Parametric Drawing Titles” on page 263.
• Complete Pet Palette for all direct editing functions on Layouts
• Vectorial real time (mouse wheel) zoom feedback 
• Template files also contain Layout information
• Quick selection (area-based selection) available for drawings placed on layouts
• Unified shortcut set for layouting and modeling commands
• Autosave for Layouts
• Multi-step Undo when working on Layouts
• Enhanced Autotext features

Project Overview in Navigator
The full Project structure is now accessible from the Project Navigator in a consistent way. 
The leftmost button at the top of the Navigator is the Project Chooser button. Use it to switch 
among running ArchiCAD versions, or to access the Organizer (see“Project Organizer: Instant 
Documentation” on page 251) or the Drawing Manager (see “Drawing Manager” on page 253).
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Use the four buttons at the top of the Navigator to switch among the Navigator’s four maps (from 
left to right): Project Map, View Map, Layout Book and Publisher Set. 

Within a Project, all Navigator Items are handled in a consistent way:
• Each map contains the most important commands, in the form of context menu and buttons, 

that can be performed in that map (e.g. New Folder, Clone a Folder, Delete from Views, New 
Layout, New Subset, Update for Layouts etc.)

• All Navigator maps have a Properties panel at its bottom, which indicates the most important 
settings of the selected item (e.g. View settings for Views, Layout Name and Layout Size for the 
Layout Book.)

• All items have an ID and a Name in the Properties panel for consistent identification through the 
whole design and documentation process.

• All item types have a Settings button in the Properties panel. Use this button to open the 
relevant Settings dialog for the selected item.

• The current Navigator Item is indicated in Bold Type.
• The fully functional Publisher is now integrated into the Navigator. Each Publisher Item refers 

directly to a View or Layout; the Item adds only formatting settings used for publishing the 
referred view or layout.
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Saving/Redefining Views
The process for saving and redefining Views has been enhanced. ArchiCAD 10 enables you to set 
any of the most important view options when saving the View. Since Views can now be listed in 
View lists, View Settings include customizable identification information.
When you click the Save current View button in the Navigator or the Organizer, the Save View 
dialog comes up, where you define the View Settings, then click Create to save the view.

On the Identification panel, set the ID and Name values for the View.
In the ID field, you have 3 possible choices:
• By Project Map: The ID specified for the View in the Project Map will be used.
• None: no ID is specified for the View.
• Custom: you can specify the ID. The text field to the right of the drop-down list will become 

active and you can enter the custom ID there.
In the Name field, you have 2 possible choices (None is not available as a choice, since each View 
must have a Name):
• By Project Map: The Name specified for the View in the Project Map will be used.
• Custom: Enter a custom View Name using the text field to the right of the drop-down list.
The General panel shows options that apply regardless of whether the View is saved from a 2D or 
3D Window.
• In the Layer Combination field, specify a Layer Combination for the saved View. (When saving a 

View, it is not possible to choose the Custom Layer Combination, if there is one. Similarly, you 
cannot choose Custom Model View Options or Dimensions, either. However, you can choose a 
Custom definition when you redefine your View– see later in this section).

• Specify a Scale field for the saved View.
The 2D Only panel contains options that apply to Views saved from the Floor Plan, from Section/
Elevation Windows, and Details.
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• Click the Floor Plan Cut Plane Settings button to access this dialog box if you want to set custom 
values for the saved View. Otherwise, it will use the project’s currently specified values.

• The Model View Options: use this field to specify a Model View Options Combination for the 
View. Please note that On-Screen Display Options (unlike Model View Options) are not saved 
with the View. See “Separate On-Screen and Model View Options” on page 285.

The Dimensions field lets you specify which saved Dimension settings to be applied in your saved 
View.
The Zooming field lets you save your View using either the Current Zoom or None.
The 3D Only panel contains options that apply to a View saved from the 3D Window or the 
PhotoRendering Window. (When saving a View from Floor Plan, Section/Elevations and Details, this 
panel is not enabled.)

The Generate in field lets you set whether to save the contents of the 3D Window or the 
PhotoRendering Window. The View will store the part of the project that was displayed at the time 
the View was saved – whether all elements, an explicit selection, or a Marquee-limited part. In case 
of PhotoRendering, PhotoRendering Settings will be stored. 
The View also stores image settings: that is, all other settings that affect how the 3D model will 
appear, such as Projection Settings and Cut Planes.
Once a View is saved, you can select it at any time in the View Map and click the Settings button to 
bring up its Settings dialog to change any of the settings.
In this case, the View Settings dialog box includes a new button named Get Current window’s 
Settings appears.
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If you click this button, all fields will be modified to reflect the current state of the Project. Here you 
can switch to Custom Layer Combinations, Model View Options and Dimensions Options. (However, 
it is recommended to always save these settings with a specific name, rather than leaving them as 
Custom, because if the Custom settings are further modified, the Views using them will be 
automatically updated).
For 3D views, the 3D Only panel includes a checkbox: Redefine Image Settings with current 
appears. If you check it, all additional 3D Settings will be overwritten with the current state of 
settings in the Project.
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Another opportunity for defining or redefining a view is available when Cloning a folder in the View 
Map.

Once you choose a folder to clone, the relevant options for that type of folder will be available. For 
example, if you clone the Stories folder of the View Map, you can proceed to set completely 
different Layer Combinations, Model View Options etc. for the new (cloned) folder. Later, when any 
View is created in this folder, it will automatically assume these settings.

Quick Options
The Quick Options Palette contains buttons for quickly setting Layer Combinations, Scale and 
Model View Options Combinations for the view in the currently active window, without having to 
go to their Settings dialog.

Keep in mind that the Quick Options Palette always shows the current state of the project (e.g. 
which Layer Combination is in effect in the frontmost window), while the Properties panel of the 
Navigator View Map shows the settings of the saved View.
For more information about Views, see the “View Map” section of the Interaction chapter of 
ArchiCAD 10 Help.
With the new Quick Options Palette, the buttons available in the lower left corner of Windows have 
slightly changed. The Scale button is no longer included (since it is now part of Quick Options, which 
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is available whenever needed). Instead, the Quick Options toggle button took its place. Use this 
button to toggle the display of the Quick Options palette.

Project Organizer: Instant Documentation
The Project Organizer is like opening two Navigators side by side. Using the various combinations of 
the panels on both sides, you can choose between three modes:

View Editor
• Project Map (or View Map) on the left, View Map on the right.
• Define Views out of Viewpoints – drag and drop Viewpoints from the left to the right, thereby 

saving Views.

Layout Editor
• View Map on the left, Layout Book on the right.
• Place Drawings on Layout – drag and drop Views from the left to the right, thereby placing 

Drawings onto Layouts.

Publisher
• View Map or Layout Book on the left, Publisher on the right.
• Add Items to the selected Publisher Set – drag and drop a View/Layout from the right to the left 

thereby adding shortcuts of View/Layouts to Publishing Sets.
When using the Organizer, the intended workflow is to select items in the left panel you wish to add 
or create in the right panel. You can also use the Organizer in such a way that both panels show the 
same items (e.g. Layout Book on both sides). In this case you can perform copy operations from the 
left to the right panel.
When the left Organizer panel shows the Project Map and the right panel shows the Layout Book, 
you will be placing viewpoints (from the left) onto Layouts (on the right.) However, since Layout 
Book items consist of Views (not viewpoints) placed on Layouts, ArchiCAD will first create a View 
out of the viewpoint (the new View will be added to the View Map), then place the View onto a 
Layout in the Layout Book, all in one step.
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You can also use the Organizer to access the Project Map, View Sets and Layout Book of external 
Project Files and copy or merge all or part of their contents into you active Project File. This is 
especially useful with large Projects where model and documentation data may be distributed 
among several Project Files. For more details, see “Scalable Project Setup to Handle Multiple Project 
Files” on page 278.

Using Drag and Drop in Navigator/Organizer
A Drag-and-Drop operation results in either the creation of an item, or, if an item with the same 
name exists, a new copy of the original. While working in a folder hierarchy, dragging an item onto a 
folder will place the item into that folder; while an item dragged to a new location will take its place 
there in the hierarchy. 
In the Navigator/Organizer, you can use drag and drop for the following additional tasks:
• Drag a Viewpoint from the Project Map to the View Map: defines a View out of the Viewpoint, 

using the View Settings in effect for the folder onto which it is dropped. If it is not dropped onto 
a folder, it will save the View using the current settings for the Viewpoint.

• Drag a Viewpoint from the Project Map to the Layout Map: first, ArchiCAD defines (in the View 
Map) a View based on the current settings of the dragged Viewpoint. Next, it automatically 
places a Drawing based on this newly created View onto the Layout onto which the Viewpoint 
was dropped. If it was not dropped onto a specific Layout in the Layout Map, a new Layout 
(based on the default Master Layout) will be created and the Drawing will be placed on that 
Layout.

• Drag a View from the View Map to the Layout Map: places a Drawing, based on the dragged 
View, onto the Layout upon which it is dropped, and immediately generates the Drawing data. If 
the View was not dropped onto a specific Layout in the Layout Map, a new Layout (based on the 
default Master Layout) will be created and the Drawing will be placed on that Layout.

• Drag a View from the View Map to a Publisher Set: creates a new Publisher item in the folder of 
the Publisher Map onto which the View was dropped. The item will have the file format defined 
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for that folder of the Publisher Set. If it was not dropped onto a folder, the PDF file format will be 
applied by default.

• Within the Layout Book, drag a Master Layout and drop it onto a Layout: applies the Master to 
the Layout.

• Within the View Map, drag a View and drop it
- into another folder: moves the View into the folder it is dropped on 
- next to another item: moves the View to the specified location (note: if the View is dragged 
from a Clone folder, a copy of the View is created)

In all of the above, pressing the CTRL (Windows) /CMD (MacOS) key will copy the dropped item 
instead of moving it.
In the Organizer, you can load the whole Navigator structure of another external Project and 
perform these same Drag-and-Drop operations using the Views and Layouts of that external 
Project.
For example, dragging a Layout of an external Project into a folder within the Layout Map will merge 
that Layout into the Layout Map of the current Project.

Drawing Manager
The Drawing Manager is a comprehensive palette used to manage Drawings: to monitor their status 
and change their settings. It replaces the Drawing Usage view of PlotMaker’s Navigator. The 
Drawing Manager Palette lists all types of drawings within a Project File, such as:
• Drawings referring to internal Model Views (Model Views of the active Project File) 
• Drawings referring to external Model Views (Model Views located in an external Project File – 

ArchiCAD Solo and TeamWork files or archives)
• External Drawing files of specific types: PDF, DWG, DXF, DWF, PLT, HPGL Plot files (this is a legacy 

feature since PlotMaker has been merged into ArchiCAD), DGN (MicroStation files), WMF and 
EMF (Windows Metafiles), and PMK (PlotMaker legacy files)

• External Image files of any type: SGI file, PSD (PhotoShop files), TIFF, BMP, JPG, PNG, (Windows) 
and PICT (MacOS) 
Notes: 

• Although it is possible to place PMK files as Drawings into ArchiCAD Model Views and Layouts, 
saving as PMK file is not supported anymore. There are other types of vectorial formats you can 
save from ArchiCAD, which you can then place as Drawings. 

• Handling of bitmap files has been enhanced. In previous versions, the size of bitmap images was 
limited to 4048x4048 pixels. The limit has now been raised significantly (to 32767x32767pixel 
size) in all these areas:
- When importing/placing bitmap images with the Figure Tool.
- When setting Rendering Size
- When setting Rendering Background Size
- When Printing/Plotting bitmaps.

The Drawing Manager Palette’s main area contains the list of Drawings and their relevant data.
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You can sort the Drawings by any of the criteria represented by each column: click on the desired 
column header. The ‘ appears in the column header to indicate the “sort by” column. Click once to 
sort in ascending order; click a second time to sort in descending order. 
You can sort in up to two levels: whenever you click on a column title, it becomes the primary 
sorting column ‘ , and the former primary sorting column becomes the secondary sorting column “. 
To customize the columns in the Drawing manager, click the … button at the far right in the row of 
column headers to access the Customize List Columns dialog box. 

To show or hide a column header in Drawing Manager, open or shut the eye icon next to the header 
item. To change the listing order, drag the up-and-down arrows at the beginning of rows or use the 
Move Up and Move Down buttons. Specify the width of any column by selecting an item and 
entering its width in pixels. Click the Reset button to return all settings to their factory defaults.
Width: Enter a value (in pixels) to set the width value of the selected column.
Checking the Fix Width column will retain the column width as defined, even if other column 
widths change.
Buttons at the top of the Drawing Manager Palette represent commands you can carry out on any 
selected Drawing. 
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First is the Link Drawing to button. Click it to link the selected Drawing to a source View or file other 
than the current link. 

Use the next, Break Link button to break a link between the selected Drawing and its source View or 
File: this means ArchiCAD will embed the Drawing, with its status at the current moment, into the 
Project File. The Drawing’s status column will show “Embedded.” Henceforth, this Drawing will not 
be updateable, unless you later re-link it to a source View/File.

The next button is Update Drawing(s). Select one or more Drawings in the list and click this button 
to update them.
The final, Delete button will remove all selected Drawings from the Drawing Manager list and from 
the Project File.
Use the Check Status button to determine the exact update status of selected Drawings. This is 
needed if a Drawing’s status is listed in the Drawing Manager as “Needs checking.” See the 
automatic update mechanism of ArchiCAD 10 later in this section.
There are two more buttons at the bottom of the Palette.
The Open source View button will open the ArchiCAD View linked to the selected Drawing. If a 
selected Drawing is embedded or comes from an exterior file, this button is disabled. If the source 
View is located in another ArchiCAD Project File that is not currently open, the program will start a 
new ArchiCAD session and open the required View there.
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The Settings button directly accesses the Drawing Settings dialog box for the selected Drawing.
Context Menu commands are also available in the Drawing Manager.

The Set as Autotext Reference command, accessible from the Drawing Manager’s context menu, 
lets you select a Drawing to act as a reference for Drawing-related Autotext entries placed in Text 
Blocks in the Project. 

Flexible Drawing Update
There are obvious advantages to “live”, automatically updated model views. However, in some 
cases it is preferable to “freeze” drawings instead of updating them automatically, yet still retain the 
Drawing’s link to its source. ArchiCAD 10 supports all of the following Drawing update types.
• Auto-update: the Drawing is always automatically updated to reflect any relevant changes.
• Manual update: the user has full control over the update of Drawings: the Drawing will be 

updated only upon explicit user command.
• Embedded: no update is possible: the Drawing is embedded into the Project File.
Use the Drawing Settings dialog’s Update Type setting to control how a Drawing should be updated. 
Set it to Auto if you want ArchiCAD to automatically take care of updating the Drawing. Choose 
Manual to perform updates yourself whenever needed. The Last Updated field shows the last time 
the Drawing was updated. The Update Status field shows whether the file is OK, Needs Checking, 
Modified, Embedded or Unavailable. (While an update process is underway, the status fields may 
also display “To be Updated” and “Updating”.)
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Below Update Type, the Store Drawing in the Project File checkbox gives you the option to save the 
Drawing’s data as part of the Project File. Since generated Drawing data will not be saved with the 
file, file size is reduced. Drawing data will be regenerated in the next update.
This checkbox is not available when the Manual update option is selected, because in that case 
ArchiCAD always saves Drawing data with the Project File.
The Update Status indicated in the Drawing Settings dialog and the Drawing Manager is the result of 
a status-checking mechanism. This is a mechanism that was completely renewed in ArchiCAD 10 to 
speed up the checking/update process (no Background ArchiCAD, as such, but running instances of 
ArchiCAD are aware of each other and of the Project data contained in each). It has become a two-
level process:
• Quick check of Viewpoint modification dates: this routine checks whether there was any change 

in any of the Viewpoints that are sources of Drawings. This process is automatically run in the 
background as a continuous process. For example, if you move a Window in a Wall on Story 0., 
the modification date of that Viewpoint will be modified and the program will know Drawings 
related to it need updating.

• Check of relevant Elements’ modification dates. This second-level check is applied only to auto-
update Drawings automatically whenever the Layout Window is rebuilt. For Drawings of any 
other status, you can update them manually after being alerted to this by the Need checking 
status in the Drawing Manager.

If the source of a placed Drawing is a View in an external Project File, there are two possible cases 
for update. If the source file is not opened or running, the Drawing is updated based on the last 
hard save done on that file. If the Project is open and running, that instance of ArchiCAD will 
automatically generate the desired data, and the Drawing is updated based on that generated 
information.
If you prefer that all of your drawings remain up to date as you work, even if you store Model Views 
and linked Drawings in separate project files, then you should keep all needed project files open 
concurrently so you can modify your model views, and all auto-update drawings will automatically 
reflect those modifications.
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Drawing Tool
The Drawing Tool lets you import and place Drawings from exterior sources or internal project views 
into both Model Views and Layouts.
To import a Drawing, activate the Drawing tool and click into the project. If you click into a Model 
View, choose the desired drawing file from the appearing Link To directory dialog box. If you click 
into a Layout with the Drawing Tool active, the Place Drawing dialog box lets you choose between 
an external or internal link, then opens a corresponding directory dialog box. Check the file you 
wish to place as a Drawing; select one to place it into the currently active Model View or Layout. 
In the directory dialog box, check the Store Path as Relative to Project box to specify the relative 
path of the loaded file.

If you choose an ArchiCAD project as the source of your drawing, the following dialog box appears:

(The same dialog box appears if you use File > External Content > Place External Drawing into a 
Model View.)
Choose the view you need and click Place.
After you placing a Drawing, select it and go to its Settings dialog to adjust its settings.
The first panel is the Identification panel.
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The Drawing ID field gives you three ways to set the Drawing ID:
• By View ID: The Drawing ID will be equivalent to the ID of its source View, if any.
• By Layout: the Drawing ID will be defined automatically, in accordance with the Layout it is 

placed on
• Custom: you specify the Drawing ID by entering it into the field to the right of the drop-down 

list.
By checking the Include Drawing in ID sequence checkbox, the Drawing will receive its ID 
consecutively with other Drawings. This checkbox has no effect with the Custom option above.
Similarly, the Drawing Name setting has three options:
• By View: Name only: takes the Drawing Name automatically from the name of its source file
• By View: ID+Name: combines the view’s ID and Name as the Drawing Name
• Custom: lets you specify the Drawing Name in the field to the right of the drop-down list 
The Source File field shows the path of the source file of the Drawing.
The small button to the left of the non-editable field showing the Path has two states:
• Relative Path: the Path data of the Drawing is set relative to the location of the Project File
• Absolute Path: the full Path of the Drawing’s source file is stored
The Update Type area was discussed at “Flexible Drawing Update” on page 256.
The next panel is the Properties panel. 
In the Size area, you can set the print-sized Width and Height of the Drawing. Alternately, you can 
set a magnification factor for the Drawing, or alter the Drawing Scale. 
The four fields are interlocked, so changing any of them changes the other three accordingly. 
The magnification factor can be set numerically (as a percentage), or by using two automatic 
rescaling options (accessible using the small button at the right of the Magnification field): 
• Fit to Layout: the multiplication factor and the sizes of the Drawing will be set so the Drawing’s 

size will be adjusted to the size of the Layout
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• Fit to Grid Cell: if the Layout contains a Grid for Drawing IDs, this option will set the 
multiplication factor and the sizes of the Drawing so the Drawing’s size will be adjusted to the 
size of the Grid Cell it was placed into, if the Layout contains a Drawing Grid.

In the Anchor Point field, you can set the Drawing’s Origin by which it is placed in a View or onto a 
Layout. By default this point is the middle of the Drawing.
Use Drawing’s internal original as anchor: If you enable this checkbox, the Anchor Point field above 
is disabled and the Drawing’s default setting is used as anchor.
The Angle field lets you set a rotation angle for the placed Drawing.
The Pen Set field of Drawing Settings determines which pen set this drawing will use. 
For information on Pen Sets in ArchiCAD 10, see “Named Pen Sets” on page 280.
The default option, “Assign Model's current Pen Set,” means that the Pen Set currently in effect for 
the project's model views is assigned to newly placed drawings. The Drawing will retain this pen set 
until you change it. This method is available only for drawings placed from the current project's 
model view. 
The other option is “Own Pen Set by Source”: the placed Drawing uses the pen set assigned to the 
source project’s Model Views. If the Pen Set of the source project changes, the drawing's pen set 
will change accordingly after an update.
To assign another pen set to a placed drawing, click the Pen Set drop-down menu and choose a 
different pen set, for this drawing only. 
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To review the contents of the Drawing’s pen set, click the “View Drawing’s own Pen Set” button to 
open Drawing Pens & Colors. This is a view-only dialog box; you can add this pen set to the project’s 
existing pen sets, or use it to overwrite an existing pen set.
To do this, click the Add to Project’s Pen Set button, which will bring up this dialog:

Click Store Drawing’s Pen Set as to specify a name for it, or use the Drawing’s Pen Set to overwrite 
one of the Project’s existing Pen Sets, selecting the Pen Set to be overwritten from the list. Then 
click the Store button to carry out adding/modifying the Pen Set, or click Cancel if you do not wish 
to add the Pen Set.
This can be useful when you have placed a Drawing in your Project but find its Pens not to your 
taste. In this case, add the Drawing’s Pen Set to the Project’s Pen Set, then modify the Pens in this 
new Pen Set to your liking, and finally apply this modified Pen Set to the placed Drawing.
The Colors field applies when the Drawing’s source is a View of an ArchiCAD Project File. In this case 
you can specify how the colors of the Drawing should be displayed. It has three options:
• Colors defined by Pen Set: Colors will be displayed as defined in the Pen Set used by the 

Drawing.
• Black and White: Colors will all be displayed in Black and White.
• grayscale: Colors will all be displayed in grayscale.
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Check Transparent background to make any element located behind the Drawing Frame (either in 
the Model View or on the Layout) to be visible, even if the Drawing overlaps those elements. If it is 
unchecked, the Drawing’s frame will act as an opaque element and will cover elements behind it.
The next panel is the Frame panel.

In the Frame’s behavior area, choose the Fit Frame to drawing radio button, and the Frame will be 
as large as the enclosing rectangle of the Drawing. If you choose Manually resized frame, the frame 
will be the same size as the enclosing rectangle of the Drawing, but you can modify its shape like 
any other polygon type element. The frame will be drawn with a dashed black line.
Check the Add printable Border checkbox if you wish to create a Border around the frame. Choose 
a line-type for this Border and set its color using the appropriate controls.
In the Border offset field you can set how far the Border of the Drawing should be offset from the 
frame of the Drawing.
The Title panel of the Drawing Settings dialog will be enabled only when a Drawing is placed onto a 
Layout. If you place a Drawing into a Model View, no Title may be appended to it.
See more information on the Title panel at “Parametric Drawing Titles” on page 263.

New Options for Layouts
One new function is the Continue Drawing ID sequence from previous Layout checkbox in Layout 
Settings.
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If you check this box, ArchiCAD assign an ID to the current Layout in conformity with the ID Prefix 
and ID Style defined for the previous Layout in the Layout Book. This way all IDs of all Layouts in a 
Layout Book can be set to follow the same pattern automatically. Check this checkbox for all Layouts 
except for this first (the checkbox is not available for the first Layout in the Layout Book) to create a 
continuous sequence of Drawing IDs throughout the Layout Book.
The other new feature is the Anchor Point field in Master Layout Settings (Name and Size panel). 
The Anchor Point you set will remain fixed if you resize the Master Layout. If, for example, you have 
assigned a Master Layout to several layouts, then change the Master Layout size, the Drawings 
located on those layouts will retain their positions relative to the Master Layout’s Anchor Point. 
Multi-Page Layouts are discontinued in ArchiCAD 10.

Parametric Drawing Titles
Parametric (GDL Objects) associative Titles can be placed with Drawings automatically in ArchiCAD 
10. When you place a Drawing on a Layout, you can use the Title panel of Drawing Settings to assign 
and format a Drawing title. 
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At the top left corner of the panel, use the pop-up field to select the file of the Drawing Title to be 
used (or select No Title).
Below, use the Font Type and Font Code Page for to assign default font values for texts in this Title 
Marker.
The top pencolor pop-up specifies the default Pen number for the Title Marker. To the right, check 
the Uniform Symbol Pens box to use this default on all 2D elements within the Title Marker. (If you 
leave it unchecked, Marker items can appear in their own color specified in the parameter list 
below.)
Enter a Font Size and Pen Number as default values for Texts within the Drawing Title. To the right, 
check Unified Text Format to use these defaults for all Text elements of the Title Marker. (If you 
leave it unchecked, Texts within the Title will appear with the size, pen and formatting specified in 
the parameter list below.)
If you check the Flip Title box, the Title Marker will be mirrored to its vertical middle axis: what was 
on the right end before will now be displayed on the left end, and vice versa.
The three Formatting buttons below the three checkboxes provide the default formatting (from left 
to right: Bold, Italic and Underline) for Text elements within the Title Marker.
In the lower left part of the panel, the parameter lists shows the available options for the selected 
Title. The most common parameters are:
• Position: the Title Marker may be positioned to align in length to the Drawing it belongs to or to 

the Layout it is placed on. The length of the Title will adjust automatically to the length of that 
side of the Drawing/Layout.

• Side: You can define which side (Top, Bottom, Left, Right) of the Drawing/Layout the Title should 
be placed.

• Alignment: You can define which side (Left, Center, Right) of the Drawing/Layout the Title 
should be aligned.

• Rotation: If the Drawing is set to be positioned to the Left or Right of the Drawing, it will 
automatically rotate to align with that side of the Drawing/Layout. Also, it can be set to rotate 
with the Drawing in case the Drawing is rotated on the Layout.
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• Drawing Name: can be displayed in its own Text Format; Custom Drawing Name may be 
specified.

• Drawing Scale: can be displayed in its own Text Format; Drawing Scale Prefix may be specified.
• Drawing ID: can be displayed in its own Text Format; Drawing ID Prefix may be specified.
• Layout ID: can be displayed in its own Text Format; Layout ID Prefix may be specified.
The lower right part of the panel contains a Preview Picture. Two small buttons in its upper left 
corner determine what the Preview will show. If the upper button is active, the Preview will show 
the Title’s position relative to the Drawing it belongs to. If the lower button is active, the Preview 
will show a preview of the Title itself. 

Direct Drawing References from Section/Elevation 
and Detail Markers
Section/Elevation and Detail Markers in ArchiCAD 10 can be linked directly to Views or Drawings 
placed on Layouts.
The Section/Elevation Marker can be made to refer either to a Section/Elevation View or to a 
Drawing created from a Section/Elevation View and placed on a Layout. New fields in the Marker 
panel of the Section/Elevation Settings dialog accommodate this new feature.

Check the Refer to Drawing checkbox to enable this feature for the current Section/Elevation 
Marker. The field to its right will show which View/Drawing the program has selected to be linked 
with the Marker. If you wish to change that, click the Browse button. In the appearing dialog, you 
can see a hierarchical list of the source Section, Viewpoint, Views and Drawings (if any Drawings 
created from this View were placed in the current project’s Layout Book).
You can set your reference to any of the listed Section/Elevation Views or any of the listed Drawings 
placed on Layouts. If the item you selected is a valid choice, the OK button will become enabled and 
you can quit the dialog by clicking it. Or you may abort it by clicking the Cancel button.
If there is more than one View of the same Section/Elevation Window (e.g. with different View 
settings), you can choose which one the Section/Elevation Marker should refer to.
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Also, if you select several Section/Elevation Markers on the Floor Plan at the same time, you can set 
them to refer to the same View/Drawing. But as a rule, one Marker can refer to one View/Drawing 
at a time, but several Markers may refer to the same View/Drawing.
If you linked the Section/Elevation Marker to a Drawing on a Layout, you can select the Section/
Elevation Marker and select the Go to Drawing command of the Context Menu to directly access 
the View of the referred Drawing.
In case of Detail Markers, the feature works similarly. Check the Refer To Drawing checkbox and use 
the Browse button to select the desired Drawing to link to.
If you wish to unlink a Section/Elevation Marker or Detail Marker from a View/Drawing, you can just 
uncheck the Refer To Drawing checkbox in the Settings dialog of the Marker. You can also re-link 
any of these Markers to another View/Drawing.

PDF Drawings in ArchiCAD Projects
ArchiCAD 10 can now import pages from PDF document as Drawings into Layouts or Model Views 
(for example, a complete standard detail onto a Section drawing or manufacturer’s specifications 
onto a Detail Drawing).
A PDF file (like any Drawing) may be placed using a menu command (File > External Content > Place 
Drawing) or by using the Place Drawing command in the Drawing Manager. When you select the 
PDF file to be imported in the Open File dialog, you have the option to check the Store Path as 
Relative to Project box to store the path of the imported PDF file relative to the location of the 
Project File it is imported into. If you leave it unchecked, the full path of the PDF files will be stored.

After selecting the PDF file to be imported, another dialog appears if the PDF file contains more 
than one page. Here you can graphically select the desired page of the PDF file from the list of 
available pages and click the Place button.
266 New Features in ARCHICAD 8-20



New Features in ArchiCAD 10
Now you can place the PDF page to any position in your Model View or Layout.

For PDF and other external files placed as Drawings, the Drawing Name may be defined using the 
name of the source file (as set in the Drawing Settings dialog box).

PDF pages placed as Drawings can also be set to update automatically (Update Type: Auto) and they 
can be set to be stored in the Project File for off-line use (check the Store Drawing in the Project file 
checkbox).
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Navigable 3D Models in PDF Documents
On Windows, it is possible to take advantage of the U3D file format with ArchiCAD 10.
U3D (“Universal 3D”) is a file format for 3D data. It is a standardized three-dimensional data format 
with the purpose of facilitating 3D data exchange among programs of various kinds.
Adobe Acrobat Reader 7.0 and later supports this file format, which means that it can, within PDF 
documents, display a frame containing a 3D model saved in the U3D format. By clicking on the 
image, the 3D model comes alive, and you can navigate it (rotate it, zoom in/out and do various 
things with it). This enables an ArchiCAD user to create a PDF file which has actual 3D models of his 
design included right in the PDF file.
To create a PDF file with U3D content, follow these steps:
1. On the Floor Plan, select the elements you wish to display in the 3D Window. Make sure you 

have only the necessary layers visible, so unnecessary details are not included in the 3D model, 
because it might cause the U3D file to become excessively large and harder to navigate in the 
PDF file. Then go to the 3D Window to display the 3D model.

2. Use the File > Save As command to save the content of the 3D Window in U3D format. The 
model in the 3D Window may be in either in axonometry or perspective.
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3. With the 3D Model still generated, save a View in the Navigator. The stored 3D View will keep 
Marquee and 3D Cutting Plane settings. Name the saved 3D View to your liking.

4. In the Organizer, place the generated 3D View onto a Layout. Set the Layout to the size you wish 
to see it in the resulting PDF document.
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5. Go to the Layout onto which you placed the 3D View and add any other drawing, text etc. 
information you wish to appear on the PDF file.

6. In the Organizer, add the Layout to a Publishing Set. Set the path of the folder you wish the PDF 
file to be saved in the Publishing Properties dialog. 
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7. Select the added file in the Publishing Set, and in the Format field, set it to PDF format. Then 
click the Document Options button. In the appearing dialog, check the Embed 3D content 
checkbox. Click the Browse button, and find the U3D file you saved from the 3D Window. This is 
the file you need to embed into the resulting PDF document. Click OK to exit this dialog.

8. Publish the Publisher Set. Then open the resulting PDF file and find the page where your 
embedded 3D model is located. Click on the image displayed in its placeholder box. The 
Navigation buttons will appear at the top of the Navigation box. You can now freely navigate 
your Model.
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f
Notes:

• In step 4 you placed a 3D View onto a Layout, then added additional data to the Layout. This 
step is optional. You can also directly place a View into the Publisher Set and publish it. In that 
case, only the View will be shown in the resulting PDF file.

• This feature currently works only on Windows. Also, you must use Adobe Acrobat Reader 7.0 or 
later to view and navigate PDF files created this way.

Enhanced Element Schedules
In ArchiCAD 10, Interactive Element Schedules are significantly enhanced and fully integrated into 
the workflow: the model is fully accessible through the Interactive Schedule, just as from any 
graphical model view (Floor Plan, model Section/Elevations, 3D views). The Interactive Schedule 
View is a WYSIWYG tabular Model View that can be published as a view or as part of a Layout. 
Elements can be listed based on sophisticated model filters (Layer, ID, Story, etc.) that can be set in a 
redesigned Scheme Settings dialog (for new options see 5.5 Project Indexes below). You can now 
export as well as import Interactive Schedule Settings.
All relevant data (element parameters) are available in the Settings dialog for filtering and listing the 
different element types. Attribute-type specific, standard controls are also available (e.g. structure, 
pen, line-type, material controls) for better filtering.
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In the Interactive Schedule View you can change numerical and alphanumeric values directly: right 
inside the formatted table. Click on a field and editable fields will become Text edit fields. Non-
editable fields (e.g. quantity, which is automatically calculated – it cannot be set) will be displayed 
with a dark blue background. Changes made in the table are immediate and carried over into the 
model; every change is undoable. 
To the left of the Schedule View, the panel contains Schedule and Format Options - the same 
settings that were available in ArchiCAD 9.
Schedules are also available from within the Project Navigator:
• Schedule Schemes (“what to list”) are found in the Project Map 
• Schedule Views (Scheme with all formatting options) are located in the View Map 
• Schedule Drawings are in the Layout Book, placed on Layouts
Schedule Drawings can be clipped or rotated just like any other Drawing. 
The Restructure Table command is available in the Pet Palette: large tables which exceed the Layout 
size will be automatically split and laid out next to each other, based on the resulting overall height/
width of the Drawing. The following image shows a Window Schedule that does not fit onto an A4 
sized sheet.

The Restructure Table command is used to define a new enclosing rectangle for the Schedule table. 
In this case, ArchiCAD recalculates sizes and lays out the Schedule so it best fits the new geometry. 
The result: the Schedule is split in two portions which are placed under each other.
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Project Indexes
In ArchiCAD 10, various types of Project Indexes can be defined and placed in a manner similar to 
Interactive Schedules. There are three types available: Drawing List, Sheet Index and View List.
The Document > Project Indexes > Project Index Schemes dialog box lets you define these similarly 
to Interactive Schedules.

By default, there are three existing lists (one of each type). Click the Create New button to create 
any number of new Project Index schemes for listing. In the appearing dialog, use the three “Use 
with” buttons to set the type of Project Index you wish to create (from left to right: View List, Sheet 
Index, Drawing List).

Use the ID and Name fields to specify the ID and Name given to this new Project Index. Click OK to 
create the Index or click Cancel to abort the creation process.
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Use the Export button to save a selected Index as an Interactive Schedule Settings (*.iss) file. Or use 
the Import button to import settings from an already saved Interactive Schedule Settings file 
containing Project Index definition.
In the Criteria panel, you can set up criteria based on which Project Indexes will be sorted and listed. 
This works the same way as for Interactive Schedules, only the criteria set is different in each type of 
Project Index and applies to that type of Project Index. The Title bar of the panel always shows the 
name of the Project Index being defined.

The last panel in the dialog is the Fields panel. This area defines which available fields should be 
listed and in what order. This, too, works the same way as in Interactive Schedules, only the 
available parameters are different in each type of Project Index and they apply to that type of 
Project Index. The Title bar of the panel always shows the name of the Project Index being defined.

After defining settings, click OK to quit the dialog and accept changes, or click Cancel to quit it 
without accepting changes.
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If you wish to see any of these Indexes, you can switch to Index View and select the desired Project 
Index to be displayed. You may select it from the View Map in the Navigator or by using the menu. 
This Index View is a WYSIWYG tabular view of View Lists/Sheet Indexes/Drawing Lists.

Index Options and Format Options are available to the left of Index View. These generally contain 
the same options as Interactive Schedules (as these Indexes are special types of Interactive 
Schedules). The Header Options button accesses commands affecting the Index’s Header cell: 
adding a merged Header cell above two or more selected cells, deleting Header cells, showing/
hiding the Main Header, showing/hiding Column Headers.
The Index Settings button accesses the dialog box where you can change the settings of the current 
Project Index.
You can click into cells that contain alphanumeric values (numbers or text strings) and modify them 
directly. Any change made in the table will be carried over immediately onto the appropriate View/
Layout/Drawing. For example, if you change the name of a Layout in this table, the name of the 
Layout will change in the Layout Book in the Navigator. Changes are bi-directional: any change made 
in one place updates the value in the other.
These Project Indexes can be placed on Layouts like any other list-type drawing.

During a publishing process, Project Indexes are automatically regenerated by ArchiCAD to reflect 
the most up-to-date state of the Project.
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Teamwork – Collaboration
With the integration of PlotMaker into ArchiCAD 10, the Teamworking mechanism is extended to 
the Documentation process. 
There are several new things you can do while working with Teamwork Projects.
The first one is that you can reserve Layouts as part of your Workspace during the Sign-In process 
into a shared Teamwork file. You can reserve these Layouts the same way you would reserve Layers 
or Section/Elevations: select the ones you wish to reserve, and click the Next button in the Sign-In 
dialog.

You can also use the Organizer to add New Layouts/Master Layouts (or copy them from other 
Project Files) and Views to your shared Project on the fly. You can do this the same way it is done 
with normal Project Files.
You can also use the Organizer to place Drawings onto Layouts (Layouts in your own and in others’ 
Workspace).
In the Organizer, the handling of Public Views and your own Views (called My Views) is done 
separately for better distinction.
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As a new Teamwork strategy, Teams still can keep their Model and Documentation files separate, 
but can share the Documentation part as well.

Scalable Project Setup to Handle Multiple Project 
Files
The single file concept that ArchiCAD currently implements has proven itself well in small firms with 
small to medium-sized projects. Firms with larger projects divide these into several files for many 
practical reasons. ArchiCAD 10 is well suited to many types of workflows involving both single-file 
and multiple-file projects. 
• Small Projects: in this case ArchiCAD 10 provides a one-file workflow, which is easier than 

previous versions. All Model Views and Layouts are available in one Project File making working 
in documentation faster and easier.

• Medium-sized Projects: in this case two ArchiCAD Project files may be used. One Project File 
contains the architectural model. The other Project File contains all the document files 
(Layouts). Since the Project Navigator can access the Project Structure of all running ArchiCAD 
instances, it becomes easy to place Model Views of one Project File onto the Layouts of the 
other Project File.

• Large Projects: Model views may be located in multiple Project Files; Layouts may also be 
located in several different project files. For example, a project may involve a building lot with 
several large buildings: each building has its own model Project File and Layout Project File. As 
described below, the Navigator and Organizer Palettes provide a single interface to help you 
keep track of all these projects simultaneously.

For information on migrating ArchiCAD and PlotMaker 9 files to ArchiCAD 10 (into single or multiple 
files), see “Migrating ArchiCAD 9 Projects to ArchiCAD 10 ” on page 3.
Another feature of ArchiCAD 10 is Multiple file handling. One Project File is available for full editing 
in one ArchiCAD session: this is called the active Project File. The full content of the active Project 
File is accessible from within the Navigator/Organizer. 
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In ArchiCAD 10, the Project Navigator is able to access the View Map and Layout Book structure of 
all running ArchiCAD instances, and it is also able to extract View Map and Layout Book structure 
from non-running Project Files.
Using these capabilities, the following types of files are available with the Project Chooser button of 
the Navigator/Organizer (located in their upper left corner – see image above):
• The active Project File (at the top of the list).
• All instances of ArchiCAD running on the same computer containing open Project Files 
• All files linked to the current Project File (all files which contain Views or Layouts linked to the 

current file). This is possible by using the Browse button of the Project Chooser. Once you open 
an ArchiCAD Project File, its View Map and Layout Book structure become available in the 
Navigator, letting you place Views onto Layouts of the active Project File, or copy Layouts from 
the other Project File to the active Project File. In the image below, a View from the Project File 
Villa.PLN is placed onto the Layout named A.02.1 Ground Floor in Athena – Building C.PLN, the 
active Project File.

When you open the Organizer, the Layout Book of the active Project File will always appear on the 
right panel. Views and Layouts (including Master Layouts) coming from other Project Files will 
appear on the left panel. You can switch among these other Project Files using the Project Chooser 
button. Views and Layouts may be placed/copied only into the Layout Book structure of the active 
Project File. 
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When opening a new File, the Open File dialog box now contains the Launch a new instance of 
ArchiCAD checkbox. If you check it, a new instance of ArchiCAD will be launched and the Project 
File will be opened in that instance. Your current Project File will not be closed in your running copy 
of ArchiCAD. This is another way of speeding up communication and data exchange between 
Project Files.

Named Pen Sets
Users typically need one set of colors for on-screen display and another set for output documents. 
For example, the on-screen display would use pens in various colors, while an output would require 
grayscale or black-and-white color schemes. Also, different documents of the same Model View 
(created for different audiences) often require different attributes (in color and line weight). In 
ArchiCAD 10, named Pen Sets are available as a new feature.
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When you go to the Pens & Colors dialog you can see a list of Named Pen Sets in the Select a Pen 
Set for Model views/for the Layout Book field (depending on whether a Model View or Layout 
Window is active when you open the dialog). 
After changing any settings of Pens, you can use the Store as button to save your new Pen Set. In 
the appearing dialog, you can either use the Store Custom Pen Set radio button to save it under a 
new name, or the Overwrite following Pen Set radio button to redefine an existing Pen Set. Click 
Store to carry out the operation, or click Cancel to abort it.

Click the Rename button to change the name of any Pen Set.
Use the Delete button to delete any Pen Set you do not want to be used in your Project.
You can define any number of named Pen Sets. The lower panel shows all colors of the selected Pen 
Set, plus the name of the selected Pen Set in the panel’s Title Bar.
A new feature is the Description field, available for every single pen, to help identify what that Pen 
is used for. This can be helpful in enforcing office standards.
Model Views and Layouts use separate Pen Sets (as indicated in the View’s or Layout’s Settings 
dialog). The one it applies to is indicated in parentheses in the Title Bar of the dialog.
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All open Model View windows share one pen set at a time. All Open Layout windows share another 
pen set. Individual Drawings embed or refer to Pen Sets one by one. These Drawings store their own 
Pen Sets, but any named Pen Set can be used for any particular Drawing. To set this, select the 
Drawing(s), go to its Settings dialog and use the Pen Set drop-down list on its Properties panel.

Out of the box, there are several consistent named Pen Sets available, compatible with Element 
default- and Favorite Settings. These Named Pen Sets are also available directly using menu 
commands.
As in PlotMaker, in ArchiCAD 10, you can use Parameter Transfer on any Drawing to pick up the Pen 
Set and reassign it to another Drawing. But since the Drawing is now associated to a Tool, all the 
Drawing Tool Settings will be picked up and transferred, not just the Pen Set.

Note: The Pen Sets feature is also incorporated into the Attribute Manager, which includes a 
new Pen Set tab page where you can perform all the same operations as with other attribute 
types (e.g. transferring Pen Sets from other Projects into the current Project).

Autotext Features
In ArchiCAD 10, Autotext items may be placed in any Window, including the Floor Plan or any 
Layout. Autotext data can be specified in the Project Info dialog.
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You may create as many new items as you wish by clicking the New button and typing a name into 
the new field. 
Every field also has a Description field. If you run out of room while typing the description, click the 
right- arrow at the right of the Description field you are in to bring up a bigger text-editing box.

To save your Project Info fields and Descriptions into an XML file for later use in other Projects, click 
the Save button. Use the Load button to import fields and Descriptions from an XML file into the 
Project Info dialog.
Click the OK button to apply changes to the dialog, or click Cancel if you do not want them applied.
These Autotext items can be placed into any Text Block as part of their Text.
The new Insert Autotext button is available from the Text Editor Palette. While editing a Text Block, 
click Insert Autotext to bring up its dialog.
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At the top, choose a Category of Autotext items to filter the list, or All to see all available items. 
Recent will show only the ones you have recently inserted. 

For a list of available Autotext Items, see “Conversion of Other Attributes/Settings ” on page 7.
Select the desired item. The Preview field will show you what will be inserted (the Description field 
in the Project Info dialog). If no value is given for the item, the Preview field will display 
“#ProjectName”. Click Insert to insert the Autotext item into the Text Block being edited, or click 
Cancel to abort the insertion operation.
After an Autotext Item is inserted, its actual value is displayed in the Text Block with a gray 
background while in editing mode. When you click any part of it, it will be selected as a single entity. 

There are several enhancements that make the use of Autotext items easier:
• Any Autotext Item may be a multi-line entity (create page breaks when entering its value in the 

Description field of the Project Info dialog).
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• Autotext Items that refer to Drawings but are placed directly on Layouts can indicate parameters 
of Drawings placed on the same Layout. For example, the “Drawing Name” Autotext placed onto 
a Layout will show the names of all Drawings placed on this Layout, one after the other, 
separated by commas.

•  You can also use so-called "reference" Autotext Items, which show information about a 
particular file/drawing. The Set Autotext Reference command is found in the context menu of 
any selected Drawing, both on a Layout and in the Drawing Manager.

Separate On-Screen and Model View Options
Model View options determine how particular views are displayed in documents; Model View 
Options can be defined separately for each view and are saved along with the view. In contrast, on-
screen options are pure display settings for more effective on-screen navigation and operation, and 
are global in their effect for all ArchiCAD Views.
On-Screen View Options are all available as individual commands, and you can create custom 
shortcuts for them for easier access. 
• Clean Wall & Beam Intersections

Note: In earlier ArchiCAD versions, this command included Auto Intersection: When drawing a 
new wall to meet an existing wall, it is sufficient to click any edge or inside the hatching of the 
target Wall; the new Wall’s reference line will be adjusted automatically for proper connection. 
In ArchiCAD 10, Auto Intersection is a separate option (on by default), at Options > Auto 
Intersection.

• Show Walls and Beams Reference Lines 
• Show Roof Pivot Lines
• Show Fill Handles
• Show Textbox Handles (options for displaying Text in Greek type is discontinued – ArchiCAD 

automatically displays Texts as Greek below a certain size at the given zoom factor)
• Show Figure Handles (the Placeholders option was discontinued)
• True Line Weight (when this option is ON, the Bold Cut Lines option is grayed)
• Bold Cut Lines (available when the True Line Weight options is not ON)
• Show Section Depth Outline
• Show Detail Boundaries
• Show Mark-Up Items
• Show Drawing Frames.
• Show Master Items on Layout 
Multi-page Layouts are not available in ArchiCAD 10.
There are some new On-Screen View Options available in ArchiCAD 10. These are the following:
• Show/Hide Drafting & Editing Aids
• Show Spline Handles 
• Show Fills as Vectorial Hatching (if this option is not enabled, all Cover/Cut/Drafting Fills are 

displayed as bitmap fills)
All On-Screen View Options are available in a Toolbar ("On-Screen View Options" – use Windows > 
Toolbars to show or hide toolbars.)
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The Model View Option Combinations panel contains options for storing Model View Options.
The Options for Construction Elements panel contains familiar settings. Each area has a preview 
field to provide instant feedback of how it will look, so you do not need to go to the Floor Plan to 
see the effect of the setting.

While display options have changed since ArchiCAD 9, the following information should help you 
recreate the same display in ArchiCAD 10 for migrated projects.
Options for Doors and Windows are set separately, giving you more flexibility in applying model 
views:
• If you choose the Show On Plan radio button, but leave the with Markers checkbox unchecked, 

it will achieve the same result as the Show on Plan option in ArchiCAD 9.
• If you choose the Show On Plan radio button, and check the with Markers checkbox, it will 

achieve the same result as the Show with Dim. option in ArchiCAD 9.
• If you choose the Show Opening Only radio button, but leave the with Contours checkbox 

unchecked, it will achieve the same result as the Hide on Plan options in ArchiCAD 9.
• If you choose the Show Opening Only radio button, and check the with Contours checkbox, it 

will achieve the same result as the Reflected Ceiling options in ArchiCAD 9.
• The Hide on Plan radio button is a new choice in ArchiCAD 10 and if you choose it Doors/

Windows will not be shown on the Floor Plan at all just as if there were no Doors/Windows in 
Walls. In Section/Elevation and 3D Windows, the Door/Window hole will be visible.

The Options for Fills & Zones panel also has a preview picture for instant feedback.
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Regarding Cut Fills, you will notice that there is no option to set Bitmap Patterns. A bitmap display is 
available for on-screen display only: Bitmap or Vectorial is set globally using the Show Fills as 
Vectorial Hatching option of On-Screen View Options.
If you check the Show Cut Fill Contours Only checkbox, it will achieve the same result as the No 
Fills option in ArchiCAD 9. In this case, the As In Settings and Solid radio buttons become 
unavailable.
When you check the above checkbox, the Show Skin Separator Lines checkbox will also become 
enabled. If you check this checkbox, too, you will achieve the same result as the Separators Only 
option is ArchiCAD 9.
By choosing the As In Settings radio button, you will achieve the same result as the Bitmap Pattern/
Vectorial Hatching option is ArchiCAD 9 (depending on the state of the Show Fills as Vectorial 
Hatching option of On-Screen View Options). The Show Skin Separator Lines option does not apply 
to this case so it is grayed.
If you check the Solid checkbox it will achieve the same result as the Solid w/o Separation Lines 
option is ArchiCAD 9.
When you check this checkbox, the Show Skin Separator Lines checkbox will again become 
enabled. If you check this checkbox, too, you will achieve the same result as the Solid option is 
ArchiCAD 9. 
The next area in the lower left corner is for Drafting Fills.
If you check the Show Drafting Fill Contours Only checkbox, it will achieve the same result as the 
No Fills option is ArchiCAD 9. In this case, the As In Settings and Solid radio buttons become 
unavailable.
By choosing the As In Settings radio button, you will achieve the same result as the Bitmap Pattern/
Vectorial Hatching option is ArchiCAD 9 (depending on the state of the Show Fills as Vectorial 
Hatching option of On-Screen View Options).
If you check the Solid checkbox it will achieve the same result as the Solid option is ArchiCAD 9.
The next area in the upper right corner is for Cover Fills.
If you check the Show Cover Fill Contours Only checkbox, it will achieve the same result as the No 
Fills option is ArchiCAD 9. In this case, the As In Settings, Solid and Empty radio buttons become 
unavailable.
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By choosing the As In Settings radio button, you will achieve the same result as the Bitmap Pattern/
Vectorial Hatching option is ArchiCAD 9 (depending on the state of the Show Fills as Vectorial 
Hatching option of On-Screen View Options).
If you check the Solid checkbox it will achieve the same result as the Solid option is ArchiCAD 9.
The Empty option is new in ArchiCAD 10. If you check its checkbox it will draw an Empty Cover Fill 
over the element – it will use the background color defined for the Cover Fill of the element.
The last area is for Zone Backgrounds and Zone Stamps. The options in this area achieve the same as 
the Zone Polygons and Zone Stamps fields achieved in ArchiCAD 9. The following table shows the 
11 possible combinations of the “Zone Background” settings. It will also show what state of the 
Zone Polygons and Zone Stamps fields were in to achieve the same results in ArchiCAD 9.

Notes: If you choose Empty in the Cover Fill Patterns field, the Show Cover Fill Pattern checkbox 
becomes unavailable (since there is no Cover Fill Pattern to draw over the Zone Polygon).
If you choose the No Background radio button, and the Show Cover Fill Pattern checkbox is not 
checked, the Show Zone Stamp checkbox will be automatically checked and locked. This is 

Options in ArchiCAD 10 Options in ArchiCAD 9
Zone Background 
Color

Cover Fill 
Pattern

Zone Stamp Zone Polygons in 
ArchiCAD 9

Zone Stamps in 
ArchiCAD 9

Category Color - - Category Only Hide
Category Color - Show Zone 

Stamp
Category Only Show

Category Color Show Cover Fill 
Pattern

- Fill Pattern on 
Category

Hide

Category Color Show Cover Fill 
Pattern

Show Zone 
Stamp

Fill Pattern on 
Category

Show

Cover Fill 
Background

- - Solid Background 
Colored Fill

Hide

Cover Fill 
Background

- Show Zone 
Stamp

Solid Background 
Colored Fill

Show

Cover Fill 
Background

Show Cover Fill 
Pattern

- Cover Fill Hide

Cover Fill 
Background

Show Cover Fill 
Pattern

Show Zone 
Stamp

Cover Fill Show

No Background - Show Zone 
Stamp

None Show

No Background Show Cover Fill 
Pattern

- Fill Pattern Only Hide

No Background Show Cover Fill 
Pattern

Show Zone 
Stamp

Fill Pattern Only Show
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because one of the three main parts of a Zone (Zone Polygon, Cover Fill Pattern, Zone Stamp) 
must always be visible.

Distorted Fills
Individual fill elements can now include various distorted instances of the very same vectorial fill 
attribute. In a fill defined as distorted, you have the following editing options:
• Position of the fill origin (positioning) 
• Orientation of the fill as a whole (rotation) 
• Orientation of individual fill axis (skewing) 
• Length of the unit along any axis (scaling)
The General Settings panel of the Fill Settings dialog now includes the Use Distorted Fills radio 
button.

In the below illustration you can see the 3 options available in ArchiCAD (from left to right): Link to 
Project Origin, Link to Fill Origin and Use Distorted Fill.

When creating a Distorted Fill, you first create the contour of the Fill, then you need 3 clicks to 
define the distorted coordinate system of the Fill. The first click defines the Local Origin of the 
Distorted Fill. The second click defines both the direction and the unit length of the first major axis 
of the Distorted Fill. The third click defines both the direction and the unit length of the second 
major axis of the Distorted Fill. At this point the Fill is generated.
Any of these three points can be dragged while the Fill is selected, so you can move the Local Origin 
of the Fill; you can also redefine both the direction and unit length of either of the two axes of the 
Distorted Fill.
Besides being available for Fill elements, Cover Fills on plane surfaces which are non-parallel to the 
View plane (e.g. roof fills on the Floor Plan) can be distorted automatically using the “Distort with 
Slope” checkbox in the Cover Fill section of Roof Tool Settings.
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Gradient Fills
ArchiCAD 10 introduces Gradient Fills to help you create better representations of your design. 
Gradient Fills enhance architectural graphics, but do not indicate any physical properties (like cut 
and cover fills assigned to construction elements do). The two most commonly used types of 
gradient fills are available in the program:
• Linear: the color changes along the segment linearly and evenly, the solid foreground/

background colors are displayed beyond the transition segment
• Radial: the color changes between two concentric circles evenly, the solid foreground/

background colors are displayed beyond the circles.
Both the Linear Gradient Fill and the Radial Gradient Fill are available as standard fill types. They 
are hard-wired into ArchiCAD similarly to Solid Fills and Empty Fills.

When you place a Linear Gradient Fill, the Fill Handle will be automatically placed horizontally into 
its center. You can then select the Fill and define the direction of the color gradation by dragging the 
two end points of the handle (the gradation will proceed along the direction of the Fill Handle). 
Between the two endpoints of the Fill Handle, the Fill will gradually change its color. The two 
defined colors will be applied on the two sides of the Fill Handle.

Similarly, you can create a Radial Gradient Fill (you may also switch from Linear Gradient Fill to 
Radial Gradient Fill while the Fill is selected). In this case two concentric circles will be placed, which 
will define the gradation of the Fill’s color. Within the boundaries of the smaller circle ArchiCAD will 
apply the first color. Between the two circles, the color of the Fill will gradually change from the first 
color into the second color. Outside the boundaries of the second circle, the second color will be 
applied. 
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Consistent Printing and Plotting
In order to bring Model View and Layout printing to a common “platform”, the following options 
are available for Layout printing:
• Header/Footer – you can define Header/Footer information when printing Layouts the same 

ways you can define when printing model Views
• Print Marquee Area – any rectangular or polygonal marqueed area on a Layout may be printed.

There are some new general output enhancements that are available for both printing and plotting:
• High resolution in large format without size limitation•
• Hairline printing (based on the maximum resolution of the device)
There are some special Layout printing features:
• Print Selected Layouts in Navigator – select one or more Layouts in the Navigator and the 

Selected Layouts in Navigator radio button will become enabled in the Print Layout dialog.
• Layout Size now equals the physical paper size (not the printable area of the paper based on the 

current device). 
• Resize (%) options are available in the Size area – with it you can achieve photocopy-like 

enlargement/reduction for your Layouts. 
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With regard to line weights: The True Weight On-Screen Display option has no effect on how line 
weights are printed (On-Screen Display options do not affect output). As default, all line weights are 
printed as True Weight unless the Hairline checkbox is checked in the Print dialog, in which case line 
weights are printed as hairline.

Publishing
The Publisher is fully integrated and is available from within the Project Navigator. You do not need 
to open a separate Publisher dialog to publish. If your Publishing Sets are already defined, you can 
simply switch to Publisher Sets in the Navigator and Publish from there.
The Publisher now allows you to publish Model Views and Layouts as part of the same Publishing 
Set. Any View or Layout available in the Organizer may be added to a Publishing Set to be published 
at the same time.
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When a Project Index (Drawing List, Sheet Index or View List) is placed into a Publishing Set, it is 
automatically regenerated before saving, and will always reflect the latest state of your Project.
For information on Project Indexes, see “Project Indexes” on page 274.
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User Interface and Navigation
This section covers features that are aimed at improving the ArchiCAD user interface for both novice 
and advanced users.

Enhanced Fill/Pen Attribute Pop-ups
The Fill-selection and the Pen-selection pop-ups have been redesigned:
• Fills are listed more spaciously and along with their names. No need to recognize the fills by 

their pattern any more.
• A scrollbar will help to navigate when the number of Fills in the list increases
• At the top of the palettes, the currently selected Fill is shown in a Preview window along with 

the Fill name, type (Vectorial or Symbol), and relation to scale changes (Scale with Plan or Scale 
independent). In case of Composite Structures, the total thickness of the Composite Structure is 
displayed.

• Pens can have their own names (set in the Description field in the Pens & Colors dialog) from 
now on, which will be also listed on the Pen palette for easier identification.

Context-Sensitive Help System
The new Help system provides more information in the working context, without you having to 
manually search the Help. In conformity with system standards, you can press the right mouse 
button at any location on your ArchiCAD screen and choose “What’s this?” or “Help” to jump to the 
relevant section of the Help.

When using this command, you can get Help on the following types of items:
• context-sensitive help on dialogs and dialog controls
• context-sensitive help on Toolbar buttons
• Tool Tips on modal and modeless dialogs
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XP Style
ArchiCAD 10 is integrated into the Windows XP environment as much as possible. Every button, pop 
up menu and other controls will look and behave according to the standards of Windows XP; also, 
the current Windows XP Theme settings will be automatically applied to ArchiCAD.

New Menu Structure, New Commands
ArchiCAD 10 has a greatly revised menu structure to accommodate many new features as well as 
previously hidden commands and former PlotMaker functions. Menu commands are placed into 
logical groups and sub groups. For example, the Design menu contains those items that you would 
use most while designing in Floor Plan, Section/Elevation and 3D Window Views. The Document 
menu contains items most relevant to the documentation phase of the Architectural practice. The 
View menu contains options and commands that you usually use to view the Project or change how 
it is viewed.
Features which earlier were available only through shortcuts are now also available as menu 
commands:
• Eyedropper, Syringe, Trim, Adjust tools are accessible from the menu; they can be placed on any 

toolbar
• Every page of the Work Environment dialog has a menu command, making it possible to access 

the right part of the dialog box using shortcuts.
The following functions are also available as menu commands:
• On-Screen Display Options commands
• 3D Navigation commands
• Commands related to Complex Elements and Profiles
• Commands related to Layouts, Master Layouts, the Layout Book and navigation within these
• List of every possible View, List, Schedule, Layout, Index in ArchiCAD
• Recent Lists (Drawings, Layouts, Projects, Schedules, Stories etc.)
• Commands relating to the Coordinate Box (Grid, Grid Snap, Coordinates, Gravity, Reference 

Levels) and the Control Box (Relative Construction Methods, Special Snap Points) 
All new Commands (both those related to new features and those which were not commands in 
earlier versions of ArchiCAD) are marked (displayed in blue) in the Work Environment Settings 
dialog. In Command Layout Schemes > Menus, a new sorting option is available in the List drop-
down list: All new commands in alphabetical order.
For a summary of new shortcuts and shortcut changes in ArchiCAD 10, see http://
www.archicadwiki.com/TechNotes/Shortcut_changes_in_AC10.

Getting Around Within Palettes
The Toolbox and Info box almost always contain more information than their size on the screen. In 
ArchiCAD 10, a scrollbar in the Toolbox and Info Box (whether docked or floating) give a clear 
indication that there is more information available than is currently displayed. 
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If you do not see the scroll bar at the right side of the Palette (or along its bottom in case it is docked 
horizontally), increase the width (or height in case of horizontal docked position) of the Toolbox or 
Info Box and the scrollbar will appear.

Shortcut commands to switch to Next/Previous item in Pet Palettes: when the Pet Palette of any 
Tool is visible, it is possible to switch to the next item available in the Pet Palette (default shortcut: 
F), or to switch to the previous item available in the Pet Palette (default shortcut: SHIFT+F). This is 
handy because you will not need to move your cursor over to the Pet Palette to select another 
command. Instead you can switch to the desired command using the keyboard, while keeping your 
mouse over the edited element.

Measure Tool
Use the Measure command (keyboard shortcut: M) to measure the distance, angle, and X/Y 
coordinates between two points. Activate the command and click the Reference point from which 
you wish to measure and start moving the cursor. An Element Information Pop-up will appear, 
showing Distance, Angle, X Coordinate and Y Coordinate from the Reference Point.
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The command may be used in 3D, too. In this case, even more data is displayed in the Info Tag 
(Projection and Z Coordinate). Projection here means that the measured spatial distance is 
projected onto the X-Y plane of the Reference Point and its value reflects this projected distance.

Work Environment and Preferences
ArchiCAD 10’s Work Environment setup dialog was re-organized to serve its existing functionality 
better and integrate the new functions seamlessly: 
• Company Standards are now separated from individual User Preferences and form a separate 

scheme. The reorganized Work Environment will help CAD Managers find and control all office-
related settings in one separate Scheme. Therefore, a usual Work Environment Profile will be a 
set of 6 Schemes (as opposed to 5 Schemes in ArchiCAD 9).

• Dedicated Work Environments will be available out of the box for different stages of the 
workflow (Layouting, Visualization)

• ArchiCAD 10 supports the use of Custom Work Environment Profiles and Schemes from 
ArchiCAD 9:
- These profiles and schemes can be imported into ArchiCAD 10 during installation or at any time 
after the installation.
- To continue your update, go to Command Layout Schemes > Menus and view the All new 
commands in alphabetical order sorting option. This is an easy way to identify new commands 
and add them to your imported profiles and schemes, if you like.

Floor Plan and Section Attributes on the User 
Interface
ArchiCAD 10’s new modeling methods result in additional attributes for the model elements. Floor 
Plan and Section display of construction elements has been redesigned in accordance with the 
Modeling Freedom enhancements: complex construction elements can be assigned separate pen-, 
line type- and fill attributes to enable the differentiation of cut, outline and overhead parts of a 
single element.
All these attributes are accessible from the Floor Plan and Section panel, from the Info Box or the 
Tool Settings dialog box.
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The relevant attribute selection controls in the Floor Plan and Section panel are collected in a 
scrollable list, and grouped into the following categories:
• Structure: Composites, Profiles and attributes inherited from Profile of Composite Structure 

definition (Profiles apply to Walls, Beams and Columns; Composites apply to Walls, Slabs and 
Roofs)

• Cut Surfaces: Cut Fills, Lines and Pens
• Outlines: Outlines above and below the Floor Plan Cut Plane (uncut and overhead lines)
• Symbols: End Lines, Crosshairs, Center Lines, etc. (for Library Parts, Beams, Columns)
• Cover Fills: Cover Fills, Lines and Pens (for Slabs, Roofs, and Meshes.

Selection and Identification
Identifying and selecting something is the most commonly used CAD operation, but this task 
becomes more difficult as the building size and complexity increases, with several elements 
overlapping each other or sharing the same edge or area. The new features in this section are 
aimed at reducing the time required for these frequent operations, and so increasing efficiency.

Element Information Highlight (Pre-selection)
With the new element information highlight feature, you will always know what will be selected 
even before doing the selection. As the mouse moves over an element, press Shift to receive visual 
feedback:
• The element edges and surfaces will change to a user-configurable highlight color drawn with a 

thick line
• An Element Information Pop-up (Info tag) will show relevant information about the highlighted 

element.
If the mouse hovers over multiple or overlapping elements and you press Shift to display the 
Highlight, then the Information Pop-up displays the Multiple Elements (TAB) text at the bottom of 
the Info Pop-up Box. By pressing TAB in succession, you can cycle through the elements and 
highlight/select only the desired one.
This feature is extremely useful if the project contains:
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• large number of elements that are similar in appearance – e.g. floor and ceiling in a room
• partly or completely overlapping elements in any view

You can also select multiple overlapping elements using this method. If you have multiple 
overlapping elements, use the TAB key until the Element Information Pop-up displays info about the 
element you wish to select. Keep pressing TAB to cycle among other elements and add them to your 
selection, first pressing the SHIFT key and then clicking. (Use SHIFT+click again to deselect already 
selected elements.)
It should be noted that Nodes of element take precedence over Edges; Edges of elements take 
precedence over Surfaces. Taking precedence means that if the cursor hovers over a point where 
multiple elements are found, it will find the type that has higher precedence.
For example, if you have your mouse cursor over the edge of a Wall which is covered by the surface 
of a Roof, the Wall will be found even if the Roof otherwise covers it.
 The same element highlight method is also used in the following cases, but you do not need to 
press Shift:
• When defining dimension nodes, this method will highlight elements prior to clicking them. 

Here you again have the possibility to cycle through elements with the TAB key. For example, 
you have a Wall Corner and you wish to associate you Dimension Point with the Wall that will be 
perpendicular to the Dimension Line, and not the other Wall. Move the cursor over the Corner 
and press TAB until the desired Wall is pre-selected. Then click to place the Dimension Point and 
it will be associated to the Wall you wanted.

• In parameter transfer mode, ArchiCAD will highlight elements prior to picking up or transferring 
parameters. You will see which element’s parameters will be picked up (TAB can be used here as 
well to pick the desired one), and to which element it will be transferred. Since elements are 
pre-selected, you no longer need to find a node or edge of an element for Parameter Transfer, 
you can also move the cursor over any position of their area for an element to be pre-selected 
and its parameters picked/transferred.
Note: These highlights (identifying related elements for Parameter Transfer and Dimensioning 
functions) will appear if the “Highlight contours of related element(s)” checkbox is active in 
Options > Work Environment > Selection and Element Information. For these highlights, you 
need not press Shift.
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Highlight Selected Elements
As you select an element, ArchiCAD will highlight its edges and will also display its area with a user-
defined highlight Fill, making it easy to see which Element(s) is/are currently selected. The Element 
Information Pop-up also appears.
This feature also works in the 3D Window with a slight difference: when the Internal Engine is 
selected for the 3D Window, only the wire-frame edges of the selected Element will be highlighted. 
When you are using the OpenGL Engine in shaded view, it will work the same way as in the Floor 
Plan: edges and all visible surfaces will be highlighted.

Setting Selection and Element Information Preferences
The Selection and Element Information page of Work Environment provides options related to pre-
selection and selection.

If you check the Highlight selected elements’ contours box, all contours (including contours of 
holes) of selected elements will be highlighted. Uncheck this checkbox if you do not need this 
feature.
With the Contour color selection field, specify the color in which contours of selected elements 
should be displayed. You can also check the Bold contours box if desired.
If you also check the Highlight selected elements’ surfaces checkbox, the Floor Plan areas/surfaces 
of selected elements will also be colored. Uncheck the checkbox if you wish not to use this feature. 
Use the Surface color selection field to specify in which color areas/surfaces of selected elements 
should be displayed.

Note: Surface highlight in 3D is possible only with the OpenGL Engine when shaded view is used. 
You can use the Transparency in Shaded OpenGL view slider to set how transparent or opaque 
this surface fill should be in 3D. This field has no effect on the Floor Plan.
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The Element information portion has controls related to pre-selection and the display of the 
Element Information Pop-up. 
Check the Highlight element contour lines before selection occurs checkbox to activate the 
Element Information Highlight (pre-selection) feature. Specify Highlight color in the selection field. 
The Highlight contours of relate element(s) when placing or editing element checkbox lets you 
highlight elements when transferring parameters of elements (ALT-click and CTRL-ALT-click 
[Windows] /OPT-click and CMD-OPT-click [MacOS]) or placing Dimensions. Use the Highlight color 
selection field below it to set the color in which these highlight should appear. This is useful so the 
two types of pre-selection will not be confused.
By checking or un-checking the Enable element information Pop-up checkbox, you can specify 
whether the Element Information Pop-up should appear or not. In the Pop-up appears after field, 
set how much time should elapse after you stop your mouse over an element before the pop-up 
appears.
If you check the Show short info only checkbox, the Element Information Pop-up will show only the 
type of the selected element, plus the Layer it is placed only (except for Windows/Door, which are 
on the same Layer as their parent Wall).
If you check the Use Tracker colors checkbox, the Element Information Pop-up will appear with the 
same Foreground and Background color as the Tracker (this is visible only if these colors of the 
Tracker’s are set to values different from its factory color settings).
For information on the Tracker, see “In-Place Numeric Input Using Tracker” on page 315.
If you check the Use small font checkbox, texts in the Element Information Pop-up will appear in 
using smaller fonts sizes so that the Pop-up takes up less space.

Guide Lines
ArchiCAD 10 simplifies and improves element input with a new feature called Guide Lines. Guide 
Lines will automatically appear whenever you are in the process of creating a new element or 
editing an existing element. Guide Lines enable you to find accurate drafting and snapping lines, 
points, arcs and directions without using keyboard shortcuts or the Control Box.
You may use Guide Lines to
• Snap the cursor to these Guide Lines the same way you snap to real elements: you can snap to 

edges, endpoints, intersection points, special snap points, tangent points etc.
• Invoke automatic, relative Guide Lines on the fly (relative to the active Guide Line) and snapping 

the cursor to those.
• Constrain the cursor to the nearest Guide Line by pressing Shift.

Note: Guide Lines and Guide Circles are not selectable.
Guide Lines may be used in any of the Drawing-type windows of ArchiCAD (Floor Plan, Section/
Elevation Windows, Detail Drawing Windows, Layouts), but not in the 3D Window. Guide Lines are 
displayed as long as the current element creation or modification process is in progress. For 
example, if you placed Guide Lines while drawing a Polyline, those Guide Lines will remain displayed 
until you finish constructing the whole Polyline.
There are two types of Guide Lines: Main-direction Guide Lines and Relative-direction Guide Lines.
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The direction or angle of Main-direction Guide Lines is determined based on the drawing 
environment (e.g. horizontal/vertical direction, skewed grid etc.) Relative-direction Guide Lines are 
those that are created based on the position of the active Guide Line.
When there are Guide Lines placed on the drawing, one of them is always the active Guide Line. The 
active Guide is always drawn thicker than other Guide Lines. You can make any displayed Guide Line 
active by moving your cursor over it and in about 1 second it will become the active Guide Line 
(shown as a thicker line), and the previously active Guide Line will turn back to an ordinary Guide 
Line.

Setting Guide Lines Preferences
A new page in the Work Environment dialog box lets you set all your Guide Lines preferences.

To show or hide Guide Lines in the project, click the Show Guide Lines button on or off. If it is OFF, 
all options in this page will be grayed, and no Guide Lines will be displayed while you work on the 
project.
The Extend Edges and Arcs if the mouse stops moving for field lets you specify a value in seconds. 
If you move your cursor over any line or arc that is recognized by ArchiCAD as an edge (as indicated 
by the Mercedes cursor form) - e.g. a side of a Wall, edges of polygonal elements - a new Guide Line 
will appear. The newly created Guide Line will become the active Guide Line.
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Main-Direction Guide Lines
Show the following Main-direction Guide Lines if the mouse stops for: Click this button on enable 
Main-direction Guide Lines and choose from the options belonging to this category. Set a value in 
seconds for the amount of time that will elapse before this category of Guide Lines appears.
The next four checkboxes are the Main Directions.
Horizontal-vertical: This set of Guide Lines appears as in the illustration below.

Several possible Guide Lines can be created based on the node you found - these are “multiple-
choice” Guide Lines. (You can set your color preference for both single and multiple-choice Guide 
Line colors – more about this later.) In this case you need to move your cursor toward a direction. 
ArchiCAD will create the Guide Line that is closest to the direction you moved your mouse and 
delete all other offered possible choices. In the above example, if you move your mouse downward, 
then the Vertical Guide Line will be created, since it is closer to your mouse position than 
Horizontal, the other possible choice. However, this will only happen if you move your mouse 
cursor close enough to the desired Guide Line (as defined by Cursor Snap Range setting in the Work 
Environment).

You can also move your mouse away from the node so that it remains far from all offered Guide 
Lines. If this happens, these Guide Lines will disappear and none of them will stay there - the 
program assumes you do not wish to choose any of the offered Guide Lines.
Horizontal-vertical to Skewed Grid: This works the same way as the previous option, only it applies 
when a Skewed Grid is active. It will display the possible Guide Lines parallel to and perpendicular to 
the main direction of the Skewed Grid.
In the example below, both the Horizontal-vertical and the Horizontal-vertical to Skewed Grid 
options are enabled, and a Skewed Grid is specified and used.
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Consequently, ArchiCAD offers the following possible Guide Lines:

Again, you need to move your mouse along the Guide Line you wish to be drawn. Let’s say you 
move it toward the left, along the bottom of the existing green line to get the Guide Line parallel to 
the horizontal of the Skewed Grid. This is the result:

Fixed Angle: Check this box to specify an arbitrary angle (generally, an angle you use frequently); 
the two Guide Lines along this angle and its perpendicular angle will be offered by ArchiCAD when a 
node is found. For example, 45° and 135° may be used. In the example below, ArchiCAD offers the 
following Guide Lines with both Horizontal-vertical and Fixed Angle checked:

You can also check the Relative to Skewed Grid checkbox, which will make this Main-direction 
Guide Line work in case a Skewed Grid is used. Note that this checkbox works as a toggle. This 
means that in case it is checked, it will work when a Skewed Grid is used, but will not be offered 
when a normal Horizontal-Vertical Grid is used.

Input vector Angle and Length: Whenever you are inputting a segment, and you find a node with 
your mouse cursor, the direction and the radius of the last input vector will be offered for you to 
choose from.
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The above Main-direction Guide Line options may be combined. In this case, all that apply will be 
displayed at the node you found.

Relative-direction Guide Lines
Show the following Relative-direction Guide Lines if the mouse stops for: Click to switch this group 
of Guide Lines ON and OFF. Set a value in seconds for the amount of time that will elapse before this 
category of Guide Lines appears. 
The next four checkboxes specify which Guide Lines should appear relative to the active Guide Line: 
• parallel to the active Guide Line
• perpendicular to the active Guide Line
• Guide Line that is the angle bisector line of two other intersecting Guide Lines and
• tangent to the active Guide Line (in case it is an Arc or Circle), respectively. 
You can enable or disable any of these independently. 
When a Relative-direction Guide Line is displayed, there are visual clues as to what kind of Relative-
direction Guide Line is found.
In the picture below, the offered Guide Line next to the mouse cursor shows a Parallel sign.

At the bottom of this illustration, the near-vertical offered Guide Line displays a Perpendicular sign.
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On the following image, tangent signs are visible on the Relative-direction Guide Line offered for 
the circular active Guide Line.

On the image below, Bisector signs can be seen on two Relative-direction Guide Lines offered at the 
intersection of two existing Guide Lines.

Incremental Guide Lines
Show Incremental Guide Lines in increments of: Use this button to enable and disable this feature. 
Specify the angle increment in the field to the right. ArchiCAD will display Guide Lines at every 
increment of the specified angle based on the Horizontal-Vertical coordinate system.
If you check the Relative to active Guide Line checkbox, the angle increments will always be 
displayed relative to the currently active Guide Line. If you make another Guide Line active in the 
middle of an operation, all increments will henceforth be based on that Guide Line.
Incremental Guide lines also have their own sign: see the Guide Line in the image below.

Incremental Guide Lines will always originate from the current User Origin/Edit Origin. If you 
relocate your User Origin/Edit Origin during an operation, Incremental Guide Lines will start 
appearing based on that location.
In the image below, the User Origin was relocated to the left side node of an existing Line, and 
Incremental Guide Lines appear accordingly.
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Guide Line Color
Use the last two fields of the dialog to set Guide Line color. In the first field, specify the color used 
when a single Guide Line is the only option based on the edge/node you found with your mouse. In 
the second field, specify the color used when multiple possible Guide Lines may be created (multi-
choice Guide Lines).
If you find a node and more than one group of Guide Lines is available, the Show next Guide Line 
Group command will display the next group without waiting for the defined time interval.
In the following example, the Line is extended by a Guide Line. We find the right end of the Line. 
Here, various groups of Guide Lines will appear when their timing settings dictate it. First, a 
Relative-direction Guide Line appears: a Guide Line perpendicular to the active Guide Line.

If you click the keyboard shortcut for the Show next Guide Line Group command, ArchiCAD will 
immediately display the next Guide Line group and you do not have to wait for the specified time 
interval to elapse. You can use the keyboard shortcut successively to cycle through available Guide 
Line groups.

Guide Line Commands in the Standard Toolbar
The Standard toolbar contains a group of commands related to Guide Lines.

The main icon on the toolbar turns the Guide Line function on and off. 
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Click the arrow to access additional commands:

Create Guide Line Segment: This is handy if you want to create a Guide Line of a fixed length during 
element input.
If you need a special line segment during element input, click Create Guide Line Segment, draw the 
Guide Line Segment and continue creating your element.
For example, in the image below, you might want to draw a horizontal Line from point A, and you 
want it to end where it intersects the Line originating from point B and being perpendicular to line 
c.
You can start drawing the line,

then click the Create Guide Line Segment command, and draw the Guide Line Segment,

and then finish drawing your Line.

Remove All Guide Lines: Click this command to remove all Guide Lines from the screen.
The rest of the commands in this toolbar group toggle the state of any of the three Guide Line 
groups (Main-direction Guide Lines, Relative-direction Guide Lines and Incremental Angles).
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Guide Line Commands in Context Menu
When any Guide Lines are displayed, the Remove Guide Line and the Remove all Guide Lines 
commands are available from the context menu anywhere on screen. You can remove any displayed 
Guide Line by going over it with the mouse cursor (so the Mercedes cursor appears) and choosing 
Remove Guide Line from the Context Menu. Or you can right-click anywhere in the drawing and 
choose Remove all Guide Lines to clear all Guide Lines from the screen.
While you are creating or editing elements, three additional commands are available in the Context 
Menu. The first is Convert to Guide Line Segment. It will take the line segment between the last 
placed node and the position of your mouse cursor and create a Guide Line Segment from it. After 
placing the Guide Line Segment, you can continue your element operation.

The second one is called Place Guide Line. It will take the line segment between the last placed 
node and the position of your mouse cursor and create a Guide Line from it (infinite). This is a useful 
option for creating a lasting Guide Line from an Incremental Angle Guide Line. The last one is called 
Place Guide Circle. This command takes the line segment between the last placed node and the 
position of your mouse cursor and creates a Guide Circle from it.
These latter three commands have the advantage that they let you create Guide Lines and Guide 
Circles not offered by the program.
There is another trick you should know about. If you cancel an operation, or press Esc 
(accomplishes the same), or delete the last created segment with Backspace, the Guide Lines will 
not disappear. They disappear only after an element has been created or modified.

Note: Guide Line on/off controls and some related commands are also available from the 
Control Box.

Guide Lines examples
A) Find the angle bisector line between two Walls that do not meet:
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Find the edges of both Walls, so that the program displays Guide Lines along those edges.

Then, find the intersection point of the two Guide Lines. Several relative Guide Lines are offered by 
the program. 

Move your mouse cursor toward the one that has the Angle Bisector icon over it. The desired Guide 
Line will be displayed by the program.

B) Place a Guide Circle:
A Guide Circle may be placed when the creation or editing of an element is already in progress.
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Find a node, and a Guide Circle will appear as one of the offered Guide Lines.

Move your mouse cursor toward the offered Guide Circle and the program will display it.

You can also, at any location, simply press ALT+R (Windows) / OPT+R (MacOS) to lock the Radius. In 
this case, a Guide Circle will automatically be created with that Radius.

You can also specify the Radius of the Guide Line by pressing R, then numerically specifying the 
Radius, and then pressing ALT+R (Windows) / OPT+R (Mac) to lock the Radius at that value (4000 in 
the example).
New Features in ARCHICAD 8-20 311



New Features in ArchiCAD 10
C) Create a tangent Circle to both Lines with a radius of 5000 mm:

There are several things you know about the center of the desired line. It is located on the Angle 
Bisector line of the two lines. Also, it is located on a line parallel to, and at a distance of 5000 mm 
from the upper line (or the lower line). With this, we know enough to create Guide Lines that let us 
do our job. We select the Circle tool. First, let’s draw the Guide Lines along the two lines, so we will 
be able to find their Intersection point later.

Then draw a Guide Line Segment downward from the right end of the upper line, perpendicular to 
the upper line.

Make the Guide Line along the upper line into the active Guide Line. Draw a Guide Line from the 
end point of the Guide Line Segment we just created, and make it parallel to the upper line.
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Now, move over the Intersection Point of the two Guide Lines along the Lines, and create their 
Angle Bisector Guide Line. Where the two latter-drawn Guide Lines intersect, we will find the center 
of our Circle.

Click their Intersection Point to specify the center of the Circle, then find the point where it is 
perpendicular to the upper line.

Click to specify the radius, and again to specify its Arc to be a full Circle. The Circle is drawn, and 
Guide Lines will be cleared as the operation ended.
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Element Snap
In ArchiCAD 10, the element snap feature has been enhanced. If you start dragging an element, you 
can snap any of its nodes to the edge or node of any other element. In the image below, we started 
dragging a Wall from its middle. The four corners of the Wall are marked with rectangles, indicating 
that these points of the Wall’s geometry can be snapped to any other node or edge. When 
ArchiCAD has found a node or edge for any of these nodes to snap to, that node’s rectangle will 
become thicker. In the image below, the upper right corner of the Wall can be snapped to a node of 
the Fill.

If your dragged element could be snapped to several other nodes or edges, the possible nodes will 
display a solid black rectangle. The node currently selected for snapping will have a thick hollow 
black rectangle marking.

In the above image, the lower left node of the Wall is selected for snapping, but the lower right and 
upper right ones are also possible choices. In such a case, use the SPACE key to cycle through all 
available choices and select the one you need. 
Any Special Snap point visible at the moment you start the Drag operation will also be available for 
snapping, increasing your available options. In the example below, your Wall’s Reference Line is in 
the center. (Special Snap has been set to 3 Divisions.) To enable the maximum number of Special 
Snap Points, move your mouse quickly over the Wall’s right edge, then its left edge, then its 
Reference Line: Special Snap Points will appear on all three. Once you start dragging the wall, all 
Special Snap Points will be available for snapping (see image below).
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Notes:
Element snap is available in all editing windows (Floor Plan, Section/Elevation Windows, Detail 
Drawing Windows, Layouts), as well as in the 3D Window.
When the cursor is constrained to an Angle, snap points will not be able to snap to other snap 
points, only to edges.
Grid Snap takes precedence over Element Snap; when Grid Snap is on, it is not possible to use 
Element Snap.
You can also use Element Snap to snap to nodes and edges of Guide Lines/Guide Line Segments.

In-Place Numeric Input Using Tracker
While Guide Lines offer improved graphics input, the Tracker, a new in-place numeric input feature, 
improves numeric input. You can choose to keep the Tracker always ON, or have it appear only 
when carrying out an input or editing operation. Five Tracker fields are available: X coordinate, Y 
coordinate, Z coordinate, Radius (Distance) and Angle. These are the same values you would find in 
the Coordinate Box. However, the Tracker always follows the cursor and gives better feedback. The 
Coordinate Box is still available in ArchiCAD 10, but is hidden by default.
The Tracker has two modes: running mode and editing mode
Running Mode is displayed during graphical input: all values track the mouse pointer’s movement, 
none of them is editable, and the preferred value is shown in bold type. The preferred value is the 
value last edited or used. So, if the last value you modified was the X coordinate, it will be displayed 
in bold type.

The Tracker changes to Editing Mode when any numeric input starts. It can be started in several 
ways:
• Type a number for the default coordinate (the one shown in bold.) The cursor will automatically 

jump to the Tracker and enter the values.
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Note: This input method works if the “Enable direct input into Tracker” box is checked in 
Options > Work Environment > Tracker and Coordinate Input. This is the default setting.

• To enter numeric coordinates, type the shortcut of the desired coordinate (X, Y, Z or D/R or A) 
immediately followed by the value you intend to assign to it, for example X3 or Y-4. The + prefix 
is optional for positive values. You can type coordinate values in any order.
Notes: This input method works if the “Coordinate Shortcuts prefer Tracker” box is checked in 
Options > Work Environment > Tracker and Coordinate Input. This is the default setting.
If the Tracker is displayed in its compact form, typing the shortcut for a hidden parameter will 
display it.

• If you click the “+” or “-“ signs, you can start inputting the preferred value.

To switch to another field and make it the preferred value, either press the value’s shortcut key, or 
use the TAB key to cycle through all fields of the Tracker until you reach the one you want to use.
There are two small command buttons at the right side of the preferred value. 
• The first one (checkmark) is analogous to the OK button in the Control box to the Enter key: the 

value you typed is entered.
• The other button, Mark position, lets you create a Guide Line or Guide Circle based on the 

preferred value and the position of the mouse pointer. 
In the image below, we drew a Wall, then used the Mark position command of the Tracker on all 
four possible coordinates (X, Y, Radius and Angle) and the current location of the mouse pointer. For 
example, while the Y coordinate was the preferred value, clicking the Mark position command 
created a horizontal Guide Line at that Y coordinate. While Radius is the preferred field, Mark 
Position creates a Guide Circle with that Radius.

The operation of the Mark position command is similar to the existing Lock Coordinate command 
of the Coordinate Box, with a small difference. If you use the Lock Coordinate command (e.g. Alt-X 
[Windows] or Opt-x [MacOS] to lock the X coordinate), it will create a Guide Line (just as the Mark 
position command did), but it will also lock the coordinate. 
In the Tracker you can choose whether to show X-Y coordinates or Radius and Angle (polar) 
coordinates. Whenever the Tracker is displayed, you can switch between the two modes using the 
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Prefer X-Y coordinates in Tracker / Prefer polar coordinates in Tracker commands in the Context 
Menu. 

In the Tracker there is also a small right arrow in the field of the Z coordinate.
Click it to access additional options related to the Z coordinate.

With the Show Z in Tracker command, you can turn the display of the Z coordinate in the Tracker 
OFF. This way only the preferred coordinates (X-Y coordinates or polar coordinates) will be visible in 
the Tracker when it is in running mode (in editing mode all coordinates are visible).
The Elevation Value Origin command lets you set the level relative to which Z values are displayed 
(this is useful in the 3D Window). 
The Gravity command lets you turn Gravity ON and OFF altogether. When the Gravity button is 
turned ON, you can enable (something) to gravitate to Slabs, Meshes or Roofs. Only one of them 
can be selected at a time.

During editing operations, the Tracker will intelligently show the relevant parameter(s) for the 
particular action. For example, when modifying a Column’s slant angle, the Tracker will display the 
relevant angle values as you edit. Other coordinate fields will be displayed as soon as you enter the 
Tracker or expand it.
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The Tracker can be also used when modifying editable hotspots of Library Parts, either in 2D or in 
the 3D Window.

The behavior and appearance of the Tracker is configurable through its own section in the Work 
Environment dialog. 
318 New Features in ARCHICAD 8-20



New Features in ArchiCAD 10
Use the Show Tracker to enable or disable Tracker altogether.
Note: If you disable Tracker, you can still use the Coordinate Box for numeric input. 

If Tracker is enabled, the Always radio button means the Tracker will be always visible. On-demand 
means it will appear only when you start creating or modifying an element, or when you invoke the 
Tracker by pressing one of the shortcut keys to its fields (“+”, “-“, X, Y etc.).
Use factory color settings checkbox controls the foreground/background color and opacity of the 
Tracker. If you check this checkbox, any change you made to the three fields below it will be reset to 
their default. 
• The Foreground color field lets you set the color of texts in the Tracker, and the frame of the 

Tracker. 
• The Background color field lets you set the background color of the Tracker. 
• The background opacity slider affects the background of the Tracker should be: the more 

transparent you set it, the more you will see from the content of the drawing below the Tracker.
If you check the Show Z value checkbox, the Z coordinate will always be displayed in the Tracker 
whenever it appears.
If Show parameter tags is enabled, a descriptive text will appear beside the names of fields in the 
Tracker for easier identification. On the image below, the Tracker on the left has Show parameter 
tags checkbox OFF, the one on the right has it ON.

Check the Show frame checkbox for a frame to appear around the Tracker.
If you check the Use small font checkbox, texts in the Tracker will be displayed with a smaller font.
In the Coordinate input logic portion you can define how various aspects of the numeric input 
should work. 
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If you check the Prefer polar coordinates in Tracker during straight vector input checkbox, the 
Tracker will display Radius and Angle when in running mode (The Prefer X-Y coordinates in Tracker 
/ Prefer polar coordinates in Tracker commands in the Context Menu of the Tracker will toggle the 
state of this checkbox).
Show X-Y Coordinates relative to User origin in Tracker: 
The Coordinate shortcuts prefer Tracker checkbox is effective when both the Coordinate Box and 
the Tracker are enabled. If this box is checked, pressing a coordinate shortcut key (e.g. X for X 
coordinates) will activate the proper field in the Tracker. If it is not checked, it will activate the 
proper field in the Coordinate Box.
If you check the Use relative angle measures checkbox, it will have an effect during element 
creation. Let us say you are creating a chain of Walls. If this checkbox is checked, the Angle value of 
Tracker will display the angle relative to the direction (angle) of the last drawn edge of the element 
being created. In the image below, the second segment of the Wall chain is at a 90-degree angle to 
the first Wall. This is shown by both the Angle field and a graphical feedback on the drawing (a 
feedback that does not appear when this checkbox is unchecked).

If you check the Use angle relative to the active Guide Line checkbox, the Angle field of the Tracker 
will display the angle relative to the direction of the active Guide Line (if there is one). Note that Use 
angle relative to the active Guide Line checkbox takes precedence over the Use relative angle 
measures checkbox, which means that if you are creating an element, and you have an already 
drawn edge of your element, plus you have a Guide Line, the angle will be shown relative to the 
Guide Line, not the previous edge of the element. This is graphically shown by the program. If there 
are no Guide Lines drawn or the active Guide Line is a Guide Circle, the Angle field is displayed 
relative to the horizontal direction.

If the Expand Tracker automatically during numeric input box is checked, the program will expand 
the Tracker to show all five fields. For example, as seen in the image above, polar coordinates are 
the preferred values, Z coordinates are not shown. If you now press the A key (or the shortcut key 
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for Angle), the Tracker will expand and will shown the X, Y and Z coordinates as well, although they 
are not the values you are inputting. 
Even if this box is unchecked, the Tracker will be expanded whenever you start editing a field that is 
not visible in the Tracker (such as the X coordinate in this example).

3D Window Display
ArchiCAD 10 has new options for displaying elements in the 3D Window.
While you are in the 3D Window, you can either display the selection you made on the Floor Plan or 
Section/Elevation Window (using the F5 key), or you can display all elements [using the CTRL+F5 
(Windows) / CMD+F5 (MacOS) key combination].
Use the commands in View > Elements in 3D View. The Show Selection/Marquee in 3D command 
(shortcut: F5) will enter the 3D Window and show elements that are currently selected (either by 
explicit selection with the Arrow Tool or by the Marquee). If both types of selection are in effect 
(elements are selected using the Arrow Tool and a Marquee area is also defined), the Arrow Tool 
selection takes precedence.
While in the 3D Window, you can select elements (either by the Arrow Tool or the Marquee) from 
among those currently displayed in the 3D Window, then use the Show Selection/Marquee 
command to display only this more limited selection – to further narrow down the set of elements 
displayed in 3D. 
At any point, you can use the Show all in 3D command [CTRL+F5 (Windows) / CMD+F5 (MacOS)] to 
display all elements in the 3D Window (but even if you choose “Show all”, settings in the Filter 
Elements in 3D and 3D Cutting Planes dialogs also apply, potentially limiting the display).
You may also use the F3 key to simply display or activate the 3D Window, and it will show its last 
state, regardless of any selection changes elsewhere. Activating the 3D Window is not a display 
command and does not regenerate the contents of the 3D Window, just brings it to the front.
Example: The following selection is made on the Floor Plan.

The Show Selection/Marquee in 3D command will result in the following display in the 3D 
Window:
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If you now choose the Show all in 3D command, this is what you get:

However, if at the beginning you made only the Marquee selection (not any explicit selection with 
the Arrow Tool), the Show Selection/Marquee command would give the following result in 3D:

3D Navigation
New 3D navigation features in ArchiCAD 10 incorporate popular techniques used in many computer 
games, while fitting them to meet the unique needs of our users. With these new features, 
ArchiCAD now has three different modes for 3D navigation.
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3D Orbit Mode
In ArchiCAD it is no longer necessary to switch back and forth between Navigation mode and Editing 
mode in the 3D Window: everything is available concurrently.
While you are editing a model the usual way (either in Perspective mode or in Axonometric mode), 
you can use your mouse to navigate in the model. Press the mouse wheel at any time, keep it 
pressed, and move your mouse up and down or left and right to pan the model in these directions. 
Or use your mouse wheel to zoom in and out of the model. If you press the SHIFT key on the 
keyboard and press your mouse wheel at the same time, the program will switch to Orbit mode (for 
as long as this combination is kept pressed). Orbit mode navigation means that you “hold” the 
building in your hands and look at it from any direction by rotating in with simple mouse 
movements. As long as you are in Orbit mode, the mouse pointer shape changes to indicate this 
(see image below).

Although you cannot edit elements while in Orbit mode, you can go in and out of Orbit mode even 
after you have started an editing operation (such as stretching a Window in a Wall).
You can also enter Orbit mode by clicking the Orbit mode button at the bottom of the 3D Window.

When you are in Orbit mode, your mouse pointer will change shape, and a crosshair will also 
appear in the middle of the 3D Window. The function of the crosshair is to show you the center 
point around which rotation occurs in Orbit mode. 
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If the 3D Window shows the model in such a way that the crosshair is not on any model surface, 
ArchiCAD will calculate the geometric middle point of the complete model shown in the 3D 
Window, and will consider that point as the center of rotation.
You can exit Orbit mode any time by again clicking the Orbit mode button at the bottom of the 3D 
Window. You also enter and exit Orbit mode by using either the 3D Visualization Toolbar or the 
appropriate command in the Context Menu (right-click).

3D Explore Mode
Another feature is the 3D Explore mode, which gives you the impression of going inside the 
building, walking through it and exploring its various parts.
This mode is available only in perspective mode. You can enter it by using the View > Explore Model 
command or the Explore mode button at the bottom of the 3D window. When you enter 3D Explore 
mode, an instruction dialog pops up, listing the various keys and mouse movements available in this 
mode.
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When in 3D Explore mode, you can move your mouse around to look around in the model. You can 
look around in a complete sphere in every direction. 
Move forward with the Arrow Up or W key, backward with the Arrow Down or S keys, move to the 
left laterally (not rotate left) with the Left Arrow or A keys, and move laterally to the right with the 
Right Arrow or D keys. You can move up and down vertically (regardless of which direction you 
look) with the PgUp and PgDn keys, respectively.
The F key toggles Fly mode. If you are not in Fly mode, moving back and forth with the Arrow Up/W 
and Arrow Down/S keys does not change the height of the camera. Your camera will be moving on 
a horizontal plane. 
If you switch to Fly mode, the height of the camera will change with your forward or backward 
movement, and you will keep looking toward the exact same point in the model (this point is always 
located at the center of the 3D Window). This behavior simulates flying: if the nose of your plane is 
pointing downward, you will descend with forward movement (and in ArchiCAD 10, you can also 
ascend with backward movement). Similarly, if a higher or lower point is located at the center of 
your 3D Window, moving forward will increase or decrease, respectively, the height of the camera 
just as if you were sitting in an airplane.
To increase your movement speed, press the SHIFT key and keep it pressed. You can increase and 
decrease you base speed using the + and – keys, respectively. The SHIFT key will always increase the 
speed relative to the current base speed.
To exit 3D Explore mode, click with the mouse at any time or press the Esc key.
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Classic (AC9) 3D Navigation
The controls of the 3D Navigation Palette, familiar to users of previous versions, have been replaced 
by standard menu commands in the Navigation Toolbar, so you can still access the commands 
located on it (such as Look to, Reset Roll Angle etc.)
Another 3D Window improvement is faster analytical shadow casting. Vector-based shadow casting 
has become significantly faster since ArchiCAD 9. The speed increase is especially evident in larger 
models. Due to various optimizations, 3D model generation also requires much less memory than 
previous versions. The new structure and methods have also solved several geometry and 
algorithmic errors of previous versions.
OpenGL navigation in the 3D Window has also been improved, via two new features.
The first is the incorporation of an OpenGL feature called Culling. This means that when you are 
navigating in 3D, OpenGL always calculates which parts of the whole 3D model will not be visible for 
the current frame at the current camera position, and will not calculate with those for that frame. 
This can increase the speed considerably, especially if you consider how much data you don’t have 
to process when your camera position puts most of the building behind the camera. Culling is part 
of OpenGL, so all graphics cards that support OpenGL (practically all graphics cards today) will be 
able to take advantage of this feature.
The other feature is called Occlusion Check. This is another OpenGL feature, but not all graphics 
cards support it. Occlusion Check checks which parts of the model are positioned in such a way that 
they will not be visible, because another part of the model covers them completely from the 
camera. There is no need to calculate such non-visible elements.
The reason this feature is incorporated is related to a new option in the OpenGL Options dialog, 
accessible from the 3D Window Settings dialog.

If you check the Customize feedback speed in Frames per Second checkbox, you can set a value 
either using the slider or by entering a value in the field to the right. Possible values range from 1 to 
25 Frames per Second.
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If you use this option, ArchiCAD will always maintain a constant frame rate while navigating in the 
3D Window using OpenGL. This means that you will navigate without the 3D Window slowing down 
or its movement becoming jerky. The way ArchiCAD accomplishes this is by calculating how much 
time it has to draw one frame in OpenGL. Then it starts to calculate and draw elements, starting 
from the middle and going outward. If the available time is enough, it will draw the whole model. If 
it cannot finish that frame, elements to the side will not be drawn. Occlusion Check is also done, if 
the graphics card supports it. Using these techniques, the program can maintain a constant frame 
rate.
The frame rate you should set depends on how complicated your model is and how powerful your 
graphics card is. 15 Frames per Second usually provides an acceptable result.
Always display all elements within the following radius: This slider fine-tunes your feedback speed 
preference: regardless of the effect of the Frames per Second set above (which may result in some 
elements not being shown during navigation), you can set a minimum radius here, within which all 
elements will be shown during navigation. (Set the radius either numerically or by using the slider.)
The new OpenGL features will noticeably improve performance when working with large and 
complicated models. The effect of the above features depends on the speed capability of your 
graphics card. With a smaller project, a lower-performance card can also suffice. But with big 
projects, the faster the graphics card, the better.

Notes:  ArchiCAD performs Occlusion Check on whole elements. This can be of interest if you 
have saved a whole building as a GDL Object and placed it into another Project as an Object. In 
such a case, ArchiCAD will show or hide the whole Object.
This is not the case with Hotlinked Modules. Although they are treated as a Group, this does not 
affect how they are generated in 3D and Occlusion Check is performed on them piece by piece.

Improved Section/Elevation Functions

Continuous Update
When a Section/Elevation is set to Autorebuild Model in its Settings dialog, the Section/Elevation 
will be updated continually with every modification: the result of each change will be instantly 
visible.
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However, in large plans, continuous auto-redraw can cause slowdowns. If you prefer that your 
Section/Elevation window be rebuilt only when it is opened or brought to the front of the screen 
(the way it worked in ArchiCAD 9), go to the Options >Project Preferences > Miscellaneous tab page 
and uncheck the “Update Autorebuild Model...” checkbox. 

Shaded Sections/Elevations
In ArchiCAD 10, you can now use shading on elements in Section/Elevation Windows.
To activate shading in Section/Elevation Windows, check the Fill Uncut Surfaces with box in the 
Model Effects panel of the Section/Elevation Settings dialog box.

You have two options here.
If you choose the Uniform Pencolor radio button, ArchiCAD will shade every single surface that is 
not cut and is not part of the Distant Area with a certain color. Choose a Pencolor from the controls 
at right.
If you choose Elements’ Own Material Colors, every element will be shaded using the color of its 
Material. Surfaces will look the same as they would in the 3D Window in Shaded View (while using 
the Internal 3D Engine). The program will calculate colors of vectorial shadows based on the 
materials’ surface colors.
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If you choose Uniform Pencolor, and Vectorial Sun Shadows are enabled, the Shadow Polygon 
chooser controls will also be enabled so you can set the shadow’s Fill type, Fill Pattern Pen and Fill 
Background Pen.

If your Section includes a Distant Area, the same shading options are available in the Distant Area 
Options panel. However, to enable a shading option for the Distant Area, you must first enable the 
same option type in the Model Effects panel. If you disable it in Model Effects, it will become 
disabled in Distant Area Options, too. 
In the image below, uncut surfaces were set to be shaded by their own color, and surfaces in the 
Distant Area were set to be shaded by a light blue color.

Story Levels in Sections/Elevations
Story Level lines can now be displayed on Section/Elevation drawings, giving a graphical 
representation of story levels. 
To display Story Level lines, go to the General panel’s new drop-down list in Section/Elevation 
Settings: this is the Show Stories on this Section field.
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If you select None, no Story Levels will be displayed on the Section/Elevation. In this case, the 
Stories on Section panel of the dialog will be grayed.
If you choose the Display Only option, Story Levels will be displayed in the on-screen Section/
Elevation, but will not be visible on printed output.
If you choose the Display & Output option, the Story Levels will be displayed both on screen 
Section/Elevation and also appear on the printed output (including PDF files saved through a printer 
driver).
The Stories on Section panel contains all settings related to Story Level Markers.

At the top of this panel, specify the line type and pen color of the Story Level Marker (the main line 
of the marker).
Use the two checkboxes in the Markers area either show or hide one or both Story Markers at the 
end of Story Level line.

Note: Each Story Level line has Story Markers located on either side of the Story Level. Since 
these Markers are GDL objects, they can have their own separate user interface (as specified by 
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the User Interface Script of the Marker object), which can be customized in the Story Handle 
marker Custom Settings panel of the dialog.

In the Offset to Section boundary area below, specify the how far beyond the end of the Section 
boundary the Story Level line should be drawn.
The pop-up field lets you choose a predefined Story Marker, which is a GDL object. Use the usual 
controls to specify the Pen color of the Story Marker; the font type and size for text portions of the 
Story Marker, the code page and other text formatting options, plus the height of the Elevation 
Marker used with the Story Handle Marker.
The fields below contain the parameters of the Story Marker, along with a Preview Picture. If you 
check Use Symbol Colors, the Story Marker will use the colors defined within its GDL code instead 
of the single color chosen in the pencolor control of this panel.

Story Settings and Story Level Lines
The Story Settings dialog box now includes a new checkbox at the name of each Story.

Story Level lines will appear in Section/Elevation views only for those stories which are checked 
(and if Show Story Levels is enabled in Section/Elevation Settings). This option is useful if, for 
example, you have Stories in your Project which are not model Stories (e.g. the lowest story might 
contain the Site Plan of the Project), for which you do not need Story Levels displayed in Section.

Editing Story Level Lines
To edit Story Levels, right-click anywhere in the Section/Elevation Window to access the Edit Story 
Levels command in the context menu. The appearing palette has four options for graphically editing 
story levels. You will modify the level of Stories and then click the OK button to apply all changes at 
once. As long as you are in Story Level editing mode, you cannot perform any other operations. 
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The leftmost button is the Edit only the chosen Level command: you can modify only the selected 
Level. You cannot raise it higher than the Level of the Story above it, and you cannot push it lower 
than the Level of the Story below it. 
The second button is the Edit all Levels below the chosen Level command: when you modify the 
selected Level, all Levels below it (even below-ground Levels) will keep their relative distance to 
each other. You cannot raise the selected Level raise it higher than the Level of the Story above it.
The third button is the Edit all Levels above the chosen Level command: when you modify the 
selected Level, all Levels above it will keep their relative distance to each other. You cannot raise it 
lower than the Level of the Story below it.
The fourth button is the Edit all Levels command: when you modify the selected Level, all Levels 
both above and below it will keep their relative distance to each other. You can raise or lower the 
height to any extent, without restriction. 
While editing a Level (shown by the rubber-band line of the Story Level), you may switch from one 
type of editing mode to another and continue the operation.
After you finish setting Story Levels, click the OK button, at which time all your changes will be 
carried out in one step. 
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Note that elements are always placed relative to the height of the Story they are placed on. So 
changing Story Levels on a model that already has its geometry set according to existing Story 
Levels will require you to adjust their geometry once again (e.g. modifying the height of Walls and 
Column etc.)
The Hide Story Levels in this Section/Elevation command, also available in the context menu, 
means that no Story Level line will be shown in the current Section/Elevation. This is the same 
effect as setting the Show Stories on this Section field to None in the General panel of the Section/
Elevation Settings dialog. To restore Story Level Lines, you must set the Show Stories on this Section 
field to Display Only or Display & Output.
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Miscellaneous

Project File Compression
When saving ArchiCAD Project Files, you now have the option of saving them files with ZIP 
compression.
The Save (or Save As) dialog for an Untitled Project includes the Options button. Click it to access 
the Save Options dialog box. 

Use the checkbox to specify whether you want ArchiCAD to save the current ArchiCAD Project file 
with ZIP compression or not.
Once a file is saved as compressed, it will be automatically decompressed when you open it and 
recompressed when you save it.
File compression is also available when saving as ArchiCAD Archive Project (*.PLA), ArchiCAD 
Project Template (*.TPL), ArchiCAD TeamWork Project (*.PLP), ArchiCAD TeamWork Draft (*.PLC) 
and AC TeamWork Draft Archive (*.PCA).
If you saved an ArchiCAD Project in zipped form, and you no longer want to use compression, you 
may use the Save As command and uncheck the Compress file checkbox in the Options dialog.
Using this ZIP-technology has the advantage of reducing the sizes of ArchiCAD Project files to about 
1/3 of their original sizes, which can make the use of 3rd-party compression application 
unnecessary in such cases. 
Because sizes are smaller, these files will travel faster over the network, so compression gives the 
greatest advantage where network throughput is slow or limited.
Saving these ZIP-compressed files will take about 30% more time, but save about 70% on disk space 
and network traffic.
TeamWork Send-and-Receive operations will also benefit from this new feature, especially when 
the network is slow. The slower the network, the greater the expected gains from compression. 
With very fast networks, compression may not make an appreciable difference. 
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Library Container Files
Library Container Files are single files with the *.LCF extension. They can store a complete hierarchy 
(library folder structure) of libraries (individual objects, whole folder structures, PLA files, other LCF 
files). When you are in the Library Manager dialog box, all the various Libraries and Library Objects 
that you select to be loaded with the Project can all be saved into a single file, which preserves their 
exact hierarchy, and Library Parts will be loaded from the lowest levels within this Library Container 
File.
A Library Container File loads much faster - up to 2-3 times faster - than individual Libraries. For 
example, the standard ArchiCAD 10 Library will now come in a Library Container File instead of a 
PLA file.
Library Container Files may be used by Library Part developers to distribute their whole Library in a 
single file.
The File menu has two new commands related to Library Container Files.
Create Container will open a new dialog.

This dialog lists all currently loaded Libraries. Click the Create button to create the new Container 
file. In the appearing Save As dialog box, specify the name for the new Container File. File 
compression is available by clicking the Options button and checking the Compress File checkbox.
As shown in the above illustration, Library Container Files may contain other Containers.
The Extract a Container command lets you find and open a Library Container File. After you select 
the Container to be extracted, use the appearing dialog to set the location to which the extracted 
Library folder structure should be written. After you click OK, ArchiCAD will extract the Container 
file to the desired location.
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As with regular Libraries and individual Library Parts, you can use Library Manager to specify the 
Library Container Files you want to load.
When you save an ArchiCAD Project Archive (*.PLA), the Libraries saved with the files are also 
stored in Library Container Files within the PLA file.
The behavior of Library Container Files is similar to PLA files in one respect: when you load a Library 
Part from either and modify the Library Part, it must be saved under a new name. ArchiCAD cannot 
update the Library Part within the Container file and automatically update the Container File.
To edit a library part located in a Library Container, you must first extract the container, edit the 
part, then Create the Container again.

DXF/DWG Translation Improvements
Because ArchiCAD functions and former PlotMaker functions are now integrated, it is possible to 
create DXF/DWG files in which Model Views are converted into real Model Space, and Layouts are 
converted into Paper Space in the resulting DXF/DWG file, all in a single operation.
Layering capabilities have also been enhanced. These new features are reflected in changes in the 
Translator Setup dialog:
On the Open Options page, the “Import Drawing Data from” field has been removed. With the new 
translation method, Model Space elements will always come into the Floor Plan, and Paper Space 
elements will always come onto Layouts in ArchiCAD. If ArchiCAD finds Paper Space definitions in 
the DXF/DWG file, it will create Layouts accordingly, and create the necessary placed drawings on it 
so as to correspond exactly to how the Paper Space looked in the DXF/DWG file.
On the Save Options page, slight changes in the File Format field reflect all supported formats. The 
two save options available are ‘AutoCAD 2000, 2002’ and ‘AutoCAD 2004, 2005, 2006’. 
The “Save Elements Into” field has been removed: by default, in ArchiCAD 10 the contents of Model 
Views are always saved into Model Space, and elements, drawings, and images placed on Layouts 
will automatically be placed in Paper Space in the resulting DXF/ DWG file.
In conjunction with this change, the “Save Layout Into” field now contains more choices, and some 
of the earlier choices were either eliminated or renamed to reflect the latest changes in the way the 
program works.
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The current choices are the following:
• Paper Space as Flattened Drawing: This is a new option. All elements drawn on the Layout, plus 

all drawing data will be saved into the Paper Space of the resulting DXF/DWG file. All Drawings 
placed on the Layout will be converted into AutoCAD Blocks, and these will be clipped so only 
those portions of the Blocks will be visible in the AutoCAD Paper Space that were visible on the 
Layout in ArchiCAD. The purpose is perfect reproduction of what you saw on the Layout. With 
this option, the Model Space of the resulting AutoCAD drawing will be completely empty.

• Model Space as Flattened Drawing: All elements drawn on the Layout, plus all drawing data, 
will be saved into the Model Space of the resulting AutoCAD drawing. All Drawings placed on the 
Layout will be converted into AutoCAD Blocks, and these will be clipped so that only those 
portions of the Blocks will be visible in the AutoCAD Model Space that were visible on the 
Layout in ArchiCAD. The purpose is perfect reproduction of what you saw on the Layout. With 
this option, a default Paper Space will be created in the resulting AutoCAD drawing, which will 
be empty. This option produces the same result as was produced by the Model Space with 
Cropped Drawings’ content option in ArchiCAD 9. 
Note: a Drawing placed on a Layout will be saved into Model Space only when certain conditions 
are met: the Drawing’s source must be Model View (Floor Plan, Section/Elevation, Detail); and 
its Update Status must be OK before saving it as DXF/DWG. If its status is not OK, then those 
Drawings will be exported into Paper Space as flattened Drawings. For this reason, you should 
always update all Drawings in the Drawing Manager prior to saving as DXF-DWG.

The “Place Drawings into” field is now enabled whenever the data on the Layout is not saved as 
Flattened Drawings. In this case, you can save the contents of Model Views placed in the Layout as 
either a Single DXF/DWG File or as Linked XREF drawings. 
Two buttons to the right of “Place Drawings into” field there are two buttons. Click the left button 
to define a folder path relative to the location of the folder where the AutoCAD drawings will be 
saved. The path should be placed between single quotation marks.
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The other button will let you delete the relative path you entered in the previous dialog. Click on it 
and the path will be cleared without having to enter the dialog. If there is no relative path defined 
for the XREF files, they will be saved into the same folder where the parent AutoCAD drawing is 
saved.
In the Attributes->Layers->Methods section, new options have been added in the “Create Layers 
according to” field. The way Layer->Layer conversions and Pen->Layer conversions are combined is 
revised in ArchiCAD, hence the 2 new options.

The ArchiCAD Layers, Pen Numbers and Element Types options work the same way as in ArchiCAD 
9. For ArchiCAD Layers and Element Types, pen colors do not play a role in conversion, so the Pen-
based layer names section of the Layers section is grayed.
When the Pen Numbers option is selected, the Pen-based layer names section has a new option.

The “Custom tags to Pen Numbers” field has Prefix and Postfix fields. Use these to specify the 
format of the created Layer names. The resulting Layer name will follow the following format: 
<Prefix>Pen No.<Postfix>. For example, if Prefix=’AA_’ and Postfix=’_PEN’, then all elements drawn 
using Pen 23 with be converted to Layer ’AA_23_PEN’ in the resulting DXF/DWG file. When you 
choose this option, the Pen-based layer names dictionary will be used to replace some of the layer 
names. Also, custom layer names are not available with this option.
When the Layer or declared Pen Number option is selected, the program creates AutoCAD layers 
according to ArchiCAD Layers, but definitions in the Pen-based layer names conversion dictionary 
take precedence over ArchiCAD Layer conversion. Within ArchiCAD Layer conversion, Custom Layers 
take precedence over normal Layer conversions.
With the Layer extended by Pen Number option, ArchiCAD creates AutoCAD Layers according to 
ArchiCAD Layers, but a single ArchiCAD Layer may result in several Layers in the resulting AutoCAD 
drawing, because the translation function will place ArchiCAD elements located on the same Layer 
but using different Pens onto separate Layers in AutoCAD. The names of Layers will be created in 
the following pattern: 
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<ArchiCADLayer>_<Prefix>Pen No.<Postfix>. 
When you choose this option, the Pen-based layer names dictionary will be used to replace some of 
the <Prefix>Pen No.<Postfix> portion of the Layer names.
Pen Methods have also been revised in ArchiCAD 10, in the Attributes->Pens and Colors->Methods 
area. The conversion process now has two possible choices: 

If you choose the best matching Standard AutoCAD color radio button, the program searches 
through the AutoCAD color table to find which AutoCAD color matches the ArchiCAD pen color best 
and assign it accordingly. If you choose the RGB color if no exactly matching Standard AutoCAD 
color exists radio button, the program searches through the AutoCAD color table to find an exact 
match for the pen color just as with the other radio button. If it does not find one, it will save the 
RGB value of the ArchiCAD Pen and assign it a pen index number of 256 or higher in the AutoCAD 
drawing.
The Set all Elements’ Colors and Lineweights to “BYLAYER” checkbox is new in one regard: it can 
now set the “BYLAYER” attribute not only to Colors, but Lineweights as well. 
Since penweights can now be exported, the last checkbox of this area is the Do not export 
ArchiCAD penweights checkbox. If you check this box, penweights will not be exported from 
ArchiCAD to the resulting DXF/DWG file. In the Appendix of the ArchiCAD 10 Reference Guide (DXF/
DWG Translation Setup: Pens and Colors), you will find a penweight conversion table that shows 
you how ArchiCAD penweights are exported in case this checkbox is not checked.

Custom Components
In ArchiCAD 10, it is possible to create and save elements created on the Floor Plan as GDL files in 
such a way so that they become custom components of existing GDL Library Parts. For example, the 
Door Panel of a Door or the sink type of a kitchen cabinet can be a Custom Component. In case of a 
Door Panel, you can create a Slab which can then be saved as a custom Door Panel. All Doors that 
use Door Panel types (have such parameters in their Parameter List) will be able to use this newly 
created custom Door Panel. You can create custom components for all types of GDL elements 
(Windows/Doors/Objects etc.) This enables you to expand the number of options available in your 
libraries in case default options do not meet your specific requirements.
Let us say you have a usual Door in your Library (“D1 10.dor” in the example) and you wish to create 
a new custom Door Panel for that Door.
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The steps to do this are the following:
1. Using ArchiCAD Construction Elements (e.g. Slabs etc.), create the Door Panel on the Floor Plan. 

In case of Door/Window custom panels what you draw in the X-Y plane of the Floor Plan 
Window will be ‘stood upright’ in the Window/Door library part (rotated 90 degrees around the 
X axis – as described in the GDL Reference Guide). In case of other custom component types, 
this condition does not apply.

2. Select the drawn element(s) and choose the File > Libraries and Objects > Save Custom 
Components command
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3. If you have no elements selected, the command will give you an alert to do so.

4. A dialog comes up where you can specify the type of Custom Component you want to save it to.

The Custom Door Panel and Custom Window Panel options are self-explanatory.
An example of a Custom DW Hardw Component could be a custom door knob.
An example of a Custom Object Component could be a custom sink type or tap type of a kitchen 
cabinet.
An example of a Custom 2D Symbol Component could be a custom 2D View of a custom sink 
type or tap type of a kitchen cabinet.

5. Then specify a Location and File Name for the newly created file.
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6. The saved object will be saved and will be loaded as part of available Libraries. It will become 
immediately available as a Custom Panel Type for Doors. You do not need to reload the Libraries 
for this to happen.

Note that if you save it as a type other than Custom Door Panel, the saved object will not be 
available here, but in the appropriate location as defined by the type it was saved as.

7. In the Door Settings dialog, set the Custom Panel Name parameter to the desired value (if there 
is only one custom component defined, the parameter will be automatically set to that 
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Notes:
It does not matter where the elements from which you create the Custom Component are 
located vertically. ArchiCAD will automatically place them to their appropriate location.
When applying it, ArchiCAD will automatically resize the custom component to its desired size 
when needed. For example, you may create a Door Panel type Custom Component that is 1000 
by 2000 mm in size. If you have a Door that is 800 by 2000 mm in size, with its Trim Width 50 
mm on all sides, the actual size of the Door Panel calculates to 700 by 1950 mm. The program 
will stretch/shrink all parts of the Door Panel Custom Component proportionately to fit this size.
You should set the attributes (Pen, Material etc.) values of the Custom Component to the 
desired values prior to saving it, because these are the values that will be applied to it when it is 
actually used later in the Project.

Library development
Several enhancements have been made in GDL for ArchiCAD 10. One is that macro calls have been 
optimized. As a result macro calls in ArchiCAD 10 are executed much faster. Another new feature is 
that macro calls can have return values in this version. Also, the hierarchy of the ArchiCAD Library is 
not constrained by performance issues; library developers are allowed to build any depth of macro 
calls, the return values support more structured programming.
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The User Interface that can be created by the User Interface Script of Library Parts has been 
improved significantly. Navigation among the tab pages is more straightforward. There are also 
richer controls (icon pop-up, transparent pictures, Tool Tips) to choose from when designing Custom 
User Interfaces for Library Parts.
For details on new features in the ArchiCAD 10 Library, see the “ArchiCAD 10 Library Guide” in the 
ArchiCAD 10 Help menu.
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Virtual Trace
Worksheet Tool
Section and Elevation Tools Separated
Interior Elevation Tool
Enhanced Drawing Markers: “Section in Section”
Enhanced Project Navigator
Linework Normalization
Pen Sets in Views
PDF Export
Quantities of Individual Element Components
XREF Layer Separation
Uncut Line Types
Enhanced Selection/Editing Feedback
New Curved Wall Types
Link Construction Elements to Stories
Multistory Hotlinked Modules
Single, unified Undo Queue for the whole Project
Simplified Process for Creating Company-Standard Install Package
Long file names
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Virtual Trace
Allows placement of selected Reference view as “Virtual Trace Paper” above/below/alongside 
current model display. You can use the following items as a Trace Reference:
• all model views (floor plans, sections/elevations), drawing views (Worksheets and Details)
• views and layouts
• Drag/offset/rotate Reference
• Trace & Reference Palette shows settings of Reference of currently active window
• Use Trace Reference to edit active view: trim with/adjust to elements on Reference, pick up 

element parameters from Reference
• Navigate easily and directly between the Active Content and the Reference by using the “Switch 

Reference with Active” command
For more information, see “Virtual Trace:” Using References to Edit and Compare Model Views and 
Drawings.
Compare the Reference with the Active Content (not available in 3D Views). Differences can be 
detected and visualized in several ways:
• Dynamic movement of Active over Reference and vice versa
• Dynamic adjustment of color & transparency/intensity of Reference and Active 
• Moveable splitter bar dividing Active from Reference
For more information, see Compare Reference with Active.
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Worksheet Tool
Dedicated Tool and environment for any kind of drawings (e.g. enlarged, partial floor plans and 
sections, site plans, etc.)
• Transfer (explode) the entire visible model (including annotations/dimensions) or any selected 

model content into Worksheet for further editing
• Finish plans using drafting & annotation tools
• Create any drawings from scratch and/or link to external files 
• Link any type of marker to a Worksheet
• Worksheet and Detail Tools available to generate/mark further Worksheets and Details from 

within a Worksheet
For more information, see Worksheets.
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Section and Elevation Tools Separated
Sections and Elevations available as separate Tools in the Toolbox
• Own default settings and Favorites
• Dedicated Markers, linked Section and Elevation Markers
• Separate entities on the whole UI:

- Navigator
- Find and Select
- TW Sign in

For more information, see Sections.
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Interior Elevation Tool
Interior Elevation becomes a live ArchiCAD model view, with separate IE tool and dedicated IE 
viewpoint.
Interior Elevations are defined by polylines (no longer tied to zones)
An IE polyline represents a group of separate IE viewpoints, one for each edge of the polyline
Such IE groups are grouped in the Navigator’s Project Map
Each viewpoint has an ID and name that can be assembled from various data (zone number, 
orientation, ID…) as an autotext
IE markers can be assigned to the whole group or to each individual viewpoint
IE view can be placed on layouts or published all at once. Configuration options:
• order of viewpoints
• gap between viewpoints
• automatic adjustment of adjacent IE viewpoints to correspond to their story levels in the project
• optimize display to fit in space available
Dedicated Drawing Titles available to annotate IE viewpoints on Layouts
For more information, see Interior Elevations (IE).
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Enhanced Drawing Markers: “Section in 
Section”
The primary function of markers is to indicate the location of the corresponding view and relevant 
drawing/layout information
Place any kind of drawing markers on any view with the appropriate view tool: Section, Elevation, 
Interior Elevation, Worksheet, Detail
There are two kinds of markers:
• Source marker: defines a viewpoint. Placing a source marker creates a new viewpoint. If deleted, 

the corresponding viewpoint will also be deleted
For more information, see Create a Section Viewpoint.
• Linked Marker: refers to an existing view or drawing. (multiple markers can refer to any single 

view/drawing)
Linked markers can refer to any kind of drawing. For example, a Section marker can be placed within 
another Section; a Detail marker can refer to a Section drawing.
For more information, see Define Marker Reference for Linked Marker.
Navigation in the project is easy by using the markers
Broken links can be identified, relinked, deleted (Check Markers Palette)
For more information, see Managing Markers in ArchiCAD.
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Enhanced Project Navigator
Project Map: structure separates all new view types (corresponding to the tools of the Toolbox’s 
View group)
View Map: separate clone folders for all new view types
Select Trace Reference for the Active window directly from the Navigator
For more information, see The Navigator Palette.
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Linework Normalization
Goal: optimize the 2D content for further editing and final output when creating 2D content 
(Details, Worksheets)
Logical display order maintained
Commands to merge connecting / overlapping elements or delete unnecessary / duplicate 
elements (lines, fills)
For more information, see Consolidating Lines and Fills in Drawing Windows.
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Pen Sets in Views
Pen Sets are assigned to the views (as a result model views will be WYSYWYG)
Pen Set selection is available from View Settings and can be varied for placed drawings in Drawing 
Settings. Pen Sets can be edited directly from Drawing Settings.
For more information, see Pen Set.
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PDF Export
Save as… PDF command available
High Resolution solid arcs/circles
Embedded Third Party font support
Enhanced gradient fill representation
For more information, see Save Document in PDF Format.
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Quantities of Individual Element 
Components
Calculation of individual components of complex elements 
Analytic volume calculation of composite element skins
Quantities available for listing (simple text and formatted) and Interactive Schedules
For more information, see Interactive Schedule in ArchiCAD Help.
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XREF Layer Separation
In Layer Settings, the layers of any attached XREFs are listed separately, at the bottom of the layer 
list. 
Layers of XREF projects cannot be unlocked, but you can show or hide these layers. When the XREF 
is deleted, these layers will also be deleted automatically.
If you do not want XREF layers to appear in Layer Settings, use the display filter pop-up at the top 
left of the dialog box and choose “Hide Xref layers”. 
XREF layers are not available from layer selection pop-ups in other parts of the user interface (e.g. 
Tool Settings dialog boxes and Info Box). However, if an XREF element is included in the last 
selection, its XREF layer does appear - for information purposes only (in italics) - in the Layer 
chooser pop-up.
For more information, see XREFs and the Layer Structure.
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Uncut Line Types
Line Type of Uncut Lines for the floor plan representation can be set for individual elements
Drawing Quality can be enhanced (e.g. footing parts covered by earth, remote elements, etc.)
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Enhanced Selection/Editing Feedback
Perfect visualization when feedback and drawing content conflict in such situations as:
• selection and pre-selection feedback
• moving elements in worksheet windows
• moving pasted content
More options in configuring selection/feedback: 
• Element Information highlight always appears in the color that you set it.
• Element Information highlight “fades in” rather than appears suddenly
• Set the color of general feedback graphics (Options > Work Environment > More Options: 

Feedback graphics color)
• Set color of Marquee (same as Selection Dot color)
Functional improvements for placed drawings
• moving full drawing content
• clipped by the frame on the fly
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New Curved Wall Types
Curved Slanted, Double Slanted walls
Curved Complex walls
For information on Complex walls, see Place a Wall/Column/Beam with a Complex Profile.
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Link Construction Elements to Stories
Home Story and Show on Story settings will be separate option sets.
Home Story:
• Select Story - Assigns the element's Home Story as defined by the user; this can be the current 

story or any other story in the project
• Automatic – ArchiCAD assigns the element’s Home Story based on its reference level when the 

element is created, and adjusts the Home Story as necessary whenever the element’s elevation 
changes.

For more information, see Set Home Story.
Show On Stories:
• Home Story Only 
• All relevant stories (Walls, Beams, Columns, Roofs only)
Additional options for Roofs, Slabs, Meshes and Objects:
• Home Story + One Story Up
• Home Story + One Story Down
• Home Story + One Story Up And Down
• All stories
• Custom (N/A for Objects)
For more information, see Control Element Display by Story (Show On Stories).
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Multistory Hotlinked Modules
Save/Publish Multistory Module files
Holink Multistory structures in one step
• Select Story range from the file
• Hotlink the whole multistory file
All elements relevant in a story will be saved and hotlinked.
For more information, see Modules Involving Multiple Stories.
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Single, unified Undo Queue for the whole 
Project
All model and drafting operations can be undone step by step, chronologically, regardless of the 
model or drawing view they were performed in.
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Simplified Process for Creating Company-
Standard Install Package
• for CAD Managers and for holders of University licenses
• Easy-to-use wizard creates “recorded” installation process with preferred custom settings
• End result: Single .exe file for installation on any number of computers
For information, see Getting Started.
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Long file names
Long unicode file names (exceed the 32 character limitation) 
• ArchiCAD project files (.pln, .pla., plc...)
• Hotlinked Modules
• Library Parts, Library Container
• DWG files, XREF-d DWGs
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ArchiCAD 12 New Features List
Curtain Wall
3D Document
StairMaker Enhancements
Partial Structure Display
Bi-Directional Drawing Marker Referencing
Nudge/Align/Distribute Elements
Dialog Box Enhancements
Section/Elevation Marker Display
Reveal Options for Doors/Windows
Fill Enhancements
PMK File Format
Improved Dimensioning Input Logic
DWG Element Conversion Improvements
Performance
Multi-Page Layouts for Schedules and Indexes
Grid Tool
Improved Hotlink Management
Label Enhancements
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Curtain Wall
A new Curtain Wall tool, located in the regular ArchiCAD toolbar, lets you design and document 
complex Curtain Wall systems in the Floor Plan, Section or 3D window.

With the Curtain Wall, we introduce the first System Tool for ArchiCAD - a new approach to 
construction elements. Curtain Walls are an assembly of members arranged according to a scheme, 
to form a hierarchical system that can be handled together as a single element, with each level of 
the hierarchy remaining accessible and editable separately.
The Curtain Wall tool enables you to configure, place, and edit an element consisting of Frame, 
Panel, Accessory and Junction elements: these are the Members of the Curtain Wall, arranged on a 
Base Surface according to a pre-defined and editable Scheme.
To control the whole hierarchy at once, System level settings, which defines the overall scheme and 
configures members on all levels, has been organized into a multi-page settings dialog, new to 
ArchiCAD.
Curtain Walls can be manipulated in the same way as any construction element in ArchiCAD. But 
unlike other elements, a Curtain Wall’s component members can be placed and edited individually, 
without disassembling the System.
To enable graphical manipulation of sub-structural members, each Curtain Wall can be accessed at 
a deeper level: the Curtain Wall Edit mode. This is a graphical 3D workspace, similar to ArchiCAD's 
own, with dedicated tools and techniques to manipulate Curtain Wall members. In this context, 
only the members and scheme of the Curtain Wall are editable, although the rest of the model can 
be also displayed in a background manner, as a reference.
Since Curtain Wall members are typically present in sequences of similar elements, dedicated “find 
and select” options and the new “grip” functionality help to identify and select members for further 
editing.
Once selected, any parameters of any Curtain Wall member can be accessed in settings dialogs.
Since Curtain Walls often feature extreme geometry that does not necessarily coincide with 
vertical-horizontal planes, ArchiCAD offers versatile input planes for greater freedom in surface 
definition. Also, in comparison with other construction elements, a higher level of editing freedom 
is provided: including input in Section views, boundary editing, and free rotation.
See “Curtain Wall: A System Tool” in ArchiCAD Help.
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3D Document
The 3D Document allows you to use any 3D view of the model as the basis for creating a document 
where dimensions, annotations and additional 2D drawing elements may be added. 
For example, you can convert a detail drawing into a document that shows information in 3D - such 
as intersection of composite walls in space, including dimensions and annotations.
• In the 3D window, set up a 3D view of the model: the view you want to see in your 3D 

Document.
• Set up the perspective or projected 3D view; use 3D Cutting Planes, filter or select elements, use 

Marquee as needed, or perform solid element operations.
• Create a new 3D Document based on the 3D Window source.
• Annotate the document as needed, adding labels and dimensions.

For more information on this feature, see “3D Document” in ArchiCAD Help.
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StairMaker Enhancements
More Flexible 2D Display of Stairs with Improved Interface
• Stair Settings offers many more parameters allowing you to adjust the Floor Plan symbol display 

of stairs to conform to local standards.
• Custom User Interface Settings (2D Symbol and Attributes) allow for flexible text display, 

railing/walking line symbols, handrail types, 2D symbol and 3D attributes.
See “Symbol Settings (StairMaker)” in ArchiCAD Help.

• Text Display parameters similar to those of regular GDL stairs:

Four New Standard Stair Types for StairMaker
• Single Winder at Lower End; Single Winder at Upper End; Single Winder U-Return; Double 

Winder U-Return.

• User defines number of risers in the winder; related parameters will be adjusted accordingly.
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• User defines offset of risers in winders from the corner(s) of the stair.

Flexible Options for Defining Location of Saved Stair
When you save a new stair created with StairMaker, you can browse any library location:

See the ArchiCAD 12 Library Guide, available from the Help menu, for more detailed New Features 
information for Stair Tool and StairMaker.
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Partial Structure Display
• Flexible Display of Core/Finish skins of Composite and Complex Elements
• Show/Hide skins as needed using Partial Structure Display dialog box: Entire Structure; Core 

Only; or Without Finishes.
• Save “Partial Structure” settings along with views
See “Partial Structure Display” in ArchiCAD Help.
370 New Features in ARCHICAD 8-20



ArchiCAD 12 New Features List
Bi-Directional Drawing Marker Referencing
The Title panel of Drawing Settings now gives you access to the Back Reference function.
Back Reference allows you add Layout ID information to the Drawing Title: specifically, the ID of one 
or more Layouts that contain a Drawing showing the source marker of the current Drawing.
See “Drawing Title Reference to Drawing Source (“Back Reference” to Layout Containing Source 
Marker)” in ArchiCAD Help.
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Nudge/Align/Distribute Elements
User may now select any object in 2D or 3D and nudge, align and distribute in a manner similar to 
popular office applications. 

Nudge Shortcut
A quick way to move elements on the screen is to use the “Nudge” feature: select one or more 
elements, then use Shift + arrow key (Left/Right/Up/Down) to move the element left, right, up or 
down.
The “Nudge factor” - the increment by which you will move the element - is the same as the 
distance entered for your Snap Grid in View > Grid Options > Grids & Background.
To Nudge a selected element in larger increments, use Shift + Alt + an arrow key. This will move the 
selected elements by the distance entered for your Construction Grid in View > Grid Options > 
Grids & Background.
See “Nudging Elements” in ArchiCAD Help.

Align Elements
Use the Align menu (Edit > Align) to align selected elements with each other, or to a custom-drawn 
target line, using a variety of criteria:
• Align elements right or left;
• Align elements to the top or bottom;
• Center elements vertically or horizontally;
• “Special”-align elements to any line on an existing element, or to a temporary line/arc drawn by 

you.
The Align commands are only active if you have selected at least two elements.
See “Align Elements” in ArchiCAD Help.

Distribute Elements
Use this menu (Edit > Distribute) to evenly distribute selected elements using a variety of criteria:
The Distribute commands are only active if you have selected at least two elements.
The two selected elements at either end will remain in place; the rest of the selected elements.
See “Distribute Elements” in ArchiCAD Help.
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Dialog Box Enhancements
Splitter Bars
Splitter bars make it easier and faster to see and interact with dialog box panels as you need them. 
New splitter bars in the following dialog boxes:
• Layer Settings
• HotLink Manager
• Work Environment (Keyboard Shortcuts, Toolbox, Tool Settings, Info Box, Toolbars, Menus)
Moreover, in the Layer Settings Dialog Box and the Object Tool Settings dialog boxes (Door, Window, 
etc.), you can double-click anywhere along the Splitter to open or close it. (Or single-click on the 
black arrow.)

Resizeable/Sortable Headers
Just click and drag to sort or resize the header fields in the following dialog boxes (Resize is available 
where the header contains text rather than icons).
• Favorites
• Story Settings
• Add-On Manager
• Choose HotLink
• Xref Management
• DXF-DWG Translation Setup
• Library Part Editor
• Project Info
• Update Zones

Navigation in Object Settings Dialog Box
In Object Settings, if you select an object from the browser area, that object’s settings appear on 
the right-hand side of the dialog box.
These settings will remain in the right side of the dialog box even if you use the browser to look 
through library objects on the left. To again return the browser to the status in which it shows the 
currently selected object’s place in the library, click the Show in library command, accessible by 
clicking the black arrow next to the object name in the Preview and Positioning Panel.
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Section/Elevation Marker Display
Section and Elevation Marker display is no longer a Model View Option. Set separate preferences 
for Section markers and Elevation markers in the respective Settings dialog boxes. 

See “Section Marker Panel” in ArchiCAD Help.
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Reveal Options for Doors/Windows
An expanded set of options for defining Door/Window Reveals is now available in Door/Window 
Settings. For standard library parts, these are listed in graphical form in the Custom Settings panel of 
Door/Window Settings.

The original Reveal Method options are still available on the Reveal panel for those doors and 
windows that are not part of the standard library or don’t use the new set of reveal options.
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Fill Enhancements
ArchiCAD now offers additional variations for creating and applying fills. 

New Fill Type Names
Fill types listed in the Fill pop-ups are grouped under new names:
Solid Fills include:
• the Foreground Fill (formerly Solid): You see only the Foreground, because it covers up the 

Background.
• the Background fill (formerly Empty): You see only the Background, because the Foreground is 

set to zero.
• Three fills whose foregrounds are of predefined Translucence (25%, 50%, 75%).
These percentages can be adjusted by hand in Options > Element Attributes > Fill Types:
In addition, you can create a new solid fill type with any translucence value you wish: click New, and 
choose Solid fill from the Add New Fill dialog box.
See “Defining Fill Types” in ArchiCAD Help.

Image Fills
The Image fill lets you use images as the foreground part of Drafting fills.

By default, ArchiCAD 12 provides two Image fills as Attributes, but you can define your own.
See “Image Fills” in ArchiCAD Help.

Better Zone Fill Representation
The “Options for Fills and Zones” panel of Model View Options is now called “Override Fill Display.”
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By default, all types of fills use the settings defined at the element level (formerly called “As in 
Settings”). In ArchiCAD 12, to set a different global display preference for any type of fill, you must 
check the “Override” button in the Model View Options “Override Fill Display” panel.
See “Model View Options Override Fill Display” in ArchiCAD Help.

New Fill Types for GDL Objects
Apply a Gradient or translucent fill to GDL objects.
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PMK File Format
As of ArchiCAD 12, the PMK format is available for saving views in the Publisher. This is a native 
ArchiCAD drawing format which takes up relatively less hard drive space than many other formats. 
Saving views in PMK format can be a good workflow if your project is divided among multiple files 
(e.g. Model pln and Documentation pln), with several team members working through a network.
See “Larger Projects” in “Layouting Workflow Schemes” in ArchiCAD Help.
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Improved Dimensioning Input Logic
Improved dimensioning input logic makes it easy to visualize dimension lines and adjust dimension 
points on the fly. The “Any Direction” input method enables you to choose from several logical 
possibilities for placing the dimension line, including placing it parallel to any existing line or edge.
See “Linear Dimensions” in ArchiCAD Help.

Dimensions in the 3D Document Window
In the 3D Document Window, an addition input method lets you dimension along any chosen plane.
See “Linear Dimensions in the 3D Document Window” in ArchiCAD Help.

Pet Palettes for Dimension Editing
For selected dimension lines, pet palettes are now available with editing commands.
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DWG Element Conversion Improvements
ACIS Import
A new function allows you to convert AutoCAD 3D Solids, Regions and Bodies into GDL Objects. 
Opening or merging such objects brings up a Browse dialog box, where you choose the folder to 
which to save the GDL objects you will create.

Fill-Hatch Conversion Table
Set up fill conversion table in DXF-DWG Translation Dialog Box to map ArchiCAD fills to AutoCAD 
hatches (analogous to Font-Style Conversion).
See “Fills” in ArchiCAD Help.

Attribute Purge
When saving an ArchiCAD file as DWG, only those ArchiCAD attributes will be included which are 
actually used in the project. This is an automatic process, reducing file size.
You can opt to purge further attributes: a new checkbox in DXF-DWG Translation Settings 
(Miscellaneous) enables you to purge all unused attributes that originate in the DWG template file.

LTScale
The LTScale variable used in DWG files will now be correctly interpreted when opening or merging 
DWG files in ArchiCAD. New line types will be created as needed, regardless of the length of the 
original line pattern.

Saving Layout Content to DWG Format
When ArchiCAD Layouts are saved to Paper Space in DWG format, the content of every Drawing in 
the AC project is transferred into the DWG Model Space, regardless of the drawings’ status and 
source. Even the content of external Drawings and internal-source Drawings which are not in 
updated condition is transferred to Model Space, because this content is now assigned to layers in 
DWG Model Space. 
This works if the DXF/DWG Translator Settings for “Save Layout Into” are set to either “Paper Space 
with Cropped View’s Content” or “Paper Space with Full View’s Content.”
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Performance
• Multi-core processor support. With ArchiCAD 12, multi-core processors becomes the 

recommended and standard platform for higher performance computing.   Areas that will see 
noticeable improvement include navigation and 3D model generation including sections and 
shadow casting. 

• Image and fill handling. New technology allows for significant increases in performance in 
working with bitmap images and large fills in the design phase and during the generation of the 
document set layouts. PDF generation is also improved. 

• Layout book:
- Algorithm change makes working on large layouts significantly faster, due to faster rebuild 
speed while navigating.
- On-screen Preview options let you choose the level of precision of on-screen display of 
drawings.

See “On-Screen Preview” in ArchiCAD Help.
With large Layout Books, your choice here can affect navigation speed significantly:
• Full Precision (drawing shown with full details, always rebuilt)
• Quick Preview (faster navigation; Drawing rebuilt only upon explicit Rebuild of the Layout, or 

when a Drawing update occurs)
• No Preview (fastest navigation).
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Multi-Page Layouts for Schedules and 
Indexes
An Interactive Schedule or Project Index placed as a Drawing can be automatically converted so that 
it is split up among multiple Layouts - to ensure output of the entire Schedule/Index content.
See “Split Schedule into Multiple Layouts” in ArchiCAD Help.
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Grid Tool
The Grid Tool allows you to place Grid elements individually or in a Grid System. The Grid Tool 
creates a custom local Grid whose elements are part of the model and serve as an editable 
framework for placing multiple elements or for identifying locations in the model.
See “The Grid Tool” in ArchiCAD Help.

Note: The Grid Tool was included in some localized earlier versions of ArchiCAD; as of ArchiCAD 
12, it is now a standard part of the package.
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Improved Hotlink Management
• One-step update of Hotlinked Modules which include Nested modules (Nested Modules 

updated from own source files, so that you don’t have to open the hotlinks with nested modules 
separately to update them). 

• Comprehensive user interface provides clear overview of Module instances and hierarchy; 
allows you to open separate ArchiCAD with the source file from the Hotlink Manager.

• Improved performance, smaller file size when placing multiple instances of a single module
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Label Enhancements
• Label tool has new Label Type: Label Members (currently for Curtain Wall only, in Section 

window only)
See “Placing Member Labels on Curtain Walls” in ArchiCAD Help.
• Optionally hide Label Arrowhead depending on window scale
See “Label Pointer Panel” in ArchiCAD Help.
• New Label Pointer type: Pointer with underlined text
See “Label Pointer Panel” in ArchiCAD Help.
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ArchiCAD 13 New Features
Collaboration – Next Generation Teamwork Solution
Oriented View
Interactive Schedule Enhancements
Improved Curtain Wall Editing
Library Improvements
Enhanced Automatic Dimensioning Options for Doors/Windows
Fill Enhancements
Slab/Roof Edge Custom Settings
Improved OpenGL Display for Smooth Edges in 3D
Ruler
Dynamic „Fit in Window” Zooming when Navigating Among Views 
Improved Find & Select
Boundary Contour Options for Section/Elevation/Interior Elevation 
DWG Exchange
Improved Data Exchange with Structural Software
License Borrowing
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Collaboration – Next Generation Teamwork 
Solution
The new Teamwork in ArchiCAD 13 represents an entirely new approach to collaborative project 
work, and is specifically designed to meet the demands of a modern, international team effort. This 
next generation Teamwork solution is based on a client-server architecture and is designed to 
ensure maximum flexibility, speed and data safety to enable teams - even those spread out around 
the world - to collaborate on large projects.
Highlights of the new Teamwork:
Client-Server Technology
On-Demand Reservation System
Task-Oriented Instant Team Communication
Remote Project Management
Data Safety, Project Reliability
Performance

Client-Server Technology

This new collaboration solution is based on a client-server technology, in which one or more server 
applications are connected through the network to many client applications. The clients: architects 
using ArchiCAD. The server: a new application called Graphisoft BIM Server.
This technology ensures 
• Fast, simultaneous access to projects for multiple clients
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• Low network traffic featuring DELTA-Server technology: only the changes since the last 
Send&Receive will be sent through the network and processed by the server or clients

• High level of data integrity
• Access to project data via Internet (even without VPN)
• A single user can work on several projects with different Roles and permissions levels
• Always up-to-date information about project and users
• Offline work support
• Server-based control via remote access to project settings and user roles
This system is scalable, and can be tuned to fit the needs of either a small office or large 
multinational operations.  The number of server clients is unlimited; several server computers can 
be used in tandem to ensure top performance.
The Graphisoft BIM Server application is a new, multithreading, object-oriented database 
application. Graphisoft BIM Server is available in 32 and 64 bit versions.

On-Demand Reservation System

In Teamwork 13, users can reserve or release elements or other data quickly and easily, anywhere in 
the project.
• Reserve or release elements individually by selection or criteria
• Reserve or release other data using simple Control Light interface (See Overview of Teamwork 

Reservation)
• Request data in case of a reservation conflict (See Request Elements or Project Data)
• Assign elements to users with an attached message (See Assign Elements)
Use this dynamic reservation approach to:
• Continuously keep track of which project areas other users are working on (ownership 

information is always up to date - no Send & Receive necessary)
• See who owns what at a glance: reservation by user is displayed on screen with different colors 

(See Colored Workspaces.)
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Task-Oriented Instant Team Communication

Teamwork for ArchiCAD 13 introduces an efficient, easy way for users to instantly communicate and 
manage workspaces. Teamwork Messaging is integrated with the ArchiCAD project: its functions are 
tied to elements and actions within the project, so that many messaging functions are automated.
• Send instant messages to other users about project-related tasks (e.g. “Send changes to the 

Server,” “Release these elements”)
• Request specific elements reserved by others
• Ask for review of selected elements
• “Flyover” appears on screen when a new message arrives; messages set to “high priority” will 

stay on screen until handled
• Follow up on your pending requests and to-do tasks in separate lists
• Check online/offline status of users before sending a message
• Undeliverable messages will be stored on the server, then delivered as soon as the recipient is 

online again
See Messaging.
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Remote Project Management

In Teamwork 13, the company user list, project list and company-specific permissions (Roles) are 
managed centrally for all projects by the Graphisoft BIM Server application.
All data can be accessed remotely via Internet with the BIM Server application, so the Server 
Administrator(s) can, for example:
• Start a new project or modify the settings of existing projects
• Add or remove Teamwork users or modify their permissions/settings
• Define or modify the company-specific Roles
• Create project archive at any time
See BIM Server Manager.

Data Safety, Project Reliability
A priority goal of the new Teamwork: to preserve data integrity in all cases. This is achieved with the 
following methods:
• Client-server technology: the BIM Server double-checks the data received from the client and 

handles the action only if the data fits the needed conditions (user permissions and reservation 
status)

• Transaction management: the BIM Server refuses and revokes all actions which are faulty for 
any reason (e.g. hardware failure, network split or power cut)

• Automatic creation of project backups at scheduled intervals
Better control over user access helps further ensure data integrity:
• Administrator can tailor user rights to match user responsibilities and knowledge
• Project log accessible - even from a remote location - providing list of key project-related actions
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Performance
Teamwork 13 sets the standard for high performance: not only in terms of the speed of different 
hardware and software components, but also in terms of team effectiveness and flexibility. 
Functions that speed up the workflow include:
• The ability to work on the project from anywhere, with a simple internet connection
• The sophisticated send and receive process decreases the time needed to synchronize with the 

server - so users are willing to send in their modifications more often
• Faster local save
• Dynamic reservation system meets user needs immediately; no need for exclusive access
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Oriented View

To simplify editing and documentation when working with models at odd angles, use this technique 
to rotate the project view (in Floor Plan, Worksheet, Detail, or 3DD) while keeping project 
coordinates constant. 
• The rotation angle is saved with the view, which is published as shown on the screen – that is, in 

its rotated position
• Annotation elements (texts, labels, markers, zone stamps, etc.) can be adjusted automatically to 

match the oriented view
See Oriented View.
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Interactive Schedule Enhancements
Annotated Schedule Drawings
More Flexible Setup/Display of Interactive Schedules
Expanded Listing Options Using Calculation Rules

Annotated Schedule Drawings

In the Interactive Schedule window, annotations (e.g. associative or static dimensions, text, fills, 
lines) may be added to any object/door/window preview.
For doors/windows, dimensions can be placed automatically.
See Add Annotations to Schedule Previews.

More Flexible Setup/Display of Interactive Schedules

• In Scheme Settings, nested parentheticals and user-defined and/or conditions enable any 
combination of logical relationships among criteria
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• Previews can be aligned along their top or bottom; or can be positioned in the cell to reflect the 
element’s elevation from the story/project zero level or any reference level

• Manually adjust the height or width of any row or column individually, using rulers at top and 
side of the window

See Interactive Schedule.

Expanded Listing Options Using Calculation Rules

Interactive Schedule criteria now include “Conditional” criteria for certain listing parameters 
involving the calculation of walls, slabs, roofs, and beams. 
Define these criteria using the new “Calculation Rules” options: for example, specify which fill types 
used in your project should be calculated as insulation and air space. This way, these quantities will 
be calculated in the Interactive Schedule and other list outputs.
See Calculation Rules.
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Improved Curtain Wall Editing
Direct Editing of Curtain Wall Reference Line

The Reference line of a selected Curtain Wall can now be edited directly on the Floor Plan, Section/
Elevation, or 3D windows using familiar pet palette commands, without needing to enter Curtain 
Wall Edit mode.
See Edit Curtain Wall Reference Line.

Editable Curtain Wall Height/Angle Parameters
After Curtain Wall is placed, its height and slant angle parameters will appear in the Selection 
Settings dialog box. The user can modify these parameters numerically from the settings dialogs or 
the info box, or graphically, using pet palette commands.
Curtain Walls with horizontal Reference lines will behave the same way as walls; they will have the 
following parameters:

- Base height
- Height of Curtain Wall
- Offset of Reference Line from base
- Slant Angle

For a Curtain Wall with a non-horizontal Reference Line:
- Length of extrusion
- Vertical position from the Curtain Wall’s lowest point
- Offset of Reference Line from base
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See Graphical Editing of Curtain Wall.
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Library Improvements
Objects Saved into the Project
Model View Options for Library Parts
Selected New Library Objects

Objects Saved into the Project

Project-specific GDL objects (such as StairMaker Stairs and Patch objects) can be automatically 
saved as part of the project file. Such “embedded” objects will behave the same way as regular 
library parts, but it will be impossible to lose them. Thus, all linked libraries can be uniform for every 
project.
• All newly created objects are stored in the Embedded Library by default, and can be organized 

into folders.
• Project-specific libraries from earlier ArchiCAD versions will be transformed into Embedded 

Libraries in ArchiCAD 13. 
See Libraries.
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Model View Options for Library Parts

Model View Options now include options for the global display of certain library parts in the 
project. (e.g. Show Opening Lines; Show/hide Door handles)
Model View Options will vary depending on the loaded libraries, to enable specialization for  local 
requirements (e.g. scale-dependent display of window components according to local 
documentation standards). 
See Model View Options for GDL Objects.

Selected New Library Objects
Some of these objects may not be available in all localized libraries.

Pivot Door
“D1 Pivot” door leaf turns around a vertical axis that can be offset to any distance from the center.
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Sliding Folding Multipanel Door
“D Sliding Folding Multipanel” door has optional outside/inside/middle stacking. In closed position, 
access is through a panel at one end that behaves like a normal door.

Asymmetric Curtain Wall Door Panel
“CW Door 2 Asymmetric” object. Double door with asymmetric leaf width option.

Enhanced Curtain Wall Anchor Object
Possibility to place it on the frame side, and to rotate it at 0, 90, 180, 270 degrees.
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Enhanced Options for Curtain Wall Panels at Corner Positions
Mitred and butt-joint options for connecting panels.

New Steel Pan Stair
Stair stringer can be channel, tube or bar. Metal riser is optional.

Swimming Pool
Vary number of lanes (4-10) and length (25, 33 and 50 meters).

Bowling Alley
Standard competition size.
400 New Features in ARCHICAD 8-20



ArchiCAD 13 New Features
Bed Layout
Several variations for design aid, plus 3D model.

Trapezoid Bathtub 
Freely resizeable.

Space Saver Toilets
New “WC High Seat Corner” and “WC LT Corner” space saver toilets for corner positioning.
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Minimal Space for Wheelchair Access
New design aid and symbol: Wheelchair man. Define and check minimal space for disabled access; 
display it on 2D and section. Display disabled person symbol on 2D and section.
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Enhanced Automatic Dimensioning Options 
for Doors/Windows

The Automatic Exterior Dimensioning function now gives you full flexibility in defining the Door and 
Window values you wish to dimension.
New options enable you to dimension the wallhole, the reveal, the window/door unit, and/or the 
door’s egress or leaf size.
See Automatic Exterior Dimensioning.
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Fill Enhancements
Symbolic Soft Insulation
Image Fill as Cover Fill
Gradient Fill Enhancements

Symbolic Soft Insulation

New Symbol Fill representation makes it easy to model insulation in a composite or complex 
structure, including curved elements, and ensures proper display of the insulation, even as the skin 
thickness varies.
This option is available for any symbol fill, so its use is not limited to insulation: you can apply it to 
display any directional fill, e.g. when modeling wood sheathing or metal decking.
See “Orientation” at:  Composites Edit Selected Item (Composite Structures), as well as at:  
Components - Default/Selected Panel (Profile Manager) .
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Image Fill as Cover Fill

To display surfaces more attractively in 2D views, you can now apply an image fill to any Roof, Slab 
or Mesh with a cover fill.
New Features in ARCHICAD 8-20 405



ArchiCAD 13 New Features
Gradient Fill Enhancements

• Transparent background available for Gradient fills
• Accurate output of Gradient fills in various 2D formats including PDF and DWG.
• DWG Translator option to explode Gradient fills to separate components (including the 

transparent fill background)
406 New Features in ARCHICAD 8-20



ArchiCAD 13 New Features
Slab/Roof Edge Custom Settings

To match the slope angle of the connecting building structures, you can slant a slab’s edges 
individually. For an even better match, modify the material of any slab or roof edge. 
For Roofs, you can also assign an edge type (e.g. gable, eaves, etc.) which will classify the roof for 
calculation purposes.
See Set Custom Roof Edge Angle and Material and Set Custom Slab Edge Angle and Material.
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Improved OpenGL Display for Smooth Edges 
in 3D

Sharp contour lines and improved shading colors in 3D views using OpenGL will enhance the quality 
of every 3D drawing, reducing the necessity to fine tune the images in 3rd party graphical 
applications.
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Ruler

New editing aid gives instant, dynamic feedback on cursor’s vertical and horizontal position.
• Available in every ArchiCAD window, except the 3D Window and Schedules.
• Create Guide Lines by clicking and dragging on the Ruler
See Ruler.
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Dynamic „Fit in Window” Zooming when 
Navigating Among Views 

New “Fit in Window” option in View Settings ensures that this view will always display the entire 
project contents on screen, subject to Layer status.
This setting is also applied when drawings from this view are updated or published.
See View Settings 2D/3D Documents Panel.
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Improved Find & Select

More sophisticated Find & Select interface, analogous to criteria lists for Interactive Schedule, 
enables more complex searches.
• Add multiple search values to a single criterion
• Use stored Find & Select criteria to reserve elements in Teamwork 
• Store Find & Select criteria sets locally or share them in Teamwork
See Find and Select Elements.
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Boundary Contour Options for Section/
Elevation/Interior Elevation 

Display of element contour lines at the place where they are cut by the Section boundary can now 
be controlled precisely.
Define the contour’s visibility, pen colors and line types from Section Settings.
See Boundary Contours.
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DWG Exchange
Export Multiple Layouts into Single DWG
Filter DWG Elements by Layer when Opening as ArchiCAD File
Improved Options for Saving to Custom Layers
Keep Exploded DWG Drawings on Single Layer

Export Multiple Layouts into Single DWG 

New option enables you to merge the entire Publisher Set contents into a single DWG file.
• Merge all Layout items plus the model to which they refer into a single DWG
• Resulting DWG file will contain as many Paper Spaces as the number of Layouts that have been 

used as Publisher Set items.
• Resulting DWG file will be in Paper Space, and the same translation options apply for all 

published Layouts.
See Defining Output Format.
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Filter DWG Elements by Layer when Opening as 
ArchiCAD File

Filter elements by layer to restrict DWG conversion to just the elements that you need. This 
function enables faster conversion speed and reduced file size when opening DWG file in ArchiCAD.
See “Enable Partial Open” in Open Options in DXF/DWG Translation Setup.

Improved Options for Saving to Custom Layers
Improves the quality of your projects converted to DXF/DWG, providing greater control over which 
elements and sub-elements should be assigned to their own layers.
• New Custom Layers now available in DXF-DWG Translator Setup dialog box:

- Zone Background (any visible zone cover fills)
- Zone Outline
- Zone Stamp (geometry of zone stamp)
- Zone Texts (textual content of zone stamp)

• Insert AutoText into Custom Layer name with a single click.
- While editing the Custom Layer field, click the Insert Source Layer button to insert an AutoText 
for the element’s Source Layer. This way, the name of each element’s ArchiCAD layer will 
automatically appear as part of the layer name of the saved element.

See Custom Layers (in DXF/DWG Translation Setup.)
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Keep Exploded DWG Drawings on Single Layer
This new option helps you avoid creating large numbers of unneeded layers in ArchiCAD.
If you place a Drawing in DWG format to ArchiCAD, then explode it, the Explode follow-up dialog 
includes a new option: to keep all drawing primitives on their original layer (that is, the same layer 
as the Drawing’s layer). 
See Explode into Current View.
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Improved Data Exchange with Structural 
Software
Standard Steel Column/Beam Profiles
You can access thousands of standard profiles from a worldwide industry standard profile database. 
These profiles can then be used when placing Columns or Beams.
During the data exchange process, structural engineering programs will recognize and identify such 
standard elements accurately and completely, without requiring any settings adjustments.
See Use Standard Steel Column or Beam Profile.

Define Load-Bearing/Non-Load-Bearing Structure for Construction 
Elements
Walls, Beams, Columns, and Slabs can now be defined as either Load-bearing or Non-load-bearing. 
This is useful when exchanging data with structural programs.
See Structural Property Panel in Tool Settings.
416 New Features in ARCHICAD 8-20



ArchiCAD 13 New Features
License Borrowing
License borrowing allows you to continue working in ArchiCAD with a network license, even when 
the license server is not accessible - e.g. when you are visiting the client or on a business trip.
The user can borrow a license with a single click from the ArchiCAD interface, and return it before it 
expires so that other users can access it.
• Administrator determines the number of borrowable licenses and borrowing period
• Administrator monitors who has borrowed the licenses and when they will expire
• Expired licenses stop functioning and are returned to the Server, even if the user is not 

connected to the server

See License Borrowing.
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Collaboration
Teamwork and the BIM Server
Coordination with Engineers

Teamwork and the BIM Server
Easier Portability and Remote Access
Polished Reservation Methods
Transparency and Control Over Client-Server Technology

Easier Portability and Remote Access

Take Your Teamwork Project Anywhere
All you need is a pen drive: create a Travel Pack out of your local copy of the Teamwork project and/
or libraries. Once you get to the remote computer, just plug it in and go to work: no need to access 
the BIM Server or download large data packages.
Optionally, if you do have access to the BIM Server, you can send in your changes to BIM Server 
from the remote machine too.

See “Travel Pack: Move Your Project and Libraries to a Different Computer” in ArchiCAD Help

Automatic Server Recognition for No-Fuss Remote Access
ArchiCAD now automatically recognizes and resolves the varying addresses of your BIM Server, no 
matter which address (i.e. “internal” or “external” server address) you provide.
New Features in ARCHICAD 8-20 419



ArchiCAD 14 New Features
• If you often work from alternate locations - for example, home and the office - ArchiCAD will 
automatically recognize both addresses used to locate the BIM Server.

• You will no longer run into problems with “missing” BIM Server libraries or hotlinks, even if 
many team members are accessing the project using various server addresses from different 
locations.

See “Accessing the BIM Server Over the Internet” in ArchiCAD Help.

Polished Reservation Methods

One-Click Reservation for “Single-User Mode”
“Reserve All” command  reserves all available project elements, which is practical when only a 
single user is working on a Teamwork project.
See “Reserve All Elements and Data” in ArchiCAD Help

Automatic Release of Data When Closing Project
Sometimes, users forget to release their elements and data even after they stop working on a 
project. Once these users go offline, no other team user can reserve or request those data.
This new preference helps users to routinely release their data every time they close the project.
See “Keep or Release Your Reservations with Send & Save” in ArchiCAD Help

Smarter Techniques to Find and Reserve Data
• Faster element reservation on multiple layers: use Layer Combination as a criteria, instead of 

entering layers one by one.
• When reserving by Criteria, add or remove Project Regions easily
• Better feedback on reservation conflicts involving Navigator item settings
• Colored workspaces extended to Schedule windows
• Reserve all IS Scheme Settings from Schedule window
• Easily reserve all elements of a schedule: use the Schedule as a reservation criteria
• Reserve individual elements directly from Interactive Schedule to edit them immediately
See “Reservation in Interactive Schedules” in ArchiCAD Help

Centrally Defined User Colors
Each Teamwork user has a unique color which is, by default, uniform on all client machines, 
regardless of project. When using Colored Workspaces, every client will see the same colors, 
making it easier to communicate.

Teamwork Face to Face
Every user-specific Teamwork interface now features the user’s uploaded photo: Info Tags, user 
lists, messages... have fun!
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See Define User Image and User Color.

Transparency and Control Over Client-Server Technology

Modular BIM Server
Offices running several projects in different ArchiCAD versions need a BIM Server that serves all of 
them. Version 14 introduces the “Modular BIM Server” to achieve this safely and efficiently.  The 
Modular BIM Server serves as many ArchiCAD versions as the number of its modules. Managing  the 
Modular BIM Server is just as simple as having a standalone BIM Server.

See “Modular BIM Server” in ArchiCAD Help

Monitor Server Activities
For Server Administrators: Continuous monitoring of BIM Server’s performance and memory, to 
assist decisions on hardware/software needed for optimal server performance
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See “Server Activities” in ArchiCAD Help
For Project Administrators: view Project Settings and User Settings for project-level feedback on 
each user’s activities involving the BIM Server.
See Monitor User Activity by Project and “List of User’s Recent Project Actions” in ArchiCAD Help
For standard user: Verify specific project actions using the Project Log.
See “Project Log” in ArchiCAD Help

Transparent Local Data Management
User can easily access information on his/her local copy of the Teamwork Project and libraries  
(“Local Data”), including:
• which projects he/she has joined
• which projects contain unsent changes
• the amount of disk space occupied by each project’s Local Data
User can delete any project’s Local Data if it is no longer needed, assisted by ArchiCAD’s automatic 
reminders.
See “Get Feedback on Local Project/Library Data” in ArchiCAD Help
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Direct Import/Export of Projects, Users and Roles Among BIM Servers
Straightforward transfer of Projects, Users (including User Settings), Role Settings and Custom 
Properties from one BIM Server to another. Use this feature:
• to make backups of BIM Server data
• to move data to another BIM Server when upgrading machines
• to ensure that data modified on one BIM Server is synchronized with similar data on another 

BIM Server
See Export Teamwork Project, Export Users and “Export Roles” in ArchiCAD Help

More Feedback on Network Processes and Interactions
• Better feedback on ongoing and completed Teamwork operations involving server activities
• ArchiCAD sounds now include Teamwork interactions (e.g. messaging “beeps”)

Coordination with Engineers
Model-Based Data Exchange
Drawing-Based Data Exchange

Model-Based Data Exchange
Engineers and architects, who use a variety of specialized applications, increasingly rely on model-
based collaboration to interact with each other. Working with model databases ensures more 
accurate calculations and more effective change management.
To ensure that ArchiCAD users can exchange model data with any other application, ArchiCAD  
bases its model-based coordination features on the IFC standard of data exchange. ArchiCAD 14 has 
renewed its IFC features to make the collaboration process easier and more efficient.

Definition of Structural Elements within ArchiCAD
Enhanced Model Exchange
Direct (IFC-Based) Revit MEP/Structure Link
Reference-model Version Tracking
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Definition of Structural Elements within ArchiCAD

Element Classification for More Accurate Model Mapping
Element Classification extends ArchiCAD construction element data by adding three properties that 
are key to accurate model exchange:
• IFC Element Type: Ensures precise mapping of ArchiCAD elements to IFC element definitions. 
• Structure Type: Define element as being either part of the building structure or not. (Replaces 

“Structural Property” add-on from ArchiCAD 13.)
• Position: Define element as being either an external or internal part of the building, to 

streamline coordination with energy analysis applications.
These parameters are now integral parts of the Virtual Building, and so can be used with Find & 
Select and the Interactive Schedule.
See “Classification” in ArchiCAD Help

Other Improvements
• Column Veneer: Define a component type for Column veneer: either “Finish”, “Core” or 

“Other”. This way, you can use Partial Structure Display to show your columns without their 
finish-type veneers, as a way to limit the model to its structure-only parts.

See “Display of Column Core and Veneer” in ArchiCAD Help
• New “Core of Load-Bearing Elements Only” Option for Partial Structure Display: With this 

option, you can limit the Virtual Building to just its load-bearing components. Then, when you 
save it as an IFC model for a structural engineer, you will export only the needed parts of the 
project.

See “Partial Structure Display” in ArchiCAD Help

Enhanced Model Exchange
The procedure for exporting and importing an IFC model from ArchiCAD has been streamlined:
• Export or import specific parts of the model with advanced filtering options: by selection; by 

element type; by discipline; etc.
• Optionally export 2D elements, including annotations and text
• Support for Zip compression of IFC files (useful for compressing large models to be emailed)
• Improvements in saving Grid System to IFC, for better interpretation by other applications
• For big-project IFC experts: manage additional IFC data irrespective of elements’ Teamwork 

reservation status
• Other usability improvements: Save as IFC from 3D Window; accurate interpretation of rotated 

profile elements, rotated columns, and door frames; IFC building material converted to 
ArchiCAD fill.

See “Working with IFC” in ArchiCAD Help
• Save your configured IFC exchange settings as a translator, or use out-of-the-box translators 

specially configured for particular applications, such as Tekla Structures.
See IFC Translators.
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Direct (IFC-Based) Revit MEP/Structure Link
• Use ArchiCAD’s preconfigured translators optimized for exporting model data to Revit MEP and 

Revit Structure
See IFC Translators.
• Add-in for Revit Structure: This free downloadable add-in for Revit, developed by GRAPHISOFT, 

helps map architectural and structural models through the IFC-based export/import process 
between Revit Structure and ArchiCAD.

See Autodesk Revit Structure.
• Add-in for Revit MEP: Use this free downloadable add-in when importing Revit MEP elements to 

ArchiCAD, which will correctly interpret them as MEP Modeler elements (provided that a MEP 
Modeler license is available).

See Importing MEP Data via IFC.

Reference-model Version Tracking
When external consultants modify their own model and provide it in IFC format, ArchiCAD 
automatically compares the current and previous versions of the IFC model, and displays these 
differences in the context of the architectural model.
Due to this automatic version tracking, you can be sure that you are notified of each and every 
model change. Model-based, on-screen change management makes it easier to handle all iterations 
with the Mark-up interface.
The same feature lets you identify changes in the different versions of your own architectural model 
exported to your partners.
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See “Compare 3D Models (Model-Based Exchange)” in ArchiCAD Help

Drawing-Based Data Exchange
Despite their increased reliance on model-based data exchange, architects and engineers still rely 
on each other’s CAD drawings to use as a reference in their respective models. The following 
features improve the export and import of DWG files in ArchiCAD:
• New options in Drawing Tool Settings enable you to control a drawing’s visibility based on the 

layers of the linked file, independently of the project’s layers. This way, you can place a DWG in 
your project without importing all the source file attributes, yet still control the visibility of its 
layers.

See “Embedded Layers” in ArchiCAD Help
• Support for DWG formats used by all Autocad 2010-based applications
• Other usability enhancements:

- Save Marquee area as DWG: save only the parts you need from the window
- When opening XREF file, filter the imported drawing by layer (Partial Open)
- XREF Manager shows feedback on translator used by each XREF file
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General Productivity Improvements
Easy Offset Functionality
Better Accessibility and Feedback for Input Constraints
Dimension Text Prefix and Suffix
Expanded Find and Select Criteria
Easier Selection of Trace Reference
Use Any Number of Layers in Composite Elements
Shadows in Open GL
Improved Interaction in Schedules and Project Index
Streamlined Export of Interactive Schedule into Excel
Layout Book Improvement
Keep Revised Versions of Published Items
Convert Surveyor’s Data into ArchiCAD Mesh
Improved Page Setup for PDF Output

Easy Offset Functionality
• Easier access: Offset command available from Pet Palette from any part of selected polygon, as 

well as from Edit menu.
• Extended functions:

- Create multiple element copies (Ctrl/Opt) while using Offset
- Offset multiple selected elements simultaneously

See “Offset Selected Element” in ArchiCAD Help

Better Accessibility and Feedback for Input Constraints
• Offset Constraint commands are now accessible from the toolbar
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• Icon of the currently selected constraint method is displayed with the cursor during input, so 
you always know which type of constraint you are using. (This is especially useful if you use 
shortcuts to switch between methods.)

See “Offset and Multiple Offset Constraints (Relative Construction Methods)” in ArchiCAD Help

 Dimension Text Prefix and Suffix
• Add prefix and/or suffix as custom text to any dimension, using regular or superscript-style text. 

The measured dimension value will remain associative even after you add a custom text.

See “Edit Content of Dimension Text” in ArchiCAD Help
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Expanded Find and Select Criteria
Use new text parameters to:
• Find elements by the text in the element’s associated label
• Find text blocks by their content
• Search for part or all of text content
See “Find and Select Text Blocks/Labels” in ArchiCAD Help
Use new criteria to find and select “problematic” elements so you can fix them:
• Find elements by missing attributes
See “Find and Select Elements with Missing Attributes” in ArchiCAD Help
• Find elements referring to missing library parts
See “Find and Select Missing Library Parts” in ArchiCAD Help

Easier Selection of Trace Reference
Changing the window’s Trace Reference has become easier. Just access the “Choose Reference” 
dialog box, using “Browse for Trace Reference...”, from wherever you are working: the window’s 
context menu, the Trace Palette, or the menu.

See “Browse for Trace Reference” in ArchiCAD Help

Use Any Number of Layers in Composite Elements
The emphasis on sustainable architecture has introduced new complex building sructures with an 
extended number of layers. Now you can model these structures accurately as composite elements, 
which can contain up to 48 layers (up from previous limit of 8 layers).
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Shadows in Open GL
Shadow casting now available with Open GL 3D Engine, for better results in 3D.

Improved Interaction in Schedules and Project Index
Use familiar spreadsheet-editing techniques to work in Schedule and Index windows:
• Use Tab/Shift+Tab to navigate right and left among Schedule and Index fields; use Enter/

Shift+Enter to navigate up and down.
• Cell-based scrollbar helps you navigate while editing multi-line texts
Other usability improvements:
• Cell selection in Schedule window now highlights both the row and column, since both can be 

affected by your format changes.
• New “Subset Name” and “Subset ID and Name” fields are available for Project Index. Your 

Drawing Index can now be organized to reflect the subset-based hierarchy of the Layout Book. 

Streamlined Export of Interactive Schedule into Excel
• Save as Excel format supported on MacOS as well as Windows
• Export graphics and text formatting from Schedule to Excel for wysiwyg results
• Save as .xls file even if you do not have Excel installed on your computer

Layout Book Improvement
New layouts added to the Layout Book are now appended to the bottom item in the tree or the 
folder - so that the numbering of your existing Layouts remain unchanged. Similarly, new views are 
now appended to the bottom of the View Map.

Keep Revised Versions of Published Items
Often, you may need to output a Publisher item multiple times to keep pace with revisions. You may 
wish to keep the older published files as a record.
As of ArchiCAD 14, the file name of each output Publisher item is identical to the name of the 
Publisher item itself. This means that if you output a Publisher item, and later rename it to reflect a 
new revision, you can re-publish it under the new name, without overwriting the previously output 
file, as was the case in older ArchiCADs. 
Feedback on the publishing process now includes each published item’s file location.
See “Revisions of Publisher Items” in ArchiCAD Help

Convert Surveyor’s Data into ArchiCAD Mesh
Use new command (Design menu) to import any text file containing xyz data (e.g. surveyor’s data) 
into ArchiCAD, creating a Mesh element automatically.
See “Surveyors’ data (.xyz)” in ArchiCAD Help
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Improved Page Setup for PDF Output
Scaled drawings, including those with header or footer, are printed from PDF correctly.
New Features in ARCHICAD 8-20 431



ArchiCAD 14 New Features
Libraries
Enhanced Library Management
New Library Content

Enhanced Library Management

Keep the Objects You Need, Eliminate Obsolete Libraries
A single click allows you to place project-specific objects where they belong: in the Embedded 
Library, while getting rid of old libraries from which you have placed only a few objects. Just select a 
library in Library Manager and click  “Embed Placed Library Parts”. All objects from this library that 
have been placed in the project are moved into the Embedded Library; the original library is 
removed.
The Embed Library Parts function
• puts project-specific objects into the Embedded Library, so they are always available for the 

project
• helps reduce the number of the project’s duplicate library parts, by removing one of the 

libraries, while keeping the objects you need
• speeds up library loading time, since you have fewer libraries to load
See “Embed Placed Objects from a Library” in ArchiCAD Help

Streamlined Migration of ArchiCAD Libraries
If you have added more than one linked ArchiCAD Library to your project, ArchiCAD provides an 
easy one-click method of consolidating them. The automatic migration process makes sure that you 
have loaded the newest ArchiCAD Library, and will replace older ArchiCAD libraries with their much 
smaller “migration” versions, so that you have everything you need, yet nothing superfluous.
The same consolidation process is available for BIM Server Libraries, once you have loaded the 
migration libraries you need to the BIM Server.
See “Consolidate ArchiCAD Libraries” in ArchiCAD Help

Avoid Library Conflicts and Missing Library Parts
ArchiCAD will provide more detailed  information about loaded libraries and objects: 
• For each library: how many elements and which elements have been placed. With this 

information, you can decide whether you need a particular library.
• For missing library parts: the name of the unavailable library and its last known location - 

helping you  to locate it. 
• For duplicated objects: which library parts are causing the conflict - helping the user to decide 

which library, or which object should be removed from the project.
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• “Ambiguous” objects have several possible sources - these are identified, so you can choose the 
version you need and avoid conflict.

See “Troubleshooting Library Issues” in ArchiCAD Help

New Library Content
New Library Parts
Redesigned Library Parts
Library Parts Expanded with New Features
Door-Window Developments

New Library Parts
New library parts, listed by their folder location in the ArchiCAD library:
Basic Library / Furnishing / Office Equipment:
• Projector
• Projector Screen
• iMac
• MacMini
• MacBookPro
• MacPro

Basic Library / Furnishing / Chairs:
• Office Chair 05
• Office Chair 06
• Designer Stool
• Designer Chair 11
• Designer Chair 12
• Stool
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Basic Library / Furnishing / Retail Furniture
• Umbrella Holder
Basic Library / Furnishing / Cabinets and Shelves
• Flexible Shelf

Basic Library / Furnishing / Couches and Sofas
• Designer Couch
Basic Library / Furnishing / Beds
• Hospital Bed
Basic Library / Mechanical / Plumbing Fixtures
• WC for the Disabled
• Bath Free-Standing

• Wall-mounted Tap
Basic Library / Furnishing / Bathroom Accessories
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• Commercial Toilet Paper Dispenser
Basic Library / Mechanical / Plumbing Fixtures
• Mop Sink
Visualization / People and Vehicles / People
• Woman Sitting

• Man Sitting 1, Man Sitting 2
• Man on Bicycle, Woman on Bicycle

Redesigned Library Parts
Existing library parts that have gotten a face-lift to bring them up to date:
Basic Library / Furnishing / Office Equipment 
• Copier
• Plotter

• Laptop
• LCD Monitor
• PC
• Apple Mouse
Basic Library / Furnishing / Chairs
• Designer Chair 03
Visualization / People and Vehicles / Vehicles
• A new car in each automotive category (e.g. pickup)
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Basic Library / Mechanical / Elevators and Escalators
• Elevator: replaces the old Elevator 01-03 objects with unified and amended functionality

Library Parts Expanded with New Features
Objects listed here have been extended with new properties or options.
Basic Library / Furnishing / Chairs
• Lounge Chair: new types
• Chair 03: new types
Basic Library / Furnishing / Cabinets and Shelves
• Office Cabinet 01: new drawer combinations, new interface
Basic Library / Furnishing / Tables
• Office Desk L1, Office Desk L2, Office Desk Rect: new accessories (leg, partition, front panel, 

cabinet) and UI

Visualization / People and Vehicles / People
• People Bitmap: new pictures
Basic Library / Furnishing / Cabinets and Shelves
• Lockers: leg and additional door type options

Door-Window Developments
New Reveal and Wall Closure Settings
Settings for Reveal and Wall Closure are now separated on the interface, so that these two settings 
can now be set independently.
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Independent Reveal and Wall Closure settings 
on the General UI tab

The new Reveal UI tab page
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You can set the following combinations of reveal and wall closure options:

The No Reveal - Edge option allows the placement of doors and windows directly on the outer 
surface of the wall, with no reveal depth.
The Turn Plaster option was moved to Closure settings. The user interface was restructured for the 
better understanding of the parameters. A remark was added to warn the user that wall skins that 

Turn Plaster Traditional Prefabricated Custom

No Reveal-Edge yes yes yes yes

No Reveal yes yes yes yes

Reveal yes yes yes yes

Negative Reveal yes yes yes yes

Slanted Reveal yes no no yes

Splayed Reveal yes no no yes

Historic Reveal yes no no yes

Custom Reveal yes no no yes

The new Wall Closure UI tab page

Splayed Reveal with Custom Closure
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are wrapped as plaster skins will be turned outside of the wall contour defined in the reveal 
settings. A new checkbox was added to the Turn Plaster parameters to display the wrapped plaster 
skin on the 3D model.
To understand how the Turn Plaster option works, here are two examples. In most cases and 
countries, the wrapped plaster skin shouldn't modify the nominal reveal/wallhole size of the doors 
and windows, so these skins are turned outside the wall contour, as can be seen on the following 
picture:

However, if the user wants to wrap the outer skin inside the wall contour, it can be done with the 
Custom Closure option:

Until now, the Turn Plaster option only worked on the 2D symbol. As of ArchiCAD 14, Turn Plaster 
can be also switched on for the 3D model.

Note 1: If the plaster skin  is enabled for 3D, it will appear also in Section - but as part of the wall, 
not as an independent skin.
Note 2: A plaster skin is never wrapped on the side of the wall where a casing, sill or board is 
placed.

Plaster skin wrapped with the Custom
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New and Updated Doors

• D1 Sliding Folding Multipanel
• D2 Sliding Folding Multipanel
• D1 Garage 3

Basic Windows: New opening types
Formerly, the main sashes of all windows in the Casement Windows folder only had the Side Hung 
opening type option. In the AC14 Library, these sashes have the following opening types: Side Hung, 
Side Hung Mirrored, Bottom Hung, Top Hung, Tilt-Turn, Tilt-Turn Mirrored, Reversible.
Consequently, the names of the library parts were also changed from "Casement" to W1, W2 etc. 
and the Casement Windows folder was renamed to Basic Windows.
440 New Features in ARCHICAD 8-20



ArchiCAD 14 New Features
New Sunshades

New Shutter types:
• Folding
• Outfolding
• Sliding
• New sunshade
• Rolling Shutter

Minimal Space for Doors
The minimal space display can be switched on for all doors of the standard library.
This feature can be activated in the library-specific Model View Options dialog box.

The Minimal Space setting tab page of the D1 

The Minimal Space setting tab page of the D1 
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Performance
The following is a list of specific performance improvements achieved in ArchiCAD 14 as compared 
with ArchiCAD 13.
These results are based on tests performed on more than a dozen real projects provided to 
GRAPHISOFT by the ArchiCAD user community. Because test results vary widely depending on the 
nature of the project, test results are shown here as a typical range, rather than as an average. In 
some cases, performance results were strongly correlated with particular project characteristics; we 
have noted these where applicable.

Faster Generation of Door/Window Schedules
On average, generation and update of door/window schedules are 15-40% faster than in ArchiCAD 
13.
When using complex listing criteria - when you add “Additional Parameters” to the fields of the 
Schedule Scheme - performance has increased even more dramatically: long (120 sec) interactions 
have speeded up dramatically (to 5 sec).

Faster Library Reload
Faster library reload on projects which contain sections and details: the more sections/details, the 
greater the performance improvement.
Our tests produced speed improvements ranging from 25%  to 500%, compared to ArchiCAD 13.

Immediate Feedback on ArchiCAD Startup (Windows)
With earlier versions of ArchiCAD, it was possible that a user started ArchiCAD on a PC, but 
receiving no feedback from the operating system, the user would start it up a second time.
With ArchiCAD 14, a splash screen appears immediately upon startup, to reassure you that the 
program is being loaded.
(Since there was no such problem on MacOS, whose dock provides immediate feedback on the 
program’s startup, feedback on MacOS remains the same as before.)

64-Bit BIM Server Available on MacOS
Now the GRAPHISOFT BIM Server can take advantage of the capabilities of your 64-bit server on 
MacOS as well as Windows. The 64-bit version of the GRAPHISOFT BIM Server can handle much 
more memory than the 4 Gigabytes of the 32-bit server. This results in better performance, 
especially if your server is hosting  numerous large projects. 

Faster IFC Handling
Working with IFC-format models has become faster. Opening an IFC file is now 10-50% faster; saving 
an IFC file is 10-35% faster.
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ArchiCAD 15 New Features Guide
Design Freedom
Interactions
Renovation
Integrate with Engineering
Library
Performance
Customer Experience Improvement Program
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Design Freedom
Roofs
Shells
Enhanced Model Element Connections 
Skylights

Roofs

Multi-Plane Roof: a Single Element with Maximum Flexibility
• Easily create a complex roof that includes multiple planes and several roof levels.
• Complex roof element remains an integrated whole and never falls apart.

See Create a Multi-plane Roof.

Integrated Editing of Roof Geometry
• Edit the roof geometry as a whole: all parts of the roof change in concert.
• Edit any plane of the roof separately, or move any roof ridge: all connected roof planes will 

adjust accordingly.
• Edit roof contour uniformly for entire roof, or separately for any part of it.
• Use familiar pet palette commands for easy polygon editing.
See Editing Roofs.
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Custom Modeling of Individual Roof Planes
• Individualize any Roof plane to model specialized details: change the pitch or make it a gable; 

change its material, fill or eaves overhang. The whole Roof remains a single, coherent element.
See Customize Roof Plane.

Add Special Roof Features Easily
• Create an Atrium with a pet palette command.
See Create an Atrium.
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• Create a Gable out of any roof plane with a single click.
See Gable Roof.
• Create a tower from a curved roof plane.
See Add a Tower to the Roof.

Shells
This versatile new tool lets you create a wide variety of shapes. Use the Shell to model elements, 
ranging from a building’s entire exterior, to a single custom object.
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Easy Creation of Shell Geometries
• Create a Shell using one of three basic geometries:

- Extrude a Shell between any two points in space.
- Create a Revolved Shell
- Make a Ruled Shell between hand-drawn profiles on any two planes in space
- In the 3D window, define Shell height graphically by placing it anywhere you want
- Fine-tune the Shell parameters as needed

See About Shells.

Graphical Editing for Full Design Freedom
• Edit Shell profile graphically in any window: extrude, distort, tilt, rotate or revolve the Shell to fit 

your needs.
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• Freely define the Shell outline by drawing its contour by hand.
• Add skylights, fitting them smoothly to a flat or curved surface.
• Create holes of any shape in any part of the Shell.
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• Customize any edge of the Shell.
See Graphical Editing of Shells.

Accurate Geometric Display on the Floor Plan
Shell display on the Floor Plan reflects its real geometry in 3D.

Flexible Classification
Classify Shell as e.g. Roof or Slab for listing purposes or for export to structural programs.
New Features in ARCHICAD 8-20 449



ArchiCAD 15 New Features Guide
Enhanced Model Element Connections

Associative Connections for Integrated Model Editing
If you modify any element, all connected elements will be modified too. For example, if you change 
the pitch of a Roof, any connected Walls will be trimmed automatically.
See Model Element Connections.

Precise Element Trimming with Shell/Roof
Trim model elements to Roofs and/or Shells, regardless of their complexity, so even many complex 
shapes fit together the way you need them. The graphical interface gives you full control over the 
trimming process.
• Automatic trim for standard trim results: By default, ArchiCAD automatically trims selected 

Shells and Roofs to each other, then uses the resulting structure to trim off the overlap from the 
other selected elements. The result: just what you would expect.

• Create special trim geometries: For more complex situations, trim any model element to a 
specific Roof or Shell, while deciding which parts of the trimmed element should stay, and which 
should go. Color feedback guides you each step of the way.

• Display the trimming body to see exactly what will be trimmed and how.

• Edit the trimming body to shape the trim the way you need it.
• Merge trimming bodies of separate Roofs/Shells. This way, the entire Shell-Roof complex of a 

large building structure can act in concert when trimming other elements, such as the walls that 
run the full length of the building.

See Trim Elements to Roof or Shell.
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In-Place Feedback and Management for All Connections
• No more “hidden” connections: for any element, see a list of which elements it’s connected to 

via:
- Roof/Shell Trims
- Solid Element Operations
- Wall/Curtain Wall Connections

• Use the connection list to select any connected element, or to clear a connection.

See Managing Element Connections.

Skylights
Skylights have been improved in ArchiCAD 15.
• Skylights easier to place: ArchiCAD automatically places them smoothly into curved or flat Roof 

plane or Shell.
• Skylights associative to the “parent” Roof or Shell: they adjust automatically when Roof or Shell 

geometry changes.
• Skylight interface similar to that of Doors and Windows; Model View Options apply to Skylights, 

which also have a dedicated Marker object.
• Skylight display on Floor Plan based on 3D projection.
See Skylights.
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Interactions
3D Editing Plane for Accurate Element Placement
More Sophisticated 3D Feedback
Guide Line Improvements

3D Editing Plane for Accurate Element Placement
In the 3D window, the new editing plane gives you a sense of where you are in the model. The 
result: you can place or modify elements in the 3D model more accurately and easily.
• Place new elements onto a visible plane, instead of into “mid-air.”
• Use Guide Lines in 3D for precise placement.
• Grid lines, Snap grid and Rotated grid available in 3D window.

 
• Move the editing plane to a more logical position, or change its orientation, and use it to help 

define element position through precise numeric input in the plane’s coordinate system. For 
example, you may need to draw an opening of a particular size, as measured on a horizontal 
plane, onto a slanted roof plane. Redefine the input plane to be horizontal, then use the Tracker 
to define the hole measurements you need. See the result projected onto the Roof plane.
452 New Features in ARCHICAD 8-20



ArchiCAD 15 New Features Guide
 
• Project the points of elements outside of the editing plane onto the editing plane - horizontally, 

vertically or perpendicularly, as needed. For example, when drawing a roof opening, you can 
project the outline of an existing Wall horizontally onto the targeted roof plane.

See Editing Plane in 3D Window.

More Sophisticated 3D Feedback
• Get a feel for position of selected items in space: Selected items in the background don’t “jump 

forward” as in previous ArchiCADs.
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• Find reference lines easily for graphical editing: In 3D views, special editing lines (e.g. Wall 

reference line, Roof pivot polygon) are now shown in their own specific colors, so you can pick 
them out right away.

• Coordinate axis feedback: Coordinate axes display main (X, Y, Z) directions.

 

Guide Line Improvements

Easier Guide Line definition
Guide Lines appear automatically during input, so you can choose one on the fly and keep working.
• Guide Line on any edge: Click the Guide Line handle to activate it.

BEFORE (ArchiCAD 14) AFTER (ArchiCAD 15)
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• Guide Line at any point: At any point status, press and hold the mouse button to see Guide 

Lines. Choose one, then continue where you left off.

 

Drag or Delete Guide Lines
• Click and drag to move a Guide Line to a more useful location. (Or use the Tracker to define its 

new location numerically.)
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• If you are done with a Guide Line, just move the cursor to its handle and press Esc.

Better Guide Line Feedback 
• Automatic yellow highlights alert you to main directions (e.g. input parallel or perpendicular to a 

Guide Line).
• Automatic feedback on X and Y axes help you stay on track - especially useful in 3D perspective 

views.

Guide Lines in the 3D Window
• Guide Lines appear on the new 3D editing plane.
• 3D Guide Line remains visible and its status points available even as you navigate around, and 

even if it ends up in a “hidden” location.
• To suggest perspective, the line type of a Guide Line will vary as it recedes into the distance.
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Simpler Guide Lines Settings
Now that you choose your Guide Lines while you work, there are only 4 Guide Lines settings in the 
Work Environment (instead of 13).
See Guide Lines.
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Renovation
Element-level Definition of Renovation Status
• No need to create extra layers: just set a default Renovation Status (Existing, New, To Be 

Demolished) for all element types.

• Switch Renovation Status of any/all selected elements with a single click.
See Assign Renovation Status to Elements.

Renovation Related Plan Types Out of the Box
• Renovation Filters available out of the box (e.g. Existing Plan, Demolition Plan, New 

Construction).
• Renovation Filters show, hide, or override elements depending on their status.
• Switch among Renovation Filters to display the project at various renovation stages.
• Redefine or create new Renovation Filters to fit your office standard.
• Views and drawings graphically communicate the Renovation process.

Existing Plan Demolition Plan After Demolition
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See Renovation Filters.

Graphical Highlighting of Elements by Renovation Status
• Assign an override style (color, fill, line type) to highlight elements by status (e.g. demolished or 

new).

• Overrides automatically appear as defined by the current Renovation Filter.
• Customize override styles to match your office standards.
See Override Styles.

Simple Export of Different Plan Types
• Saving in DWG: Elements can be automatically sorted onto different layers depending on their 

renovation status.
• Saving in IFC: WYSIWYG logic prevails: if the element is shown in the current Renovation filter, 

then it is exported to IFC. If it is hidden, then it is not exported.

New Construction Planned Status
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Integrate with Engineering
With a more straightforward, logical IFC interface, ArchiCAD 15 continues to ease the process of 
model-based IFC exchange with other disciplines.
Easier IFC Property Management
New Features of IFC Import/Export

Easier IFC Property Management

IFC Properties as Native ArchiCAD Parameters
• Better performance: Since IFC data no longer needs to be synchronized with ArchiCAD data, the 

Settings dialogs open faster.
• Access and edit IFC parameters directly from Element Settings (not just from IFC Manager).

• Show only the parameters you need: display just the core properties, or display all the derived 
and standard properties too.

• Build the IFC database easily as you work with model elements in ArchiCAD, since IFC properties 
are included in:
- the Project template file
- Favorite element settings
- Parameter transfer (Pick Up/Inject Parameters)
- Copy/Paste operations

• Elements saved as a module (.mod) file.
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• Better support for the “reference model” workflow: when you open an IFC project and hotlink 
its elements to another ArchiCAD project, all IFC parameters are retained.

• More properties available to ArchiCAD elements, even independently of model exchange. For 
example, use the standard IFC Fire Rating property for an ArchiCAD wall.

• Use Undo to reverse an incorrect IFC property assignment.

More Accurate Assignment of IFC Parameters for Library Parts
• Convert ArchiCAD library parts parameters to IFC properties based on conversion rules. This way 

you can ensure that, for example, a door’s fire rating parameter will automatically be converted 
to the right IFC property.

• Edit these custom properties by object.
• Conversion rules can be saved and re-used for subsequent export and import processes.
• Export all used library part parameters as part of the IFC model with a single click.
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More Powerful IFC Manager

• Displays IFC elements by type as well as by containment structure.
• Displays the (custom) converted library part parameters as well as standard IFC properties.
• Displays sub-element relationships in logical groups: for example, all constituent parts of a Stair 

are grouped together in the ArchiCAD model and in the IFC Manager.
• Select any listed element in 3D as well as 2D.

Effective IFC Data Handling in Teamwork
If you reserve an element in Teamwork, you can now modify its IFC parameters without having to 
reserve IFC data, and without requiring any special access rights.

Improved Localized Text Handling
• Localized texts in IFC files are transferred correctly to different platforms (Windows/Macintosh) 

or machines with different localized versions of ArchiCADs.
• Export to IFC supports Unicode characters, for smoother interchange of data that includes 

special characters.
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New Features of IFC Import/Export

Story-Mapping
When merging an IFC project, you can define the ArchiCAD story to which the imported IFC model 
data should be mapped - just like in ArchiCAD’s PLN Merge.

Simplified Model Export
If your purpose in model exchange is to display model geometry - such as in a viewer or in an MEP 
program - now you can use the simplified BREP (boundary representation) geometry export option. 
The result: perfect geometric display of element intersections and Solid Operations, without 
including all element properties and data.

Improvements in Detect IFC Model Changes
• The Detect IFC Model Exchange workflow now allows you to choose and edit the preferred 

translator as you go.
• Better management of Model Changes entries in the Mark-Up palette: multi-select entries for 

deleting and zooming.
• Distinguish the modified elements coming from the newer- and older file versions: the older-

version’s modified elements are shown with the “Corrected” style, while the newer-version’s 
modified elements are shown as “Highlighted”.

Improved Merge to IFC Function
The entire architectural model or a part of it can be added to an existing IFC file while keeping its 
original content; existing model elements will not be overwritten. This way you can insert your 
architectural model into a consultant’s IFC file (e.g. MEP or structural model) and see them side by 
side.

Renovation
Elements’ renovation status are saved as part of IFC data, in a custom property set. Renovation 
status is also taken into account after merging the IFC data back to ArchiCAD.
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Library
Easier Library Migration
New and Enhanced Objects
Door/Window Enhancements

Easier Library Migration
When you migrate a project to ArchiCAD 15, new features ensure that your ArchiCAD library parts 
will also be migrated to use the latest available versions.

Automatically use latest library part versions
If you consolidate your older ArchiCAD libraries (13 or 14) with the ArchiCAD 15 library, placed 
objects from the older libraries will automatically be replaced with their latest compatible version in 
the ArchiCAD 15 library.

Backward compatibility supported for library parts
When back-saving your ArchiCAD 15 project to version 14, any library parts that were revised for 15 
will be automatically replaced by their original counterparts in version 14.

Avoid duplicates when embedding objects
You may wish to embed a particular library’s placed objects into your project. Now you can ensure 
that you won’t embed objects that already exist in other, linked libraries, by using this new Library 
Manager feature.

New and Enhanced Objects
New Objects Supporting Sustainable Design
New Objects Supporting Hospital and Health care Design
More Modern Furnishings
More Contemporary Sanitary Objects
Boats

New Objects Supporting Sustainable Design

Basic Library / Mechanical / On-site Renewable Systems
• Rain Water Tank
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• Solar Collector Evacuated Tube
• Solar Photo voltaic Panel
• Wind Turbine Household
• Wind Turbine Industrial

New Objects Supporting Hospital and Health care Design

Furnishing / Medical Equipment
• Bedside Cabinet
• Dental Chair
• Examination Bed
• Hospital Bed
• Infusion Stand
• Medical Cart

Wind Turbine Evacuated Tubes
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More Modern Furnishings

Basic Library / Furnishings / Cabinets and Shelves
• New object: Modular Wardrobe

Basic Library / Furnishings / Office Equipment
• New object: Office Partition Panel

Dental Chair Bedside Cabinet

Modular Wardrobe
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Basic Library / Special Constructions / Fireplaces and Stoves
• New object: Built-In Fireplace
• Fireplace Freestanding - new types

More Contemporary Sanitary Objects

Basic Library / Mechanical / Plumbing Fixtures / Bathtubs, Showers, 
Jacuzzis
• New object: Shower Cabin

Basic Library / Mechanical / Plumbing Fixtures / WC, Bidets, Urinals
• New object: Urinal 04

Basic Library / Mechanical / Plumbing Fixtures / Partitions
• New urinal type in the Commercial Bath Stall object

Shower cabin
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Basic Library / Mechanical / Plumbing Fixtures / Basins
• New object: Multi-Basin Counter

Basic Library / Mechanical / Plumbing Fixtures / Taps
• New types among the Tap and Wall Mounted Tap objects

 Basic Library / Mechanical / Plumbing Fixtures / Sinks
• More sink types in the Belfast Sink object

New urinal with partitions

New taps
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Basic Library / Furnishing / Kitchen Cabinets
• More sink types in the Cabinet Belfast Sink objects

Boats

Visualization / People and Vehicles / Vehicles
• Three sailing boats and a motorboat

New Cabinet Belfast Sink

Motorboat
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Door/Window Enhancements
Door Enhancements
Window Enhancements

Door Enhancements

New Doors
• Twelve new doors with raised sidelight on one or both sides
• New industrial garage doors: High-Speed Door and High-Speed Roll-up Door

Other Door Developments
• Frame for pocket doors

Window Enhancements

Basic Windows: New and Updated
• Basic Window folder restructured to follow a more logical system
• New parametrization logic for shape definition, sash type selection and opening options.
• Former W1 Hdiv and W2 Hdiv windows are incorporated into the new W1 and W2 windows. 

(Your older W1/W2 Hdiv windows will be migrated automatically.)
• Window names (W1, W2...) reflect the number of sashes divided by frame mullions

Other New Windows
• New sliding window: W4 Horizontal Sliding

The new W3 window
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• Six new historical windows

The ne

The new Historic Window Triple Arched
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Performance
Improving performance is an ongoing priority. In ArchiCAD 15, we have achieved the following 
performance-related improvements over ArchiCAD 14.

64-bit ArchiCAD on MacOS
ArchiCAD for MacOS is now a 64-bit program. Starting with ArchiCAD 15, only the 64-bit version is 
available for MacOS.
ArchiCAD users on MacOS can now take advantage of the increased memory management offered 
by 64-bit technology. Enjoy greater speed even when working with extra-large, extra-detailed 
models. If your larger models ran into slowdowns on the 32-bit program, you will now see a definite 
speed improvement, given sufficient memory. 

Supersafe Autosave
The improved Autosave function provides 100% data safety: your changes are continuously saved in 
the background as you work.
Unlike the earlier Autosave function, all data modifications are now instantly saved into a 
background project. Thus, in case of a blackout, system error or other crash, ArchiCAD can retrieve 
the very latest state of your project. Autosave works on the same “delta logic” principle used by the 
GRAPHISOFT BIM Server, making it so speedy as to be unnoticeable, even with large-scale projects.

Accelerated IFC Usage
Enjoy definite performance improvements when using IFC format for model-based exchange.
The IFC data parameters assigned to model elements are now saved using a new technology. You 
will notice that the following functions work faster: 
• modifying IFC data in the Element Settings or the IFC Manager dialogs
• exporting model elements to IFC format
• importing IFC building models into ArchiCAD

Optimized BIM Server 
The BIM Server’s internal processes have been optimized. For you, this means:
• A single BIM Server will manage multiple projects more efficiently, because running the Server 

takes up less memory than before
• Send and Receive response time is slightly faster, because the BIM Server’s internal processes 

have been speeded up
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Customer Experience Improvement Program
At GRAPHISOFT, we strive to create a product that is easy to learn and meets our users’ real needs. 
Consequently, we strive to involve our users in our development process, via surveys, usability tests 
and other research projects. 
Given the size of our user base, we could not include all users in this process, until now. As of 
ArchiCAD 15, we have created the Customer Experience Improvement Program (CEIP) to allow 
every user to contribute to improving ArchiCAD. While ArchiCAD is running, the CEIP works in the 
background to gather information on how users interact with the program, without affecting 
ArchiCAD’s performance. 
GRAPHISOFT will use the resulting statistics as part of its product design process, with the aim of 
improving the user experience. Participation in this program is voluntary and anonymous. More 
details are available on the GRAPHISOFT home page: http://www.graphisoft.com/.
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ArchiCAD 16 New Features Guide
Design Freedom - Morph Tool
Integrated Energy Evaluation
Productivity Enhancements
Integrate with Engineering

Design Freedom - Morph Tool
Create freeform elements directly in ArchiCAD - so you don’t have to import special shapes from 
other programs.
The Morph has no geometric limitations: every edge and every surface can be moved and shaped in 
any direction, so you can create exactly the element you need to fit project-specific situations.
Graphical interface uses familiar methods and interactions: select any edge, grab any point or 
surface, or any combination of their sub-elements, to modify the Morph with the help of the pet 
palette and real-time feedback.
The Morph is a full-fledged ArchiCAD element that appears in all ArchiCAD views and lists, and can 
be classified for export to structural programs.
Design Unique Elements
Transform Existing Elements
Graphical Editing for Full Design Freedom
For more information, see Morphs.

Design Unique Elements
• Dedicated tool for creative geometries: model whatever you like from scratch, without an 

overload of parameters
• Create a solid body or surface by extruding one or more points, edges and/or surfaces along any 

path in space or revolving around an axis 
• Transcend the limits of library parts: form object-like elements with curved and sloped surfaces 

to fit your specific space, without having to learn GDL programming
• Fine-tune texture display for any Morph surface
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Unique furniture

Built-in furniture
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Conceptual modeling 

Specialized railing
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Quick modeling of project environment 

Model load-bearing elements and consoles in detail

Transform Existing Elements
• No need to create a brand-new Morph: Select one or more existing elements, and transform 

them into a Morph
• Using graphical editing, create unique geometric variations that are not supported by element 

parameters 
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Transform Wall to Morph, Change Edge Angle

Graphical Editing for Full Design Freedom 
• Extrude, stretch, fillet from any point or surface
• Draw a polygon on element faces, then push to create a hole
• Use geometrical smoothing to achieve soft surfaces
• Use permanent Boolean operations to transform the Morph or any of its sub-elements 
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Integrated Energy Evaluation
ArchiCAD’s new Energy Evaluation tool is an easy way to produce a reliable, quick snapshot of your 
building’s energy efficiency level. This native ArchiCAD function is specifically designed for use at an 
early design phase - when cost-saving design strategies can still be effectively compared and 
implemented.
Energy Evaluation is designed for architects: no specific sustainable design training is needed.
Building Energy Analysis on Projects of Any Size
Produce Quick Energy Evaluation Report
Use Evaluation Feedback to Optimize Building Design
For more information, see Energy Evaluation.
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Building Energy Analysis on Projects of Any Size

Design the basic building envelope and internal spaces, then put the 
Energy Evaluation tool to work:
• ArchiCAD 16 turns the architectural building model directly into a building energy model, 

utilizing the state-of-the-art automatic model geometry analysis function - a new benchmark for 
accuracy in energy simulation geometry data.

• Automatic model analysis turns the architectural building model into a single Thermal Block 
energy model 

• Opaque and transparent elements of the building envelope and internal structures are 
automatically listed with their relevant properties 

• A single ArchiCAD element is automatically split into several parts depending on its position (e.g. 
underground vs. above-ground parts) if necessary, in order to generate precise energy 
calculation input

• Multiple energy model visualization options
• Possibility to communicate the ArchiCAD building’s simplified geometry to third-party, locally 

compliant, stationary energy calculation tools in Excel format
• Possibility to export the ArchiCAD building’s second-level space boundary geometry data to 

external energy simulation software via IFC

Building energy model - Structures view                   Space boundary category

Assign Additional Data to the Building Energy Model from Extensive 
Built-in Lists- No Specialized Knowledge of the Topics Below is Required:
• Physical properties of structures and openings 
• Levels of self-shading and different shading devices
• Environmental settings: soil type, surrounding surfaces, wind protection, external shading 

conditions
• Operation profile (e.g. day-to-day building usage) with at-a-glance visualization 
• MEP systems: basic heating, cooling, hot water generation and ventilation methods
• Green systems: solar collectors, air-to-air energy recovery and heat pumps
• Primary energy and CO2 emission factors 
• Local prices of energy source
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Operation Profile dialog box

Climate Data Access and Visualization
• Import analytic weather data files
• Obtain gridded climate information from the online weather server

Produce Quick Energy Evaluation Report 
• Certified VIPCore engine calculates hourly building energy balance for a one-year period, in next 

to no time
• Advanced dynamic energy simulation technology (e.g. surface-based calculation of heat flow 

through underground structures)
• Energy Evaluation Report displays detailed graphical and numerical feedback on energy-related 

structural performance, yearly energy consumption, carbon footprint and monthly energy 
balance
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Energy Performance Evaluation Report

Use Evaluation Feedback to Optimize Building Design
• Use Report data to optimize design parameters (e.g. building area/orientation, fenestration, 

shading, composites, glazing ratio, green strategies) in order to minimize energy consumption 
and carbon footprint
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Productivity Enhancements
Easier Access to More Library Parts
Improved Custom Creation of Library Parts
Improved 3D Editing
Easy-to-Use Rotate Command
Better Project Location/Project North Definition
Expanded Project Info Dialog Box
Expanded Teamwork Backup Options
Assign Thermal Properties to ArchiCAD Fills
Faster Hotlink Updates
Library Enhancements
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Easier Access to More Library Parts
Access to GRAPHISOFT’s new web-based BIM Components Portal (BIMcomponents.com), plus an 
improved search function, ensures that you can quickly find and use the exact object your project 
requires.

Improved Search Function: Find Library Parts Faster
• More intuitive Search function (in Settings dialog box of Object-type tools) finds library parts in 

all your project’s active libraries - including linked, embedded and BIM Server Libraries
• Engine searches not just among library part names, but also their parameter names and 

descriptive texts
• The same Search function also finds library parts on the Internet, through the BIM Components 

Portal

For more information, see Search for Library Part.

New BIM Components Portal for Direct Access to GDL Objects 
• Search on BIMcomponents.com directly from ArchiCAD to access thousands of GDL objects - 

including international, country-specific objects not included in the ArchiCAD library of your 
own language version 

• See a preview and view instant information on the found library parts
• One-click Download and Embed command brings the object from the web straight into your 

project library
• Join the BIMcomponents.com community to evaluate and recommend objects
• Optionally share your own custom objects on the BIMcomponents.com

For more information, see BIM Components Portal.
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Improved Custom Creation of Library Parts
In ArchiCAD, you can save construction elements as custom GDL objects - like windows, doors, and 
their components (such as a customized door knob).
Now in ArchiCAD 16, custom creation of library parts is simpler and more logical:
• All model-based library parts can be saved from the Floor Plan as well the 3D window
• Library parts saved from the 3D window can now use any 3D projection, instead of only 

dedicated directions
• All of these functions are conveniently grouped under a single menu: File > Libraries and 

Objects > Save Selection as.
• Define the new library part’s default Materials, Fills and Pens. After placing the library part, you 

can further fine-tune these attributes in Object Settings. (In previous versions, custom objects 
included only the attributes of their source elements with no possibility to change them in 
element settings.)

For more information, see Graphic Creation of Custom Library Parts and Components.

Improved 3D Editing
These handy improvements take the guesswork out of 3D input.

Input Elements Anywhere in 3D Space
Even before you start the input:
• You can offset the Editing Plane and thereby reset the default element elevation - with every 

construction tool
• Projection line to the Editing Plane is shown immediately
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• Place new Objects not just at their default elevation, but at any clicked point: such as a surface 
(e.g. wall, tabletop), or other snap point

Snap to Surface in 3D Window
As of ArchiCAD 16, your cursor will snap to any surface (as well as edges and points) in the 3D 
window - for easy input among elements in space.

Move and Elevate in One Step
• Use the Drag command to move a selected element to any point in space (not just on the XY 

plane)

• The Z-direction Guide Line is available to constrain the move to be perpendicular to the Editing 
Plane

• Lock input to Editing Plane (use Shift or the Lock to Plane command)

Better Editing Plane Controls
• Easier access to plane-switching buttons
• New “Next Plane” option lets you cycle through context-specific planes
• Zoom-sensitive gridlines: as you zoom in, additional automatic gridlines appear on the Editing 

Plane
486 New Features in ARCHICAD 8-20



ArchiCAD 16 New Features Guide
New “Smart Cursor” Variants
These new variations for the familiar ArchiCAD “smart cursor” help make precise input even easier: 
• Surface
• Edge meets a surface
• Edge meets a surface at a 90 degree angle
• Two surfaces meet
• Two surfaces meet at a 90 degree angle

Improved 3D Feedback for Split Command
• Red cutting plane in 3D shows where the element will be split
• For Morphs, use a cutting plane at any angle (not just vertical)

Easy-to-Use Rotate Command
• Now all elements use the same, single Rotate command, with new fun feedback that looks like a 

protractor

• Shells, Curtain Walls and Morphs can be rotated around any axis in the 3D window space - 
(known as the separate “Free Rotate” command in earlier versions) - to do this in ArchiCAD 16, 
just use the plain Rotate command
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Better Project Location/Project North Definition
Define the project’s geographical coordinates more accurately in the new Project Location dialog 
box.
• Use the Project Location dialog box (instead of the Cities dialog box) to set the exact project 

location with a precise latitude and longitude; click built-in link Google Maps to get coordinates 
and see your location

• You can still set an approximate project location by applying a predefined City (also available 
from the Project Location dialog box)

• Define Project North here, either numerically or by turning the arrow graphic
• Define a Project Altitude relative to Project North; optionally use the Altitude value as a fixed 

Reference Level in Project Preferences, available in all dialogues that refer to a Reference Level
• Save all location data in an xml file for easy import/export to other projects
• Use Project Location dialog for easy access to Project Info data (Project Name, Site Address)
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Define Project North Within the Building Model
• A new function makes it a snap to define Project North right in the project. In either Floor Plan 

or the 3D window, use the Options > Project Preferences > Set Project North command
• Click in the project, then drag the cursor to define Project North

For more information, see Project Location and Project North.

Expanded Project Info Dialog Box
• Project Info contains many new data types - like the new “Full Address” fields, for Site, Architect 

and Client alike, whose data entry interface has all the room you need
• List of data types has been reorganized into three transparent categories for easier management

For more information, see Project Info.

Expanded Teamwork Backup Options 
Two backup formats - the new PLN backups plus the familiar BIM Project Backups - are now 
available, so you can keep working in case of emergency, even if your BIM Server stops working for 
any reason (e.g. hardware problem, power outage).
Combine the BIM Project backups and PLN backups to find the right balance for the backup strategy 
in your office.
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Use BIM Project Backups to Quickly Restore BIM Server Data
• BIM Project Backups also contain all BIM Server-related information (such as user data and 

roles); users can resume working as soon as the backup file is restored to any BIM Server, 
without the need to re-add users or re-define roles

• BIM Project Backups are created and managed by the server - no user interaction needed
• By default, a new BIM Project Backup is created every hour - re-set the schedule to fit your 

company’s needs

Use PLN Backups to Restore Data in ArchiCAD
• A PLN-format backup of your Teamwork project contains your model data only
• If your server stops for any reason, yet you need to keep working while the server is restored, 

open this PLN file as a solo project, using any current or future version of ArchiCAD
• The PLN Backup process, which utilizes a client’s computer, is quick and fully automatic, apart 

from the need for the client confirmation
• By default, PLN backups are created daily - re-set the schedule to fit your company’s needs

Easy Recovery of Both Backup Formats
Both types of Teamwork backups are listed in Project Settings.
Restore BIM Project backup file: 
• Use Rollback to restore the file on the same BIM Server, then keep working 
• Download the BIM Project backup file to any location, then restore it to a different BIM Server
• Use Server Manager to import or export the BIM Project backup file to any other BIM Server
Restore PLN Backup file:
• Download the file, then open it in any current or future ArchiCAD client version
• Re-share the file from ArchiCAD once the server is running again

Automatic Backups of Additional Server Data 
• Backups of Teamwork User/Role data are created automatically by the BIM Server whenever 

data are modified
For more information, see Backup Teamwork Project.

Assign Thermal Properties to ArchiCAD Fills
• For defining Cut Fill types, the Fill Types dialog box now has a new tab page for Thermal 

Properties 
• These properties are used in the new Energy Evaluation function
• While all the Cut Fills provided in ArchiCAD have predefined properties, you can still define any 

other Cut Fill and assign thermal properties to it as needed, so you don’t have to open and edit 
an XML file

• Access the comprehensive Material catalog from Fill Types
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• Click to choose the desired material and assign its thermal properties

For more information, see Fill Thermal Properties Panel.

Faster Hotlink Updates
Hotlink updates are faster in the following situations:
• Single-story hotlinks updated from the same source file
• Update of modules in Teamwork, whose source file is also a Teamwork project

Library Enhancements
General Library Developments
Furniture
Lamps
Plumbing Fixtures
Building Structures
Other objects
Streamlined Label Options
Story Sensitive Display of Library Parts
New Door/Window Folder Structures and Names
Rationalization of Door and Window Objects
Window Improvements
Door Improvements
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General Library Developments

Descriptions
All library parts are accompanied by a short text description to aid in searching and identification.

New Preview Pictures
All objects in the following folders have new rendered previews: Beds, Chairs, Couches and Sofas, 
Tables, Cabinets and Shelves, Kitchen Cabinets.

Furniture

New and Improved Objects Support Office Design
Three new library parts support the efficient design of large office workspaces in 3D:
• Office Workstation Solo
• Office Layout Island
• Office Layout Linear
The following library parts were enhanced for the same purpose: 
• Office Desk L1 / L2 / Rect
• Office Cabinet 01-02

Options of the new Office Layout Island 16 library part

Lamps
New and merged lamp types accommodate a better graphical interface and a wider range of 
geometry options: more shapes and shade types to choose from, more options for lighting setup.
• Pendant Lamp: Incorporates former Hanging Lamps 01 through 04
• Ceiling Lamp: Incorporates former Mushroom Fixture Lamp
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New shade types of the Ceiling Lamp 16 library part
• Wall Lamp: Incorporates former Wall Lamps 02 through 05
• Fluorescent Lamp: Incorporates all former Fluorescent Lamps except Fluorescent Wall lamp)
• Spotlight Kit: 

- The old library part of the same name has been replaced by a new, modular, configurable 
lamp

- The old geometry is available as one option in the series of selectable new geometries
• Wall Spotlight: The old Wall Lamp 01 object is extended by functionality similar to that of the 

Spotlight Kit object

Some mount types of the Spotlight Kit 16 library part

Plumbing Fixtures
• WC

- A single, flexible object, the WC 16 library part incorporates all the options of eleven 
separate WC variations from the ArchiCAD 15 library. Moreover, the choice of types is now 
even wider:

- New floor-mounted and wall-hung bowl types were added
- New cistern types and in-wall carrier were added
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New bowl types of the WC 16 library part
• WC Corner

- This library part involves the following old objects: WC High Seat Corner, WC LT Corner
- This WC object also includes new cistern types

Building Structures
• Metal Web Joist: New library part

The dimension settings of the new Metal Web Joist 16 library part
• Profiled Sheet: This library part, which includes new profiles, merges the following old objects: 

Corrugated Sheet Inc, Corrugated Sheet Vert, Profiled Sheet Inc, Profiled Sheet Vert

Other objects

Railings and Fences
All railings and fences have a new and improved interface for easy parameter assignment.
494 New Features in ARCHICAD 8-20



ArchiCAD 16 New Features Guide
The new Dimension settings UI tab page of the railing library parts

People 2D Symbols
All 2D people symbols now have a 3D version, mainly for use in sections/elevations.

Bollard
New bollard shapes are available as part of the Parking Place object, as well as the Parking Stall and 
Parking Places Polyline (USA library only).

Simplified Taps
New simple styles were introduced to decrease 3D model size.

Electrical symbols: ganged switches, duplex and quad receptacles
USA Library only.
Revised, corrected and improved 3D for US electrical symbols.

Coordinate Object
The library part displays the x,y,z coordinates of its insertion point; coordinates are also available for 
listing.

Zone Stamp 2
New, advanced zone stamp with scale sensitivity.

Streamlined Label Options 
The old tool-specific labels have been merged into just two library parts:
• Structure Label: involves the features of the old Wall, Roof, Slab and Shell Labels
• Dimension Label: involves the features of the old Object, Beam and Column Labels
New Features in ARCHICAD 8-20 495



ArchiCAD 16 New Features Guide
Story Sensitive Display of Library Parts
The following library parts, which typically can appear on more than one story, now have the option 
for different displays by story. These are the following: 
• Steel Frames
• Downspouts
• Ladders
• Hoods
• Escalator
• Moving Walkway (New object)

   

The story sensitive display of the ladder objects

New Door/Window Folder Structures and Names
• Doors and Windows are now organized in new folder structures that reflect the operation type, 

shape and functionality of the openings
• All doors and windows have new, clear names without abbreviations

Rationalization of Door and Window Objects
• To reduce the number of library parts, many openings having the same or similar functionality 

(operation type) were merged and in many cases improved, without any loss in features
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• The eliminated library parts are seamlessly migrated to their AC16 successors
For a complete list of changes, see Door and Window Migration.

Window Improvements

Improvements for Special Windows
• Multiple opening types are now available for special windows (where needed)
• Special windows now have the same user interface tabs introduced earlier for basic windows: 

Shape, Sash Options, Opening, Frame and Sash

New Opening Types for Basic Windows
All basic windows (except for double sash windows) have the following new opening types: Double 
Sash, Sliding, Sliding Mirrored, Double Sliding, Double Sliding Mirrored, Single Hung, Double Hung.

Variable Frame Widths
All windows (where needed) can now use a different frame width on each side.

The frame width settings of the Double Window

New Sash Type
Fixed Sash is available for all windows.

Reveal Improvements
The bottom reveal type can be set separately from the reveal on other sides of the window. 
Available bottom reveal types: No Reveal, Reveal, Negative Reveal, Slanted Reveal, Historic Reveal, 
Custom Reveal.
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Door Improvements

New Doors
• Arch Sliding Door with Transom 16
• Sliding Door with Transom 16

 
The new Sliding Door with Transom 16 library part

• Double Egress Door - US only. New door with double egress opening type and special frame 
profile

The frame settings tab page of the new Double Egress Metal 16 door

New Sash Types for Sidelights
New sash types are available for sidelights: Divided and Panel.

New Opening Types for Sidelight and Transom Sashes
The following new opening types are available for all sidelight and transom sashes: Fixed Sash, 
Double Sash, Pivot, Sliding (horizontal), Single Hung.
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Double door with reversible sidelight and bottom hung transom sash

Handle types
Handle type selection was revised for all doors. New handle types are available in most doors, and 
certain unnecessary handle types were eliminated, where applicable.

Pocket Frame
Frame can be selected for the pocket (in-wall) part of the door, and displayed in 2D windows and 
schedules.

Storefronts
Storefront doors were updated to achieve the same functions as other doors:
• Nominal Sizes and Tolerance options were added, enabling the same dimensioning methods as 

other doors
• User Interface is now similar to other doors 
• The parameter “Door/Window belongs to the Zone into which it opens” was added for 

scheduling purposes

Casing with Rolling Shutter
• A Rolling shutter placed behind the façade can now use inside and outside casing, on both sides 

of the frame
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Rolling shutter with casing
• Set Shutter Width for Decorative Shutter
• Decorative shutter’s width can be set separately from the window width

Integrate with Engineering
IFC Improvements
Smarter DXF/DWG Data Exchange

IFC Improvements
Usability Improvements for Easier IFC Property Management
Support for Multiple IFC Standards
Extended IFC Database
Improved Site Geometry Import
Better IFC Performance

Usability Improvements for Easier IFC Property Management
IFC properties can be very numerous - including custom parameters, built-in parameters, and those 
you have imported into your project from another program. Though the IFC database in ArchiCAD is 
becoming more sophisticated, now it’s easier to manage it all:

Use Find & Select on all IFC Properties
• Search for any IFC property, just like ArchiCAD properties
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• List IFC properties in the Interactive Schedule
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View Only the Data You Need

For a better overview of data in IFC Manager, you can display IFC properties for just those elements 
on visible layers. Thus, if your project contains both structural and MEP models, you can edit the IFC 
properties of each model separately within the IFC Manager - you don’t have to sift through all the 
data at once.

Save Custom Property Schemes for Easy Transfer Between Projects
Once you are done defining custom IFC properties in one project, you don’t have to start over again 
in a new project.
• Save all custom properties as a Scheme in an .xml file 
• Export and merge custom properties file between ArchiCAD projects: all the custom-defined 

properties (without their values) are recreated in the new project, without overwriting any data

“One-Click” Custom Property Assignment to All Elements
Save time and trouble with the option to assign a custom property to all elements of a given type, 
or to all elements in the project.

Quick Property Editing
Rename or delete custom properties one by one.
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Support for Multiple IFC Standards
ArchiCAD supports IFC 2x3 Coordination View. This built-in and default standard is the most widely 
used IFC standard (Model View Definition).
In addition, you can export IFC data to comply with other IFC standards.
Define Custom Properties and other definitions (e.g. Classification Reference, Space Occupant and 
Actor) using formats which comply with:
• U.S. GSA standards such as OmniClass and UniFormat
• Norway’s Statsbygg
• Finland’s Senate Properties
• Japan’s buildingSMART and others

Extended IFC Database
To allow your exported data to comply with these additional standards, the IFC interface in 
ArchiCAD includes the following new data types: 

New Assignments: Space Occupant and Actor
• New ways to group elements in IFC Manager: the “Space Occupant” and “Actor” assignments 

(alongside the existing “Group” and “Zones”) allow for more detailed definition of individual 
zones, buildings, stories, and building elements

• Required for compliance with many IFC standards

Classification Reference for Elements and Zones

• Optionally add a Classification Reference to all ArchiCAD elements and Zones, so that your 
exported IFC data complies with standards such as GSA

• Assign Classification Reference in either element Settings dialog boxes or the IFC Manager
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• Built-in Data Rules for Automated, Standard-Specific Definition

• When defining a Classification Reference, choose among the built-in, predefined rules, 
depending on the standard you have to use. Just click on a rule - the required data fields are 
added automatically

• You can also custom-define Classification rules in XML format. Use these rules to automatically 
classify or define properties for selected project elements

Access to IFC Data 
• IFC properties and attributes can now be queried through the ODBC interface
• 3rd party developers can also extract, create and modify IFC properties and attributes on the 

ArchiCAD API interface

Improved Site Geometry Import

Filter Imported Sites to Limit File Size
If data contains multiple sites, choose to import just the site(s) you need.
Or you can choose to import no site at all.
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Smarter Import of Site Geometry

 
IFC Sites are now imported to ArchiCAD as Morphs, rather than GDL objects. The result: 
• More accurate geometry: editable Morph with perfect site geometry can be converted from all 

type of geometry representations of IFC Site (BREP, Surface Model, Geometric Set)
• More flexibility: the resulting Morph element is freely editable in graphical form

Better IFC Performance
The possibility to import sites as Morphs (rather than objects) improves performance, since Morph 
generation is faster. This means:
• Faster IFC import (about 20%)
• Faster IFC model handling

Smarter DXF/DWG Data Exchange
These developments improve roundtrip data exchange using DWG/DXF file formats:

Preserve Original Data 
If you import DWG blocks to ArchiCAD and then re-export them without editing, you can check the 
option to store the original blocks, so that unmodified DWG blocks remain intact.
This way, consultants working in ArchiCAD can edit parts of the imported DXF/DWG file, then export 
it back without overwriting the unchanged blocks. (In earlier versions, new DWG blocks were 
created at the end of a roundtrip, even if those parts of the project had not been modified.)
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Preserve Original Block Positions
The original insertion points of blocks in the ACAD model are preserved even after a roundtrip with 
ArchiCAD: the revised blocks will be inserted in the same position as their original starting-point.

Smarter Handling of Zone Data
• Zones exported from ArchiCAD are interpreted more intelligently in the DXF/DWG file
• As GDL objects, the zone stamps are now converted to blocks separately from other parts of the 

zone
• This way, identically structured zone stamps will constitute a single block, resulting in fewer total 

blocks created in the DXF/DWG file; smaller file size; and more efficient editing of the zone 
stamp blocks

Smart DWG Export of Rotated Views 
When you export a Layout that contains a Drawing originating from a rotated ArchiCAD view, the 
model will appear in DWG Model Space in its unrotated form; but the DWG PaperSpace viewpoint 
will show the model in its rotated form.
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ArchiCAD 17 New Features Guide
Modeling
Workflow
Open BIM
Energy Evaluation
Library Enhancements
ArchiCAD Performance Improvements
Integrated ArchiCAD Help Center
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Modeling
Automatic Model-Based Junctions
Link Element Height to Stories
Core-Based Reference Line
Curved Beam
More Intuitive Element Creation in 3D Window
Anchor Door/Window Reveal to Wall Core

Automatic Model-Based Junctions
Ability to configure all construction elements so that when they intersect or collide, their display 
accurately and automatically reflects their construction - particularly in section views, used as the 
basis for detail drawings. Most of the junctions of a section will look correct up to 1:50 scale.

Priority-Based Connections Available for All Construction Elements
• Extend priority-based connections (formerly available only for walls on the floor plan and to a 

limited degree in section) to all construction elements and composites, and column/beam 
profiles, in all model views, via the Building Material. Separate intersection priorities can be set 
for column veneer and core.

• A revised interface simplifies these priority settings to make their input easier and the results 
more predictable.

See Element Intersections.
508 New Features in ARCHICAD 8-20



ArchiCAD 17 New Features Guide
Other Improvements for Better Intersections
• Eliminate common contour lines where construction elements meet, subject to Building 

Material
• Represent the T/L/X connections between walls based on their actual skin/component based 

connections.
See Specific Element Intersections and Junctions.
• Symbolic representation of connections of any (normal/profiled) vertical columns and non-

polygon walls on Floor Plan 
• Improved dimensioning of structural components in section view - e.g. place dimensions at 

contour lines or separator lines, or at boundaries of core/finish skins 
• More flexibility for displaying cut surfaces in Section views (consistent with 3D Document)

• Snap to composite separator or any visible edge in 3D as well as Floor Plan
• View results of skin-based connections in 3D
• Helping modeling interactions for Junctions: better manual editing options and new automated 

junction command from the Edit menu: Adjust Elements to Slabs 
See Adjust Elements to Slabs.
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Link Element Height to Stories 
Enable the height of walls, columns and zones to be linked to a particular story: when the story 
position changes, the heights of the linked elements are automatically adjusted. This way, you do 
not have to manually adjust element heights every time the story height changes.
See Define Top Link for Wall, Column or Zone.

    
• Use a built-in Find and Select criteria set to locate any inverted elements (e.g. with a negative 

height) with a single click. Such elements are also highlighted on the plan for easy locating.
See Inverted Elements.
• You still have the option to input a fixed height, and to define a base elevation to a given 

reference level
• Option to retain or ignore toplinks in Hotlinked Modules 
• Door/Window sills and headers can be linked to the top of the wall, not just to the bottom
See Sill or Header Heights.
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Core-Based Reference Line 
• For walls and slabs: Option to assign a reference line-plane not just to either side of the wall, but 

also to either side of the wall’s core skin, or to the top/bottom of the slab core.
This way, when the user edits the wall or slab (e.g. adds skins or changes the thickness), the 
wall/slab core connections remain constant, and the elements' positions relative to their 
reference line remain unchanged.

For example, walls can join slabs by connecting to the slab core, rather than the top of the slab 
finish. This feature is also useful when slabs are used for another purpose (such as a ceiling): the 
reference level can be placed at the slab bottom, rather than the top.

See Wall Reference Line and Slab Reference Plane.
• Use the new Modify Wall Reference Line/Slab Reference Plane dialogs (replaces Wall Extras) to 

relocate reference line/plane without moving the geometry. 

See Modify Wall Reference Line and Modify Slab Reference Plane.
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Curved Beam
Use the Beam tool to create beams that are curved on a horizontal plane. Thus, beams can serve as 
support structures along curved walls. Such wall/beam intersections are automatically shown 
correctly in sections (no need for solid element operations to represent them).

More Intuitive Element Creation in 3D Window 
In the 3D window, element input takes place at the elevation at which you click; the input plane 
snaps to the corresponding story level in space. (The “current story” option for defining element 
location in 3D is eliminated.)
In 3D window and in Section, use graphic feedback and snap to story level when editing element 
elevation. 
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Anchor Door/Window Reveal to Wall Core
Anchor the Door/Window reveal to either the Wall face or the Wall core. 
For example, you anchor a window to a composite Wall’s core. If you later make changes in the 
composite structure (e.g. thicker insulation), the reveal depth is automatically adjusted, to maintain 
the window’s distance relative to the Wall’s core skin.

See Anchor Reveal.
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Workflow
Building Material
Easily Editable 3D Cutting Plane
Improved Door/Window Placement
Enhanced Composite/Profile Workflow
Floor Plan-Based 3D Document
Improved Zone Creation and Editing
Smarter Attribute Management
Better Management of Hotlinked Modules
PDF/A Support
Export ArchiCAD Model to STL Format
Integrated Connections with Google Earth, Sketchup
One-Step Renovation Status Update for All Elements
Conceptual Design
Improved Tool Settings Interface
Duplicate Elements in Section

Building Material
The new “Building Material” attribute, which combines cut fill, surface material, priority, physical 
properties and pens, is defined globally, then applied to any construction element, simplifying the 
user interface and allowing the same cut fill to be used consistently throughout the model.
See Building Materials.
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• At element level, pens and surfaces can be overridden as needed, including for Profiled 
elements.

• Improved visualization of Building Materials on Composite and Profiled Structures in 3D
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Easily Editable 3D Cutting Plane
• Define 3D cutaway sections of the model graphically, using one or more cutting planes in any 

location.
• Instead of setting controls in a dialog box, simply drag an icon to create graphical cutting planes 

in the floor plan, Section or 3D window, then drag/rotate/move these planes into place to 
define and limit the 3D model view.

See 3D Cutting Planes.

Improved Door/Window Placement
New intuitive feedback removes the guesswork when you are placing a new opening into a Wall. 
Ghost previews of each option let you know exactly what you are going to get in terms of:
• opening location
• anchor point
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• reveal side
• opening direction
Even while you are placing the opening, you can switch any of these options on the fly.

See Placing Doors or Windows.

Enhanced Composite/Profile Workflow
• Select any Composite or Profile element in any view, then right-click to access the relevant 

Composite or Profile Settings directly.

In Composite Settings:
• Simplified UI consolidates all settings within a single table format
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• Drag skins to change skin order
• “New” command creates a simple 1-skin composite
• All Line Types now available as separators, including Symbol line types
• Updated Preview shows Surface color as well as Cut Fill
In Profile Manager:
• Simplified UI, smaller palette save “screen real estate” when fully open
• “New” and “Duplicate” commands require naming the profile before creating it
• “Apply” correctly applies the stored profile to selected element.

Floor Plan-Based 3D Document
With a single click, create a 3D Document based on the Floor Plan: a section view, based on a 
horizontal cut plane in the Floor Plan window. Define the projection by setting a cut plane height 
and the projection direction either upwards (toward the ceiling) or downwards (to the floor). This 
type of 3D Document shows the cut part of the model, including sections of vertical structures (e.g. 
walls, openings). Interface and settings are based on the 3D Document.
This is useful, for example, to display the load-bearing structures on a slab plan, or as a reflected 
ceiling plan. Use it also to create shaded Floor Plan views for presentation/interior design.
• Create 3D Floor Plan using single command
• Filter content by Marquee, cutting planes, and element type
• Save document as view; print or place on Layout
• Dimension 2D elements on ceiling plan
• Show hidden lines
• Option for Reflected ceiling-type view
• Model-based element display (including Solid Element Operations)
• Options for display include cut and uncut attributes, contours, true 3D vectorial hatching, 

shading, shadow and sun effects
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See Create a 3D Document from the Floor Plan.

Improved Zone Creation and Editing

New Zone input methods
New Rectangle/Rotated Rectangle options when drawing a manual zone.

Keep Zone Area Fixed while Editing
Use new “Fixed Area” option in pet palette to offset the Zone in a way that keeps its area 
unchanged.
New Features in ARCHICAD 8-20 519



ArchiCAD 17 New Features Guide
Smarter Attribute Management
After migration to ArchiCAD 17, using file merge or working with hotlinks, you may need to get rid 
of the unneeded attributes (e.g. layers, line types, fill types). A new workflow for attribute 
management helps save you time and prevent costly mistakes, allowing you to safely delete and 
replace attributes:
• Delete and Replace: When you delete an attribute, define which attribute should replace it 

throughout your model - in one step (available for Building Materials, Line Types, Fill Types, 
Composites, Profiles, Surfaces, Zone Categories)

• Delete Layers and Move Elements: If you delete a layer, you now have the option to move its 
elements onto a different layer (instead of losing those elements forever)
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Better Management of Hotlinked Modules
Now you can define a custom Master ID to every Hotlinked Module instance.

• For example, if your hotlinked module is a hotel room, then R213 would be the Master ID for 
the 13th room hotlink on the second floor. 

Once this instance is placed in the host file, its Master ID is assigned to every element of that 
Hotlinked Module, as an extension of their element ID: the original element ID is kept, but is 
extended based on the Master ID of the hotlink.

• For example, the element ID of the room sink (original element ID: SINK16) is now changed 
to R213 SINK 16.

As a result, all elements have unique IDs, yet for Hotlinked Module elements, their IDs remain 
protected from editing in ID Manager.
As an additional benefit, Zone handling is much easier. If you define your Zones in the source file of 
the hotlink, its Zone ID will be extended by the Master ID of the module instance they belong to: 
this way, Zones in a Hotlinked module can each have a unique ID. 
Thus, you can define Zones once in your source Hotlink module, rather than afterwards in the host 
file.
Optionally, connect the Zone ID with its Zone Number to display this information in the Zone Stamp.

• For example, a Zone with an ID of Bathroom in the source file is placed into the host file as 
part of a HLM with a Master ID of R213. Its Zone Number will then be R213Bathroom.

PDF/A Support
As of ArchiCAD 17, it is possible to save or publish views, layouts, publisher sets or the entire project 
in PDF/A format, a standard format for archiving purposes.
This feature uses PDF Technology powered by PDFTron.
See PDF Options.
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Export ArchiCAD Model to STL Format
Support for STL file format (Stereolithography) is built into ArchiCAD 17: you can directly save the 
ArchiCAD model as an STL file. An STL file carries only the surface geometry of a 3D model, divided 
into triangles, without any additional information (e.g. color, material).
You can also open or merge an STL file directly to ArchiCAD.
The format is usually used for rapid prototyping, 3D printing, and computer-aided manufacturing. 

Integrated Connections with Google Earth, Sketchup
• Open or merge models from Google Earth (.kmz) or Sketchup (.skp) directly into ArchiCAD, or 

save the ArchiCAD models in either of those formats: the related add-ons are now fully 
integrated in ArchiCAD and require no extra downloads

• Use File > File Special > Send Model to Google Earth for a one-step viewing experience
• When merging a model to ArchiCAD, the user can choose between using the imported location 

coordinates, or retaining ArchiCAD’s Project Location data and placing the new data relative to 
these coordinates

• If you only need the location data, you can import the location data stored in the .kmz or .skp 
file straight into your ArchiCAD model by using the Project Location dialog box

One-Step Renovation Status Update for All Elements
When a renovation project is finished, you will need to update all elements’ renovation status: for 
example, those that were “To be Demolished” can now be deleted; those that were “New” are now 
“Existing”.
 In earlier versions, this process required several rounds of Find & Select, and 2D elements, such as 
annotations, had to be updated viewpoint by viewpoint. Now you can do all this with a one-step 
workflow that is intelligently and flexibly applied to all elements in all views, including your 
annotations. The Reset Renovation Status command (Document > Renovation menu) lets you 
globally update (or delete) elements by status, or leave them unchanged - speeding up your 
Renovation workflow, leaving no element forgotten.
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Conceptual Design
New Morph scheduling features support conceptual design and mass modeling. 
List the volume and area of Morphs separately by story (even as the multi-story Morph remains a 
single element). 
These data provide valuable input at the conceptual stage about the useful area of the planned 
project.

Bruttorauminhalt (GER, AUT versions only)
This feature enables the automatic generation of a building volume report which complies with the 
(German) DIN 277 and the (Austrian) ÖNORM B 1800 standard. 
The workflow involves using Morphs to conceptually model the building as a whole. In Morph 
Settings, each Morph is assigned a category (A, B, C or undefined), which corresponds to a building 
structure type, as defined in the standard specification. The user then runs the BRI command to 
generate the standard-compliant report.
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Improved Tool Settings Interface
• Updated user interface for Geometry and Positioning panel of all construction element tool 

settings
• More descriptive graphics in Tool Settings, which change depending on top link and offset 

settings
• More consistent settings among all construction elements
• Coordinated and updated Info Box panels

Duplicate Elements in Section
The following element creation commands are available in section views, from the pet palette as 
well as the context menu:
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• Drag a copy/Drag Multiple Copies
• Mirror/Mirror a copy (not available for Doors/Windows)
• Multiply
• Rotate/Rotate a copy (where applicable - for Morph, Shell, Curtain Wall)
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Open BIM
IFC Improvements
Saving Elements to Common DWG Blocks

IFC Improvements
Support for Multiple IFC Standards
IFC Publishing
Other IFC-related Improvements

Support for Multiple IFC Standards

Coordination View 2.0
Complete the certification process of IFC 2x3 Coordination View version 2.0 (IFC2x3 CV 2.0) 
standard based on its export and import requirements. All other major applications, such as Revit 
Architecture/Structure/MEP, AutoCAD Architecture/MEP, Bentley Architecture, Tekla Structures, 
Vectorworks, Allplan, Scia Engineer, DDS-CAD MEP, Solibri Model Checker, are also working on this 
certification process. The result: improved model-based data exchange with these applications.

Other Model View Definitions
• Expanded capabilities for defining new IFC data requested by other Model View Definitions such 

as Concept Design BIM 2010 (required by GSA (US), Statsbygg (Norway), Senate Properties 
(Finland) and FM Handover (required by COBie, for example) and others:

• IfcSystem assignment (especially for MEP elements): group project elements in system hierarchy 
manually, by using MEP Modeler defined systems, or by importing systems from MEP 
applications 

• Define sub-system hierarchy (parent and child system): 
• Group elevators in a vertical circulation system which can be a child system of a mechanical 

system
• Assign plumbing elements to cold water sub-system of a plumbing system.

• Multilevel (“Sub”) hierarchy available for IfcZone and IfcGroup assignments.
• Group some ArchiCAD Zones (IfcSpaces) in an IfcZone (Security Zones), which is a part of a 

higher level IfcZone group (Govermental Zones)
• IfcTimeSeriesSchedule assignment: occupancy, lighting and equipment schedule assignment to 

project elements such as ArchiCAD Zones.
• Calculation and export of special base-quantities of site/building/story defined in Concept 

Design BIM 2010 MVD (required by e.g. GSA). 
• Support for all IFC Type Products, such as IfcSlabeType, IfcCurtainWallType etc. 
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• Editing of IFC data (renaming, new properties, classification etc.) on element types/styles (e.g. 
IfcDoorStyle)

• Lining and panel properties (including operation type) of doors and windows will be added 
automatically to their IfcDoorStyle/IfcWindowStyle.

• Assign elements directly to the IfcSite or IfcBuilding. 
• Neighboring buildings and site context elements (trees, fences, roads, etc.) can be assigned 

to the site instead of the project building with its story system.
• Set and export currency and time units 
• Support for “calendar date”-type IFC properties (for example WarrantyStartDate, etc.)
• New global and localized classification systems (e.g. Uniclass in UK)

IFC Publishing
Use the ArchiCAD Publisher interface to publish the model in IFC format with one click. You can 
publish the entire model or just floor plans by story, on a WYSIWYG basis. All IFC Translator options 
are available through the Publisher as well.
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Other IFC-related Improvements
• At IFC model import, a customizable folder-system of the library parts is generated (embedded 

library, linked library and .lcf) 
• Reduces project file size and allows user to control location of the newly created objects

• The name of a custom IFC Property Set can be easily edited by just clicking on its name field and 
entering a new value.

• Find & Select and Interactive Element Schedule works for IFC Assignments and IFC Type 
Products

• Sophisticated automated junctions in the ArchiCAD model (new in 17) are supported in the 
context of IFC export: construction element connections are exported to IFC in “WYSIWYG” 
fashion

• 2D symbols of doors and windows can be exported within the IFC model

Saving Elements to Common DWG Blocks
Until now, multiple instances of a single GDL Object - if they used varying parameters - were saved 
as separate DWG Blocks. As of ArchiCAD 17, such GDL objects will be saved as a single DWG Block. 
This way, you only have to edit a single block in AutoCAD, rather than multiple instances.
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Energy Evaluation 
By introducing multiple thermal blocks to the Building Energy Model, Energy Evaluation for 
ArchiCAD 17 produces an increasingly sophisticated and accurate report of the project’s energy 
demand, using a standard-compliant engine. An expanded interface and new evaluation features 
take advantage of the more detailed data provided by multiple thermal blocks (instead of the 
single-block method used in ArchiCAD 16).
Easy Creation and Visualization of Thermal Blocks
Streamlined Management of Structure/Opening Data
Model-based Solar Irradiation Study
Custom Operation Profiles
More Detailed Energy Reports
Assign Multiple Building Systems
More Detailed Energy Reports

Easy Creation and Visualization of Thermal Blocks
A project’s Thermal Blocks are defined by the user; their geometry consists of one or more 
ArchiCAD zones. Each Thermal Block (e.g. Stairwell, Office, Basement, Technical Area) typically has 
its own energy characteristics and needs. 
• Define thermal blocks by drag-and-dropping ArchiCAD zones from the model window into the 

Thermal Block list
• New Thermal Blocks page of the Model Review Palette lists thermal blocks with all their relevant 

properties 
• Highlight the list entries to visualize Thermal Block geometry directly in the ArchiCAD model
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Streamlined Management of Structure/Opening 
Data
• Use the Model Review Palette’s new Tree View to browse, edit and visualize the Openings/

Structure data, organized by Thermal Block
• Properties panel provides editable list view 
• Openings page provides individual analysis (listing, editing and visualization) of each opening
• More detailed parameter set allows for a more accurate energy simulation

Model-based Solar Irradiation Study
• Model-Based Solar Irradiation Study determines precise solar gain through each individual 

opening in the building envelope
• Graphical Solar Analysis feedback for each opening

• Solar analysis also considers shading effects of building environment (e.g. adjacent objects, 
other buildings) 
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• ArchiCAD plant objects act as intelligent shading devices: their shading capacity is scheduled for 
the reference year, making it possible to factor in whether the plants used for shading are 
coniferous or deciduous

Custom Operation Profiles
• Define custom Operation Profiles (in addition to default profiles) to fine-tune occupancy 

according to local regulations or to match actual building usage
• Hourly scheduling for the entire reference year guarantees accurate input of occupancy patterns

Assign Multiple Building Systems
In ArchiCAD 17, assignment of MEP systems is available for each thermal block separately - not just 
for the project as a whole. The resulting Energy Simulation thus presents a more realistic picture of 
the project’s energy demand.
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More Detailed Energy Reports
• More detailed energy reports in PDF and XLS formats
• New formatting options, including colors, font, add image as header
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Library Enhancements
Please note: Some new Library part developments are available in certain localized libraries only 
(where applicable, this is indicated in the descriptions below).

General Library Developments
Objects
Labels
Zone stamps
General door/window developments
Doors
Windows

General Library Developments
• To speed navigation among objects, similar library parts have been merged, while retaining all 

their parameters.
• Some objects have been renamed to eliminate confusing abbreviations.
• A new criterion allows library parts to be scheduled based on the name of the subtype they 

originate from.

Objects

Coordinate Dimension
The Coordinate Dimension object now has a 3D appearance, so that you can easily place it on the 
target point by using gravity.
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Stairs and Railings
New 2D appearance for stairs and simple railings, similar to those created by Stair Maker: new 
options to show rail or carriage on Floor Plan.

RoofMaker Elements
• Roof elements used by RoofMaker have a new graphical user interface for easier parameter 

setting. Story sensitive floor plan display is also available.
• Lumber Cut Size and Rounded Lumber Size values are calculated automatically and displayed in 

the parameters with the same names. They can be listed with the new schedule scheme called 
Roof Construction (included in the INT template and in selected local versions).

• Structural Length, Lumber Size and Lumber Size (rounded off) are displayed correctly and 
available for listing and schedules.

• Subtype-based schedule scheme for Roof construction elements can be created.

New Object: Multileader Label Symbol
New multileader label object can be placed on the Floor Plan. Similar to the existing independent 
label, this one can have several leaders.

Labels

Dimension Label Includes Elevation Data
• The Dimension label can display an element’s bottom and top elevation
• The label was improved with a user interface for better transparency
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Zone stamps

More Flexible Zone Stamp Data Display
For Zone Stamp 2 and local stamps:
• Customize display order of data within the Zone Stamp
• Show height values individually

General door/window developments

Improved Placement of Doors/Windows
• As part of the improved workflow for Door/Window placement, the Opening Direction 

parameter has been eliminated: new feedback clarifies the inside/outside and reveal side 
parameters

• Door/Window Marker functions are more consistent
• Opening Orientation is shown correctly in schedules

New closure types
Predefined options for common closure types.
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Note: Closures are displayed in Floor Plan. Closure types are generated correctly only if they are 
placed in a composite Wall with a proper skin composition.

• Variable Cavity Closure
• Plaster Reveal 

• Insulated Reveal

• Insulation Closure for Renovation 

• Finish Closure

• Air Space Closure 
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Better Documentation of Openings
• Doors and windows calculate and schedule their glazed surfaces (considering default material 

settings)
• Markers and stamps can read and display U-values defined by the opening’s listing parameters 

Sill and Threshold Improvements -> DACH only
• New threshold types in doors:

• Normal

• Up to Door Panel

• Underneath Door Panel 1
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• Underneath Door Panel 2

• Threshold Thickness = Wall Thickness

• Set gap between door leaf and threshold (gap affects door leaf height) 
• Blind threshold available with each threshold type
• Flooring thickness can be defined in windows
• Sill is available in Terrace Doors

Casing representation -> NOR only
Casing is not shown in 1:50 or smaller scale

Doors

New Doors 
• New Telescopic elevator doors -> DACH only

• Telescopic Door
• Telescopic Double Door
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• New Doors with one sidelight: door leaf is hinged on the sidelight side

New Door Leaf Types
• 25 new door leaf types: 

• All doors have an empty door panel option -> DACH only.
• Double doors can be designed with two different door panels -> DACH only 
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Improvements for Doors with Sidelight
• Set a casing for doors with one or two sidelights, even those with a raised sidelight parapet (T-

shaped and P-shaped doors).

• Horizontal division is available for doors’ sidelights. Divided parts can be designed with different 
sash and opening types.

• New doors with one sidelight: door leaf is hinged on the sidelight side.
540 New Features in ARCHICAD 8-20



ArchiCAD 17 New Features Guide
Improved 2D Representation of Doors
• New opening line representation is available for doors: simple line, drawn at the axis of the door 

opening

• New arrow symbol on sliding doors
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• Glazing of door leaves is shown on floor plan

More Parameters for Sliding Doors
Leaf overlapping and gap between door leaves can be set in sliding doors.

Garage Door Enhancements -> DACH only
A new motor position is available in Sectional Door
Editable door frame sizes in Garage Door Type 2 Top Hung
Sectional Door and Garage Door Type 2 Top Hung contain a threshold

Windows

Basic Window improvements
Easier symmetric positioning of horizontal divisions

New Sash and Opening Types for Windows
• Solid panel is available for window sashes
• New opening type for basic windows: Reversible Horizontally.
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Better Opening Symbol for Elevation and 3D
Opening lines fit to sash contour instead of glass contour.

Window Frame Improvements -> SWE, DACH only
Frame widths can be set one by one
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ArchiCAD Performance Improvements
Faster Navigation with OpenGL 
When navigating in large projects in the 3D window using Open GL, an improvement in 3D engine 
processes has speeded up navigation: up to ten times faster.

Improving SEO Performance 
If your project contains a large number of Solid Element Operations, your performance will improve 
noticeably - due to more sophisticated data management, which avoids the need to recalculate 
Solid Operations that are used multiple times.

Double-Quick Library Loading Times 
Library loading is now twice as fast! If you have loaded a library on this machine before, the next 
load will be much speedier, thanks to new caching processes. Works for any kind of library.

Better Performance with Older-Version Libraries 
If you are using library parts from older-version libraries and older-version PLA files, the 2D rebuilds 
and 3D display of these library parts will speed up - thanks to improved management of archival 
library part data.

Faster Handling of Library Parts’ 3D models 
The handling of library parts’ 3D models has been improved on a multicore processor: when you 
switch to a 3D view, the view can be generated up to 50 percent faster, depending on the number of 
library parts in the project.

Background Operations for Faster 3D
ArchiCAD uses background operations to calculate the precise geometry of construction elements 
which intersect or collide with each other. Background operations means that you can, for example, 
work on a floor plan view while the application calculates the geometry of elements not visible in 
the current view - without interrupting your workflow. Benefit: when you switch to another model 
view, the result will be displayed much faster.
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Integrated ArchiCAD Help Center
Find the information you need faster! The new Help Center is a search site, accessible directly from 
ArchiCAD, that replaces the current offline Help. 
Type your query into the Search field: the ArchiCAD Help Center instantly pinpoints the material you 
need from the following resources:
• ArchiCAD Help documentation
• Training videos from GRAPHISOFT’s Youtube site
• ArchicadWiki
• ArchiCAD-Talk
Find a simple answer to a simple question, or watch a tutorial explain a complex feature: it’s all 
here.
The content is specialized for your geographic location and may vary depending on your license 
type.
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ArchiCAD 18 New Features Guide
Modeling
Rendering
Revision Management
Workflow
Teamwork and BIM Server
OPEN BIM
Library Enhancements
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Modeling

Edit Multiple Elements Simultaneously
• Improve productivity by editing multiple elements at once.
• Editing (such as dragging nodes, stretching edges) of multiple overlapping nodes and edges, with 

enhanced ghosting feedback of all affected elements.

       
• Available in Floor Plan and 3D for all polygon-based elements (i.e. all except Morph and Shell).
• Create hole, subtract or add polygon shapes: Pet Palette commands will affect all selected 

polygon elements.
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Improved Visual Feedback During Multi-Element 
Editing
• More realistic feedback during vertical stretch of multiple elements in 3D.
• Multi-Wall editing shows the complete wireframe of the element with junction, not just its 

reference line.
• Mesh editing shows the complete wireframe of the element including ridges.
• Mesh drag node editing improved in 3D to correctly keep clicked point instead of reverting to 

corresponding bottom node.

Composites and Profiles: More Flexible Definition, 
Better Display Control
• Define a Composite element without a core skin. If you use several composites to represent a 

single structure (e.g. water proofing with sloping insulation within a flat roof structure), the 
composites might not need any core.

• With Partial Structure Display set to “core only”, openings belonging to non-core elements will 
also be hidden (in earlier versions, such openings were shown).

• Identical Building Material fills no longer merge in Profiles.
• When you convert a Composite to a Profile, its display remains consistent; custom-defined lines 

and edges are retained.
548 New Features in ARCHICAD 8-20



ArchiCAD 18 New Features Guide
• Profiles are now as flexible as Composites; turn off end lines and individual cut edges as needed.
• Dimension Core Only of Profile Elements in section.

Better Visualization of Transparent Building 
Materials used as Air Gaps
• In 3D view: both semi-transparent and fully transparent Building Material surfaces used in 

Composites/Profiles will correctly display neighboring skins.

• In Floor Plan, 3D Document and Section views: Fully transparent Building Material surfaces used 
in Composites/Profiles will display correctly.

• Slanted Walls using Building Material with air gap will display the neighboring skins’ slanted 
surface more accurately within this air gap.
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• Improved Collision Detection.
- Define Building Material (e.g. an air gap) according to whether it “Participates in Collision 

Detection” (checkbox in Tags and Categories). 
- This way, only element parts having real geometry will participate in Collision Detection in 

IFC model-checkers and in GRAPHISOFT MEP Modeler.

Pipe intersects with air and concrete block: collision occurs.

Middle (air) skin is flagged to not participate in collision detection: NO collision occurs
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Expanded Tags and Categories for Building Materials
• Expanded Building Material properties: ID, Description, Manufacturer.
• Additional Physical Properties for use in a building’s Total Life Cycle energy analysis: Embodied 

Energy, Embodied Carbon.

• Improved and expanded criteria for Surface and Surface Name, Building Material and Building 
Material ID/Name to search any element matching those criteria, both for Element and 
Component Schedules.

• Morph and Mesh are now available for Component listing, allowing a single list of elements 
using Building Materials.

• Building Materials priority number is now displayed in all Building Materials pop-ups.
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Other Enhancements
• More Intuitive Wall Surface Assignment: New option to “End Surfaces: Override using Adjoining 

Walls” (instead of having to override edges manually).

• Morph has new option to remove the automatic outline (its 2D and 3DD display is identical to 
3D).

• Improved Morph Performance: In previous versions, ArchiCAD could slow down while you 
worked with complex Morph elements. In ArchiCAD 18, visualization in Floor plan and 3D views 
is now significantly faster when working with Morphs. 

• Better display of Slanted Columns in Floor Plan, consistent with other model elements
- uses 3D projection,
- uses hidden line geometry (instead of wireframe).
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Rendering

New Integrated CineRender Engine: High-end 
Renderings Made Easy
• Multiprocessing takes full advantage of hardware for significantly shorter rendering times.
• Global Illumination (GI) provides photorealistic lighting conditions.

- Considers not only explicit light sources but also light reflected by other surfaces.
- No need to add and configure any additional lights.

• Background Processing lets the rendering engine do its work in the background while you keep 
working in ArchiCAD.

• HDRI Support: High-Dynamic-Range Images (HDRI) provided in the package allow easy creation 
of realistic environments.

• Physical Sky presets: Ready-to-use environment presets according to specified time and 
location, resembling various weather conditions.

• White model effect concentrates on lights and forms only, for quick concept visualizations.
• Built-in physical engine for users who are familiar with cameras and don’t want to deal with 

abstract rendering parameters.
- Quickly configure the scene with parameters familiar from photography.
- Use the progressive mode of the engine for continuously improving results.

• Export model to Cinema4D with all the settings to further extend the visualization capabilities.
See PhotoRendering.

Modeless Rendering Palette for One-Click Settings 
Access
• Rendering preview provides immediate feedback on rendering settings changes.
• Rendering presets (Scenes) available out of the box. No need to configure any complicated 

parameters, just hit the Render button.
• Scaleable User Interface in Rendering Settings.

- Novice users may prefer very simple setups (Basic view).
- Expert users can access full list of parameters (Detailed view).

See Detailed CineRender Settings.
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Rich Default Content; IES Support
Extensive collection of preconfigured lights and photorealistic C4D surfaces.
• Wide selection of typical lights and light sources provided as default library content, all C4D light 

effects supported.
• Load content from lighting manufacturers in IES format to perform real lighting simulations.
• Improved Surface content and interface (see below).
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Surface Settings Improvements (CineRender Engine)

Upgraded Surface Settings Interface 
• Choose from several hundred ready-to-use Surfaces within the standard library.
• Larger Surface preview.
• Export Surface and share to BIMcomponents portal or with other users via GDL.
See Create, Load and Share Surfaces (All Engines).

Intuitive Surface/Shader Management
• Import C4D materials with one click into ArchiCAD; override a surface using any material 

imported from an external Cinema4D file.
• Match properties from/to an equivalent surface for the Internal engine.
• A second preview window lets you visualize the shader currently being edited.
• Surfaces organized in a tree structure, with all shaders and sub settings from each channel; use 

shortcut buttons to move up or down the tree structure.
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• Change order of shaders within a layer, or drag shaders into a folder to apply blends to all its 
contents at once. One click removes a shader from the folder.

• Click and hold the arrow at either end of a slider to exceed the standard value shown.
See Surface Settings (CineRender).
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Revision Management
Intuitive new feature set makes it easy to manage Layout revisions in your issued documentation: 
ArchiCAD tracks your model-based changes automatically on all affected Layouts. Define and 
control Changes, Layout Revisions, and Issues over the whole lifetime of the project.
See Revision Management.

Intuitive Change Management
• New Change Tool: Create Change entry with one click; add an optional Cloud and/or Marker.
• Link or unlink elements from Change.
• Changes are added to the correct Layout Revision, automatically.
• Show/Hide Change markers on Layouts as needed.
• Add descriptive, custom Change data.
• View and manage all project Changes in Change Manager.

Intelligent Layout Revisioning
• New Layout Revision is created automatically as soon as a new Change appears on a Layout 

compared to its last issue.
• Layout’s Revision History (a customizable GDL Object) is automatically updated with latest 

Layout-specific Changes.
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• Add any Layouts to the current Issue; Layouts with new Revisions are added automatically.
• Flexible numbering of Changes and Revisions.

At-a-glance Feedback and Easy Report Creation
• Color codes show which Layouts have new Revisions, and which Layouts are part of the current 

Issue.
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• Predefined Project Indexes let you create Change List, Issue List, Transmittal Report with one 
click.
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Workflow

Improved PDF-based data exchange
New options enable optimized export to PDF format; more flexible use of PDF documents placed in 
ArchiCAD; and reduced file size.
See Working with PDF Documents.

More Export Options to PDF
• Export visible layers when publishing project views in PDF format. In the resulting PDF 

document, you can show or hide content by layers, or navigate among layers.

• Image compression options reduce file size.
• Exclude ArchiCAD Project Info from the PDF document - for example, if you will submit the PDF 

as part of an anonymous competition.
• Embed 3D Content feature: now available on Mac as well as Windows.

Flexible Editing of PDF Drawings in ArchiCAD 
• Show or hide Drawing content by its PDF Layer.
• Explode and edit graphical and text elements from a placed PDF Drawing.
• Avoid Attribute Creep: Attribute conversion options and Pen/Font overrides give you full control 

over incoming pen/font attributes.

Smart Master Layout Items Display Layout-Specific 
Data
A Layout’s Master Items can now display data that are specific to each particular Layout.
New Features in ARCHICAD 8-20 561



ArchiCAD 18 New Features Guide
• For example, the Revision History (a GDL object) is placed only once, on a Master Layout. But for 
each Layout on which it appears, the data it shows is specific to that Layout.

• Display of Master Layout items can reflect specific Layout parameters, such as a different 
appearance depending on Layout ID/Name/Status. (Use new Tag fields in Layout Settings to 
enter Layout-specific data such as Status, Comment, Drawn by, and Checked by).

Improved Hotlink/ XREF Management
• Relink any single instance of a Hotlink Module: this can support work with design variations. For 

example, if you have two different Modules in the project representing two different room 
layouts, you can now re-link any single instance to the other Module, to use the alternative 
furnishing layout.

• More flexible archiving: New option to break all Hotlinks and XREFs ensures that all linked 
elements become part of the project.

i

Attribute Handling
• Attribute Management: new option to overwrite attributes by Name, reducing the need to keep 

index numbers in a fixed order.
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• When transferring attributes from left to right in Attribute Manager, you now have more options 
for including any associated Attributes (as with Building Materials i n ArchiCAD 17):
• Layer Combinations can include associated Layers
• Composites and Profiles can include associated Line Types, Fills, Surfaces, Building Materials
• Surfaces can include Vectorial Fills

• Improved Feedback on “Delete and Replace:” When you delete and/or replace attributes 
throughout your model, the dialog box now lists the number of elements and/or attributes that 
will have “Missing” attributes. In Teamwork, feedback includes the number of such elements or 
attributes that are not reserved by you. 

Interior Elevation Improvements
• More consistent input logic, better graphical feedback.
• Define a limited range that automatically reaches to Room Boundaries.
• Click and drag boundary line to fine-tune the view’s horizontal range.
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Enhanced Mark-Up Features
• Create Mark-Ups in 3D views as well as Floor Plan.
• Save 3D views, including cutting planes and camera views, as Mark-Up Entries.
• Create and save Screenshots in Mark-Up palette.
• Re-designed Mark-Up comment interface with status and style information.
• Export all markup data to consultants in BCF format.
See Project Mark-Up Interface.
See also BCF Compatibility for Expanded IFC-Based Collaboration.

Other Enhancements
• Dimension Line editing: Ctrl (Cmd)+Click to instantly delete individual nodes.
• New option in Drawing Settings to include or omit the scale within Autotexts and Indexes.
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Teamwork and BIM Server

Browser-Based Server Management
With BIM Server for ArchiCAD 18, the BIM Server Manager is now a browser-based tool which is 
automatically installed together with the BIM Server. For server managers, this is a zero deployment 
tool: start a web browser on any computer, enter the address of the BIM Server, and log in. This 
solution does not even require a desktop computer or a laptop: any tablets or mobile phones with 
the Internet access can utilize this interface, on a screen display adjusted to the device’s 
parameters.
In addition to server managers, regular users can access this interface to review the status of their 
projects, access the project Activities list, and modify their personal parameters (e.g. password). Of 
course, they can access only those resources of the BIM Server to which they have adequate 
permissions.
For the Teamwork user, there is no difference in interaction: he/she joins or opens the desired 
Teamwork project. The BIM Server Manager ensures the connection, with no user interaction 
needed.
See the BIMcloud/BIM Server User Guide for details.

More Flexible and Transparent Messaging
• Attach the current view together with its settings (e.g. Cutting Planes, Layers) to your message: 

the recipient can apply the sent view settings to match yours and open a preview of it.

• All Teamwork message types are now modeless (the palette stays on screen), so you can 
continue to work in the model while also working on a message.
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• When creating a message with attached elements, you can now reselect them and update the 
attachments before sending, without needing to close the message and start again.

• Message displays the number of elements attached.
• Set an optional limit on the number of completed messages in your local mailbox: the oldest 

messages will be automatically deleted when this cap is reached.
• All message type notifications (not just high priority) will remain on screen until dismissed.

Reservation and Feedback Changes
ArchiCAD’s Teamwork features are designed to eliminate the possibility of data conflict, while 
ensuring a smooth user experience. Building on this logic, Teamwork in ArchiCAD 18 contains 
several changes to preempt possible conflicts in the following areas:
• New reservation logic for views and layouts and their folders eliminates possibility of conflict if 

several users try to move these Navigator items simultaneously.
• Reservation of Hotlink Sources now required for Hotlink updates.
• New feedback keeps everyone informed whenever simultaneous editing results in renamed 

objects in the Embedded Library.
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OPEN BIM

IFC Developments

BCF Compatibility for Expanded IFC-Based Collaboration
The BIM Collaboration Format (BCF) is an open standard format officially endorsed by 
buildingSMART. BCF is used by many structural, MEP and model checker programs to add 
comments, screenshots, camera position and 3D cutting planes to IFC models (e.g. collision 
detection).
• ArchiCAD 18 is compatible with BCF files, allowing you more flexibility in managing collaboration 

issues. For example, solve collisions between your elements and merged MEP system elements 
that are detected and commented by other software, such as IFC model checkers.

• When you open or merge an IFC file, ArchiCAD incorporates the BCF data assigned to the model 
(screenshots, camera position, cutting plane, and status) into Mark-Up Entries.

• Export all markup data to consultants in BCF format. ArchiCAD keeps the elements’ original IFC 
Global ID, to keep track of element iterations through multiple merge cycles (including Merge 
IFC and Hotlink PLN (IFC)).

See also Enhanced Mark-Up Features.
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Scheme-Driven IFC Data Management and Export
All IFC data now behave as native ArchiCAD data: every operation involving ArchiCAD data is 
available as IFC data. The following features support the data exchange workflow:

Data Mapping
• Map all ArchiCAD tool parameters (not just Library Part parameters, as in previous versions) to 

IFC properties based on conversion rules (stored in XML files).
• All text-, label- and logical-type IFC data of all elements (e.g. IFC Column, IFC Wall, IFC Window); 

all IFC Type Products (e.g. IFC Column Type, IFC Wall Type, IFC Window Style) and IFC Space 
entities can be derived from ArchiCAD element properties and Interactive Element Schedule 
(IES) data.

• ArchiCAD data can be exported as mapped, standard or custom data to the IFC model.
• IFC Type Product naming is managed automatically based on user-defined naming rules.

New Scheme Management
Better Scheme management means a more user-friendly interface, less manual data entry, and 
more comprehensive content for predefined and custom schemes (stored in XML files). With 
ArchiCAD 18, compliance with various IFC standards is easier than ever.
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• Schemes (in XML format) can store not only custom IFC properties (as in previous versions), but 
also standard IFC Properties, IFC Attributes, and Classification Reference items.

• Schemes are customizable for your company or for any national or international standard
• Predefined schemes are available (IFC 2x3 Coordination View 2.0, COBie, Concept Design BIM 

2010, etc.).
• User-friendly interface: IFC Manager can filter properties to show Scheme data only, so you can 

easily view which data must be defined for the particular scheme or standard.
• Option to export only the properties of the loaded scheme (instead of exporting all IFC 

properties).

Labeling IFC Data
Parameters from “Tags and Categories” panel (Element Settings dialog), including all IFC data (e.g. 
Structural Function and Position classification, fire rating, acoustic rating, Zone classification) of any 
ArchiCAD element can be displayed in the model and on documentation via Labels, Door/Window 
Markers and Zone Stamps.
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Better Export of Composite/Complex Elements

Improved Collision Detection

Air skin is flagged to not participate in collision detection: NO collision occurs.
• Define Building Material according to whether it “Participates in Collision Detection”, so you can 

export composite elements that don’t have solid geometries as air gaps.
• This way, for example, MEP engineers can place pipes in the gaps without collision detection, 

and only those element parts having real geometry will participate in Collision Detection in 
model-checkers and in GRAPHISOFT MEP Modeler.

Original Color Export by Composite Skins and Complex 
Element Parts
New export option (Explode Composite and Profile elements into parts) will retain original colors of 
all building parts, instead of exporting them in all one color.
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Export of ArchiCAD Schedule Quantities
All Schedule data – and not just the standard IFC base quantities (length, width, area, etc.) - can be 
exported with model elements as IFC data.

Quick Accessibility of IFC Manager
Fast key combination Ctrl+ALT+I opens the IFC Manager modeless dialog box.

IFC Quality Improvements

Import/Export Quality Certification
With IFC developments for version 18, ArchiCAD became the first architectural software certified 
for both import and export of IFC 2x3 Coordination View 2.0. 
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Improved Support for Collaboration Involving Large 
Projects
ArchiCAD 18 is able to manage larger IFC models than before.

Improved Revit 2015 Connection
The GRAPHISOFT ArchiCAD Connection Add-In for Autodesk Revit 2015 software (including Revit 
Structure, MEP and Architecture) is available free from the GRAPHISOFT website. The Add-In 
improves the IFC model-based and bi-directional data exchange between GRAPHISOFT ArchiCAD 
and Autodesk Revit applications.
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DWG Developments

Compatibility with DWG Version 2013 and 2014

XREF Naming Options
When saving or publishing DWG files that include Xrefs, the user can now decide whether to 
include those Xref files, and to define their name (including Autotext) and location in the local 
folder structure. 

The naming and folder definition options are of particular interest to users who must use a standard 
file naming convention. With this feature, they can avoid having to rename hundreds of file names 
by hand. 
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Publisher Improvement
Naming of Publisher items is now easier and more flexible.
• Multi-select and rename several Publisher Items at once.
• New Autotext options (including Revision Number) for item names support any local file naming 

conventions.
• Smart naming rules automatically apply to a folder’s sub-items, similar to file extensions.

BIMx Desktop Features
BIMx desktop application now supports the Hyper-model format, allowing you to browse 3D 
models within the Hyper-model file. 
(Like the free mobile BIMx app, the desktop version does not support 2D documentation.)
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Library Enhancements

General Library Developments

Simplified Settings
The settings dialog boxes for the Door, Window, Corner Window, Object, Stair, Lamp and Wall End 
tools have been simplified to eliminate confusion over duplicate settings on the Parameters and 
Custom Settings panels.
By default, the graphical interface (Custom Settings) is shown where available.
For any library part, users can still choose to use the Parameters list if they prefer.
The old list control for Parameters was replaced by a new, polished, more functional one.

Enhanced Graphical Interface: Attribute List Control
The scrollable attribute list control that was already used on the Floor Plan and Section palette of 
the construction tools’ setting dialogs is now available for the graphical interface of library parts as 
well.
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New Furniture Objects

School Furniture
Laboratory Workstation, School Desk, School Chair, School Board, Digital Board

Nursery Furniture
Kiddie Chair, High Chair 01, High Chair 02, High Chair Wooden, Crib

Lamps and Lights

General Light Sources
For better illumination of your project, seven new general light sources have been created:
• OMNI light: a general light source emitting light in every direction.
• SPOT light: a simple spot light, which can be directed on any object.
• AREA light: a basic shape emitting light in every direction; can be visible on the rendered image.
• PARALLEL light: infinite plane emitting parallel rays in a general direction.
• IES light: a light using .ies files which describe the form of their illumination.
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• SUN object: a special PARALLEL light, which behaves like the sun, has no falloff, and can use the 
AC sun’s position.

• WINDOW light: a special Area light which strengthens the interior luminosity of daylight 
renderings; Its intensity is affected by the ArchiCAD sun position.

     
Apart from the basic settings, light sources come with many optional effects – such as visible light 
and lens flare – for more realistic renderings.
All major Cinema 4D parameters implemented, in an easy-to-understand format.
See Special Lamp Parameters.

Lamps
All existing lamps have been updated with Cinema 4D lights, containing only the most important 
parameters for quick and easy set-up. 
New lamp objects:
Floor Lamp 04, Desk Lamp 05, Ceiling Ventilator, Ceiling Lamp/Style 12, Wall Lamp/Style 13-14.

                    

Improved User Interface for Lamps
• Use hierarchical page selector for easier navigation among settings
• Settings are divided into two groups: basic and advanced, to support either a quick set-up or an 

in-depth exploration of the functions.
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• New slider and color picker controls ensure better visualization of parameters, more consistency 
with other ArchiCAD interface.

• Graphical previews make it easy to understand lighting parameters.
• New, scrollable control for setting up Listing Parameters.

Markers, Labels, Zone Stamps

Display IFC Data, other Tags and Categories
Data (such as IFC data) from the Tags and Categories panel of element settings dialog box can be 
displayed on Labels, Zone Stamps and selected D-W Markers associated to these elements.

New Label: Generic Label
New Generic Label can display most data from its associated element: dimensions, structural 
details, tags and categories.

Expanded Options in Zone Stamp 1
Additional options: scale dependent content, optional fixed width with word wrapping, custom text 
option.

Objects for Visualization

New 2D Trees
Trees are organized in groups (e.g. deciduous or evergreen), and contain several rendered images. 
You can also use any custom picture.
Both Top and Side views can be placed on floor plan, section/elevation or in 3D. The 3D mode will 
assist orthogonal renderings of your building.
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Consolidation of 3D Trees
Existing 3D tree objects have been merged into a single tree object.

Other Objects

Graphical Interface for the Elevator
To enhance its usability, the Elevator library part got a graphical interface that explains its complex 
functionality.
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Vehicle Turning Curves (selected markets only)
2D design aids: vehicle turning curves based on the SIA.

          

Model View Options Improvements

More Control Over Opening Symbols in 2D
Model View Options offers several options for how to display the 2D symbols of doors, windows 
and skylights. As of ArchiCAD 18, these options are expanded: users can choose among several 
variations of detailed, middle-scale and simple 2D symbols.
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Improved Interface in Model View Options
Due to the greater number of Model View Options for Library Parts, these controls have been 
reorganized onto several panels. 
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Door and Window Improvements

Ventilation Frame
Two types of ventilation frames are available:
• built above the door/window frame (available for rectangular doors and windows).
• built into the window sash (available for windows with rectangular sashes and for doors with 

rectangular sidelights or transom).

New Sash Type: Vent Sash
• Vent sash can be selected for windows with rectangular sashes and all doors with rectangular 

sidelight or transom.
• Louvers can be built directly into the frame or as part of a fixed or moveable sash.
As a result of this improvement, the old Vent Window library part is not available anymore and will 
be automatically replaced during project migration by a normal window with vent sash.
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Wall Contour Lines Improvements
Use different line types for visible and hidden wall contour lines (displayed on the 2D symbol of 
doors and windows).

Door Improvements

Metal Frame Doors (selected markets only)
Two new frame types that are characteristic for metal doors: Extrusion and Wrapped Extrusion.

        

New Sectional Doors (selected markets only)
The Sectional Garage Door has been enhanced with new functions:

                          
• With options for more head room and slanted ceilings, the door can be defined to better fit the 

building geometry. 
• Several new installation methods allow you to match the garage door to the façade. 

- For garage door with reveal: use the ‘Simply in Wallhole’, ‘with Cover Profile’ and ‘with 
Flush-Fitting Panel’ options. This allows you to align the door with the façade or to create 
a wall connection with visible frame.
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Option to use your own custom door leaf for both sectional and top hung garage doors. 

Window Improvements

New Multi-Sash Windows
• Horizontal Multi-Sash Window
• Vertical Multi-Sash Window. 
Select the number of sashes (1-10). Define a shape and opening type separately for each sash.

To create a window with more than 10 sashes, repeat the basic unit of sashes as needed.
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Handles for Windows (selected markets only)
Handles can be selected for windows with unfixed sashes. 8 different types are available.
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ARCHICAD 19 New Features Guide
PERFORMANCE
INTUITIVENESS
DOCUMENTATION
SCHEDULING
OPEN BIM
TEAMWORK AND BIM SERVER
LIBRARY IMPROVEMENTS
SMALL INTERFACE CHANGES

PERFORMANCE

New Background Processing for Nearly Instant Model Views 
With background processing, ARCHICAD 19 takes advantage of the processor’s unused capacity to 
build up different model views in advance. Background processing also utilizes your hardware more 
efficiently. Enjoy a smoother workflow and a lot of saved time!
• Open model windows (or tabs) are always kept up to date
• Much faster switching among 3D, 3D Document, Section/Elevation/IE-type views
• No waiting for rebuilds - if you open a view by mistake, you no longer have to wait for it to 

rebuild before switching to a different view
• Page through layouts that contain auto-rebuild drawings without delay
• See feedback on background processing in your status bar (click to suspend as needed)
• Work Environment option for Power Save mode: Suspend background processing feature if 

you’re using a battery-powered device
See also Background Updating in the ARCHICAD Reference Guide.

Optimized OpenGL Engine for Smoother, Faster Navigation
For working in 3D and for informal client presentations, most users turn to ARCHICAD’s built-in 3D 
window with the OpenGL engine. OpenGL provides fast navigation in 3D views that are always up to 
date, and allow co-design with the client. 
• As of ARCHICAD 19, an optimized OpenGL engine means that 3D navigation will be smoother 

and faster, free from flickering, even with big models.
• Mac only: When using OpenGL in 2D views (and when the 2D Drawing Hardware Acceleration, 

in Work Environment, is On) - then editing and certain functions (such as Trace Reference) will 
be faster on computers using retina displays and dedicated graphics cards.
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INTUITIVENESS
Surface Painter
Snap Points and Guide Lines
Mac Interface: Unified Window Mode with Docking Palettes
Tab Bar on Windows and Mac
Expanded Surface Catalog

Surface Painter
Use the new Surface Painter palette to change element surfaces (either model elements or GDL 
objects) in the 3D window. With Surface Painter, creative design is instantaneous, and makes for 
impressive presentations.

“Paint” Elements Directly in 3D
• Pick a surface from Surface Painter (or pipette a surface from a 3D element), then click on an 

element to paint it
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• Another workflow: select any element(s) in the 3D window to add them to Surface Painter’s 
selection list. Double-click to access and modify their Surface Settings.

• Alternatively, use the two lists in Surface Painter to override surfaces: choose a surface (from 
the content list) and click another surface (from the selection list) to override that model 
selection (or use drag and drop to achieve the same)

• The Select All Elements Using Surface context menu command, from a selected Surface in 
Surface Painter, will get all the model elements which use it

• Remove All Surface Overrides command strips elements (selection or entire model) down to 
their Building Materials (construction elements only)

Feedback in Paint Mode
Any time you select a surface from Surface Painter, you enter Paint Mode, providing special 
feedback as you move your cursor in the 3D window:
• Targeted element surface(s) are highlighted
• Element surface changes temporarily, giving you a preview of how it will look after you paint it
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• Info Tag provides graphical and written info on which surface will replace which
• Tab through multiple element faces: paint all surfaces of an element, or just certain faces

Manage Surfaces with Surface Painter Palette
• Use Palette’s search function to identify the right surface

• Option to narrow search to project attributes, surface catalogs, or BIM Components
• From web or catalog, add a surface to the project with one click
• Double-click a surface preview to open Surface Settings, or use its context menu
• Customize the palette view to fit your preferences

• Previews in OpenGL or CineRender
• Small/Medium/Large icons
• Horizontal or vertical arrangement

For more details, see Override Surfaces With Surface Painter in the ARCHICAD Reference Guide.

Snap Points and Guide Lines
ARCHICAD 19 has overhauled its Guide Lines function to better match the way you work, making 
precise input even more intuitive. 
• The new Snap Guides give you on-the-fly input help when and where you need it;
• while the Guide Lines are placed by you, and stay put until you remove them.
The Snap Points feature (formerly Special Snap Points), expanded with a useful new option, works 
together with Snap Guides.

Snap Guides: Instant, Smart, Temporary
• Relevant Snap Guides (lines or arcs) are offered automatically during your input (you don’t have 

to click to find them), based on the current context
• To generate additional relevant Snap Guides, define additional Snap References (points or 

edges), simply by hovering (or click Q for an instant Snap Reference)
• Use a Snap Reference point as a temporary input origin: a distance entered in the Tracker is 

measured from this point. For example, to place a window at 60 cm. from a corner, just define 
that corner as a Snap reference point. Input 60 in the Tracker’s Distance field, and click to place 
the window.
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• Multiple Snap Guides, originating from multiple elements or references, can be used at the 
same time (no need to choose just one “active” line)

• After you are done with the current element input, the Snap Guides disappear immediately

For more details, see Snap Guides in the ARCHICAD Reference Guide.

Permanent Guide Lines
Introducing permanent Guide Lines familiar from major DTP applications. 
• Drag a Guide Line into the model window from the side of the window (like the cutting plane) to 

create a Guide Line (or circle) wherever you choose - at a point or edge, or in empty space
• Draw a Guide Line segment anywhere with two clicks
• Guide Lines stay put until you explicitly delete them
• Option to hide all Guide Lines temporarily, or erase any of them graphically
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For more details, see Guide Lines in the ARCHICAD Reference Guide.

Improved Snap Points
• A new Snap Point option is born: “best division to distance”

Provide a distance value, then hover over the full length element. The ideal division will be 
automatically calculated, producing equal parts as close as possible to the distance you 
specified. 
Here, we used the new snap point option to place columns along a slab so that they are roughly 
1500 apart, equidistant, and with no “piece” left over at the end.

• Enhanced Snap Point feedback shows starting point from which the element is marked
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• Snap Points located along a temporary Snap Reference segment remain visible as long as that 

Reference does. Even if you start editing at the other end of the Snap Reference, the Snap Points 
you defined are still visible.

• Entire Polylines can be treated as a single unit, so you can use Snap Points along them 
intelligently

For more details, see Snap Points in the ARCHICAD Reference Guide.

Mac Interface: Unified Window Mode with Docking 
Palettes
The unified-window ARCHICAD interface is now implemented for Mac (already available on 
Windows), with support for Full Screen mode.
• Resize the entire ARCHICAD interface easily
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• Switch to full screen mode with only one click
• Palettes can be docked/undocked in the main ARCHICAD interface, so users won't get lost in the 

interface of other running applications, or have their window headers disappear behind palettes
• Mac only: Undock windows and move to separate displays
• Mac only: Access the project’s file path from the application header
• More consistent interface between platforms means easier transfer of Work Environment

See also Unified Window Mode on Mac and Dock or Undock Palettes or Toolbars in the ARCHICAD 
Reference Guide.

Other Workspace Improvements
• Show/Hide All Palettes with one-click menu command
• Change your Work Environment Profile more easily, with a menu command instead of the Work 

Environment dialog box (Options > Work Environment > Apply Work Environment Profile)

Tab Bar on Windows and Mac
Switching among different open windows is now easier and faster than ever! ARCHICAD 19 
introduces the Tab Bar, placing any number of opened windows at your disposal. The design is 
specific to each OS.
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Tab Bar on Windows

Tab Bar on Mac
• Switch among model windows faster: Tab Bar takes advantage of background processing, 

introduced in ARCHICAD 19
• To open more model windows, use the new pop-up navigator from the Tab Bar - faster 

navigation without the Navigator Palette 

Pop-up Navigator for Easy Switching
• Each tab has relevant context menu commands enabling quick access to related views or 

settings

              

                       Story Tab: Open any other story               IE Tab: Open another IE from the group
• Picture window tab provides feedback on background rendering progress (CineRender only)
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• Tab icon will indicate whether it’s a view (yellow) or viewpoint (orange) and if the view does not 
match the current settings (warning icon)

• Double-click the tab (or use tab’s context menu) to restore the view’s saved status
For more details, see Tab Bar in the ARCHICAD Reference Guide.

Expanded Surface Catalog
In ARCHICAD 19, the automatically loaded Standard Surface Catalog has been expanded to include a 
much wider array of popular surfaces.
In all, the Standard Catalog now contains more than 500 surfaces - that is, 200 more than in 
ARCHICAD 18.
• New surfaces have been added, based on user request
• Many surfaces previously available as premium content are now standard, available to all users
• Surfaces that earlier were saved in local templates are now in the Standard Catalog
• Find the Surface you need more easily: keywords have been added to every surface for smarter 

searches

DOCUMENTATION
Despite the freedom of 3D design, the architect’s job always culminates in detailed 2D 
documentation. Every tool that supports this documentation means more time available for 
creative design.
The latest improvements in ARCHICAD’s documentation tools will speed up your daily, repetitive 
annotation tasks, and ensure proper appearance of dimensions and labels automatically, with fewer 
manual adjustments.
Dimensions Improvements
Label Improvements
Publish Layers to PDF from Layout
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Dimensions Improvements

Automatic Pointers for Easy-To-Read Dimensions
Dimensioning narrow structures close to each other can make it difficult to read plans, because the 
dimension numbers are too crowded. Until now, users have solved this by dragging the dimension 
texts away and using a manual pointer to connect them to the referred element. Of course, if any 
such text item was later moved, you had to readjust the line, too, by hand.
The new Pointer for Dimension Texts in ARCHICAD 19 eliminates this extra work:
• Add a Pointer line to any dimension text
• Pointer line is added automatically when dimension numbers are moved out of area
• Pointer lines are associative and follow every change
Dimension Text Pointers work like labels, with all their formatting possibilities.

Dimension Texts: Right Where You Want Them
ARCHICAD 19 introduces new options to control the placement of dimension texts – e.g. to place 
texts underneath the dimension line automatically whenever necessary, and/or allow them to shift 
laterally. Choose the dimension placement logic that you prefer.
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See also Placement of Dimension Text in the ARCHICAD Reference Guide.

Easier Editing of Dimensions
Point-specific new pet palette commands make it easier to edit Dimension points, text boxes and 
Pointers graphically. 
• Split dimension into parts with just one click

• Break and offset dimension line

 
• Move Dimension Point (with visual feedback on the dimensioned point)

• Edit Length of Witness Line (new option for graphical editing)
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• Edit starting angle of all Pointer lines through Dimension Settings
• All graphical editing commands (e.g. Drag, Stretch) available for Pointer line (as for Label 

Pointers)

Automatic Dimensioning of Story Level Lines
Dimension a whole skyscraper with just one click.
• In Section/Elevation view, click with the Dimension tool on any single Story Level Line
• After a story level change, all vertical dimensions are rebuilt automatically
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Multi-line Dimension Texts
In earlier versions, if you needed several lines’ worth of dimension text, you had to add a separate 
text box, unconnected to the dimension.
As of ARCHICAD 19, you can add as many lines of dimension text as you need. The full dimension 
text can be formatted and shifted around as needed, without falling apart.

New Witness Line Option
With ARCHICAD 19, you can choose witness lines with no overhang, required for documentations in 
some markets.

Associative Level Dimensions
Level Dimensions automatically become associative to the clicked element (Slab/Roof/Shell/Mesh). 
You can filter the types of elements further, by using Gravity.
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Label Improvements

Add Multiple Labels to Any Element
As of ARCHICAD 19, you can link any number of labels to each element - even elements in Hotlinked 
modules. This feature gives you much greater freedom to label any element as needed. For 
example:
• Label a single element with several properties - e.g., to show both “fire rating” and “ID” for the 

same Wall
• Place the same label several times along a long Wall
• Place the same label at different scales and in different sizes as needed
• On a multi-story element with varied geometry (such as a slanted Wall), place a label at a 

different position on each story
• Label elements of a Hotlinked Module within the host file
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Easier Label Placement
Until now, you had to place associated labels using element settings, after setting a default label 
separately for each element type. 
From now on, just use the Label tool: choose the desired Label type (which becomes the one single 
Label default, until you change it), then click any element. No need to open the labeled element’s 
dialog box.
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• Element highlight helps you label the right element
• Tab to switch among overlapping elements (including Curtain Wall sub-elements)
• Label multiple elements simultaneously, regardless of element type (using Document > 

Document Extras > Label Selected Elements). The current default label type is attached to all 
selected elements

• Label Curtain Wall sub-elements directly

• New Inverted Pointer option for labeling in sections: e.g., for displaying the bottom elevation of 
suspended ceilings

  

Smarter Editing of Labels and Pointers
• Select and drag several Labels simultaneously; Pointers are adjusted accordingly

• Edit starting angle of all Pointer lines through Label Settings
• Lock starting angle of all Pointer Lines to ensure a consistent throughout documentation
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• All graphical editing commands (e.g. Drag, Stretch) available for Pointer line (as for Pointers of 
Dimension texts)

• Turn Pointer on/off for all Labels of a given type (e.g. all ID labels)

New Label Objects
To fit the new Label workflow, the ARCHICAD 19 Library includes many new Label types.
See also New and Improved Label Types in this document.

Publish Layers to PDF from Layout
ARCHICAD 19 lets you export layouts (not just model views) with their drawing content layers to 
PDF format. 
In the resulting PDF document, you can show or hide drawing content by layers, or navigate among 
layers.

Note: Layer information is exported only for visible elements within drawings - not for items 
placed directly on layouts.

Whether you are publishing model views or layouts, what you see is what you get.
See Export Layers to PDF.

SCHEDULING
List Skin/Component Area in Interactive Schedule
Schedule of Finishes

List Skin/Component Area in Interactive Schedule
When compiling a bill of quantities, users can now list all components, regardless of which 
ARCHICAD tools were used to model them.
• Schedule the areas of any composite structure by skin
• Schedule the areas of profile elements by components
For example, you can easily list the areas of thermal insulation panels.
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For more details, see Skin Areas of Basic and Composite Elements and Component Areas of Complex 
Profiles in the ARCHICAD Reference Guide.

Schedule of Finishes
Newly introduced Surface Lists let you schedule the total exposed area of a surface (as well as their 
other properties, e.g. color or hatching). 
You can define exactly what counts as exposed, depending on your Surface List Scheme Settings. In 
the follow diagram, the dark blue area is considered as “Exposed”, the light blue areas are 
considered as “Covered”.

However, you can define the light blue areas to be calculated as exposed - e.g., if they are behind 
furniture objects. The “Reduce Exposed Area” sub-dialog (in Scheme Settings, from the “Exposed 
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Area” field) can specify, for example, “Element Type is not Object”. This way, the light blue area is 
also counted as Exposed Area.

These schedules provide a fast and precise list of the areas of required finishes (paint, wallpaper, 
wall coverings etc.).

• All Finishes lists every visible surface in the model with its total exposed area.
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• Finishes of Construction Elements lists the visible surfaces used by each element type, with 
their respective exposed areas. 
You also have the schedule specify whether the listed surface differs from that of the element’s 
Building Material surface - i.e., whether it has been “painted over” (here, the Painted checkbox).

• Finishes of Openings lists the surfaces (excluding glass) of Doors and Windows. That is, the 
schedule lists the surfaces used for frame, casing, and accessories such as shutters, board, and 
sill).

See also Create Schedule of Surfaces in the ARCHICAD Reference Guide.

OPEN BIM
Displaying Point Clouds
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IFC Import Improvements
MEP Improvements
BIMx Export Improvement

Displaying Point Clouds
Projects involving renovation typically require digital modeling. For this purpose, 3D scanners 
generate point cloud files, such as a historic room interior with all its volutes and ornaments.
Now such point cloud files can be placed in your ARCHICAD model, for a smoother renovation 
workflow that is in tune with the BIM concept.
• Open .xyz and .e57 file formats and convert them into native GDL-like objects, which are placed, 

in the correct sizes and colors, on the Floor Plan or in the 3D window
• Snap to any point on the resulting object
• Align existing building model to point clouds
• Use point cloud as an aid when modeling a new building in ARCHICAD - no need to start drawing 

from scratch
Use the point cloud workflow to model existing buildings prior to renovation; surroundings and 
neighbor buildings, as an aid to visualization; or the “as-built” building, to detect any deviations 
from the planned state.

Image credit:  BAM Construct UK Ltd, www.bam.co.uk | FARO Technologies UK Ltd, www.faro.com

For more details, see Working with Point Clouds.
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IFC Import Improvements

Exact Geometry Import
Since the introduction of priority-based connections and Building Materials, connecting elements 
automatically affect each other’s geometry based on their priority. As of ARCHICAD 19, users have 
the option to avoid this when importing an IFC model. This way, they can see the model exactly as it 
looked in the original authoring tool, and no auto-intersection is used.
• Imported IFC model space elements (IfcSpace) will always be generated as ARCHICAD Zones, 

which will always retain the imported elements’ original geometry
• Import functions (Open, Merge, etc.) ensure that the imported elements will always be 

displayed in their original colors
• Option to use Object or Morph tool to generate imported building, MEP or other element
• New IFC translator for “Exact Geometry Import” is provided in the template

Attribute Handling for IFC Import
• Ability to override materials and representation styles of IFC model elements with preset 

Building Material and Surface Attributes. This will lead to much cleaner project files, because 
the IFC model’s attribute set won’t be recreated unnecessarily.

• Intelligent template for converting IFC Materials to Building Materials: the list of mapped IFC 
materials can be easily expanded based on IFC file content.

In this example, the Material and Surface Conversion overrides the original materials and surfaces 
of the imported IFC model, with concrete elements in blue and steel elements in red.
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ID Management of IFC Spatial Elements
Smart ID assignment is now available in ARCHICAD’s Project Info fields for Project ID, Site ID and 
Building ID.
You can use keywords added to the Project ID, Site ID and Building ID fields to control whether the 
IFC spatial elements (IFC Project, IFC Site, IFC Building) are assigned identical or different GlobalID 
values - even if they are located in projects created with a single template.
For example, you can ensure that two buildings located on a single site will have different GlobalID 
values.

Improved Import of MEP Models
When importing MEP elements, ARCHICAD now optimizes the management of shared geometry. As 
a result, the import will produce fewer geometric elements (in the case of Morphs) and fewer 
Library Parts (in case of Objects).
In ARCHICAD’s MEP Modeler environment (an optional add-on), the program
• can convert MEP Modeler-type elements from all MEP elements of an imported IFC model, and
• can automatically detect and calculate an insulation parameter (where needed) for imported 

pipe and duct items.
MEP elements will be imported with their original color.

Update with IFC Model
The “Update with IFC Model” command has been expanded with new and customizable functions. 
Choose your preferred option:
• Generate only the new properties
• Update the existing properties with any changes
• Delete unused properties from the ARCHICAD project
• Do a total update using all three of the above options
In addition, you can use the Model Filter option to set which element types’ properties (e.g. just the 
columns, or just the elements on a particular story) should participate in the update.
In this example, the update process adds the new properties of Beams and Columns, which are 
found both in the IFC model and the current ARCHICAD project.
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Streamlined IFC data mapping of Library Part Parameters
New option in IFC Scheme Setup: if a particular parameter is common to several Library Part 
elements, you can map its corresponding IFC data in just one step.
In this example, the “FM_SerialNumber” parameter is mapped to the “SerialNumber” IFC property 
as Library Part Independent. This means that any IFC element that is generated by a Library Part 
(Window, Door, Object, etc.) is assigned the value of this parameter, provided that the element 
includes this “FM_SerialNumber” parameter.

Export IFC Data to BIMx
You can control which element information will be published as part of your Hyper-model, to be 
viewed in BIMx apps on mobile devices.
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One option is to export each element’s IFC properties, as defined in the Tags and Categories panel 
of its Element Settings dialog box.
See also BIMx Export Improvement in this document.

Improved IFC Performance
Faster IFC data handling in IFC Manager.

API IFC Improvements
Add-Ons developed for ARCHICAD can now, in runtime, assign IFC attribute, property and 
classification data to elements and product types.
This feature also allows the Add-Ons to define mapping between their custom data and IFC data 
with simple and complex rules.

MEP Improvements

Improved Collision Detection in MEP Modeler Environment
Collision detection now works for all elements classified as MEP-type in Element Settings (Tags and 
Categories > Element Classification), and not just for MEP Modeler elements. As a result, collision 
detection works on:
• all imported IFC MEP elements (regardless of which MEP application exported the IFC model), 

and
• all ARCHICAD project MEP Objects and MEP-classified elements (for example, pipes defined with 

Beam tool, but classified as MEP elements).
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The collision detection function works between solid and solid and between solid and open shell 
geometries.
For improved performance, collision detection works on a multicore basis to avoid slowdowns, and 
the algorithm itself is now much faster than in previous versions.

Element Classification Available for MEP Elements
Unique element classification (Element Settings > Tags and Categories) can be set for Ductwork, 
Pipework and Cabling elements and equipment in the MEP Modeler environment. This means you 
can classify an element in a way that best conforms to IFC element classification and IFC model 
export.
Element Classification has another advantage, not directly related to IFC exchange:
• Search for MEP elements by using specific “Element Classification” values as criteria
• List MEP elements according to their element classification, in the Interactive Element Schedule

Automatic MEP Modeler License Reservation
With the MEP Modeler network license, anyone can use the MEP Modeler functions, provided that 
a license is available.
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BIMx Export Improvement

Control Element Info for Mobile Users
When you publish an ARCHICAD project in BIMx Hyper-model format, the file’s recipient, viewing 
the BIMx model on a mobile device, sees the project’s 3D and 2D information - including certain 
element information.
Until now, the element information provided in the Info feature of BIMx mobile apps consisted of a 
predefined set of data.
As of ARCHICAD 19, you can control which element information will be published as part of your 
Hyper-model.
• When publishing the Hyper-model, use the new Info Set pop-up to define the element info that 

the recipient will see:

• The BIMx info option uses data defined in an Interactive Element Schedule of this name. This 
schedule is provided in the factory-default ARCHICAD template (for the International 
market), but you are free to modify the schedule scheme as needed, or to choose a different 
schedule.

• The Tags and Categories option uses the data defined for each element in the Tags and 
Categories panel of its Element Settings dialog box.

• The Legacy option provides the same basic element data as in previous BIMx versions.
• Choose None if you don’t want the recipient to view any element information (e.g., if the 

recipient will just be viewing the model geometry as a whole, and doesn’t need any details 
on the various component elements).

For more details, see Use the Publisher to Create a BIMx Hyper-Model.
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TEAMWORK AND BIM SERVER
BIMcloud Control Icon: Single Entry Point for Server Management
Network Diagnostic Tool

BIMcloud Control Icon: Single Entry Point for Server 
Management
• New icon in taskbar/menubar means easy access to configuration and management interface 
• See and monitor the status of all installed components, and respond quickly to errors
• All management commands are grouped under a single icon

Network Diagnostic Tool
Whether you are accessing server-based libraries, or using BIMcloud/BIM Server for Teamwork on 
large files, a secure and reliable server connection is imperative for efficient work. 
The new Network Diagnostic tool, built into ARCHICAD 19, provides an overview of connections 
information for all components of your BIMcloud/BIMServer configuration.
• If a connection isn’t working, find out why and how to solve it (using the BIMcloud/BIM Server 

Manager interface)
• Manually add additional local server paths if needed (supports data transfer over different 

server paths - BIMcloud/BIM Server Manager only)
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For more details, see Network Diagnostic in the ARCHICAD Reference Guide, and the BIMcloud/BIM 
Server User Guide.

LIBRARY IMPROVEMENTS
Please note: Some new Library Part developments are available in certain localized libraries only 
(where applicable, this is indicated in the descriptions below).

Simplified Door/Window UI
New and Enhanced Library Parts
New and Improved Label Types
Other Library Part Improvements

Simplified Door/Window UI

Graphical Interface: Better than Ever
The controls of Door/Window Settings - until now, overly complex and often redundant - are much 
friendlier. In ARCHICAD 19, finding and setting Door/Window parameters is more intuitive and 
therefore much faster. 
• All Door/Window parameters are available in a graphical interface on the Custom Settings 

panel, and grouped into a logical hierarchy
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• For fast, simple setup of doors and windows: once you have defined the shape and size, you 
only need to check the three main tab pages: Door/Window Settings, Wall Opening, and 
Connecting Structures.

• If you want to set additional details, use the additional tab pages within the hierarchy, or 
access them with shortcuts from the main pages

• Model (3D) attributes are grouped under the three main tab pages, while all Floor Plan and 
Section attributes are together on one tab page

• Icons and picture pop-ups have been redesigned

Updated Tab Page Selector
• Smoother workflow: after you navigate to a settings page, double-click to close the tab page 

selector and then you can edit the settings right away (earlier version required an extra click)
• Back/forward arrows for faster page turning
• Tab page tree view is dynamically resized when re-opened
• Vertically resize the tab pages which contain only a list

More Compact Door/Window Dialog Box
Now that many Door/Window parameters have been restructured, several panels of the Settings 
dialog box are no longer needed. These have been eliminated or hidden. The result: a more 
compact interface.
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Window Settings Dialog Box in ARCHICAD 18 (left) and ARCHICAD 19 (right)

• No More Parameter List
Since the custom interface now contains all needed parameters, the Parameter List is 
superfluous, and has been removed for all doors and windows in the GS library.

• No More Reveal Panel
The separate Reveal Panel has been eliminated from the settings dialog, but its controls are still 
available (in the Reveal tab of the new hierarchical structure) for library parts that use these 
settings.

• No More Model Panel
In earlier versions, the Model Panel contained few, rarely used controls. 
In ARCHICAD 19:
• The Model Panel is hidden by default, but can be enabled using the Work Environment’s Tool 

Settings controls
• Wall Opening Surface settings have been moved to the Custom Settings panel
• Undo All Crops command is now at Design > Roof Extras

• No More Listing and Labeling Panel
As part of the Label Improvements project for ARCHICAD 19, this panel has been renamed to 
“Listing”, and by default it is hidden in all Tool Settings dialog boxes.

• Improved Floor Plan and Section Panel
• “Enable Object’s Attributes” was replaced by “Override Object’s Attributes” for a better 

understanding of the interface 
• Irrelevant settings for all Floor Plan Display types are hidden
• New icons make it easier to differentiate parameters

New and Enhanced Library Parts
New library parts, or additional types for existing objects, have been created in the ARCHICAD 
library of the International package.

Please note: Some new Library Part developments are available in certain localized libraries only 
(where applicable, this is indicated in the descriptions below).
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Bathroom Accessories
Two new Towel Rack types
• Ring
• Hook

            

Electrical Hand Dryer Object (3 types)
• Automatic
• Push Button
• High Speed
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Towel Rack Radiator Types

Playground Elements
• Spring Rider
• Climbing Structure
• Swing
• Slide

Mitred Gutter
New object added to all libraries (already present in USA library).
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Three-Sash and Six-Sash Sliding Windows
Note: Not available in the following versions of the ARCHICAD Library: Germany, Austria, 
Switzerland, Japan, USA.

          

New and Improved Label Types
The Label tool is significantly improved in ARCHICAD 19. (See Label Improvements, above.)
Given the simplified Label placement logic, and the ability to attach any number of Labels to a single 
element, the ARCHICAD 19 Library contains an entirely new selection of Symbol Labels.

Note: Local library content will vary to meet local standards.

• All new Labels have parameters that fit their specific function
• Label Settings for many new labels have been expanded for more control over content and style
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For more information, see Symbol Labels and Custom Settings for Symbol Labels.

Other Library Part Improvements

Enhanced Graphical Interface (Selected Library Parts in the International 
package)
Settings dialogs of selected library parts (see list below) have gotten a facelift in the form of a better 
graphical interface.
• All parameters available on the more intuitive Custom Settings interface: no more parameters 

list
• Easier navigation among parameter tab pages
• Better graphics for Minimal Space controls
• Separate tab pages for 2D Representation/3D Representation and Surfaces (formerly all 

parameters were on a single “Appearance” tab page)
• “Descriptions” tab page replaces earlier “Parameters for Listing”
• New tab page icons
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Affected Library Parts
The following library parts in the ARCHICAD Library (International package) have new or enhanced 
graphical settings pages:
• Special Constructions/Accessory Items: Downspout (+ additional size parameters)
• Beds: Bed, Bed Bunk, Bed Canopy, Bed Double, Crib, Night Table
• Couches and Sofas: Designer Couch, Designer Sofa 01/02/03, Sofa
• On-Site Renewable Systems:

• Rain Water Tank
• Solar Collector Evacuated Tube (+ new Water Tank parameter)
• Solar Collector Flat Plate (+ new parameters for more consistency with similar objects)
• Solar Photovoltaic Panel

Updated Flat Panel TV
(Formerly: Plasma TV)
• New, graphical interface
• More options for screen size ratios and inputs
• No minimum screen thickness
• Flexible frame width
• More options for stand, base, and mount (e.g. motorized/ceiling/wall mount)
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Improved Minimal Space Interface
Clear, multi-color Minimal Space controls for many furniture objects in the ARCHICAD Library 
(International package).

Improved Revision History
• Show Revision History data in preferred order: list new items from the top down or from the 

bottom up
• More options for customizing display of Revision History data:

• Hide unneeded data items using filter control
• Show only data from latest Revision

Story Sensitive Controls
• Floor Plan Display parameter added to wooden trusses for control over story-specific display
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• Story sensitive display control added to relevant objects in the USA Library

Better Control of Zone Text in Zone Stamp 01
The Zone Stamp 1 object now has the option (like Zone Stamp 02) to set font size by Model Size or 
Paper Size.

Expanded Parameters for Door Leafs, Sidelights
Note: Not available in the following versions of the ARCHICAD Library: Germany, Austria, 
Switzerland, Japan, USA, Norway, Sweden.

• Door leaf undercut available for all hinged doors
• Door leaf rebate depth parameter for all hinged doors
• 2D opening angle and opening sign for door sidelights

SMALL INTERFACE CHANGES
Apart from thematic feature developments and major performance improvements, ARCHICAD 19 
contains a number of fixes, UI changes and renamed controls, all aimed at improving your user 
experience in small but useful ways. These include the following.
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Better Feedback on ARCHICAD Processes
During window updates, library loading and other processes, get improved feedback on what is 
happening and a clear indication of whether you can stop the process if needed.

               

3D Window Settings
Updated and simplified UI.

Surface Settings (CineRender engine)
• Choosing “Image” as the Texture type will now automatically open the “Load Image from 

Library” dialog box
• The two options in the Match Settings popup are renamed to make them clearer: “Update 

Internal Settings (from CineRender)” and “Update CineRender Settings (from Internal)” 

Improved Editing of Image Textures in Surfaces
• The name of each image is listed among the Surface parameters (not just “Image”)
• Texture size (width/height) in pixels is shown in Surface Settings, and when browsing for a 

texture.
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• You now get feedback if a texture is 'Missing' from the library
• If the Surface channels use multiple images textures of varying sizes, you get immediate 

feedback and the chance to select a proportion for all of them, to avoid distorting the end result

Show Full Element ID in Zone Stamps
• Zone Stamps, Markers and Labels using the Element ID parameter now display the Full Element 

ID by default - that is, the ID which includes any Master ID information 
• Thus, in a project using hotlinked modules, the Zone ID can be extended by the Master ID of 

the module instance it belongs to 
• The options for displaying element ID in Element Schedules and in library part elements are now 

renamed as: Full Element ID; Compact Element ID 
• No more 15-character limit for the ID field of construction elements (Element Settings > Tags 

and Categories panel) (new limit is 2048)

Building Material Control for Imported Steel Profiles
In the Standard Steel Profile Database (Options > Import Standard Steel Profile), you can assign a 
Building Material before importing into Profile Manager.

Composite Structures Dialog Box
• When you drag skins in the list, the dragged skin is placed between skins (instead of swapping 

two skins)
• When you reopen the dialog box, the last viewed composite is now automatically selected

Profile Manager
 “Use Building Material” checkbox renamed to “Override Surfaces” to better match Tool Settings 
and to be clearer – the on/off has been reversed to accommodate the name change.

Scheme Settings
• Data in the IES Schemes panel can be sorted by ID or Name
• Scheme Settings redesigned to better match similar dialogs and to combine New/Duplicate 

functionality
• In the Fields panel, use Cmd+A (select all) shortcut to select all fields
• Additional Parameters moved into sub-dialog, with a list view of the parameters and instant 

Search
• Use Shift and/or Cmd to multi-select, multi-edit, multi-delete, and multi-drag fields 
• The Criteria control “is/is not/contains” (e.g. for Building Material Name), now also includes 

“does not contain”
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Wall’s End Surface Pattern
When the “End Surface: Override using Adjoining Wall” is checked, the texture and vectorial hatch 
are now correctly aligned with the neighboring Wall (if you realign texture of neighboring Wall, the 
neighboring Wall’s end will match it).

Find & Select Surface Criteria
In the Find & Select dialog box, the “Surface Override” criterion has been changed to just “Surface”, 
and will search for the Surface regardless of whether it’s an override or the original Building 
Material surface.

Commands of the Window Menu
Commands have been renamed/changed to fit Tab Bar workflow

Navigator Palette
• “Auto Hide Navigator/Organizer” command has been removed (from context menu of 

Navigator/Organizer), due to the introduction of the popup Navigator in the Tab Bar
• Navigator and Organizer pop-up can now hide as well as show relevant palettes

Work Environment
• New menu command to change Work Environment Profile: Options > Work Environment > 

Apply Work Environment Profile
• Guide Lines Panel eliminated from Work Environment Settings
• Simplified Guide Lines settings are now found on the renamed Input Constraints and Guides 

Panel
• Imaging and Calculation Panel renamed to Model Rebuild Options.

• Includes the Auto-rebuild Model View Control (formerly located on the More Options panel)
• Palette Schemes group has been renamed to Workspace Schemes

Tool Settings Panels
• The Listing and Labeling Panel is now called just Listing, and is hidden by default. (You can make 

it appear in Tool Settings, by customizing your Work Environment.)
• The Relation to Zones control (formerly on the Listing and Labeling Panel of Wall, Column and 

Curtain Wall Settings) has been moved to the Model panel (Wall and Column Settings) and the 
Member Placement Panel (Curtain Wall Settings).

• In Zone Settings: the Undo Top Crops/Undo Bottom Crops command is now called Undo All 
Crops, and has moved to Design > Roof Extras.

• The Parameters for Listing tab (in Object-type Tool Settings) is now called Descriptions
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Other UI modifications
• OSX10.10 only: dialog panel headers and pop-ups now flatter in design (fewer gradients) to fit 

better with Yosemite style
• SEO palette is narrower and width can be stretched
New Features in ARCHICAD 8-20 629



New Features in ARCHICAD 20
New Features in ARCHICAD 20
INTUITIVENESS
INFORMATION MANAGEMENT
PERFORMANCE AND STABILITY
VISUALIZATION
INTEROPERABILITY
LIBRARY IMPROVEMENTS
LIBRARY ENHANCEMENTS (Selected Markets Only)
SMALL INTERFACE CHANGES

INTUITIVENESS
The following new features in ARCHICAD 20 enhance the intuitive use of the program for users at all 
levels.
Refreshed User Interface for a Cleaner Look
New Vectorial Icons for a Lighter Touch
Graphical Favorites
Improved Tab-Based Navigation
Improved Library Management
Retina Displays Fully Supported on Mac

Refreshed User Interface for a Cleaner Look
ARCHICAD’s new interface provides a larger, cleaner workspace free of visual noise. Rarely used 
functions have been restructured and superfluous graphical elements eliminated. The result: a 
unified, dynamic, up-to-date and professional look for the user interface, which is in harmony with 
Windows 8/10 and OSX.
630 New Features in ARCHICAD 8-20



New Features in ARCHICAD 20
Upgraded Interface: AC 19 vs. AC 20

• The new, horizontal Quick Options bar (at the bottom of the workspace) is easier to access than 
the palette, for faster changing of View Settings as you work. 

• The Pop-Up Navigator (accessible from the tab bar) now includes many more Navigator items 
and controls, including nearly every context menu command you might need. Thus, you don’t 
always need the Navigator Palette open, which is turned off by default in the INT template, 
freeing up more space on screen. The Pop-Up Navigator is no longer a fixed height: it resizes 
automatically, to show more information, based on the amount of content and screen size. 

• The Info Box has a new header item to help you identify controls faster. (Switch it off if you don’t 
need it.)

• Font sizes and font types have been revamped for a more uniform, cleaner look.

New Vectorial Icons for a Lighter Touch
Icons on the ARCHICAD 20 user interface are now vector-based, so that all user interface elements 
display perfectly regardless of scale. As part of overall interface renewal, most icons have been 
redesigned for a lighter, more professional look. 
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New Vector-Based Icons: AC 19 vs. AC 20

Graphical Favorites
Favorites - the option to save and apply named settings to an AC element - has long been a powerful 
feature of ARCHICAD. Yet many users have not taken advantage of it, due to the parametric user 
interface and limited options for synchronizing Favorites in several projects. 
In ARCHICAD 20, Favorites get a fresh look and feel, right in line with the new user interface. In 
addition, Favorites are now much easier to use, which makes their power accessible to beginner 
and expert users alike.
• Better visual feedback: thumbnail previews (either 2D or 3D, in medium or large size) are 

generated automatically based on the Favorite’s parameters.
• Simplified, streamlined workflow: Apply Favorites directly from the Toolbox or Info Box.
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Apply Favorite from Toolbox

• In Favorites Palette: Line, Arc, Polyline, Spline Favorites are interchangeable. Similarly, use Text 
Favorites to update text in dimensions, labels and Fill area text.

• Browse and select object-type Favorites the same way as any other library part, in their Settings 
dialog box.
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Graphical Favorites in Library Part Settings

• Extended search: Find Favorites not only by name, but also by Categories and Properties data, 
including stored properties.

• Better Favorites management: Organize your Favorites in folders; Edit settings of multiple 
Favorites simultaneously; Import/export Favorites with fine-grain control.

Improved Tab-Based Navigation
As of ARCHICAD 20, when you switch between opened tabs, each tab retains its own view settings. 
The settings of the previous tab will not override them.
It’s also easier to apply settings among different tabs: you can pick up and inject settings between 
tabs, or match all tab settings to each other, for easy and full control of view content.
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Pick Up/Inject View Settings Between Tabs 

To make navigation even faster, use context menus from the tab bar and placed markers to navigate 
to any view created from a particular viewpoint: you no longer need the Navigator to find a view.
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Select Placed Marker, Then Right-Click to Open Any Related View

Improved Library Management
The enhanced Library Manager is no longer just a hierarchy of library folders: the new Contents tab 
provides details on the contents of each library, and makes it easier to access and manage individual 
library parts. In Teamwork, too, any user (provided he/she has the access rights) can see, reserve, 
and manage the contents of the Server library in Library Manager. 
• See the contents of your project libraries, including graphical previews of each library part
• Export Library Part files (such as surfaces) for editing, then add them back to your library
• Move or duplicate any library part to a writable library folder
• See warning information (e.g. duplicated library parts), without the Library Loading Report
636 New Features in ARCHICAD 8-20



New Features in ARCHICAD 20
Retina Displays Fully Supported on Mac
Since architects prefer a drawing area as large as possible, many now use high resolution (HDPI) 
monitors as their main ARCHICAD workspace. However, interface elements on such monitors may 
appear blurred and pixelated if they are scaled, or too small if not scaled. 
ARCHICAD 20 provides full support for the use of Retina displays on OS X: user interface elements 
properly scale with the resolution settings on these displays.

INFORMATION MANAGEMENT
These new developments in ARCHICAD 20 add flexibility to model data definition and streamline its 
communication:
User-Defined Element Properties
Mass Import of Element Property Data
Graphic Overrides for Design Communication
Element Previews in Schedules
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User-Defined Element Properties
An ARCHICAD model can be described as a central BIM database that stores all project data and 
makes it accessible to any project stakeholder. Previous ARCHICAD versions have provided diverse 
data definition options, with different limitations. Now, ARCHICAD 20 introduces ARCHICAD 
Element Properties: a robust foundational technology for future BIM data management in the 
ARCHICAD environment.
Properties are user-defined custom data that can be connected to any construction element or 
zone, based on Element Classification. Property definitions for various data type can be created and 
transferred between projects, including their default values. 
Assign and custom edit these values in the Elements’ Settings dialogs and the Interactive Schedule. 
Use the new Property Manager to manage ARCHICAD Properties within the scope of a project. 
Properties can be shown on any output, enabling distribution of element-related BIM data among 
stakeholders. For example:
• Add to Labels and Zone Stamps
• Use as criteria in searching and scheduling
• Add as Fields in Element Schedules, in the re-organized Scheme Schedule settings interface
• Map as IFC scheme properties (IFC Scheme Setup) for IFC model exports

Show and Edit Element Properties in Schedules
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Display Custom Properties in Element Label

Mass Import of Element Property Data
In the design process, not all project stakeholders use CAD or BIM tools, yet they still contribute 
specific BIM data, such as the values of element properties, to the project. Thus, it is critical that 
ARCHICAD be able to access and edit element property data from an external source.
Import Property Values is an easy, semi-automatic function to import data from an Excel worksheet 
to the corresponding ARCHICAD Property value fields. With this feature, ARCHICAD users can 
eliminate the tedious and error-prone task of entering the consultant’s data manually.
To define the data to be exported from ARCHICAD, use a dedicated Schedule Scheme for each 
consultant, which contains the required properties. When the data is later sent back as an Excel 
spreadsheet, you can filter the incoming data by individual properties, using a dialog that not only 
reflects the data structure of the source Excel file, but also provides feedback on possible errors.
Retain the stored property values in Excel format as an archive of a particular stage of the project, 
with the option to revert to it at any time.
This new development complements the existing data export functionality, in which users save data 
to Excel format from any selected Interactive Schedule. The two workflows together complete the 
required data exchange circle: the foundation of any real BIM workflow.
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Graphic Overrides for Design Communication
With this feature, you can display the elements in any model view according to a customized 
graphical definition, to easily communicate the design to everyone involved.
Use graphic overrides to create thematic drawings in a semi-automatic way. You don’t have to 
spend time on supplementary 2D CAD work or “idle” presentation drawings. Instead, enjoy the 
benefits of associative 3D/BIM content.
• View settings now include the Graphic Override Combination: a set of predefined Graphic 

Override Rules.
• The new Graphic Override Rules integrate the Renovation Styles. Compared to the old 

Renovation Overrides, Graphic Overrides provide better control over pen color, fill types, and 
skin separators

You can share views having graphic overrides with consultants using other applications, by 
exporting elements with their current colors as IFC models.

Original View

Load-Bearing Structures in Red
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Zones by Fire Rating

Element Previews in Schedules
The Interactive Schedule now includes fields for graphic previews (2D and/or 3D) of any 
construction element - not just Library Parts. The preview, a simplified thumbnail, is helpful in 
describing construction typologies within the project. 2D Plan, Cross Section and 3D Axonometric 
views are consistent, and can be automatic dimensioned.
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PERFORMANCE AND STABILITY
The ARCHICAD 20 package implements a series of independent enhancements to reduce apparent 
stability issues and enable a smoother workflow. Management of Hotlinks, libraries and Drawings is 
more robust, reducing disruptions in the ARCHICAD workflow.

Drawing Update Enhancement
Better drawing update: The processes for updating drawings and checking their status now rely on 
multiprocessing technology, for a faster workflow. 

Library Manager Update
Due to a limit on the number of characters the file system could manage, previous ARCHICAD 
versions ran into problems if the Embedded Library’s structure was overly complex.
ARCHICAD 20 eliminates this character limit for a more stable functionality.
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This is accomplished by extracting the Embedded Library into a virtual file system, reducing the 
number of library errors in case of complex Embedded Library structures.

Hotlink Management Enhancement
Handling of nested hotlink structures is improved by a more stable hotlink update process. 
ARCHICAD automatically detects embedded library parts which belong to deleted hotlink files, 
allowing users to clear up and manage libraries more easily.

Server Communication Improvements
This enhancement will help reduce the number of ‘Missing’ statuses, if temporary communication 
problems occur between ARCHICAD and the dedicated hard drive containing the drawings. 
Background processing is used to check the drawing status of external references in a separate 
thread. This way, drawings are not reported “missing” after server access is re-established. 
Server communication is also carried out in a separate thread, providing more feedback and 
reducing “freeze” time. Previously (on Mac in particular), when a server could not be found, it 
would hold up ARCHICAD for minutes. Now, ARCHICAD communicates with the server in the 
background, enhancing responsiveness. 

VISUALIZATION
Several developments in ARCHICAD 20 provide a better visual experience of the Virtual Building:
CineRender Engine Upgrade: R16
NURBS Definition in GDL
Two-Point Perspective

CineRender Engine Upgrade: R16
ARCHICAD now runs the latest CineRender version, based on the Cinema 4D R16 engine.
Surface settings improvements allow you to create even more realistic surfaces, while rendering 
improvements reduce render times and enable highly realistic contact shadows.

New Surface Channel: Reflectance
The new Reflectance Channel (replacing Reflection and Specular) allows for multiple reflection 
layers, each with its own bump map and reflection model. You can use “masks” to control reflection 
parameters, such as blurriness, and the Distance Dim mode to fade them out. The Conductor 
Fresnel mode is optimized for metallic surfaces.

Improved Shaders
• Brick Shader: new Displacement mode for more realistic brick walls
• Filter Shader: Gradation Curves, to precisely set brightness/color regions of an image
New Features in ARCHICAD 8-20 643



New Features in ARCHICAD 20
• Backlight Shader: New shading algorithms

Improved Global Illumination (GI) for Renderings
Use the new, faster Irradiance Cache to enjoy incredible contact shadows. The Irradiance Cache 
includes presets for specific types of Project lighting, both internal and external. 
If needed, select separate GI settings - including separate Saturation and Intensity settings - for the 
two GI calculation methods (primary and secondary). 
With the Show Samples option, you can disable display of shading points, if they are not needed 
during prepasses.

Improved Physical Renderer
“Turbo Boost” your rendering times, with no quality loss, using the new Intel Embree raytracing 
engine for the Physical Renderer. 
Faster grass renderings and a quick preview also enhance the Physical Renderer experience.

Other Rendering Improvements
• Updated scenes using the new settings for faster and even more realistic renderings
• Set Noise Distribution as a single, global setting (General CineRender Option)
• Faster Ambient Occlusion calculation via cache

NURBS Definition in GDL
A definition for NURBS has been introduced in GDL language. As a result, complex models created in 
Rhino as NURBS and imported to ARCHICAD as GDL objects can now be adjusted through a GDL 
settings parameter.
This development improves the display of imported NURBS-based geometries in ARCHICAD, where 
models are naturally segmented. ARCHICAD users can better control the representation of each 
individual imported object, depending on its purpose in the model.

Note: NURBS (Non-uniform rational basis spline) is a mathematical model commonly used in 
computer graphics for generating and representing curves and surfaces. It offers great flexibility 
and precision for handling both analytic and modeled shapes. (Wikipedia)

Two-Point Perspective
In 3D perspective view, users can switch from the default three-point to a temporary two-point 
perspective in any camera position, while maintaining the camera’s original position and viewing 
angle.
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As a result, all 3D vertical edges appear vertical in perspective projection. This feature emulates the 
vertical correction function of shift lenses in SLR cameras.

Three-Point Perspective: Default Camera View
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Two-Point Perspective

INTEROPERABILITY
These developments in ARCHICAD 20 boost the program’s capabilities for standard-based exchange 
of model data with related disciplines:
IFC Improvements
DWG Improvement
3DM (Rhino File) Import-Export
Improved Exchange with Green Software
Improved Exchange with Sketchup

IFC Improvements
ARCHICAD 20 has improved its current IFC-based workflow with new geometry and data sharing 
possibilities for the reference model concept.

IFC4 Import-Export
GRAPHISOFT has been developing IFC – an open-source platform for OPEN BIM collaboration – 
since 1996. We continue our pioneering commitment to IFC, supporting the latest IFC standard 
version and its major subsets (called “Model View Definitions”).
ARCHICAD 20 supports the import and export of the Model View Definitions, which are developed 
for multi-disciplinary 3D mode-exchange workflows. The latest IFC4 Model View Definition 
introduces two separate directions for coordination between different disciplines:
• IFC4 Reference View is suitable for all BIM workflows that are based on reference models, 

where the exchange is mainly one-directional. Here requested modifications of the BIM data, 
mainly of the shape representation, are handled by a change request to the original author.
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• IFC4 Design Transfer View provides building information with support for element editing: 
inserting, deleting, moving, and modifying physical building elements and spaces, within the 
limited scope of parametric exchange. For example, an architect providing building design 
information to an engineer for a particular discipline, where geometric modifications may need 
to be made. Note that the Design Transfer View is not meant for round-trip model exchange 
scenarios.
Note: ARCHICAD 20 continues to support the former 2x3 version of IFC. 

Support for IFC4 Reference View
ARCHICAD supports the import and export of triangulated face-set geometry representation - a 
requirement of IFC4 Reference View.
The Renovation Status property is now shared as a standard IFC property, and Tags and Categories 
data of Building Materials are shared as standard IFC Material properties.

Colored Elements at IFC Export
Bodies with multi-color surfaces (for example, walls with different inside and outside colors) can be 
imported and exported, with the colors correctly maintained. 
ARCHICAD’s IFC function also correctly exports element colors currently displayed in your model - 
for example, the colors defined by Graphic Overrides, Renovation, Revision, and Mark-ups - so you 
can share this information with other consultants/applications.

Other IFC Improvements
• When exporting and importing an IFC model, ARCHICAD 20 now supports the survey point (site 

local placement) definition.
• The new ARCHICAD Element Properties (see User-Defined Element Properties) are mappable as 

IFC scheme properties.
• Base quantity export has been improved.

ARCHICAD’s Graphic Overrides Shown in Exported IFC Model
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DWG Improvement
By implementing higher-precision geometric algorithms, the export of Layouts to DXF/DWG format 
has been improved. 
Exported point coordinates in DXF/DWG format are more accurate when using a specific DXF-DWG 
Translation Setup option. ("Paper Space with Drawings as Blocks" and "Model Space" modes of 
“Save Layout into” option.)

3DM (Rhino File) Import-Export
ARCHICAD is now able to read and write the native Rhino (3dm) file format, enabling a “reference 
model” workflow between the two applications. 

Note: 3dm is the native file format of RHINOCEROS, a 3D computer graphics and CAD 
application developed by Robert McNeel and Associates Company. Rhinoceros geometry is 
based on the NURBS mathematical model, which focuses on producing mathematically precise 
representation of curves and freeform surfaces in computer graphics (as opposed to polygon 
mesh-based applications). (Wikipedia)

Import 3dm File
Import part or all of the Rhino model to ARCHICAD.

The imported model will appear as a non-editable GDL object, maintaining the logical structure of 
the original Rhino model. A new technology, implemented as an add-on, interprets NURBS coming 
from Rhino and turns them into segmented surfaces in ARCHICAD. The level of segmentation can be 
adjusted in the object settings dialog.
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Export to 3dm
From any 3D view, export part or all of the ARCHICAD model to Rhino (3dm file format). Only 
geometric information is exported, because Rhino handles only this type of data. Non-geometrical 
data (properties, schedule data, quantities) are not transferred. 
Mapping of ARCHICAD textures is not supported, since multiple textures in a single element is not 
supported by Rhino.

For more details, see Working With Rhino 3D Models.

Improved Exchange with Green Software
ARCHICAD’s built-in Energy Evaluation function is designed to support interoperability with external 
building performance analysis applications. In ARCHICAD 20, new export options make it easier to 
transfer BIM data directly to building performance evaluation tools.

Export to gbXML
The Green Building XML (gbXML) open schema has become the industry standard for BIM to SIM 
interoperability. Use the Export to gbXML command to save project geometry and property data 
derived from the ARCHICAD model this file format. Similarly to IFC, the gbXML model can be 
visualized using dedicated viewers or graphical interfaces of building performance simulation 
software compatible with the gbXML format.

Export to PHPP
Certified Passivhaus buildings are designed according to a strict yet straightforward directive 
defined by the Darmstadt Passivhaus Institute (PHI) in order to be extremely energy efficient. PHPP 
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is the official Excel workbook issued by PHI. The Export to PHPP button activates the dedicated 
dialog box, which enables you to send building information model data to the PHPP Excel workbook 
you specify, for post processing.
ARCHICAD 20 supports both PHPP versions 7 and 9.

Note: the PHPP Excel workbook is an independent product of PHI and is not a part of 
GRAPHISOFT ARCHICAD. For more information on PHPP and the Darmstadt Passivhaus Institute 
visit the official website at http://www.passiv.de/

For more details, see Interoperability with Green Software.

Improved Exchange with Sketchup
Save and open the latest Sketchup formats (.skp): ARCHICAD 20 supports all of the Sketchup 
formats through version 2016.

LIBRARY ENHANCEMENTS (All Markets)
The following Library Enhancements are available in all localized libraries.

Note: Some localized libraries contain different or additional improvements. For more 
information, see LIBRARY ENHANCEMENTS (Selected Markets Only) or consult your ARCHICAD 
distributor.

Upgraded User Interface for Objects
The tab page selector introduced in v18 for lamps and in v19 for doors and windows is now 
implemented for many other objects. Duplicate settings, in parameter list and graphical interface, 
have been eliminated: the user can access either the parameter list or the graphical interface, but 
not both at the same time. Similar interface tab pages (like 2D Representation, Minimal Space, 3D 
Representation and Surfaces) were unified for all library parts.
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These interface improvements can be found in all library parts of the following folders:
• Furnishing
• Door
• Windows
• Building Structures
• RoofMaker Library
and in selected elements in the Building Structures, Special Constructions and Mechanical folders.

Parking Place Improvement
• Number of parking places can be listed
• Possibility to add empty place (with no numbering)
• Optional Disabled and Family parking places with special width and sign settings

WC Disabled Improvements
• Graphical interface
• Updated for US standards
• New grab bar types
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Other Improved Library Parts
• Coordinate Dimension: new types for the 2D symbol: Empty Triangle, Full Triangle
• Ramp Objects: stair-like 2D symbol options
• New object: Parasol
• WC Disabled: graphical interface and adjusted US standard
• Zone Stamp 2: with pointer

LIBRARY ENHANCEMENTS (Selected Markets Only)
These sections list library improvements in selected local libraries.

Door and Window Enhancements: INT-Based Libraries

Casing 
• New casing types were added
• Uniform Casing Width and Casing below Sill options available for all casing types
• New interface for casing settings

Door Leaf and Sidelight/Transom Sash
• New door leaf types
• New handle type for sliding doors
• Kick board/foot protection for hinged doors, sliding doors, garage doors and storefronts
• French panel available in all sidelight and transom sashes
• Sashes of a sidelight of a door may have different surfaces

Improved Pocket Doors
• Additional Leaf sizes
• New Option: Centered in Wall
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• Connection between Pocket frame Width and Egress Dimension

Window Improvements
• Ledge option added for window sashes 
• New Rhombus and Skewed windows
• Arch Top Window: segment top may be selected

Sliding Windows
• Handle selection now available for all sliding windows
• New opening types for multi-sash sliding windows: Flexible options for fixed and sliding sashes

Misc. Door/Window Developments
• Consistent sill types in doors and windows: all sill types that available for windows are now 

available for doors too
• Double doors - handle settings available for each panel
• Panic Bar for General Doors too
• Overall height resize changes the height of transom and not the height of door panel
• Wrapped plaster skin has optional hotspots to be dimensioned

Other Local Library Enhancements
New developments in selected local libraries only, as indicated.

New Opening Type for Special Windows (GER/AUT/CHE only)
New opening types were added to the following windows, providing a complete selection of 
openings for all sashes.
• F Dreieck-Abschluss 1-Fl, F Korbbogen 1-Fl, F Segment-Abschluss 1-Fl, F Dreieck-Abschluss 1-Fl, 

Sprossenfenster 1-Fl, Fenster Oktogonal, Fenster Raute, Rundfenster
• Fixed Glass
• Fixed Sash

• Fenster Halbkreis Fest - renamed to Fenster Halbkreis Horizontal
• Fixed Glass
• Bottom Hung

• Fenster Halbkreis - renamed to Fenster Halbkreis Vertikal
• Fixed Glass
• Side Hung

• New option for Detail Level of Door Symbols in MVO: simple opening line in closed leaf position 
per leaves (NLD only)

• Swedish renovation symbol added to all doors and windows (SWE only): the symbols for 
demolished and new doors and windows that were available in Basdörr and Basfönster are now 
available for all doors and windows too
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Floor plan display of Tilt-Turn, Tilt-Turn Mirrored, Bottom Hung, Top Hung 
and Reversible Horizontal Windows (NLD only)

New Height Symbols for Zone Stamp (GER/AUT only)
Height values have new optional symbols: Halftone Triangle, Circle, Halftone Circle

New Label: Wall Type Indicator NCS (USA only)
Displays the wall type ID of a wall structure. To use the label, users should add the wall type ID to 
the name of the composite, separated by a special character.

New Title Block (FIN only)
New title block object used for Master layouts.

Labels (AUS only)
Height x Width display.

Upgraded Wohnungsstempel and TOP Stempel (GER/AUT only)
The Wohnungsstempel and TOP Stempel functionality was improved for a more polished workflow 
and enhanced stamp objects.
Improvements for both stamps:
• Apartment identification based on zone stamp parameters instead of zone ID or zone number
• Improved Refresh functionality with or without selection
• Simplified workflow and interface based on object settings dialog
Improvements for Wohnungsstempel:
• Separate column width settings
• Data to be displayed can be selected in a flexible way
• More zone data to be displayed

• Raumname
• Raumnummer
• Gemessene Fläche
• Gemessene Nettofläche
• Abzugsfläche
• Reduzierte Fläche
• Putzabzug
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• Abzug nach WohnFIVO
• Berechnete Fläche (NGF)

Improvements for TOP Stempel:
• Multiple TOP stamps of different types can be placed for the same apartment
• Option to summarize zone areas based on stories, WBF or Zone Categories
• Option to summarize apartment areas before and after renovation based on the ARCHICAD 

Renovation functionality

SMALL INTERFACE CHANGES
Apart from thematic feature developments and performance improvements, ARCHICAD 20 contains 
a number of fixes, UI changes and renamed controls, all aimed at improving your user experience in 
small but useful ways. These include the following.

New Find & Select Criteria
Building Material Name and Surface Name criteria now available in Find & Select (was previously in 
IES only)

OpenGL Previews in Object Settings
OpenGL previews are available in all Library-part type Settings dialog boxes.

Changes in Model Viewer Support
The Project Reviewer application is no longer included in ARCHICAD. 
Instead, we recommend the professional PDF viewers available from Bluebeam (e.g. Vu and Revu). 
See http://www.bluebeam.com/us/products/.

Changed Grass Rendering Settings
Grass Rendering Option no longer uses separate antialiasing settings; a very high antialiasing quality 
is used by default.

Model View Options: Override Fill Display
These settings are now part of Graphic Override Rules (Document > Graphic Overrides).

Option to Show Dimension Text Only 
Use this option to display the dimension text only, without any lines. This checkbox is available for 
linear, radial and angle dimensions, to comply with some local standards.
You can display a reference line (on-screen only) for this type of dimension as an aid in editing: turn 
it on at View > On-Screen View Options > Dimension Reference Lines.
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Changed Options When Saving BIMx Model from ARCHICAD
In ARCHICAD 20, the Save as BIMx command is no longer available. Instead, use the File > Publish as 
BIMx Hyper-model command or the Save Hyper-model option from the Navigator Publisher Map.
Both workflows were available in earlier versions. However, as of AC 20, when you publish a BIMx 
Hyper-model (*.bimx), you now have full control within ARCHICAD over the Render mode (including 
GI) and background for each 3D item (view or camera path) contained in the BIMx Hyper-model.

Extra Option at BCF File Import
You can now browse for and locate IFC files referenced by a BCF file imported as a Mark-Up entry. 
This extra step is useful, for example, if the original composite elements were exploded at export: 
this way, the exploded parts will be identified as the original element.

Reorganized Menus and Commands
To make ARCHICAD’s default menu structure more logical, and to group related commands 
together, we have renamed and reorganized some of the menus. Some of the main changes:
The File menu has a new sub-menu called Interoperability (formerly File Special)
Interactive Schedules and other List types are now in separate sub-menus of the Document menu:
The Complex Profiles submenu is now in the Options menu (formerly Design menu).
The Merge Walls/Merge Columns/Merge Beams commands are now in the Edit > Reshape menu.

Other Interface Updates

Undo-Redo Feedback
Whenever you do an Undo or Redo, an on-screen temporary message appears to let you know that 
the action has been carried out.

Quick Layers Palette
Now docks like a Toolbar, taking up less space on screen.

New Parameter in Skin List Label
Thickness parameter can be turned on and off (previously was always visible.)

Feedback on Contour Lines (Composite Structures)
In the Composite Structures dialog, the first contour now indicates it’s the Outside/Top face, while 
the last indicates it’s the Inside/Bottom face, in reference to Walls and Slabs. Previously there was 
no indication which side was which.
656 New Features in ARCHICAD 8-20



New Features in ARCHICAD 20
Info Box Controls
The Info Box “Element” panel for Library Parts has been tidied up, with Empty Opening and Create/
Edit stair now in the popup menu.

Scrolling Through Previews on Mac
On Mac, thumbnail views, such as in Object Settings, now smoothly scroll, no longer jumping from 
one row to another.

Interactive Schedule Feedback and Selection
• When a preview is selected, you now have quicker access to Scale options and info on current 

scale (previously, Scale was available only in the menu)
• Select multiple Schemes to delete them or export them all in one step

Story Settings: Edit Multiple Stories Simultaneously
Multiple Stories can now be selected in the Story Settings dialog to allow Height to Next and show/
hide Story levels to be edited for multiple floors at once. Also, multiple stories can be deleted at one 
time without having to select each story one at a time. Especially useful during early design phases 
of multi-level buildings.

Tracker Settings: New Display Option
Under Work Environment, Tracker and Coordinate Input, the Tracker (and therefore Element Info 
Tag if using Tracker colors) can have a separate Frame color. Also the settings have been tidied up to 
be clearer.

Additional Tab-Opening Preferences
• When you open another view/layout, Work Environment controls let you set a preference to 

open it in either an existing tab or a new one. Now there are two options, so you can set a 
separate preference for each (views and layouts): see Options > Work Environment > More 
Options.

• On Layouts, a Drawing’s context menu includes an option to “Open source view in New Tab” (in 
addition to the existing “Open source view.”) This command not available for Floor Plans or 3D 
views.

Library Part Settings: Search and Display options
• When setting Search options in Library Tool Settings, Surface Catalog and Surface Painter: each 

search location is an on/off control (in previous versions, options were either/or/both).
• From the browser Settings pop-up, use Tree View Above or Tree View on Left to change this 

preference. The folder chooser is automatically hidden, and only appears when the tree view is 
hidden (by double clicking or dragging up the splitter) - this also applies to the Favorites palette 
and pop-up in Tool Settings.
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